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Foreword 

Simulation has come a long way since it was generally adopted in Aerospace and 

Automotive industries in the 1970’s. On the other hand, we still see archaic 

terminology such as “card image” when today’s users may have never seen or used 

a “card” punch.    

Engineers are normally conservative and somewhat slow to change which is a good 

thing for the safety aspects of the products they design. But we live in an ever 

changing and accelerating technological era. Today, simulation is used in every 

industry that designs and manufactures products from toothpaste tubes to rocket 

engines. The demand for engineers in the simulation field has never been higher. 

The advance of computing is relentless. Today’s mobile devices are more powerful 

and can store more information than the supercomputers of the early days of 

simulation. The pace of computing continues to grow at an exponential rate even 

though a receding growth rate has been predicted many times. The only thing that 

is not changing is the basic physics behind the simulation computations. So where 

are we going with all of this advance in capability and demand?  

The level of detail in the simulation models continues to increase with fewer and 

fewer assumptions required to get answers in a reasonable time. As the models 

become more complex the requirements for assembling models, analysis of the 

results, and storing the volumes of input and output are increasing. Altair is 

working to bring the future of simulation to engineers in both an evolutionary and 

revolutionary way. We continue to modernize our tradition tools for ease of use, 

large model handling, and efficiency and at the same invent new ways of working 

for the future generations of engineers.   
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The challenge for the future is to make the complex simple by reducing the 

requirements put on the user to get into the details unless necessary or desired. 

The simulation process can be more systematic and guided versus more of an art 

as it is sometimes today.   Two engineers solving the same problem should be able 

to get similar results by establishing processes that are repeatable.  More realistic 

representation of reality can be achieved by stochastic analysis where the variation 

of real products is a standard part of the simulation process. Data and processes 

can be shared within teams and across teams. Finally, with advance in technology 

we will see a return to remote computation or as it is called today cloud computing 

which will include high speed 3D graphics. Altair is working in all of the directions 

described above to bring the best value and experience to the engineering 

community worldwide. 

In the document that follows, you will see elements of where we are going. But the 

reality is there is a lot to learn and the knowledge you need to successfully apply 

simulation is quite vast. Good luck in your endeavours and we hope we can be of 

value to you now and throughout your career. 

James E. Brancheau, Altair 

 Altair Engineering 
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About This Book 

Over the years Altair has matured into a solver company with OptiStruct (linear and 

nonlinear implicit, structural optimization), RADIOSS (non-linear explicit Finite Element 

Analysis), solidThinking Inspire (structural optimization), MotionSolve (multibody 

simulation), AcuSolve (Computational Fluid Dynamics or CFD), and FEKO (electro-

magnetic field simulation).  

Altair has always extended its hands to academia – in the past mainly with regards to 

modeling (pre-processing) and visualization (post-processing). Today, Altair’s CAE 

offering is more complete and suitable to universities. Thus, we are very grateful that 

many universities adopted HyperWorks& solidThinking in their engineering programs in 

order to train students in the Simulation-Driven Design and Optimization Process.  

The Altair Student Edition 2017 in combination with our learning and teaching program 

target the needs of teachers and students. 

“It is exciting news that the student version of HyperWorks is now available,” 

said Dr. Wei Chen, Wilson-Cook Professor in Engineering Design at 

Northwestern University. “This program truly demonstrates Altair’s 

commitment to enhancing students’ learning experience outside the 

classroom so that they can reinforce their engineering knowledge and 

classroom instruction.” 

Still, we realized that a dedicated CAE book including some best practice tips were 

missing. This was the moment when we decided to publish our CAE expertise in a book 

addressing questions typical raised by students. 
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At that time, it so happened that we learned about the book by Nitin S. Gokhale and his 

team with the title 

Practical Finite Element Analysis (from Finite to Infinite) 

An amazing book with the focus on what we were targeting at. Nitin S. Gokhale and his 

team immediately agreed to merge their CAE book and Altair’s simulation training 

material into this Study Guide. 

Even though it is the 5th Edition of this collaborative work, it is by far not complete. The 

book still is “Work in Progress”.  

This book intends to provide basic information to help the beginner Finite Element 

Analysis (FEA) modeler as well as the novice HyperWorks user to get started.  

And we know that becoming familiar with a (new) CAE system such as HyperWorks is 

somewhat comparable to learning, for instance, a new language. At the same time, we 

all face a major challenge: not having enough time. This challenge is universal. This is 

because we are educated to constantly increase the pace of our lives and work. 

Hence, learning new technologies must be as easy (and as comfortable) as possible. 

Otherwise, as practice shows, making the first step is very difficult. 

At the beginning there are many questions, such as: 

• Where to start? 

• Which “rules” are important?  

• Where to learn? 

• When to learn? 

• etc. 
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So how does one become familiar with FEA and become a proficient HyperWorks user? 

To support your endeavours in learning more about FEA and HyperWorks, we offer (in 

addition to this book): 

• The Learning & Certification Program with more than 28 eLearning courses 

https://certification.altairuniversity.com/ 

• Additional free study guides about Nonlinear Finite Element Analysis, 

Introduction to Explicit Finite Element Analysis, Introduction to Dynamic Analysis 

with OptiStruct, Introduction to Composite Analysis and Optimization, etc… 

• Highly discounted seminars at colleges or at Altair facilities, 

• Best practice Tips and Tricks, 

• Academic User Meetings, 

• Academic Blog (altairuniversity.com/academic) to stay up to date with news 

about Altair and our technology, 

• Moderated Support Forum. If you need help cracking any technical queries 

pertaining to Altair’s software suite HyperWorks, please feel free to post your 

questions on the moderated Support Forum https://forum.altair.com/  

• and more .... 
 

An ideal supplement to this book is the free Altair Student Edition which allows you to 

study and practice the various topics addressed in this book. 

 

More information about the Student Edition is available on Altair University 

https://altairuniversity.com/academic/. 

 

 

 

We are confident that this “ecosystem” will help you get up to speed quickly. 

https://certification.altairuniversity.com/
https://forum.altair.com/
http://www.altairuniversity.com/free-hyperworks-13-0-student-edition-3/
http://www.altairuniversity.com/free-hyperworks-13-0-student-edition-3/
http://www.altairuniversity.com/free-hyperworks-13-0-student-edition-3/
http://www.altairuniversity.com/academic-program/
http://www.altairuniversity.com/academic-program/
https://altairuniversity.com/academic/
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And now - enjoy the latest edition of this book and keep on learning and exploring. 

Best regards 

Dr. Matthias Goelke 

On behalf of “The Altair University Team” in cooperation with Finite to Infinite 

 

P.S.: We would appreciate your feedback about your learning experience  

(eMail to altairuniversity@altair.com)  

mailto:altairuniversity@altair.com
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HyperWorks For Teaching 
Leading universities across the globe are using HyperWorks computer aided engineering 

(CAE) simulation software for teaching and research in the fields of: 

• Structural Analysis 

• Computational Fluid Dynamics (CFD) 

• Optimization 

• Multi-Body Simulation (MBS) 

• Electro-Magnetic Simulation (EM) 

• Model Based Development and much more! 

Altair has commercial expertise to share with the academic community. By including 

real life scenarios in your teaching material, Altair can help you add value to your 

engineering design courses. 

Moreover, we provide teachers and professors curriculum material (PPT’s, reading 

material, exercises with model files). This free offer hopefully makes your life easier … 

https://altairuniversity.com/teaching-simulation-driven-innovation/ 

 

https://altairuniversity.com/teaching-simulation-driven-innovation/
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Our unique licensing system allows universities to use the entire HyperWorks suite in a 

very flexible and cost-efficient way: 

 

*Results may be used for marketing, training and demo purposes 

Please let us know your requirements by sending an eMail notification to  

altairuniversity@altair.com 

We are more than happy helping and assisting you with your teaching activities. 

 

  

Non- 
commercial  
research* 

Complimentary  
Student Edition 

No 

limitation on  
model size 

Entire Suite 

Professor 2 
Professor 3 
Professor 4 

Freely accessible 

by  
other teachers 

(same campus) 

Support 

On-site  
seminars/  
demos 

Teaching 
  

License 
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1. CAE-Driven Design Process 
*This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 

Infinite)” as well as information from the HyperWorks Help Documentation. Additional material 

was added by Matthias Goelke and Jan Grasmannsdorf. 

The “CAE-Driven Design Process” has gained significant attraction in most industries such 

as aerospace, automotive, biomedical, consumer goods, defense, energy, electronics, 

heavy industry, and marine throughout the last years. There are many reasons for the 

overall acceptance of CAE as simulation has proven to help with: 

• New and inspiring designs 

• Products with better quality (e.g. increased material efficiency where less 

material = lighter designs) 

• Designing faster (i.e. due to shortened development cycles and a reduction in 

the number of prototypes by minimizing “Trial and Error” attempts 

In other words, simulation saves time, reduces costs, and essentially strengthens the 

competitiveness of companies, thus strengthening their market position.  

When doing an analysis, we always target optimum designs, but the methods and tools 

we use in achieving the optimum design makes a difference. Still, in many “places” the 

design process is a trial-and-error process which depends on the selection of the initial 

design. This is not a well-established process in terms of how the design evolves and 

depends on the engineer’s prior experience. Due to these challenges reaching the best 

design is not guaranteed. 

To overcome these hurdles, numerical optimization is used to search for and determine 

the optimum design. 
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With the Altair Design Approach, a “concept” optimization step is employed early in the 

design process which delivers a conceived design proposal. 

 

Starting the CAE process with an optimized concept design sounds contradictory. How 

does one start with something being optimized while not really knowing how to start? 
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Without getting lost in detail – the principal working scheme (depicted in the figure 

above) is as follows: 

1. Define the maximum package/design space. If needed exclude areas/regions 

(i.e. non-design space) 

2. Finite element mesh the structure (design and non-design area) 

3. Assign material properties 

4. Apply loads and constraints 

5. Specify the objective of the optimization problem (e.g. use minimum 

weight/volume only but make sure that certain responses such as 

displacements, do not exceed specified threshold values) 

  

This optimization delivers a design concept which answers questions such as where to 

remove material, where to place (stiffening) ribs, etc. After the optimization results have 

been interpreted and smoothed (in the CAD system) an analysis is carried out to verify 

the optimized components performance. Based on these results, another optimization 

step may follow, addressing questions such as how to change local geometry in order to 

reduce stress peaks or how thick do the stiffening ribs really need to be. 

By following this design process, unnecessary redesign loops are eliminated leading not 

only to shortened design cycles but also to more competitive products.  

 

“Optimization of a structural part is all about efficient material use. Using OptiStruct takes 

the question of material distribution in a design out of the equation and tells you exactly 

what you need to do and where the material needs to be. If you use OptiStruct, you can 

skip all that messing around with different options, because it gives you the best options 

straight away.” (Mark Stroud, Monash Motorsport Team) 
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2 Introduction to Finite Element 

Analysis 

This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 

Infinite)” as well as information from the HyperWorks Help Documentation. Additional material 

was added by Matthias Goelke and Jan Grasmannsdorf. 

2.1 A Brief Summary 
As mentioned in the introduction to this guide we deliberately refrained from inlcuding a 

chapter about the theory of the Finite Element Method. The reason is rather simple - the 

book shelves in the libraries are filled up with thousands of books about FEM already. In 

addition, in the web you will find a countless number of online learning material like 

reports, FEM lecture notes, videos and so on.  

Hence, the table below is meant to give FEM beginners a “feeling” on what is happening 

in the background. 
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Methods to Solve Any Engineering Problem 

 

Analytical Method Numerical Method Experimental Method 

• Classical approach 

• 100% accurate results 

• Closed form solution 

• Applicable only for simple 

problems like cantilever and 

simply supported beams, etc. 

• Complete in itself 

• Mathematical representation 

• Approximate, assumptions 

made 

• Applicable even if a physical 

prototype is not available  

(initial design phase) 

• Real life complex problems 

• Results cannot be believed 

blindly. Certain results must be 

validated by experiments 

and/or analytical method. 

• Actual measurement 

• Time consuming and needs 

expensive set up 

• Applicable only if physical 

prototype is available 

• Results cannot be believed 

blindly and a minimum of 3 to 5 

prototypes must be tested 

Though analytical methods could 

also give approximate results if 

the solution is not closed form, in 

general analytical methods are 

considered as closed form 

solutions i.e. 100% accurate. 

Finite Element Method: Linear, 

nonlinear, buckling, thermal, 

dynamic, and fatigue analysis 

Boundary Element Method: 

Acoustics, NVH  

Finite Volume Method:  

CFD (Computational Fluid  

Dynamics) and Computational 

Electromagnetics 

Finite Difference Method: Thermal  

and Fluid flow analysis (in 

combination with FVM) 

• Strain gauge 

• Photo elasticity 

• Vibration measurements 

• Sensors for temperature and 

pressure, etc. 

• Fatigue test 
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Procedure for Solving Any Analytical or Numerical Problem 

There are two steps to solving analytical or numerical problems: 

Step 1) Writing of the governing equation – Problem definition, or in other words, 

formulating the problem in the form of a mathematical equation. 

Step 2) Mathematical solution of the governing equation.  

The final result is the summation of step 1 and step 2. The result will be 100% accurate 

when there is no approximation at either of the steps (analytical method).  

Numerical methods make an approximation at step 1 and at step 2, therefore all 

numerical methods are approximate.  

 Analytical “Approximation” Numerical 

“Approximation” 

Step 1 Little or no approximation ✓ 

Step 2 Little or no approximation ✓ 

Accuracy High accuracy Approximate results 

 

Brief Introduction to Different Numerical Methods 

1)  Finite Element Method (FEM): 

FEM is the most popular numerical method.  

The Finite Element Method (FEM) is a numerical technique used to determine the 

approximated solution for a partial differential equations (PDE) on a defined domain (W). 

To solve the PDE, the primary challenge is to create a function base that can approximate 

the solution. There are many ways of building the approximation base and how this is 

done is determined by the formulation selected. The Finite Element Method has a very 

good performance to solve partial differential equations over complex domains that can 

vary with time. 
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Applications - Linear, nonlinear, buckling, thermal, dynamic and fatigue analysis. FEM will 

be discussed later.  

Are FEA and FEM different?  

Finite Element Method (FEM) and Finite Element Analysis (FEA) are one and the same. 

The term “FEA” is more popular in industries while “FEM” is more popular at universities.  

Many times, there is confusion between FEA, FEM, and one more similar but different 

term FMEA (Failure Mode Effect Analysis). FEA/FEM is used by design or Research and 

Development departments only, while FMEA is applicable to all of the departments.  

2) Boundary Element Method (BEM):  

This is a very powerful and efficient technique to solve acoustics or NVH problems. Just 

like the finite element method, it also requires nodes and elements, but as the name 

suggests it only considers the outer boundary of the domain. So, when the problem is of 

a volume, only the outer surfaces are considered. If the domain is of an area, then only 

the outer periphery is considered. This way it reduces the dimensionality of the problem 

by a degree of one and thus solving the problem faster.  

The Boundary Element Method (BEM) is a numerical method of solving linear PDE which 

have been formulated as integral equations. The integral equation may be regarded as an 

exact solution of the governing partial differential equation. The BEM attempts to use the 

given boundary conditions to fit boundary values into the integral equation, rather than 

values throughout the space defined by a partial differential equation. Once this is done, 

in the post-processing stage, the integral equation can then be used again to calculate 

numerically the solution directly at any desired point in the interior of the solution 

domain. The boundary element method is often more efficient than other methods, 

including finite elements, in terms of computational resources for problems where there 

is a small surface/volume ratio. Conceptually, it works by constructing a “mesh” over the 
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modeled surface. However, for many problems boundary element methods are 

significantly less efficient than volume-discretization methods like FDM, FVM or FEM. 

3) Finite Volume Method (FVM): 

The Finite Volume Method (FVM) is a method for representing and evaluating partial 

differential equations as algebraic equations [LeVeque, 2002; Toro, 1999]. It is very similar 

to FDM, where the values are calculated at discrete volumes on a generic geometry. In 

the FVM, volume integrals in a partial differential equation that contain a divergence term 

are converted to surface integrals, using the divergence theorem. These terms are then 

evaluated as fluxes at the surfaces of each finite volume. Because the flux entering a given 

volume is identical to that leaving the adjacent volume, these methods are conservative. 

Another advantage of the finite volume method is that it is easily formulated to allow for 

unstructured meshes. The method is used in many computational fluid dynamics 

packages. 

4) Finite Difference Method (FDM):  

Finite Element and Finite Difference Methods share many common things. In general, the 

Finite Difference Method is described as a way to solve differential equation. It uses 

Taylor’s series to convert a differential equation to an algebraic equation. In the 

conversion process, higher order terms are neglected. It is used in combination with BEM 

or FVM to solve thermal and CFD coupled problems. 

Finite Difference Method is the discretization of partial differential equations while Finite 

Element Method, Boundary Element Method and Finite Volume Method are the 

discretization of the integral form of the equations 

Question: Is it possible to use all of the methods listed above (FEA, BEA, FVM, FDM) to 

solve the same problem (for example, a cantilever problem)?  
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The answer is YES! But the difference is in the accuracy achieved, programming ease, and 

the time required to obtain the solution.  

When internal details are required (such as stresses inside the 3D object) BEM will lead 

to poor results (as it only considers the outer boundary), while FEM, FDM, or FVM are 

preferable. FVM has been used for solving stress problems but it is well suited for 

computational fluid dynamics problems where conservation and equilibrium is quite 

natural. FDM has limitations with complicated geometry, assembly of different material 

components, and the combination of various types of elements (1D, 2D and 3D). For 

these types of problems FEM is far ahead of its competitors.  

 

Discretization of Problem:  

All real-life objects are continuous. This means there is no physical gap between any two 

consecutive particles. As per material science, any object is made up of small particles, 

particles of molecules, molecules of atoms, and so on and they are bonded together by 

the force of attraction. Solving a real-life problem with the continuous material 

approach is difficult. The basis of all numerical methods is to simplify the problem by 

discretizing (discontinuation) it. In other words, nodes work like atoms and the gap in 

between the nodes is filled by an entity called an element. Calculations are made at the 

nodes and results are interpolated for the elements.  
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There are two approaches to solve any problem  

 

 

 

 

 

 

 

 

 

 

 

 

Discrete (mathematical 

equivalent) model, chair  

represented by shell and 

beam elements, person via 

lumped mass at C.G. 

 

From a mechanical engineering point of view, any component or system can be 

represented by three basic elements:  

Mass ‘m’   

Spring ‘k’  

Damper ‘c’   

All the numerical methods including the Finite Element Method follow the discrete 

approach. Meshing (nodes and elements) is nothing but the discretization of a continuous 

system with infinite degrees of freedom to a finite degrees of freedom.  

 

 

 

 

 

Continuous approach 

All real-life components 

are continous 

 

        Discrete approach 

Equivalent mathematical 

modeling 

                                                   

 

                                              

Discrete  
(mathematical 
equivalent) model, chair 
represented by  
shell and beam 
elements, person 
 via lumped 
mass at C.G. 

 

K 



 

28 
 
 
 

When Can We Say That We Know the Solution to The Above Problem? 

If and only if we are able to define the deformed position of each and every particle 

completely. 

 

 

 

 

The minimum number of parameters (motion, coordinates, temperature, etc.) 

required to define the position and state of any entity completely in space is known 

as degrees of freedom (dof)  

Consider the following 2-D (planar) problem. Suppose the origin is at the bottom left 

corner and is known. To define the position of point A completely with respect to the 

origin, we need two parameters i.e. x1 and y1, in other words 2 dofs (translation x and y). 

P 

P’ 

Q ’ 

Q 
y 

x 
z 
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Consider that the point A is a part of a line, now one angle should also be defined in 

addition to the two translations i.e. 3 dofs (two translations and one rotation).   

 

Suppose points A and B are shifted out of the plane and the line is rotated arbitrarily with 

respect to all of the three axes.  The minimum number of parameters to define the 

position of point A completely would be 6 dofs i.e. 3 translations (Ux , Uy , Uz) and 3 

rotations (θx , θy , θz).  

DOF is a very important concept. In FEA, we use it for the individual calculation points.  

y 

x 

 x 1 

y 1 

A 

B 

A 

B 

y 

x 
z 



 

30 
 
 
 

The total DOFs for a given mesh model is equal to the number of nodes multiplied by 

the number of dof per node.    

All of the elements do not always have 6 dofs per node. The number of dofs depends on 

the type of element (1D, 2D, 3D), the family of element (thin shell, plane stress, plane 

strain, membrane, etc.), and the type of analysis. For example, for a structural analysis, a 

thin shell element has 6 dof/node (displacement unknown, 3 translations and 3 rotations) 

while the same element when used for thermal analysis has single dof /node 

(temperature unknown). 

For a new user, it is a bit confusing but there is a lot of logical, engineering, and 

mathematical thinking behind assigning the specific number of dofs to different element 

types and families.   

 

Why Do We Carry Out Meshing?  What Is FEM / FEA?  

FEM  

- A numerical method  

- Mathematical representation of an actual problem 

- Approximate method   

The Finite Element Method only makes calculations at a limited (Finite) number of points 

and then interpolates the results for the entire domain (surface or volume).  
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Finite – Any continuous object has infinite degrees of freedom and it is not possible to 

solve the problem in this format.  The Finite Element Method reduces the degrees of 

freedom from infinite to finite with the help of discretization or meshing (nodes and 

elements).  

Element – All of the calculations are made at a limited number of points known as nodes. 

The entity joining nodes and forming a specific shape such as quadrilateral or triangular 

is known as an Element. To get the value of a variable (say displacement) anywhere in 

between the calculation points, an interpolation function (as per the shape of the 

element) is used.  

Method - There are 3 methods to solve any engineering problem. Finite element analysis 

belongs to the numerical method category.  

It is not necessary to remember the mathematical definition of FEM word by word as 

given in theoretical text books. Rather what is important is to understand the concept 

and then be able to describe it in your own words.  

 

How the Results are Interpolated from a Few Calculation Points  

It is ok that FEA is making all the calculations at a limited number of points, but the 

question is how it calculates values of the unknown somewhere in between the 

calculation points.  

This is achieved by interpolation. Consider a 4 noded quadrilateral element as shown in 

the figure below.  A “quad4” element uses the following linear interpolation formula: 

u = a0 + a1 x + a2 y + a3 xy 

FEA calculates the values at the outer nodes 1, 2, 3, 4 i.e. a0, a1, a2, a3 are known.  



 

32 
 
 
 

 

4 noded (linear) quad 

The value of the variable anywhere in between could be easily determined just by 

specifying x and y coordinates in above equation.  

For an 8 noded quadrilateral, the following parabolic interpolation function is used: 

 u = a0 + a1 x + a2 y + a3 xy + a4 x2 + a5 y2 + a6x2 y + a7 xy2 

                                                                                                                         1                   2                   3 

 

8 noded (parabolic) quad 

How is the Accuracy if we Increase the Number of Calculation Points (Nodes and 

Elements)?  

In general, increasing the number of calculation points improves the accuracy.  

Suppose somebody gives you 3 straight lines and asks you to best fit it in a circle, then 

find the area of the triangle and compare it with the circle area. This is then repeated with 

4, 6, 8, 16, 32 and 64 lines.    

1 2 

3 4 

? 

? 

? 

8 4 

7 5 6 
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By increasing the number of lines, the error margin reduces. The number of straight lines 

is equivalent to the number of elements in Finite Element Analysis.  

The exact answer for the area of the circle (π r2) is 100. 3 lines gives the answer of 41, 

while 4 lines gives 64, and so on. An answer of 41 or 64 is not at all acceptable, but 80 or 

90 is, considering the time spent and the relative design concept.  

 

If a higher number of nodes and elements leads to a higher accuracy, then why not always 

create a very fine mesh with the maximum possible number of nodes and elements? The 

reason is because the solution time is directly proportional to (dof)n.. n can be 1 to 4, 

depending on the type of analyses and solver. Also, large size models are not easy to 

3  Lines 4  Lines 

6  Lines 8  Lines Shaded Area is Error 
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handle on computers due to the graphics card memory limitations. The analyst has to 

maintain a fine balance between the desired level of accuracy and the element size (dof) 

that can be handled satisfactorily using the available hardware resources.  

Assume the Analytical Method approach gives answers very close to 100 and the time it 

takes is 1 month, while the Finite Element Analysis with a reasonable mesh size gives an 

answer of 90 within 1 day. In industry, getting fast solutions with logical or reasonable 

accuracy is more important than absolute accuracy.  

That’s why the analytical method approach is also known as the Scientists way to solve 

any problem while the Numerical method is the Engineers way to solve the problem. 

Advantages of FEA 

• Visualization 

• Design cycle time 

• No. of prototypes 

• Testing  

• Optimum design 

Visualization of results: For simple geometries such as a simply supported beam or a 

cantilever beam, it is easy to visualize the point of the maximum stress and displacement. 

But in real life, parts or assemblies with complex geometric shapes are made up of 

different materials with many discontinuities subjected to flexible constraints and 

complex loading varying with respect to time and point of application. This is further 

complicated by residual stresses and joints like spot and arc welds, etc. Because of this, it 

is not easy to predict the failure location. Imagine someone shows you a complicated 

engine block and asks you to predict the failure location for a given set of forces. It is not 

easy to predict it successfully unless you have years of experience in the field. But with 
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tools like CAD and CAE, if modelled in an appropriate fashion, one can easily get stress 

contour plots that clearly indicate the locations of high stress or displacement.  

Previously, components used to be designed by highly experienced engineers who had 

seen a lot of testing and failures of the components in real life. These days, in most 

organizations, design engineers are very young, using tools like CAD / CAM / CAE and are 

confident about their designs. 

What is Stiffness and Why Do We Need it in FEA?  

Stiffness ‘K’ is defined as Force/length (units N/mm). Physical interpretation – Stiffness is 

equal to the force required to produce a unit displacement. The stiffness depends on the 

geometry as well as the material properties.  

 

 

Consider 3 rods of exactly the same geometrical dimensions – Cast Iron, Mild Steel, and 

Aluminium. If we measure the force required to produce a 1 mm displacement then the 

Cast Iron would require the maximum force, followed by Steel and Aluminium 

respectively, indicating KCI > KMS > KAl 
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                        Mild Steel           Mild Steel                                    Mild Steel 

 

Now consider 3 different cross sectional rods of the same material. Again, the force 

required to produce a unit deformation will be different. Therefore, stiffness depends on 

the geometry as well as the material. 

Importance of the stiffness matrix - For structural analysis, stiffness is a very important 

property. The equation for linear static analysis is [F] = [K] [D]. The force is usually known, 

the displacement is unknown, and the stiffness is a characteristic property of the 

element. This means if we formulate the stiffness matrix for a given shape, like line, 

quadrilateral, or tetrahedron, then the analysis of any geometry could be performed by 

meshing it and then solving the equation F = K D. Methods for formulating the stiffness 

matrix –  

1) Direct Method 

2) Variational Method 

3) Weighted Residual Method 

The direct method is easy to understand but difficult to formulate using computer 

programming. While the Variational and Weighted Residual Methods are difficult to 

understand, but easy from a programming point of view. That’s the reason why all 

software codes either use the Variational or Weighted Residual Method formulation.  
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Rod Element Stiffness Matrix Derivation by The Direct Method 

Methodology for derivation of stiffness matrix by the direct method:  

Assume there are n dof’s for a given element (for example, a quad4 element’s total dofs 

= 4*6 = 24).  

Step 1) Assume the 1st dof ≠ 0, and all the other dof = 0.  This will lead to equation 1. 

Step 2) Assume the 2nd dof ≠ 0, and all the other dof = 0.  This will lead to equation 2. 

: 

: 

Step n) Assume the nth dof ≠ 0, and all the other dof = 0.  This will lead to equation n. 

Step n+1) Sum all the equations, 1 + 2 + 3 + 4 ………..+ n. 

Step n+1 will give us the most generalized formulation of the stiffness matrix.  

 

 

 

Stiffness matrix formulation (Direct Method) 

 

U i 
F i 

i j 
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Case 1:         

  

ui >0,        uj=0 

∑Fx = 0              Fi + Fj =0            Fi = -Fj  

σx = F/A            ε = u/L  

σx = ε E             F/A= Eu/L 

 

Fi = (AE/L)*ui      Fj = -Fi = - (AE/L)*ui               ………...……..      (A) 

Case 2:   ui =0    uJ>0 

    Fj = (AE/L)*uj   Fi = -Fj = - (AE/L)*uj              …………  (B) 

U 

 

Fi = -Fj 

Case 3:  General case  -  ui , uj > 0 

                 From (A) and (B) 

    Fi =  (AE/L)*ui  –  (AE/L)*uj 

    Fj = -(AE/L)*ui  +  (AE/L)*uj 

i 

j 

j 

F j 

STATICS 

∑F x  = 0   ∑M x  = 0 

∑F y  = 0   ∑M y  = 0 

∑F z  = 0   ∑M z  = 0 
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Properties of the stiffness matrix 

• The order of the stiffness matrix corresponds to the total dofs. 

• A singular stiffness matrix means the structure is unconstrained and has rigid 

body motion. 

• Each column of the stiffness matrix is an equilibrium set of nodal forces 

required to produce the unit respective dof. 

• A symmetric stiffness matrix shows the force is directly proportional to 

displacement. 

• Diagonal terms of the matrix are always positive meaning a force directed in 

say the left direction cannot produce a displacement in the right direction. 

Diagonal terms will be zero or negative only if the structure is unstable. 

Rod elements support only tension or compression and no shear force or bending. In the 

above equation, the order of the stiffness matrix is 2x2, where the number of unknowns 

is 2.  

Number of unknowns = no. of dofs - no. of dofs constraint by a Single Point Constraints 

(at fixed nodes, dofs are specified by the user as 0) 

Usually in comparison to the total dofs for the model, the constraints are negligible and 

therefore the total no. of unknowns is approximately the total dofs.   

The order of the stiffness matrix = total dof x total dof  



 

40 
 
 
 

Summary - Stiffness Matrix, Assembly of 2 Rod Elements 

F 

Because of a force at point 3, what would the force be at Points 1 and 2? Before reading 

the answer, please shut your eyes and try to visualize the forces at the various points.  

For equilibrium Σ Fx = 0. The reaction force at point 1 is  –F and at point 2 = 0.  

The free body diagram is: 

-F  F 

   2b 3 

Total force at point 2 = - F + F = 0 

In any finite element model, the summation of forces and moments is zero at the internal 

nodes (except the nodes which are restrained and at which the external force and 

moment is applied). The overall summation of the forces and the moments for the 

complete model is 0. (The external forces and moments = the reaction forces and 

moments). This is one of the important checks for ensuring correct results. 

 

 

 

 

 

 

1 2 3 
A 1  E 1  L 1 A 2  E 2  L 2 

F 
1 2 a 

A 1  E 1  L 1 - F A 2  E 2  L 2 
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Example: Assembly of 2 rod elements 

 

K1 = A1E1 / L1  = 104 N/mmK2 =  A2E2 / L2  =  2 * 104 N/mm 

 

 

 

 

 

A 1  E 1  L 1 A 2  E 2  L 2 

1 2 3 

F = 1000 N 

R = 2 mm 

L 1  = 259.74 L = 519.48 
R = 4 mm 
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Some more discussion on assembly the global stiffness matrix from the local stiffness 
matrices for 1D bar elements. (found on Youtube, recording by Jack Chessa) 
 

 

 

 

 

 

 

 

 

https://www.youtube.com/watch?v=y1BpkAgEhAk
https://www.youtube.com/watch?v=YkCJj-Q5IcU
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We need to understand that in the before depicted “Force - Stiffness - Displacement” 

relationship the global and local coordinate system are the same (element is oriented in 

x-direction). Typically, they are different. Hence, local and global quantities are “linked” 

through a transformation matrix as shown below.  

For the more general case – which we will have a look at next – local quantities are 

marked as  

 

 

with 

 

 

In order to take displacements in y-direction into account 

 

we are expressing the displacements d in node 1 with respect to the local and global 

coordinate system.  
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The displacements in the global coordinate system are written as  𝑢1 𝑎𝑛𝑑 𝑣1. 

 

From the image above, we can directly derive: 

 

 

Written in Matrix form 
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Including node 2 of the element, the above equation may be written as 

 

alternatively 

 

With T being the transformation matrix: Multiplying global quantities 𝑤𝑒  with T 

transforms them into local quantities              Nodal forces may be written in the same 

way: 

 

alternatively 

 

Quite obviously, if global quantities are requested, we need to rearrange the above 

equation. 

 

Here it is  

 

thus                                                      

As we already know, multiplying local quantities with  𝑇𝑇  transforms into global 

quantities. 

More generally, we include the nodal forces   (node 2) in our equation from above (here            

and          are 0).  
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Taking into account 

 from above follows  

 

And again, making use of  

 

and  

 

results in  

  

or simply 

 

with 

 

Let’s have a look at the  matrix 

 

node 1) and  
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The [  ] matrix is commonly abbreviated as 

 

Example 

Let’s apply these basics to the following “problem” which was originally formulated by 

Professor B. Wender (University Ulm / Germany).  

Objective: Determine the nodal displacements and the force in element I 

Given:  
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Let us first determine the values of   regarding every element, respectively. 

 

 

 

Units in kN and mm. 

Element I 

𝛼 = 90°  

c2 = 0; s2 = 1; cs = 0 

𝐷𝐼 = 72,593 



 

49 
 
 
 

 

 

Element II 

𝛼 = 53° 

c2 = 0,3622; s2 = 0,6378; cs = 0,4806 

𝐷𝐼𝐼 = 32,611 

 

 

Element III 

𝛼 = −145° 

c2 = 0,6710; s2 = 0,3280; cs = 0,4698 

𝐷𝐼𝐼𝐼 = 49,598 
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Force equilibrium 
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With above the system of equations may be written as: 

 

Taking the constraints: 

 

into account leads to the 2 equations 

 

and 

 

 

 

Force in element I (with values from above) 

 35,784 kN 

The corresponding simulation results based on OptiStruct are shown below. Note: The 

model set-up and analysis are discussed in Chapter “Linear Static Analysis”.  
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Displacements in uy - direction (-0.492 mm) 

 

Displacements in ux- direction (0.939 mm) 
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Principal Stresses 

Force in element I 

 

In case you are not experienced with truss structures you may like the lesson (video 

below) on solving a truss (not related to FEA).  

Topics covered include determining whether the truss is statically determinate, finding 

external reaction forces, and finding internal forces  

(https://www.youtube.com/watch?v=qzmeFq8rckw) 

 

https://www.youtube.com/watch?v=qzmeFq8rckw
https://www.youtube.com/watch?v=qzmeFq8rckw
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2.2 Element Types 
In the following, mostly used element types are listed. Their number of nodes and 

DOFs are given so that the user understands the compatibility between different 

element types – matching DOFs number.  

Rod Element  

  

   Example of rod element  

  Nodes     2   nodes  

   DOFs     3 or 6 degrees of freedom per node  

Beam Element  

  

 Example of beam element  

   Nodes   2   nodes  

   DOFs      6   degrees of freedom per node  



 

55 
 
 
 

Shell Element  

  

   Example of shell elements (CTRIA3, CQUAD4, CTRIA6, CQUAD8)  

   First Order   4 or 3     nodes  

   Second Order  6 or 8     nodes  

   DOFs      6      degrees of freedom per node  

Solid Element  

  

   Example of tetrahedron, pyramid, penta and hexa elements  
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   First Order   4, 5, 6, 8      nodes  

   Second Order   8, 12, 15, 20      nodes   

   DOFs      3         degrees of freedom per node  

Higher Order Elements  

Higher order elements are those with one or more mid-side nodes, or geometry based 

elements, such as p-version elements. These types of elements offer the benefits of ease 

of modeling and a higher degree of accuracy per element. P-version type elements also 

have a built-in ability to check convergence by increasing the integration level although 

it is more difficult to understand their fundamental behavior.  

Higher order elements give rise to issues such as the sophisticated methods required to 

apply pressure to the face of a shell element. The required distribution of nodal loads to 

accomplish the same resultant force (F=P*A) on a 4 -node and an 8-node shell element is 

shown below.  

 

 

 

 

 

 

  

 

Consistent Pressure Loads for Shells (F = P x A)  
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Most codes handle these details, but you should understand these and the other 

fundamentals of higher order elements to avoid confusion. Higher order elements are 

most often used in 3-D solid modeling because the potential to reduce modeling effort 

and the number of elements required to capture the geometry is greater. Solution time 

is not often reduced however because the global stiffness matrix is based on nodal DOF 

in the model.  

Formulations for 2D elements 

1) Plane Stress   

Degrees of Freedom (DOFs) – 2 / node {Ux, Uy (in-plane translations)} 

Stress in z direction (thickness) is zero (σz = 0)  

S  

z  

Practical Applications: Thin sheet metal parts, like aircraft skin, narrow beams. 

2) Plain Strain - DOFs – 2 / node {Ux, Uy (in-plane translations)} Strain in z direction 

(thickness) is zero (εz = 0)  

 

  

y   

x   

Total dof = 8   

U   y   

U   x   

U   y   

U   x   

U   y   

U   x   

U   y   

U   x   

  

y   
x   

Total dof = 8   

U   y   

U   x   

U   y   

U   x   

U   y   

U   x   

U   y   

U   x   
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z  

Practical Applications: Under ground pipes, wide beams, dams  

Plane stress and plane strain elements are used for 2D (planar) problems.   

3) Plate - DOFs – 3 / node   {θx, θy (in plane rotations) + Uz (out of plane translation)}  

 

Practical Applications: Bending load application.  

Plate elements are three- or four-node elements formulated in three-dimensional 

space. These elements are used to model and analyze objects such as pressure 

vessels, or structures such as automobile body parts. The out-of-plane rotational 

DOF is not considered for plate elements. You can apply the other rotational DOFs 

and all the translational DOFs as needed. Nodal forces, nodal moments (except when 

about an axis normal to the element face), pressures (normal to the element face), 

acceleration/ gravity, centrifugal and thermal loads are supported.  Surface-based 

loads (pressure, surface force, and so on, but not constraints) and element 

properties (thickness, element normal coordinate, and so on) are applied to an 

entire plate element. Since these items are based on the surface number of the lines 

forming the element, and since each element could be composed of lines on four 

different surface numbers, how these items are applied depend on whether the 

mesh is created automatically (by either the mesher from a CAD model or the 2D 

mesh generation), or whether the mesh is created by hand. The surface number of 

  

Total dof = 12   
y   

z   
x   

θ   y   

θ   x   U   z   

θ   y   

θ   x   U   z   

θ   y   

θ   x   U   z   

θ   y   

θ   x   U   z   



 

59 
 
 
 

the individual lines that form an element are combined as indicated in the table 

above to create a surface number for the whole element. Loads and properties are 

then applied to the entire element based on the element’s surface number 4) 

Membrane - DOFs – 3 / node {Ux, Uy  (in plane translations) + θz (out of plane 

rotation)}  

 

Practical Applications: Balloon, Baffles  

4) Thin Shell - Thin shell elements are the most general type of element.   

DOFs:  6 dof / node (Ux , Uy , Uz , θx , θy , θz).   

Thin Shell      

(Ux , Uy , Uz , θx , θy ,  

=    Plate   

Membrane   
 

              +    

θz)    

=     Uz, θx, θy    +    Ux , Uy , 

θz  

(3T+3R)       =     (1T+2R)   +   (2T+1R)  

  

Total dof = 12   
y   

z   
x   

U   y   

U   x   θ   z   

U   y   

U   x   θ   z   

U   y   

U   x   θ   z   

U   y   

U   x   θ   z   
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Practical Application: Thin shell elements are the most commonly used elements.  

5) Axisymmetric Solid - DOFs -  2 / node {Ux , Uz  (2 in plane translations, Z axis is axis 

of rotation)}  

Why is the word ‘solid’ in the name of a 2D element? This is because though the 

elements are planar, they actually represent a solid. When generating a cylinder in 

CAD software, we define an axis of rotation and a rectangular cross section. Similarly, 

for an axisymmetric model we need to define an axis of rotation and a cross section 

(planar mesh).  

The 2D planar mesh is mathematically equivalent to the 3D cylinder.     

 

Practical Applications: Pressure vessels, objects of revolutions subjected to axisymmetric 

boundary conditions   

  

y   
x   

U   y   

U   x   

U   y   

U   x   

U   y   

U   x   

U   y   

U   x   
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Summary of element types: 

 

Side Note: Why is 2D Meshing Carried Out on A Mid Surface?   

Mathematically, the element thickness specified by the user is assigned half on the 

element top and half on the bottom side. Hence, in order to represent the geometry 

appropriately, it is necessary to extract the mid surface and then mesh on the mid 

surface.    

Midsurface  

 

t - thickness of plate  

t   

t

/
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Practical example: All sheet metal parts, plastic components like instrument panels, etc.  

In general, 2D meshing is used for parts having a width / thickness ratio > 20.  

Limitations of Mid Surface and 2D Meshing  

2D meshing would lead to a higher approximation if used for  

- variable part thickness   

surfaces are not planar and have different features on two sides. 

Constant Strain Triangle (CST) Information  

Some remarks regarding the Constant Strain Triangle (CST) element.  

The explanation below is taken from:   

The CST (Constant Strain Triangle) –An insidious survivor from the infancy of FEA, by R.P.  

Prukl,  MFT  (this  paper  is  also  uploaded  to  the 

 Academic  Blog; https://altairuniversity.com/wp-

content/uploads/2013/06/The_CST.pdf   

The CST was the first element that was developed for finite element analysis (FEA) 

and 40-50 years ago it served its purpose well. In the meantime, more accurate 

elements have been created and these should be used to replace the CST.  

  

  

 

 

 

 

http://www.altairuniversity.com/wp-content/uploads/2013/06/The_CST.pdf
http://www.altairuniversity.com/wp-content/uploads/2013/06/The_CST.pdf
http://www.altairuniversity.com/wp-content/uploads/2013/06/The_CST.pdf
http://www.altairuniversity.com/wp-content/uploads/2013/06/The_CST.pdf
https://altairuniversity.com/wp-content/uploads/2013/06/The_CST.pdf
https://altairuniversity.com/wp-content/uploads/2013/06/The_CST.pdf
https://altairuniversity.com/wp-content/uploads/2013/06/The_CST.pdf
https://altairuniversity.com/wp-content/uploads/2013/06/The_CST.pdf
https://altairuniversity.com/wp-content/uploads/2013/06/The_CST.pdf
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The Explanation  

Consider a 3-noded plane stress element in the xy-plane with node points 1, 2 and  

3. The x-deflections are u1, u2, u3 and the y-deflections v1, v2 and v3, totalling six values 

altogether.  

The displacement function then has the following form (using six constants ai to describe 

the behavior of the element):  

  

  

The direct strains can then be calculated by differentiation:  

What Does This Mean?  

The strains in such an element are constants. We know, however, that in a beam we 

have compression at the top and tension at the bottom. Our single element is, 

therefore, not capable of modelling bending behavior of a beam, it cannot model 

anything at all.  Note: Three-noded elements for other applications than plane stress 

and strain are quite acceptable, e.g., plate bending and heat transfer.  

The Remedy  

Use elements with four nodes. We then have eight constants to describe the behavior of 

the element:  
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The direct strains are then as follows:    

 

 

 

 

The strain in the x-direction is now a linear function of its y-value. This is much better 

than for the triangular element. Use triangular elements which also include the 

rotational degree of freedom about the z-axis normal to the xy-plane.  
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For a Given FE Model, How Many Equations Does a Software Solve?  

Assume there are 20,000 nodes for a mesh model consisting of only thin shell elements 

(6 dof/node).  

Total dofs = 20000*6 = 120,000. 

Stiffness matrix order = 120,000x120,000  

Number of equations the FEA software will solve internally = 120,000 

Can we solve the same problem using 1D, 2D and 3D elements? 

Is it not possible to use 3D elements for long slender beams (1D geometry), for sheet 

metal parts (2D geometry), and 2D shell elements for representing big casting parts?    

The same geometry could be modelled using 1D, 2D, or 3D elements. What matters is the 

number of elements and nodes (DOF), the accuracy of the results, and the time consumed 

in the analysis.   

For example, consider a cantilever beam with a dimension of 250 x 20 x 5 mm that is 

subjected to a 35 N force:  

 

 

 

 

 

 

  

1   D beam 

model 

  

N=2  

E=1 

  

Total DOF = 6 x 2 = 12   

N = 909  E = 

800 

  

Total dof = 909 x 6 = 5454   
2   D shell 

mesh 
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Table (see next page) on The Equivalence of Variational FEM and Weighted Residual 

FEM in Solid Mechanics 

The problem: A one dimensional rod element is subjected to a concentrated tensile force 

at one end (free end) and the other end is fixed as discussed above. 

The governing differential equation and boundary conditions: 

 Nodes  Elements  Stress  

N/mm2  

Displacement 

mm  

Analytical  --  --  105  4.23  

1D  2  1  105  4.23  

2D  909  800  103  4.21  

3D  17,448  9,569  104  4.21  

N = 17,448  E = 

9,569 

  

Total dof = 17,448 x 3 = 52,344   

3   D Tetra 

mesh 
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AE (d2u/dx2) = 0     
u |

x =0 =0   

AE (du/dx) |x=L  = P 
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Thin Shell Elements – element size vs accuracy 

In the following we investigate the “performance” of quad and tria-elements by 

looking at a plate with a circular hole. The modeling results are then compared with 

a given analytical answer.  

 

Analytical Answer  

The Stress Concentration Factor (SCF) is defined as = max. stress / nominal stress  

In this example the nominal stress is = F/A = 10,000  

N/ (1000 mm*10 mm) =1 N/mm2  for an infinite plate 

SCF =3  

Hence, the maximum stress = Stress Concentration Factor (SCF) * nominal stress = 3  

N/mm2  

In the first part of this study the effects of element type (quad versus tria elements) on 

the modeling results are investigated. The global mesh size is 100.   

The boundary conditions for all models are the same: the translational degrees of 

freedom (x-, y-, z- displacements=0) of all nodes along the left edge of the model are 

constrained (green symbols) whereas the nodes along the right edge are subjected 

to forces in the x-direction (total magnitude 10.000 N).  
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In order to better control the mesh pattern surrounding the hole, two so called 

“washers” have been introduced (i.e. the initial surface is trimmed by two circles 

with a radii of 45 mm and 84 mm, respectively.  

In the stress contour plots shown below, the maximum principal stress is depicted, 

respectively. Note that by default the element stresses for shell (and solid elements) 

are output at the element center only. In other words, these stresses are not exactly 

the ones “existing” at the hole. To better resolve the stresses at the hole, the element 

stresses are output at the grid points using bilinear extrapolation (in HyperMesh 

activate the Control cards > Global output request > Stress > Location: Corner).  

Effect of Element Type (quads vs trias)  

Model 1: The hole is meshed with 16 tria elements. The maximum principal stress 

(corner location) is 2.32 N/mm2 (the analytical result is 3 N/mm2).  
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Model 2: The hole is meshed with 16 quad elements. The maximum principal stress 

(corner location) is 2.47 N/mm2 (the analytical result is 3 N/mm2).  

  

Despite the fact, that both results differ significantly from the analytical reference 

value of 3 N/mm2, it is apparent that the quad elements (17 % error) are “better” 



 

71 
 
 
 

than tria elements (23 % error). All in all, both models are inappropriate when it 

comes to quantitatively assessing the stresses at the hole.  

Moreover, another even more important lesson to be learned is that the FEM program 

does not tell you that the mesh is inacceptable   

– this decision is up to the CAE engineer  

Effect of Mesh Density  

In the following the effect of element size, i.e. number of elements at the hole, on the 

modeling results is discussed.  

Model 3: The hole is meshed with 4 quad elements. The maximum principal stress 

(corner locati on) is 1.60 N/mm2 (the analytical result is 3 N/mm2).   

 

Model 4: The hole is meshed with 8 quad elements. The maximum principal stress 

(corner location) is 2.06 N/mm2 (the analytical result is 3 N/mm2).  
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Model 5: The hole is meshed with 16 quad elements. The maximum principal stress 

(corner location) is 2.47 N/mm2 (the analytical result is 3 N/mm2).  
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Model 6: The hole is meshed with 64 quad elements. The maximum principal stress 

(corner location) is 3.02 N/mm2 (the analytical result is 3 N/mm2).  

  

  

  Element Type  # Elements at 

Hole  
Stress (N/mm2) 

(corner location)  

Model 1  Tria  16  2.32  

Model 2  Quad  16  2.47  

Model 3  Quad  4  1.6  

Model 4  Quad  8  2.0  

Model 5  Quad  16  2.47  

Model 6  Quad  64  3.02  
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Conclusion:  

The conclusion from the first exercise was that quad elements are better than 

triangular elements. As indicated by the results shown before:  the greater the 

number of elements in the critical region (i.e. hole), the better its accuracy.   

While we have been looking at linear elements (nodes at the element corners only), 

Professor Dieter Pahr (University Vienna, Austria), documented the differences 

between second order tria and quad elements.  His study is also based on a plate 

with a hole. The image below is taken from his course notes: “Modeling, Verification 

and Assessment of FEM simulation Results”.  

  

In the figure above, the von Mises stress is depicted for linear and second order 

quad- and tria- elements.  The vertical axis is error (%), and the horizontal axis is 

number of elements at ¼ of the hole  

  

In this image, the displacements at the hole is depicted for linear and second order quad- 

and tria- elements  
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Conclusion:  

Second order quad elements behave/perform best, whereas linear trias are 

“problematic”. These element related effects are less severe while looking at 

displacements (nodal results).  

If this is so, then why not always create a very fine mesh with the maximum possible 

number of nodes and elements?   Why is the usual guideline for meshing 12-16 

elements around holes in critical areas?  

The reason is because the solution time is directly proportional to the (dof)2. Also 

large size models are not easy to handle on the computer due to graphics card 

memory limitations. Analysts have to maintain a fine balance between the level of 

accuracy and the element size (dof) that can be handled satisfactorily with the 

available hardware configuration.   
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2.3 Open Source FEM Courses 
There are literally thousands of recorded FEM lectures available on the web (especially 

YouTube).  

For instance, the lecture by Dr. Cynthia Furse, University of Utah (related to 

electromagnetic field simulation  (http://youtu. be/9uPxFZ_T3ok) 

 

or the lecture series by Prof. K.J. Bathe (http://youtu.be/20WSeL4tz2k) 

 

This video series is a comprehensive course of study 

that presents effective finite element procedures 

for the linear analysis of solids and structures. 

Professor K. J. Bathe, teaches the basic principles 

used for effective finite element analysis, describes 

the general assumptions, and discusses the 

file:///C:/Users/Gabriel/Desktop/Altair/eBooksReview/(http:/youtu
http://youtu.be/9uPxFZ_T3ok
http://youtu.be/20WSeL4tz2k
https://www.youtube.com/watch?v=9uPxFZ_T3ok
https://www.youtube.com/watch?v=20WSeL4tz2k&feature=youtu.be
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implementation of finite element procedures. Upon completion of this video course, a 

second course covering Nonlinear Analysis is available. 

 

Professor Chessa, University of Texas, El Paso (http://youtu.be/CBypsx_u3M8) 

 

Prof. C.S. Uppadhay Department of Aero Space IIT Kanpur 

(http://youtu.be/NYiZQszx9cQ) 

http://youtu.be/CBypsx_u3M8
http://youtu.be/NYiZQszx9cQ
https://www.youtube.com/watch?v=CBypsx_u3M8&feature=youtu.be
https://www.youtube.com/watch?v=NYiZQszx9cQ&feature=youtu.be
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Introduction to Finite Element Method by Dr. R. Krishnakumar, Department of 

Mechanical Engineering, IIT Madras. This introduction consists of a series of 33 videos. 

For more details on NPTEL visit http://nptel.ac.in 

 

 

https://www.youtube.com/watch?v=KR74TQesUoQ&list=PLbMVogVj5nJRjnZA9oryB

mDdUNe7lbnB0  

Again, these are just a few classes we came across by looking for public FEA classes. In 

case you like to add (or recommend) other classes, please let us know.  

Just drop a mail to altairuniversity@altair.com   

http://nptel.ac.in/
https://www.youtube.com/watch?v=KR74TQesUoQ&list=PLbMVogVj5nJRjnZA9oryBmDdUNe7lbnB0
https://www.youtube.com/watch?v=KR74TQesUoQ&list=PLbMVogVj5nJRjnZA9oryBmDdUNe7lbnB0
mailto:altairuniversity@altair.com
https://www.youtube.com/watch?v=KR74TQesUoQ&list=PLbMVogVj5nJRjnZA9oryBmDdUNe7lbnB0
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3 What is Needed to Run a Finite 

Element Analysis? 
This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 

Infinite)”. It also has been reviewed and has additional material included by Matthias Goelke and 

Jan Grasmannsdorf. 

3.1 Three Main Stages of a Finite Element Analysis 
In a high-level summary, the “working” steps involved in a finite element analysis may be 

categorized as:  

• Modeling (pre-processing) 

• Solution  

• Visualization of solution results (post-processing) 

 

This image depicts the three elementary working steps involved in a FEM analysis. Some 

details about the individual steps are summarized below. 
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3.2 Modeling / Pre-Processing 

CAD Data 

Most commonly, an FEM simulation process starts with the import of the component’s 

(or part’s) CAD geometry (e.g. CATIA, STEP, UG, IGES, solidThinking, etc.) into the pre-

processor i.e. HyperMesh 

Geometry Clean-up 

In many cases, the imported geometry is not ready for meshing. Quite often the geometry 

needs a cleanup first due to  

• “broken” surfaces 

• surfaces which are not stitched together 

• redundant (multiple) surfaces 

• surfaces which are too small to be meshed in a reasonable way later on 

• many other geometry failures 

Another issue related to geometry is depicted in the following image: 

 

In the image on the left, the imported geometry is shown. Note the lateral offset of the 

green edges. Here, the surface edges (in green) do not meet at a single point i.e. there is 

a very small lateral offset of the surface edges. As meshing is carried out with respect to 

the surfaces, this small offset will be automatically taken into account during meshing, 

which, unfortunately will result in very poor-quality elements. The image in the middle 

depicts the meshed “initial” geometry. Note how the mesh is locally distorted. The 

updated (cleaned) and meshed geometry is shown on the right.   
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Here, the surface edges (in green) do not meet in a single point, i.e. there is a very small 

lateral offset of the surface edges.  As meshing is carried out with respect to the surfaces, 

this small offset will be automatically taken into account during meshing, which, 

unfortunately will result in very poor-quality elements. 

Once these “hurdles” are mastered, one needs to ask whether all the CAD information is 

really needed. What about little fillets and rounds, tiny holes or even company logos 

which can often be found in CAD data?  Do they really contribute to the overall 

performance of the component? 

Meshing 

Once the geometry is in an appropriate state, a mesh is created to approximate the 

geometry. Either a beam mesh (1D), shell mesh (2D) or a solid mesh (3D) will be created. 

This meshing step is crucial to the finite element analysis as the quality of the mesh 

directly reflects on the quality of the results generated. At the same time, the number of 

elements (number of nodes) affects the computation time. That is the reason why in 

certain cases a 2D and 1D mesh is preferred over 3D mesh. For example, in sheet metals 

a 2D approximation of the structure uses much less elements and thus reduces the CPU 

time (which is the time while you are waiting for your results). 
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See the picture above for structures that are typically meshed with 1D, 2D and 3D 

elements. Which element type would you choose for which part? 

Despite the fact that meshing is (at least optionally) a highly automated process, mesh 

quality, its connectivity (i.e. compatibility), and element normals needs to be checked. If 

necessary, these element “issues” may need to be improved by updating (altering) the 

underlying geometry or by editing single elements. 

Material and Property Information 

After meshing is completed, material (e.g. Young’s Modulus) and property information 

(e.g. thickness values) are assigned to the elements. 

Loads, Constraints and Solver Information 

Various loads and constraints are added to the model to represent the loading conditions 

that the part(s) are subjected to. Different load cases can be defined to represent 

different loading conditions on the same model.  Solver information is also added to tell 

the solver what kind of analysis is being run, which results to export, etc. 

To determine your relevant loads, your engineering skills are needed. Think of all kinds of 

load situations that can occur on your structure and decide whether you want to use 

them in your simulation or not.  To determine the load from a static or dynamic event, a 

Multibody Simulation (MBS) might be helpful.  

The FEM model (consisting of nodes, elements, material properties, loads and 

constraints) is then exported from within the preprocessor HyperMesh. The exported 

FEM model, typically called solver input deck, is an ASCII file based on the specific syntax 

of the FEM solver chosen for the analysis (e.g. RADIOSS or OptiStruct). A section out of 

an OptiStruct solver deck is depicted in the figure below. 
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As you will see, the bulk of information stored in the analysis file is related to the 

definition of nodes (or grids). Each single node is defined by its nodal number (ID) and its 

x-, y- and z coordinates. Each element is then defined by its element number (ID) and its 

nodes (IDs are referenced). This completes the pre-processing phase. 

 

3.3 Solution 
During the solution phase of a simple linear static analysis or an eigenfrequency study, 

there is not much for you to do. The default settings of the Finite Element program do 

handle these classes of problems pretty well. Practice will show you that if the solution 

process is aborted by an “error”, it is due to mistakes you have made during the model 

building phase. Just to mention a few typical errors: 

• Element quality (http://altair-2.wistia.com/medias/rmretoumym) 

• Invalid material properties 

• Material property not assigned to the elements 

• Insufficiently constrained model (the model shows a rigid body motion due to 

external loads) 

http://altair-2.wistia.com/medias/rmretoumym
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Some of these model issues are discussed in additional videos/webinars available on the 

Learning Library (https://altairuniversity.com/learning-library/) 

3.4 Visualization / Post-Processing 

Once the solution has ended successfully, post-processing (in HyperView for contour 

plots and HyperGraph for 2D/3D plots) of the simulation results is done next. Stresses, 

strains, and deformations are plotted and examined to see how the part responded to 

the various loading conditions. Based on the results, modifications may be made to the 

part and a new analysis may be run to examine how the modifications affected the part. 

This eventually completes the FEM process. 

Remarks 

Practice will show, that in many projects, the above depicted process must be re-entered 

again, because simulation results indicate that the part is not performing as requested. It 

is quite obvious that going back to CAD (to apply changes) and working through the entire 

FEM process becomes tedious.  

https://altairuniversity.com/learning-library/
https://altair-2.wistia.com/medias/rmretoumym?wvideo=rmretoumym
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Note: 

The individual working steps of the FEM process are not only subjected to many “user” 

errors e.g. typo while defining material or loads. A lot of attention must also be paid to 

the chosen modeling assumptions (for instance, simplification of geometry, chosen 

element type and size, etc.). Even though the FEM solver may detect some of the most 

striking errors, the likelihood that your results have bypassed “errors” is high.  

The following chapters aim at creating awareness about FEM challenges and pitfalls.  

A very efficient (and exciting) technology to speed up this process is called Morphing. 

Employing morphing allows the CAE engineer to modify the geometry of the FEM model, 

i.e. apply a shape change to an actual mesh, e.g. change radii, thickness of ribs, shape of 

hard corners, etc. Quite often the morphed FEM model can be exported instantaneously 

(without any remeshing) allowing the CAE engineer to re-run the analysis of the modified 

part on the fly. 
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An example of morphing a given finite element model is depicted below  

(http://altair-2.wistia.com/medias/dp9q29f3jn) 

 

 

A nice introduction to freehand morphing  

(https://altairuniversity.com/learning-library/morph-volumes-front-of-car-1/) 

  

http://altair-2.wistia.com/medias/dp9q29f3jn
https://altairuniversity.com/learning-library/morph-volumes-front-of-car-1/
https://altair-2.wistia.com/medias/dp9q29f3jn?wvideo=dp9q29f3jn
https://altairuniversity.com/learning-library/morph-volumes-front-of-car-1/
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4 Analysis Types 
This chapter includes material from the book “Practical Finite Element Analysis (from finite to 

Infinite)” as well as information from the HyperWorks Help Documentation. Additional material 

was added by Matthias Goelke and Jan Grasmannsdorf. 

The term CAE (Computer Aided Engineering) includes the following types of analyses: 

1) Linear static analysis                 6) Fatigue analysis 

2) Nonlinear analysis                     7) Optimization 

3) Dynamic analysis                       8) CFD analysis 

4) Buckling analysis                       9) Crash analysis 

5) Thermal analysis                       10) NVH analysis 

 

1) Linear Static Analysis 

 

Strain 

Linear  

Linear means straight line.  In linear analysis, the FE solver will therefore always follow a 

straight line from base to deformed state. As an example, in terms of linear material 

behaviour, σ =ε E is the equation of a straight line (y = m x) passing through the origin. 

“E”, the Elastic Modulus, is the slope of the line and is a constant. In real life after crossing 

the yield point, the material follows a nonlinear curve but solvers follow the same straight 

Software follows this path for linear  
static calculation 

Actual stress-strain curve 

Stress 
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line. Components are broken into two separate pieces after crossing the ultimate stress 

point, but software based linear analysis never shows failure in this fashion.  It shows a 

single unbroken part with a red color zone at the location of the failure. An analyst has to 

conclude whether the component is safe or has failed by comparing the maximum stress 

value with yield or ultimate stress.  

Static 

There are two conditions for static analysis: 

1) The force is static i.e. there is no variation with respect to time (dead weight) 

dF/dt = 0 F  

t 

 

2) Equilibrium condition ∑ forces (Fx , Fy , Fz)  and ∑ Moments (Mx , My , Mz) = 0.  

The FE model must fulfil this condition at each and every node. The complete model 

summation of the external forces and moments is equal to the reaction forces and 

moments. 

The basic finite element equation to be solved for structures experiencing static loads can 

be expressed as: 

K u = P 

where K is the stiffness matrix of the structure (an assemblage of individual element 

stiffness matrices). The vector u is the displacement vector, and P is the vector of loads 
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(i.e. all the loading taking place in a component: external loads applied to the structure, 

reaction forces…). The above equation is the equilibrium of external and internal forces. 

The stiffness matrix is singular, unless displacement boundary conditions are applied to 

fix the rigid body degrees of freedom of the model. 

The equilibrium equation is solved either by a direct or an iterative solver (for nonlinear 

analysis). By default, the direct solver is invoked, whereby the unknown displacements 

are simultaneously solved using a Gauss elimination method that exploits the sparseness 

and symmetry of the stiffness matrix, K, for computational efficiency.  

Once the unknown displacements at the nodal points of the elements are calculated, the 

stresses can be calculated by using the constitutive relations for the material. For linear 

static analysis where the deformations are in the elastic range, i.e.: the stresses, σ, are 

assumed to be linear functions of the strains, ε, Hooke’s law can be used to calculate the 

stresses. Hooke’s law can be stated as: 

 σ=C ε 

with the elasticity matrix C of the material.  The strains are a function of the 

displacements. 

Please note that none of the terms in the equation is dependent on time or displacement. 

This is why it is called, as we have learned before, a linear static analysis. 

Practical Applications:  A linear static analysis is the most commonly used analysis. All 

aerospace, automobile, offshore and civil engineering industries perform linear static 

analyses.  
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2) Nonlinear Analysis 

*More details about Non-Linear Finite Element Analysis is provided in the free eBook 
"Introduction to Non-Linear Analysis using OptiStruct” 

 

                                                      Nonlinearity            

 

Nonlinear Analysis Can Mean: 

A nonlinear analysis is performed when we need to consider 

A. Material based non- linearity: this is related to for instance, nonlinear elastic, 

elastoplastic, viscoelastic, and/or viscoplastic behavior.  The Force (stress) vs. 

displacement (strain) curve is nonlinear (polynomial).  

 
                           Within E (non-metal)                                                      Beyond E (metals)   

Geometric Material Contact 

Large          
Deformation 

Gap elements &  
Contact simulation 

Beyond Elastic Limit  ‘E’ 
‘metals’ 

Within Elastic Limit ‘E’ 
‘Non metals’ 

Creep   
( Progressive) deformation of material at 
constant stress. 
- Long-time process 

  

                          Strain                                                           Strain   

Stress   Stress   

Nonlinear   Linear 
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The stress-strain diagram, along with the hardening* rule for the material, is required 

as input data.  

Metallic nonlinearity applications: Automobile, aerospace, ship industries. An analysis 

is done to know the exact value of stress or strain when it crosses the yield point. For 

low cycle fatigue analysis, this data is considered as input for the strain life approach.   

Non-metallic nonlinearity applications: Automobile, aerospace industry, analysis of 

rubber, plastic, asbestos, fiber components.  

Creep - At elevated temperatures, even a small magnitude force, if kept applied over 

a long time period (for months and years), would cause failure. Applications – nuclear 

/ thermal power plants, civil engineering etc.  

B. Geometric nonlinearity: In real life, the stiffness [K] is a function of displacement [d] 

(remember: for linear analysis [K] is constant, independent of [d]). This means in a 

geometric nonlinear analysis; the stiffness K is re-calculated after a certain predefined 

displacement. As an example, think of a buckling case. The stiffness of a geometry 

changes dramatically when or after buckling has occurred. The new “deformed” 

geometry must now be taken into account, in order to get reasonable (realistic) 

results. 

In geometric linear analysis all deformations and rotations are small (infinitesimal).  

 

Forces may follow the deformation or keep their direction. This can be controlled thru 

the choice of coordinate systems (in geometric nonlinear analysis there are moving 

and fixed coordinate systems).  
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The images depict two examples of these differences: A cantilever beam solved with 

small displacements, large displacements with a follower force, and large 

displacements without a follower force. The image below depicts a simple rigid rotated 

by an angle solved with small and finite rotations.  

C. Contact nonlinearity / boundary nonlinearity: In contact analysis, the stiffness K also 

changes as a function of displacement (when parts get into contact or separate) 

Note: Nonlinear analysis deals with true stress and strain (unlike engineering stress and 

strain in linear static analysis) 
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Nonlinear Quasi Static (small deformation) 

This solution sequence uses small deformation theory, similar to the way it is used with 

Linear Static Analysis. Small deformation theory means that strains should be within 

linear elasticity range (some 5 percent strain) and rotations within small rotation range 

(some 5 degrees rotation). The Small Deformation Analysis is used mostly for contact 

nonlinearities.  

Nonlinear Quasi Static (large deformation) 

Large displacement nonlinear static analysis is used for the solution of problems wherein 

the load-response relationship is nonlinear and structural large displacements are 

involved. The source of this nonlinearity can be attributed to multiple system properties, 

for example, materials, geometry, nonlinear loading and constraint. Currently, in 

OptiStruct the following large displacement nonlinear capabilities are available, including 

large strain elasto-plasticity, hyperelasticity of polynomial form, contact with small 

tangential motion, and rigid body constraints. 

 

3) Dynamic Analysis 

(*More information about this topic is included in the free eBook "Learn Dynamic 

Analysis with Altair OptiStruct") 

a) Linear Dynamics 

Describes those systems in which forces increase linearly with parameters such as 

position and velocity. Perhaps the best known linear system is a mass oscillating on a 

spring, or the “simple harmonic oscillator.” In this situation, force on the mass increases 

linearly with displacement by a factor of “k,” the spring constant. A graph of the potential 

energy of this system is parabolic, since F(x) = - dU / dx.  
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A particle of mass m oscillating in the potential well of this system will have an angular 

frequency of                 . The system becomes more complex when damping or a driving 

force is added. Damping alone will cause the particle to sit down in the potential well or 

“attractor.” When the system is forced, the system will oscillate at one frequency 

determined by the relative strengths of the forcing and damping. If the forcing is too weak 

or too strong, the system may oscillate at the forcing frequency. In this case, the free 

movement of the system is essentially drowned by the forcing and damping and the 

amplitude of oscillation is weak. At some frequency, however, the system will resonate 

where maximum oscillating amplitude occurs. Again, in the linear system, this resonant 

frequency is unique and is determined by the forcing, damping, and natural frequencies 

of the system. In this driven and damped linear system, periodic inputs result in periodic 

outputs. If there is error in a measurement, this error will increase linearly as the system 

progresses. 

b) Nonlinear Dynamics 

Describes those nonlinear systems where one or more “forcing elements” does not vary 

linearly with space parameters. For example, if the spring coefficient in the spring system 

described before varied with displacement, then the spring force would vary with the 

square of displacement. 

Although linear systems make for pretty equations and an efficient summary of behavior, 

nonlinear systems seem to pervade real natural systems. Friction forces, damping 

elements, resistive elements in circuits -- these and many other factors often vary in a 

nonlinear fashion. As a result, the differential equations describing these systems involve 

very messy solutions that can only be solved numerically. Even if there were analytic 

solutions to these systems the behavior in some cases would be difficult or impossible to 

predict due to the exponential increase in error 
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Static Vs Dynamic System 

To help us understand what a dynamic system is it is interesting to compare it with a 

static system. There are two basic aspects that make the dynamic systems differ from 

static systems: 

• The loads are applied as a function of time. F(t) 

• The responses are time dependent. X(t) 

Example Dynamic System 

Dynamic analysis for simple structures like the one described above can be carried out 

manually. In general, it is possible to find an analytical response for it or by using 

analytical tools it is possible to determine the mathematical functions that can represent 

the system responses. 

But for complex structures Finite Element Analysis (FEA) should be used to calculate the 

dynamic responses. This kind of analysis is well known as Structural Dynamic Analysis 
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Types of Dynamic Analyses 

Frequency Response Analysis 

Frequency response analysis is used to calculate the response of a structure about steady 

state oscillatory excitation. Typical applications are noise, vibration and harshness (NVH) 

analysis of vehicles, rotating machinery, and transmissions. 

Frequency response analysis is used to compute the response of the structure, which is 

actually transient, in a static frequency domain.  The loading is sinusoidal. A simple case 

is a load of given amplitude at a specified frequency. The response occurs at the same 

frequency, and damping would lead to a phase shift. 
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Excitation and response of a frequency response analysis. 

The loads can be forces, displacements, velocity, and acceleration. They are dependent 

on the excitation frequency W. The results from a frequency response analysis are 

displacements, velocities, accelerations, forces, stresses, and strains. The responses are 

usually complex numbers that are either given as magnitude and phase angle or as real 

and imaginary part. 

 

Transient Response Analysis 

Transient response analysis is used to calculate the response of a structure to time-

dependent loads.  Typical applications are structures subject to earthquakes, wind, 

explosions, or a vehicle going through a pothole. The loads are time-dependent forces 

and displacements. Initial conditions define the initial displacement and initial velocities 

in grid points. 

The results of a transient response analysis are displacements, velocities, accelerations, 

forces, stresses, and strains.  The responses are usually time-dependent. 
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The transient response analysis computes the structural responses solving the following 

equation of motion with initial conditions in matrix form. 

Mu’’ + Bu’ + Ku = P(t) 

u(t=0) = u0 

u’(t=0) = v0 

The matrix K is the global stiffness matrix, the matrix M the mass matrix, and the matrix 

B is the damping matrix formed by the damping elements. The initial conditions are part 

of the problem formulation and are applicable for the direct transient response only. The 

equation of motion is integrated over time using the Newmark beta method. A time step 

and an end time need to be defined. 

Response Spectrum Analysis 

Response Spectrum Analysis (RSA) is a technique used to estimate the maximum 

response of a structure for a transient event. Maximum displacement, stresses, and/or 

forces may be determined in this manner. The technique combines response spectra for 

a prescribed dynamic loading with results of a normal modes analysis. The time-history 

of the responses is not available.  

Response spectra describe the maximum response versus natural frequency of a 1-DOF 

system for a prescribed dynamic loading. They are employed to calculate the maximum 

modal response for each structural mode. These modal maxima may then be combined 

using various methods, such as the Absolute Sum (ABS) method or the Complete 

Quadratic Combination (CQC) method, to obtain an estimate of the peak structural 

response. 

RSA is a simple and computationally inexpensive method to provide an approximation of 

peak response, compared to conventional transient analysis. The major computational 

effort is to obtain a sufficient number of normal modes in order to represent the entire 
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frequency range of input excitation and resulting response. Response spectra are usually 

provided by design specifications; given these, peak responses under various dynamic 

excitations can be quickly calculated. Therefore, it is widely used as a design tool in areas 

such as seismic analysis of buildings. 

While in a linear static analysis, the equation F = K * u is solved, a dynamic analysis is 

based on some other equations: 

 

[M] x ‘‘ + [C] x ‘ + [K] x = F(t)         

 

x ‘‘ = d2x /dt2 = acceleration,   x  ‘ = dx /dt = velocity, x = displacement 

[M] x ‘‘ = 0, [C] x ‘ = 0,  [K] and F(t) = constant              -      Linear Static  

[M] x ‘‘ = 0, [C] x˙ ‘ = 0,  [K] is a function of {u}, F(t) = constant      -      Nonlinear Static 

F(t) = 0,  [C] x˙ ‘ = 0 and [M], [K] = constant          -      Free Vibration  

All the terms in above equation are present            -      Forced Vibration 

Practical applications: Natural frequency is a characteristic and basic design property of 

any component, while forced vibrations is applicable for components subjected to force, 

displacement, velocity, or acceleration varying with respect to time or frequency. 

 

4) Linear Buckling Analysis 

Some key aspects: 

• Applicable for only compressive load 

• Slender beams and sheet metal parts 
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• Bending stiffness <<< Axial stiffness • Large lateral deformation 

 

 

 

The problem of linear buckling in finite element analysis is solved by first applying a 

reference level of loading, PRef, to the structure. A standard linear static analysis is then 

carried out to obtain stresses which are needed to form the geometric stiffness matrix 

KG. The buckling loads are then calculated by solving an eigenvalue problem: 

[K-λKG] x = 0 

Where K is the stiffness matrix of the structure and l is the multiplier to the reference 

load. The solution of the eigenvalue problem generally yields n eigenvalues l, where n is 

the number of degrees of freedom (in practice, only a subset of eigenvalues is usually 

calculated). The vector x is the eigenvector corresponding to the eigenvalue. 

The eigenvalue problem is solved using a matrix method called the Lanczos method. Not 

all eigenvalues are required. Only a small number of the lowest eigenvalues are normally 

calculated for buckling analysis. 

The lowest eigenvalue lcrit is associated with buckling. The critical or buckling load is: 

Pcrit = lcrit PRef 

Output from software: Critical value of load. 
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Practical applications: Commonly used for civil engineering applications. Mechanical 

engineering applications - vacuum vessel, long gear shifter rod analysis, etc.    

 

5) Thermal Analysis 

 

 

 

Practical applications: Engine, radiator, exhaust system, heat exchangers, power plants, 

satellite design etc. 

 

 

Linear Steady-State Heat Transfer Analysis 

Heat transfer analysis solves for unknown temperatures and fluxes under thermal 

loading. Temperature represents the amount of thermal energy available, and fluxes 

represent the flow of thermal energy. Conduction deals with thermal energy exchange 

by molecular motion. Free convection deals with thermal energy exchange between 

solids and surrounding fluids. Thermal loading is defined as energy flows into and out of 

the system. 

In linear steady state analysis, material properties such as conductivity and convection 

coefficient are linear. Temperature and fluxes at the final thermal equilibrium state are 

of interest. The basic finite element equation is: 

Modes of Heat Transfer 

Conduction Convection Radiation 

Steady State  
Conduction 

Unsteady State  
Conduction 

Natural 
Convection 

Forced 
Convection 

D 1- 

D 2- 

D 3- 

1- D 

2- D 

3- D 

Specular 

Diffuse 
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([Kc] + [H]){T} = {p}             (1)  

Where [Kc] is the conductivity matrix, [H] is the boundary convection matrix due to free 

convection, {T} is an unknown nodal temperature, {p} is the thermal loading vector. The 

system of linear equation is solved to find nodal temperature {T}. 

Thermal load vector can be expressed as: 

{p} = {PB} + {PH} + {PQ}      (2)  

Where {PB} is the power due to heat flux at boundary, {PH} is the boundary convection 

vector due to convection and {PQ} is the power vector due to internal heat generation. 

The matrix on the left hand side of equation (1) is singular unless temperature boundary 

conditions are specified. The equilibrium equation is solved simultaneously for the 

unknown temperatures using a Gauss elimination method that exploits the sparseness 

and symmetry for computational efficiency. Once the unknown temperatures at the 

nodal points of the elements are calculated, temperature gradient {∇T} can be calculated 

according to element shape functions. Element fluxes can be calculated by using: 

{f} = [k]{∇T}                            (3)  

Where [k] is the conductivity of the material. 

An analogy of heat transfer analysis and structural analysis is shown in the table below. 
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6) Fatigue Analysis 

In materials science, fatigue is the progressive and localized structural damage that 

occurs when a material is subjected to cyclic loading. The nominal maximum stress values 

are less than the ultimate tensile stress limit and may be below the yield stress limit of 

the material. 

Fatigue occurs when a material is subjected to repeat loading and unloading. If the loads 

are above a certain threshold, microscopic cracks will begin to form at the surface. 

Eventually a crack will reach a critical size, and the structure will suddenly fracture. The 

shape of the structure will significantly affect the fatigue life; square holes or sharp 

corners will lead to elevated local stresses where fatigue cracks can initiate. Round holes 

and smooth transitions or fillets are therefore important to increase the fatigue strength 

of the structure (http://en.wikipedia.org/wiki/Fatigue_(material)) 

Fatigue analysis, using S-N (stress-life) and E-N (strain-life) approaches for predicting the 

life (number of loading cycles) of a structure under cyclical loading may be performed by 

using OptiStruct. 

*More information about this topic is included in our free Fatigue eBook 

 

7) Optimization  

Optimization is clearly one of the overall strengths of Altair and HyperWorks. You may 

distinguish optimization methods with respect to its position in the design phase, i.e. 

concept design optimization such as topology, topography and free size optimization, and 

“fine tuning” optimization disciplines such as size or shape optimization. Alternatively, 

you can distinguish according to the design variable, i.e. which variable of the model is 

modified/altered during the optimization. For instance, the design variable of a topology 

optimization is the density of elements, whereas in size optimization the thickness of a 

sheet metal may be varied.   

http://en.wikipedia.org/wiki/Fatigue_(material)
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Practical applications: Applicable to any component that is over or under designed.  

 

A comprehensive description of “Optimization” is also available at 

http://en.wikipedia.org/wiki/Optimization or you can view the HyperWorks help for 

Optimization. 

 

 

You may also find the free study guide entitled “Practical Aspects of Structural 

Optmization” available on the Academic Website helpful.  

 

 

 

 

 

 

 

 

http://en.wikipedia.org/wiki/Optimization
http://www.altairuniversity.com/free-study-guide-book/
http://www.altairuniversity.com/free-study-guide-book/
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8) Computational Fluid Dynamics (CFD)  

A fluid is a substance that continuously deforms under an applied shear stress regardless 

of the magnitude of the applied stress. Gas and liquids are both fluids. Fluid mechanics 

deals with the study of fluid, its properties, and its behavior. 

 

Fluid Mechanics 

                          

Fluid Statics (Hydrostatics) 

• Fluid at rest 

• Easy from a calculation point of view  

• No variation with respect to time, less realistic 

results 

• Linear equations 

• Civil engineering: Dam design 

Fluid Dynamics 

• Fluid in motion 

• Calculations are more complex 

• Variation with respect to time considered  

• Nonlinear equations 

• Aerospace, automobile, marine and 

valves 

 

Computational Fluid Dynamics (CFD) is the branch of fluid mechanics where numerical 

methods are used to analyze fluid dynamics problems. It is based on the Navier –Stokes 

equations (mass, momentum, and energy conservation equilibrium equations).  
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Flow Classification 

              

Viscosity Dimensions 
Turbulent/ 

Laminar 
Compressibility Velocity 

Inviscid: no 

viscosity 

1D: e.g. flow 

through a nozzle 

• Laminar: 

Reynolds’s 

number < 2300. 

• Flow through a 

water tap at low 

velocities 

Incompressible:  

high density 

fluids flowing at 

sub sonic 

velocity (mach 

number<1) 

e.g. water, oil  

Sub Sonic M 

< 1.0 

Viscid: Viscous  

flow. Most  

common 

2D: e.g. flow 

through a pipe or 

over an airfoil 

• Turbulent:  

Reynold’s 

number > 2300. 

• Flow through a 

water tap at 

higher velocities 

Compressible: low 

density fluids 

flowing at sonic or 

supersonic 

velocity e.g. 

discontinuities like 

shock and 

expansion waves 

Trans sonic 

0.85 < M< 1.20 

Represents weak 

shocks  

 3D: e.g. flow 

through a valve, 

flow over an 

automobile, 

aircraft, or 

missile 

  Super sonic 

1.20 < M < 4.0 

Hypersonic 

M > 6.0 

e.g. Space shuttle   

entering earth’s 

atmosphere. 

 

Practical applications: Drag prediction and stream lining of a car, combustion chamber 

design to check an optimum fuel - air mixing, aeroplane design, etc. 
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9) Crash Analysis 

    Crash Analysis 

 

 Structural Crashworthiness or 
Full Dynamic / Impact Simulations Drop Test  Simulations Occupant Safety 

To find deformation, stress, and 

energy absorbing capacity of various 

structural components of a vehicle 

hitting a stationary or moving object. 

The component is said to be 

crashworthy (safe), if it meets the  

plastic strain and energy targets .  

Applications: Frontal, side, rear, roof 

crush, car hitting  a pole / wall  etc.  

Drop test is a free fall test  

carried out to check the 

structural integrity of a 

component.  

Applications: Black box of an 

aircraft, mobile phone, 

consumer goods  such as   

TV,  fridge, etc.  

To find the effects of crash on the human 

body and making the ride safe for the 

driver as well as the passengers . 

Several regulations exist in different 

countries to ensure a proper   

certification, e.g.: FMVSS (Federal Motor 

Vehicle Safety Standards) in the USA,  

ECE (Economic Commission of Europe) 

regulation in Europe. In India, the  ARAI   

has  set up standard procedures for the 

automobile industry and called AIS  (  

Automotive Industry Standards)   

 

10) Noise, Vibration and Harshness, NVH 

Sound Radiation or Scattering or  

Uncoupled  Problems 
Coupled or Vibroacoustics Problems  

This predicts how much sound pressure level is felt 

by a vibrating source at a certain distance as a 

function of the solid angle. A typical example is 

how much sound level is felt due to a horn or a 

silencer vibrating at a certain distance.   

These problems are solved by Boundary Element 

Method.  

This is when there is a clear interaction of a 

structure and fluid cavity. A typical example is 

when there is a noise level felt at the driver’s right 

ear due to the engine vibration in an idle 

condition. 

These problems are solved by Finite Element 

Method.   

 

NVH problems are broadly classified into structure born and air born sound. 
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Practical applications: Computing the sound pressure level is of utmost importance to 

automobile, airplane, and aerospace designers as customers always prefer a low noise 

level. Computing the response at the driver’s feet (brake pedal), mirror mounts, steering 

column, and seats plays a crucial role as the driver must be comfortable. Also predicting 

the sound quality and radiation at a certain distance from the car is important.  
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5 Getting Started with 

HyperWorks 
 

5.1 The HyperWorks Desktop Graphical User 

Interface 

 

In the HyperWorks Desktop environment you may switch between different applications 

(clients) such as HyperMesh (FEM Preprocessor), HyperView, and HyperGraph (Post-

processors) as shown below 
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In addition, the screen may be divided according to your needs, allowing you to place, for 

instance, a HyperMesh window next to a HyperView window. 

 

The HyperWorks Help Documentation 

The HyperWorks Help documentation is part of the HyperWorks installation and/or can 

be viewed online (no installation needed).  

Thus, the help menu may be accessed in different ways. For instance, just activate “Help“ 

in the Menu Bar.  

 HELP 

http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/onlinehelp.aspx
http://www.altairhyperworks.com/hwhelp/Altair/hw12.0/help/altair_help/altair_help.aspx
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Under Help > HyperWorks Desktop, you will find answers related to “panels/functions” 

and working techniques. 

   

Tip: Just press “h“on your keyboard while your inside a panel of HyperMesh and you will 

be directly guided to the corresponding help entry! 

 Whenever you wonder about FEM solver related issues such as syntax, material 

definitions etc. you need to go to “Other Applications” 

The HyperMesh “Philosophy” 

Also view in the Help documentation: HyperMesh > User’s Guide > The HyperMesh 

Environment  

Tip: Start learning HyperMesh by using the Menu Bar. 

The topics/titles in the Menu Bar (e.g. Geometry, Mesh, Materials, Properties, Bc‘s etc.) 

and the pull-down menus are organized in such a way that you can build “sentences”. For 

instance, building a surface:  
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The “sentence” would read:  Geometry > Create > Surfaces 

After that a panel will be displayed offering different methods on how to create the 

surface.  

How to read panels (e.g. create surface—ruled)? 

 

Yellow = HyperMesh expects your input here.  

Blue colored frame = HyperMesh expects your input here (Note: you can jump between 

yellow panels by mouse clicking or by activating the tab-button). 

Green=Action. In this case the surface would be built with respect to the specified lines. 

Red=Close panel. No further action. 
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 Tip: Always watch the “Status Bar” (left lower corner) for information! 

 

The information provided there is instrumental for your work (at least until you have a 

sound understanding on how HyperMesh works). It is exactly this “spot” which tells you 

what is happening, what is missing, what was created etc.!! 

Model Browser 

In HyperMesh there are many browsers. The most important one to get started with is 

the Model Browser. 

Help document:  HyperMesh > User’s Guide > Browsers > Model Browser  

All entities of the FEM model such as elements, geometry, materials, properties, loads, 

etc. are stored in corresponding collectors: 
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The most important collectors (at least at the beginning) are: 

• component collector (comps) for elements & geometry 

• material collector (mats) for material definition 

• property collector (props) for properties such as thickness of shell elements 

• load collector (loadcol) for loads (constraints, forces, pressure etc.) 

Collectors are best created within the Model Browser.  The Model Browser is a kind of 

“list of contents” providing information about the loaded FEM model. 

 

In the image above, the collector written in bold letters (i.e. rigids) is currently active. 

The active collector is the storage place for newly created entities belonging to this 

brand of collector. In this example the active component collector named “rigids” would 

be the storage place for all newly created elements and geometry entities (regardless 

whether the name of the component collector is meaningful or not). 
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Collectors can be made active simply with: Make current (right mouse button click on 

the corresponding component will open up a dialog window as shown in the inset on 

the right) 

Each collector owns a number (ID) and a color. The lD is being used by the FEM solver, 

the color is used for visualisation purposes. 

At the same time the Model Browser allows which FEM entities are being displayed. 

   Elements of the corresponding component may be displayed or non-displayed 

by activating – deactivating the icon. 

  Geometry of the corresponding component may be displayed or non-displayed 

by activating – deactivating the icon. 

Note: All entities MUST (and will be) be placed in a corresponding collector.  

If you miss to create the respective collector before the entity is created, HyperMesh 

allocates a collector of the corresponding type automatically. This collector is named auto 

Don‘t worry— you can change it‘s name, color etc. at any time. It is just a right mouse 

click in the Model Browser. 

Of course, you can also move entities from the same type of collector (e.g. component 

collector) to another – at any time. 
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Selection of Entities  

(entities = elements, geometry etc.) 

Help document:  HyperMesh > User’s Guide > The HyperMesh Environment > The 

HyperMesh User Interface > Input Controls In order to select, for instance surfaces, it is 

imperative that the activated (opened) panel requests this kind of information.  

 

 

 

 

 

 

 

 

 

 

 

 

Example: The panel Geometry-Create-Lines-from nodes 

In this panel you can’t “read” anything about surfaces. Hence, there is no way to 

select/pick surfaces of the model while you are in this panel. 

In contrast, in the Geometry-Create-Lines-from surf edges panel you are “asked” to 

provide the information from which surface edges lines should be derived. Hence, you 

can (actually have to) select surfaces. The respective surfaces can be selected directly via 

left mouse button (deselection = right mouse button). 

1) What to do 

            & 

2) Method to use: 

Pick a sub-panel for the 
function to be used 

3)  What to do it to: 

Select entities that will 
be affected 

4)  How to do it: 

Give parameters that 
define how the 
function will be 
executed 

5)  Do the action: 

Execute the 
function 
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Of course, other selection options do exist. 

 

Read More: 

Help document: HyperMesh > User’s Guide > The HyperMesh Environment > The 

HyperMesh User Interface > Input Controls Panels: General Layout 

Panels often have sub-panels.  These are accessed by radio buttons on the left side of the 

panel.  Also, panels generally work from left to right.  Below is an example of the Project 

/ to plane sub-panel. 

 

 Mouse Buttons 

Left mouse button 

+CTRL & drag for rotate 

+CTRL & click on entity to change center of rotation 

+CTRL & click in graphics area, off entities to reset 

center to middle of screen 

Middle mouse button 

+CTRL & drag for zoom 

+CTRL & click for fit 
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Right mouse button 

+CTRL & drag for pan 

User Profile 

Most likely your work will not end with meshing. 

Whenever FEM solver specific information needs to be applied to the model, it is again 

imperative to “inform” HyperMesh about the FEM solver to be used. 

This is managed through the User Profile. 

 

  

Note: In the HyperWorks Student Edition not all of the above listed solvers are supported 

(and hence not listed). 

However, in general HyperMesh allows you to build FE models for third party (non- Altair) 

solvers as well. For instance, you can export your model in the format of Abaqus, Ansys, 

LS-Dyna, Marc etc. 
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5.2 Tutorials and Videos 

Recommended Tutorials (HyperWorks Help Documentation: HyperMesh Tutorials > 

Basics >) 

• Getting Started with HyperMesh - HM-1000 

• Opening and Saving Files - HM-1010 

• Working with Panels - HM-1020 

• Organizing a Model - HM-1030 

• Controlling the Display - HM-1040 

Recommended Videos 

The following videos are based on HyperWorks Desktop 11.0. Nevertheless, the basics 

concepts shown are still valid. 

• HyperWorks Desktop Framework (http://altair-2.wistia.com/medias/r9kqmwek8n) 

• Working with “panels” (http://altair-2.wistia.com/medias/qqpvdvqk90) 

• File import, save model (http://altair-2.wistia.com/medias/tmmp3hl894) 

• Organize Entities (http://altair-2.wistia.com/medias/2m355n5gnh) 

• Mask by Config Browser, Model Browser & Collectors 

• Zoom, Rotate, Pan (http://altair-2.wistia.com/medias/fievumqbpf) 

• Selection of Entities ( http://altair-2.wistia.com/medias/2vlscp3l6a) 

• User Profile in Hypermesh and model Import 

(https://altair-2.wistia.com/medias/7di95lse9d) 

http://altair-2.wistia.com/medias/r9kqmwek8n
http://altair-2.wistia.com/medias/r9kqmwek8n
http://altair-2.wistia.com/medias/qqpvdvqk90
http://altair-2.wistia.com/medias/qqpvdvqk90
http://altair-2.wistia.com/medias/tmmp3hl894
http://altair-2.wistia.com/medias/2m355n5gnh
http://www.youtube.com/watch?v=cGEM7TcXfFA
http://www.youtube.com/watch?v=s7CvPYuVodU
http://altair-2.wistia.com/medias/fievumqbpf
http://altair-2.wistia.com/medias/2vlscp3l6a
https://altair-2.wistia.com/medias/7di95lse9d
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• Model organization (partitioning) (http://altair-2.wistia.com/medias/yaues86zj9) 

  

http://altair-2.wistia.com/medias/yaues86zj9)
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6 Geometry in HyperMesh 
This chapter has been reviewed and has additional material included by Rahul 
Ponginan, Prakash Pagadala and Matthias Goelke. 

 

6.1 HyperMesh Geometry Terminology 
While dealing with geometry it is important to be familiar with the relevant HyperMesh 

terminology: 

 

As mentioned in the previous chapters, your CAE project typically starts with the import 

of given CAD data e.g. Catia, STEP, UG, IGES, SolidWorks, solidThinking etc. (of course, 

you may create your CAD model in HyperMesh as well). 
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While the importation of data generally occurs with little error, there are issues that can 

occur, and as such, HyperMesh offers a wide variety of tools to remedy these geometric 

issues (this is one of the many reasons why HyperMesh is used in so many places). 

Some of the issues described below do exist because when designers create CAD 

geometry, their priorities are different from those of analysts trying to use the data. For 

a designer, a single smooth surface is typically split into smaller patches. 

Some resulting geometry issues:  

• Surfaces are not stitched together (i.e. there is a gap between surfaces) 

• Very small surfaces are squeezed between regular surfaces 

• The juncture between two surfaces often contains gaps, overlaps, or other 

misalignments 

 

Left: CAD With “Jumps” Results in Irregularly Shaped Elements (Middle). Right: Improved CAD with Regular Mesh 

 

 

• The geometry is a thin-walled volume structure, i.e. instead of building a complex and 

exhaustive 3D mesh, a corresponding mid-surface model meshed with 2D elements 

would be far better 
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Midsurface Representation of The Thin Walled Structure  

• Surfaces penetrate each other (such as at a t-connection) but don’t “feel” each other 

 

Original Geometry 

 

Geometry Fixed So That There Is Proper Connectivity 

• Geometry is much too detailed (e.g. tiny fillets which are not needed for the analysis)  
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Original Geometry, Note the Small Fillets 

 

Simplified Geometry Where Small Fillets Are Replaced by A Sharp Edge 

• And many others ... 

6.2 Geometry Cleanup 
All of the issues defined in the previous section typically demand what is called 

Geometry Cleanup Topology Repair: Strategy 

Below is a general strategy that can be followed to perform the topology repair. This is a 

generalized strategy which may need to be changed to suit the needs of your model, but 

it provides a good starting point to perform the topology repair. 

 

 

 



 

125 

 

 

 

1. Understand the size and scale of the model 

• With models that represent everything from full size ships to microscopic 

electronic parts all residing in a graphics area on a computer monitor, it is often 

difficult to understand the overall scope of the model. It is critical to get an 

idea of the overall size of the model and determine a global element size that 

will be applied to the eventual mesh. 

2. Set a cleanup tolerance based upon the previously determined global element size. 

• With the element size established, a cleanup tolerance can now be set. The 

cleanup tolerance specifies the largest gap size to be closed by the topology 

functions. This value should never exceed 15-20% of the global element size.  

Values beyond this limit can introduce distortion into the mesh. 

3. Use topology display tools to determine what needs to be fixed. For instance, to display 

the topology of 2D geometry set the selector to By 2D Topo 
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• Visualization mode: By Comp (which assigns the color of the component) 

 

• Visualization mode: By 2D Topo 

 

• Visualization mode: Mixed which assigns the component color and adds topology 

information 

 

4. Find duplicate surfaces and delete them. 

• To delete duplicate surfaces, from the menu bar select Geometry > Defeature 

> Duplicates. 

5. Use equivalence to combine as many free edge pairs as possible. 

• Visually verify no surfaces were collapsed with this function. 
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6. Use toggle to combine any remaining edges. 

• Use replace if more control is needed. 

7. Use filler surface to fill in any missing surfaces. 

8. The equivalence, toggle, and filler surface can be accessed within the Quick Edit panel. 

• To access the Quick Edit panel, from the menu bar select Geometry > Quick 

Edit. 

 

Topology Repair: Tools and Panels 

The perimeter of a surface is defined by edges. There are four types of surface edges: 

• Free edges 

• Shared edges 

• Suppressed edges 

• Non-manifold edges 

Surface edges are different from lines and are sometimes handled differently for certain 

HyperMesh operations. The connectivity of surface edges constitutes the geometric 

topology. Below the four types of surface edges which represents the geometric topology 

is described (Note: the shown model is displayed via the 2D Topo mode in HyperMesh). 
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Free Edges 

A free edge is an edge that is owned by only one surface. Free edges are colored red by 

default.

 

On a clean 2D model consisting of surfaces, free edges appear only along the outer 

perimeter of the part and around any interior holes.  

Note: Free edges that appear between two adjacent surfaces indicate the existence 

of a gap between the two surfaces the automesher will leave a gap in the mesh 

wherever there is a gap between two surfaces  

Shared Edges 

A shared edge is an edge that is owned, or shared, by two adjacent surfaces. Shared edges 

are colored green by default. 

When the edge between two surfaces is a shared edge (this is what you typically want to 

have), there is no gap or overlap between the two surfaces - they are geometrically 

continuous. The automesher always places seed nodes along the length of a shared edge 

and will produce a continuous mesh without any gaps along that edge. The automesher 

will not construct any individual elements that cross over a shared edge. 
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Suppressed Edges 

A suppressed edge is shared by two surfaces but it is ignored by the automesher. 

Suppressed edges are colored blue by default. 

Like a shared edge, a suppressed edge indicates geometric continuity between two 

surfaces but, unlike a shared edge, the automesher will mesh across a suppressed edge 

as if it were not even there. The automesher does not place seed nodes along the length 

of a suppressed edge and, consequently, individual elements will span across it. By 

suppressing undesirable edges you are effectively combining surfaces into larger logical 

meshable regions. 

Non-Manifold Edges 

A non-manifold edge is owned by three or more surfaces. Non-manifold edges are 

colored yellow by default. 

They typically occur at “T” intersections between surfaces or when 2 or more duplicate 

surfaces exist. The automesher always places seed nodes along their length and will 

produce a continuous mesh without any gaps along that edge. The automesher will not 

construct any individual elements that cross over a T-joint edge. These edges cannot be 

suppressed. 

Solids 

A solid is a closed volume of surfaces that can take any shape. Solids are three-

dimensional entities that can be used in automatic tetra and solid meshing. Its color is 

determined by the component collector to which it belongs. 

The surfaces defining a solid can belong to multiple component collectors. The display of 

a solid and its bounding surfaces are controlled only by the component collector to which 

the solid belongs. 
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Below is an image of solid topology as well as a description of the three types of surfaces 

which define the topology of a solid. 

To activate the 3D topology mode view, please activate the corresponding setting 
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Bounding Faces 

A bounding face is a surface that defines the outer boundary of a single solid. Bounding 

faces are shaded green by default. 

A bounding face is unique and is not shared with any other solid. A single solid volume is 

defined entirely by bounding faces. 

Fin Faces 

A fin face is a surface that has the same solid on all sides i.e. it acts as a fin inside of a 

single solid. Fin faces are shaded red by default. 

A fin face can be created when manually merging solids or when creating solids with 

internal fin surfaces. 

Full Partition Faces 

A full partition face is a surface that defines a shared boundary between one or more 

solids. Full partition faces are shaded yellow by default. 
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What You Need to Know or Remember 

Green edges - 2 surfaces are stitched together; the FE mesh will be linked 

(compatible), its nodes will line up with the green edge. 

Red edges - indicates free surface edges.   Red edges inside the geometry tell you 

that the surfaces are not stitched together (gap); the FE mesh will NOT be linked 

(not compatible).  

Yellow edges — minimum of 3 edges are stitched together; the FE mesh will be 

compatible. 

Blue edges — Suppressed green edge. Surfaces are “melted” together. In other 

words, the mesher does not see this edge and elements are placed across it. 

How to visualize the edge colors? 

 

Display is controlled in the Visualization toolbar by activating for instance By 2D 

Topo (surfaces turn into grey, edges are colored respectively) or Mixed (surfaces 

are displayed in their original color (reminder: surface color is controlled in the 

Model Browser), edges are colored respectively. 
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A full partition face can be created when splitting a solid or when using Boolean 

operations to join multiple solids at shared or intersecting locations. 

The before mentioned panels describe just a very minor fraction of HyperMesh‘s 

geometry cleanup functionalities. 

Once you feel more comfortable with the process, you will automatically explore and 

learn more about other techniques.  

6.3 Geometry Creation and Editing 

There are many ways to create geometry in HyperMesh which include importing 

geometry from external CAD models, as well as creating new geometry from scratch. The 

methods used to create a particular geometry depend on both the entities available for 

input and the level of detail required.   

Panels to be used: 

• Toggle surfaces (combining, stitching) 

• Trimming surfaces (splitting)  

• Suppressing combined edges 

Geometry > Quick Edit opens up a very comprehensive panel which allows you 

(among many other options) to execute the above listed tasks. 

 



 

134 

 

 

 

The following is a list of the geometric entities which can be created and edited within 

HyperMesh: 

• Nodes 

• Free Points 

• Fixed Points 

• Lines 

• Faces 

• Surfaces 

• Solids 

For each of these entities, we will investigate how they can be created. 

Nodes 

A node is the most basic finite element entity. A node represents a physical position on 

the structure being modeled and is used by an element entity to define the location and 

shape of that element. It is also used as temporary input to create geometric entities. 

A node may contain a pointer to other geometric entities and can be associated directly 

to them. For example, for a node to be translated along a surface, it must first be 

associated to the surface. 

A node is displayed as a small circle of sphere, depending on the mesh graphics mode.  Its 

color is always yellow. 

Nodes are created using the menu bar by selecting Geometry > Create > Nodes and then 

selecting a method to create the nodes with. 
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Free Points 

A free point is a zero-dimensional geometry entity (for more information see: 

HyperMesh> HyperMesh Entities & Solver Interfaces > Collectors and Collected Entities 

in the help) in space that is not associated with a surface.  

It is displayed as a small “x” and its color is determined by the component collector to 

which it belongs. These types of points are typically used for weld locations and 

connectors. 

Free points are created using the menu bar by selecting Geometry > Create > Free Points 

and then selecting a method to create the free points with. 

Fixed Points 

A fixed point is a zero-dimensional geometry entity in space that is associated with a 

surface. Its color is determined by the surface to which it is associated. 

It is displayed as a small “o”. The automesher places an FE node at each fixed point on 

the surface being meshed. These types of points are typically used for weld locations and 

connectors. 

Fixed points are created using the menu bar by selecting Geometry > Create > Fixed Points 

and then selecting a method to create the fixed points with. 

Lines 

A line represents a curve in space that is not attached to any surface or solid. A line is a 

one-dimensional geometric entity. The color of a line is determined by the component 

collector to which it belongs. 

A line can be composed of one or more-line types. Each line type in a line is referred to 

as a segment. The end point of each line segment is connected to the first point of the 

next segment. A joint is the common point between two-line segments. Line segments 

are maintained as a single line entity, so operations performed on the line affect each 
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segment of the line. In general, HyperMesh automatically uses the appropriate number 

and type of line segments to represent the geometry. 

It is important to realize that lines are different from surface edges and are sometimes 

handled differently for certain HyperMesh operations. 

Lines are created using the menu bar by selecting Geometry > Create > Lines and then 

selecting a method to create the lines with. 

Surfaces 

A surface represents the geometry associated with a physical part. A surface is a two-

dimensional geometric entity that may be used in automatic mesh generation. Its color 

is determined by the component collector to which it belongs. 

A surface is comprised of one or more faces. Each face contains a mathematical surface 

and edges to trim the surface, if required. When a surface has several faces, HyperMesh 

maintains all of the faces as a single surface entity. Operations performed on the surface 

affect all the faces that comprise the surface. In general, HyperMesh automatically uses 

the appropriate number of and type of surface faces to represent the geometry. 

Surfaces are created using the menu bar by selecting Geometry > Create > Surfaces and 

then selecting a method to create the surfaces with. 
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Solids 

A solid is a closed volume of surfaces that can take any shape. Solids are three-

dimensional entities that can be used in automatic tetra and solid meshing. Its color is 

determined by the component collector to which it belongs. 

The surfaces defining a solid can belong to multiple component collectors. The display of 

a solid and its bounding surfaces are controlled only by the component collector to which 

the solid belongs. 

Solids are created using the menu bar by selecting Geometry > Create > Solids and then 

selecting a method to create the solids with. 

 

Reminder: The newly created geometry will be placed /stored in the currently active 

component collector. Check the Model Browser for the current component collector.  
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6.4 Importing CAD Geometry 
To import geometry, the Import Browser, accessible through the Import Geometry icon  

 , is used. 

Using the Import Browser, the user can import data from popular CAD packages such as 

(HyperMesh) 

• ACIS 

• CATIA V4/V5 

• CATIA Composites Link        

• DXF 

• FiberSim 

• IGES 

• JT 

• Parasolid 

• PDGS 

• Pro E 

• SolidWorks 

• STEP 

• Tribon 

• UG 

• VDAFS 



 

139 

 

 

 

On Export HyperMesh supports: 

• CATIA Composites Link    

• FiberSim 

• IGES 

• JT 

• Parasolid  

• STEP 

Advanced Import Options 

The cleanup tolerance is used to determine if two surface edges are the same and if two 

surface vertices are the same. The cleanup tol toggle controls the following items: 

• if two surface edges are close enough to be automatically combined into a shared 

edge (green edges)  

• if a surface is degenerate and should be removed. 

If you use the automatic cleanup tolerance option, the complexity of the surface and edge 

geometries are considered and a tolerance to maximize the shared edges (green edges) 

is selected. The automatic cleanup tolerance value defaults to 100 times what is used 

internally by the translator.  

If you want to specify a different value, use the manual cleanup tolerance option, which 

must be greater than the default value. The translator modifies data only if the data stays 

within the original data tolerance. Increasing the tolerance can cause serious problems. 

When this value is set, any features equal to or less than the tolerance are eliminated. 

The translator does not include any edge less than the tolerance long; if there are edges 

present that are important to the surface, that surface will be distorted, or will fail to trim 
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properly. Surfaces smaller than the tolerance may not be imported. If the file you have 

read has many very short edges, it may be worthwhile to reread the file using a larger 

tolerance. The same holds true if surfaces appear to be “inside out” when surface lines 

are displayed. The tolerance value should not be set to a value greater than the node 

tolerance (set in the Options panel) to be used for your element mesh.  

The Options panel is accessed through the menu bar by selecting Preferences > Geometry 

Options. 

• The Import blanked (no show) components option allows you to control if 

blanked components in the IGES translator will be imported into HyperMesh, as 

well as components containing “NO SHOW” entities from the Catia translator.  

• Place a check in the Name components by layer option to activate this option. 

This option is valid for Catia V4 and Catia V5.  

• For Catia V4, the option is enabled by default, and can’t be disabled.  

• For Catia V5, the option is disabled by default and can be enabled. If this option 

is enabled, Catia objects from the same layer are grouped into the same 

component. 

6.5 Geometry FAQ’s 
1.   How to find coordinates of a node? How to get X,Y,Z coordinates of a node? 

  Go to Geom > nodes  
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Click on “As node” option and then click on the node 

 

2.  How to create a node at the centre of a circle? How to measure the radius of the 

hole?  

 Go to Geom-->Distance 

 

 Go to Three nodes--> 

 

  Select three nodes on the circumference of the circle > circle centre 

3.  How to remove fixed points from the surface? 

 Go to Geom > quick edit panel  

 

 

 

 

 



 

142 

 

 

 

 

add/remove points option 

 

 

 

4   How to, export the geometry representing the FE model as iges/create surfaces 

from FE elements?   

 First extract faces using tool>faces  

 

 then go to geometry>surfaces>from FE 

 

User must either create feature lines or specify appropriate surface complexity while 

asking HM to recognize feature lines by itself, feature lines help HM decide where to end 

one surface and start another. 
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5   How to merge solids/subtract one solid space from another? 

Geom > Solid edit > Boolean  

 

 

 

Use this subpanel to perform complex trimming and merging operations, such as 

trimming a pair of intersecting solids down to only the portions of them that coincide. 

 

 Use (A+B) union. This involves combining multiple solids into single solids. 

6.  How to change the edge type from free to shared or shared to suppressed in a 

surface?  

 Go to Geom > quick edit > toggle edge 

 

Left-click a free edge (red) to make it shared (green), or a shared edge to make it 

suppressed (blue). Right-click a suppressed edge to make it shared, or a shared edge to 

make it free. 

7.  How to create washers on geometry and enter its dimensions?  

Go to Geom > quick edit > washer split Use these controls to create a washer seated on 

a hole in your model. 
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 First specify an offset to determine the width of the washer, and then highlight the line 

selector and pick the line(s) to which you wish to add washers of that thickness 

 8.  How to change one or more dimensions of existing geometry 

 Click Geometry > Edit > Surfaces > Dimensioning to open the Dimensioning panel. 

  

 Click the point in the model for point1. 

 Click the point in the model for point2. 

 

A dimension manipulator with a value is created between the points, which represents 

the thickness of the part. Click the dimension text for the dimension manipulator created 

in the previous step.  Enter the new value and press enter. 
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6.6 Recommended Tutorials and Videos 
Recommended Tutorials 

These selected tutorials are part of the HyperWorks installation (see Help --> Tutorials 

...): 

• HM-2000: Importing and Repairing CAD 

• HM-2010: Generating a Midsurface 

• HM-2020: Simplifying Geometry 

• HM-2030: Refining Topology to Achieve a Quality Mesh 

• HM-2040: Creating and Editing Line Data 

• HM-2060: Creating and Editing Solid Geometry 

• HM-2070: Geometry and Mesh Editing Using the Quick Edit Panel 

• HM-2080: Modifying Models using solidThinking 

• HM-2090: Dimensioning 

In the Academic Learning Library (https://altairuniversity.com/learning-library/) 

additional tutorials are available related to creating and editing geometry in HyperMesh  

 

  

https://altairuniversity.com/learning-library/
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Recommended Videos   

HyperMesh Geometry Cleanup  

• Surface Edit  

 

 

 

 

• Unsplit surfaces  

 

 

 

 

 

 

 

• Splitting Surfaces  

  

(https://altairuniversity.com/learning-

library/hypermesh-geometry-cleanup-

surface-edit/ ) 

 

• Extend Surfaces 

 

 

(https://altairuniversity.com/learning-

library/hypermesh-geometry-cleanup-

extend-surfaces/ ) 

 

(https://altairuniversity.com/learn

ing-library/hypermesh-geometry-

cleanup-unsplit-surfaces/) 

 

• Filler Surfaces 

 

(https://altairuniversity.com/learning-

library/hypermesh-geometry-cleanup-

filler-surfaces/) 

(https://altairuniversity.com/learnin

g-library/hypermesh-geometry-

cleanup-splitting-surfaces/ ) 

• Replace Edge 

 

(https://altairuniversity.com/learn

ing-library/hypermesh-geometry-

cleanup-replace-edge/ ) 

https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-surface-edit/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-splitting-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-surface-edit/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-surface-edit/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-surface-edit/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-extend-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-extend-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-extend-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-extend-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-unsplit-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-unsplit-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-unsplit-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-unsplit-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-filler-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-filler-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-filler-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-filler-surfaces/
file:///C:/Users/Gabriel/Desktop/Altair/eBooksReview/(
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-splitting-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-splitting-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-splitting-surfaces/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-replace-edge/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-replace-edge/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-replace-edge/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-replace-edge/
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• Remove Pinholes  

 

 

 

 

 

You may also consider attending a HyperWorks class held in one of our facilities. For 

students and teachers, the seminar fee is typically highly discounted - sometimes even 

waived. 

Just contact your local Altair University Liaison for details (altairuniversity@altair.com). 

6.7 Student Racing Car Project - Introduction and 

CAD Related Aspects 

Student Race Car Introduction 

The objective of this demo is to provide insight into the typical modeling steps related to 

the analysis of a student racing car subjected to bending-, shear-, and torsion loads. 

Please note, that the load cases, geometry of the frame, the dimensions of the 1D 

element cross sections, material parameters etc. are just conceptual. 

(https://altairuniversity.com/learning-

library/hypermesh-geometry-cleanup-

remove-pinholes/ ) 

 

• Equivalence 

 

(https://altairuniversity.com/learning-

library/hypermesh-geometry-cleanup-

equivalence/ ) 

 

mailto:altairuniversity@altair.com
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-remove-pinholes/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-remove-pinholes/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-remove-pinholes/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-remove-pinholes/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-equivalence/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-equivalence/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-equivalence/
https://altairuniversity.com/learning-library/hypermesh-geometry-cleanup-equivalence/
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The following working steps will be briefly discussed in the course of this book. The focus 

of this chapter is on CAD. 

• Model geometry (CAD) import  

• 1D meshing (CBAR elements)  

• 1D mesh checks 

• Material definition (Card Image MAT1) 

• Definition of frame properties (Card Image PBARL) & trouble shooting 

• Wheel suspension  

• Boundary conditions & loads 

• Analysis  

• Postprocessing CAD 

In order to keep this demo simple, the given CAD was updated and improved in order to 

account for misaligned lines, duplicated lines, and minor asymmetries in the overall 

geometry (a faultier geometry is available too). 

Let’s get started with importing the CAD data. 

The imported model consists of 2 component collectors that  
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are named lvl1 and Points (compare with the component collectors listed in the Model 

Browser). 

 

The image below indicates that the geometry of the student race car frame consists of 

lines only. The crosses displayed at the location of the lines indicate what are called “line 

handles”. These ease the viewing and selection of lines. 
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In the image the “location” of the wheel suspension is given in terms of pre-defined 

geometry points (x symbols). 

Depending on the quality of the given CAD data (here: lines) it may be required to 

manually trim (split), combine or extend lines (Geometry > Edit > Lines > …) 

 

Edit existing lines 
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In case lines need to be created from scratch, there are many possibilities available: 

 

 

Create Lines from Scratch 
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7 Introduction to Meshing 
This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 
Infinite)”. It also has been reviewed and has additional material added by Gareth Lee. 
 

 

 

7.1 How to Start Meshing 

1)  Spend A Sufficient Amount of Time Studying the Geometry  

A common observation is that CAE engineers start meshing immediately, without 

properly understanding the geometry and paying attention to all of the requirements and 

instructions provided. Observing the geometry several times and thinking about it from 

all angles is strongly suggested. Mental visualization of the steps is the first step in the 

right direction of creating a good meshing.  

2)  Time Estimation 

A time estimation is very relative, and one can find a lot of differences in estimation by 

different engineers (as much as 2 to 3 times). Usually a less experienced person will 

estimate more time. Also, if someone is handling the job for the first time, then he/ she 

will require more time. If similar kinds of jobs are given to the same engineer again and 

again, the meshing time would reduce drastically.  
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3) Geometry Check 

Generally, CAD data is provided in *.igs format.  Geometry cleanup is an integral part of 

the meshing activity. CAE engineers should at least have the basic knowledge of CAD. 

Before starting the job, the geometry should be carefully checked for: •  Free edges  

• Scar lines  

• Duplicate surfaces 

• Small fillets  

• Small holes 

• Beads 

• Intersection of parts (assembly of components)  

If suppressing fillets, small holes, beads, or the generation of a mid surface is required 

for meshing, then why isn’t the CAD data provided in the way needed for CAE by the 

CAD engineers?  

Yes, theoretically that would be an ideal situation, but practically everyone works with a 

very tight schedule and target dates. CAD data is generated keeping in mind the final 

drawing to be released for manufacturing. The same CAD model is provided 

simultaneously to the tools and jig /fixture manufactures, vendors, purchase engineers, 

and CAE engineers, etc.  

The simplification required for a FEA is understood better by a CAE engineer than a CAD 

engineer. All meshing software provides special tools for geometry cleanup and 

simplification, which are usually much faster than CAD software. Many times, for 

complicated geometry, surfacing operations fail in CAD software and it could be easily 

handled by the CAE engineer by avoiding the geometry and generating the mesh using 

manual or special meshing operations.  
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4) Symmetry Check 

•  Complete part symmetry 

 

Meshing only a quarter of the plate and reflecting it twice is advisable. 
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• Sub-part symmetry, repetition of features, and the copy/paste command 

 

Meshing the highlighted 22.5º portion and then using reflection and rotation would lead 

to a faster mesh as well as the same structure of elements and nodes around the critical 

areas (holes).  

5)  Selection of Type of Elements 

In real life, we rarely use only one type of element. It is usually a combination of different 

types of elements (1D, 2D, 3D, and others).  
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A. Geometry Size and Shape   

For an analysis, the software needs all three dimensions defined. It cannot make 

calculations unless the geometry is defined completely (by meshing using nodes and 

elements).   

The geometry can be categorized as 1D, 2D, or 3D based on the dominant dimensions 

and then the type of element is selected accordingly.  

1D Element: Used for geometries having one of the dimensions that is very large in 

comparison to the other two.   

   

Beam elements can be used effectively in beam-like structures or for fasteners and 

connections. However, due to the complexity of employing beam elements, they are 

probably the most misused elements in the family of elements. 

Practical example: Long shaft, rod, beam, column, spot welding, bolted joints, pin joints, 

bearing modeling, etc.   

2D Element: Used when two of the dimensions are very large in comparison to the third 

one.   

3D Element: used when all three dimensions are comparable    

  

Practical examples: Transmission casing, clutch housing, engine block, connecting rod, 

crank shaft etc.  
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B. Based on the Type of Analysis  

Structural and fatigue analysis - Quad, hex elements are preferred over trias, tetras and 

pentas.  

Crash and nonlinear analysis – Priority to mesh flow lines and brick elements over 

tetrahedron.  

Mold flow analysis – Triangular element are preferred over quadrilateral.  

Dynamic analysis – When the geometry is borderline between the classification of 2D and 

3D geometry, 2D shell elements are preferred over 3D. This is because shell elements 

being less stiff captures the mode shapes accurately and with a fewer number of nodes 

and elements.   

C. Time Allotted for Project  

When time is not a constraint, the appropriate selection of elements, mesh flow lines, 

and a good mesh quality is recommended.  

Sometimes due to a very tight deadline, the analyst is forced to submit the report quickly. 

For such situations   

1. Automatic or batch meshing tools could be used instead of time 

consuming but structured and good quality providing methods.    
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2. For 3D meshing tetras are preferred over hexas.    

3. If the assembly of several components is involved, then only the 

critical parts are meshed appropriately.  Other parts are either 

coarse meshed or represented approximately by 1D beams, springs, 

concentrated mass, etc. 

Rules of Thumb regarding element selection:  

• Do NOT mix trias and quads whenever possible and if required place trias in areas of 

non-concern  

• Use all trias for back-to-back comparisons when you have determined trias are 

adequate to your solution - don’t compare a quad model with a refined tria model.  

• Use elements of consistent size whenever possible  

• Do NOT combine shells and solids or beams and shells/solids without first 

understanding all the assumptions and implications to your solution  

• Model solid parts with solid elements  

• Model thin plate structures with shell elements (thickness < 10-20 x Edge length)  

• Understand all assumptions for the element type you have selected  

• Do NOT use degenerated elements unless required  

• Do NOT mix tetrahedral elements with other element types and, if required, place 

outside areas of concern  

• Use tetrahedral elements when the effort required to model hexahedral elements is 

excessive (this can run into weeks of effort versus days for tetras)  

• Use beam elements when shells or solids require excessive modeling time and effort  

6) Type of Meshing 

• Geometry based – The mesh is associated to the geometry. If the geometry is 

modified, the mesh will also get updated accordingly (automatically). The 

boundary conditions could be applied on the geometry like a surface or edge, etc. 
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• FE based – The mesh is non associative. The boundary conditions are applied on 

the elements and nodes only.  

7) Size of element 

a. Based on previous experience. with a similar type of problem 

(successful correlation with experimental results).   

b. Type of analysis. Linear static analysis could be easily carried out 

quickly with many nodes and elements, but crash, nonlinear, CFD, or 

dynamic analysis takes a lot of time. Keeping control on the number of 

nodes and elements is necessary.  

c. Hardware configuration and graphics card capacity of the available 

computer. An experienced CAE Engineer knows the limit of the nodes 

that can be satisfactorily handled with the given hardware 

configuration.  

d. Timing. Available time is a major determinant in a decision concerning 

mesh density. A compromise is usually reached between the amounts of 

time dedicated to human time and that devoted to computer time. It is 

often less time consuming to build a large model by using an automatic 

mesher, and increased computer capacity has lessened the need to use 

special techniques to minimize the number of elements. 

 

e. Deflection or Stress. In most cases, far fewer elements are necessary if 

only deflection or stiffness information is required. Even fewer elements 

can be used if only the deflection under the load is to be studied. For 

instance, one beam or one shell can estimate the deflection of a 

cantilever beam of rectangular section. It may, however, take dozens of 

shell or solid element to capture the stress at the boundary in a simple 
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cantilever beam. If there is a high gradient of stress over a large area, for 

example, a web in the corner of a frame, many elements may be required 

to get the proper deflection.  

 

f. Areas of Concern. Determine the areas of concern. If you have a known 

issue in the lab or the field, you will certainly want some detail in these 

areas. If time is limited, you may want to focus only in these areas and 

use rough approximations else where. If you have no prior knowledge of 

the component of system and a history search has not turned up any 

clues, you may have to make a very uniform mesh and refine areas that 

respond to the applied loads. Use your engineering sense to predict the 

areas that are prone to trouble. Some typical areas of concern are listed 

below:  

• Tight radii  

• Points of load application  

• Boundary points  

• Attachment points  

• Narrow sections  

• Abrupt change in section  

Suppose you are a part of a newly formed CAE group (no clear guidelines are available, 

and there is no experienced person in the group): In the first run, accept the default 

element length. Mesh with the basic rules of thumb discussed in this book. Then run 

the analysis and observe the high stress regions. Remesh the localized areas of high 

stress (with smaller element length) and solve again. Compare the difference in the 
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original and the new results. Continue the process until convergence is achieved (5 to 

10% difference in strain energy / maximum stress value).   

8) Joint Modeling 

a. Special instructions for bolted joints (specific construction around holes) 

b. Spot and arc weld  

c. Contact or gap elements and the requirement of the same pattern on 2 

surfaces in the contact 

d. Adhesive joint 

 

9) Splitting the Job 

When there is little time or when engineers in other group are sitting idle, then the job 

could be split among several engineers by providing a common mesh on the interfaces.  

7.2 Meshing Techniques 

 

Automatic / Batch 
Mapped   

(or Interactive) 

Manual (Special 

commands: Spline,  

Ruled, Drag / 

extrude,  

Spin / rotate etc.) 

Time required for 

meshing 
 

≈ (intermediate i.e. 

more than auto but 

less than manual) 

 

Geometry required  ✓ ✓ X 

No. of nodes and 

elements generated 
 ≈  

User friendliness  ≈  

User’s control over the  

mesh 
 ≈  
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Structural mesh 

(flow lines) 
 ≈  

Experience or skill 

required 
 ≈  

Patience  ≈ 

(specially for 

brick  

/ hex) 

 

Batch meshing / Mesh adviser – Now a day, all software provides special programs for 

automatic geometry clean up and meshing with little or no interaction from the user. The 

user has to specify all the parameters like minimum hole diameter, minimum fillet radius, 

average and minimum element length, quality parameters, etc. and the software will run 

a program to produce the best possible mesh by fulfilling all or most of the specified 

instructions. Though these programs are still in the initial stage and for many applications 

the output is not acceptable, the research is in progress and its performance will surely 

improve in the coming years.  

Automatic mesh vs mapped / interactive / manual mesh  

 

Nodes = 1400, Elements = 1309  

Automatic meshing Not acceptable 
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Nodes = 1073, Elements = 982   

Mapped meshing 

7.3 Meshing in Critical Areas 
Critical areas are locations where high stress will occur. Dense meshing and structured 

mesh (no trias / pentas) is recommended in these regions. Areas away from the critical 

area are general areas. Geometry simplification and coarse mesh in general areas are 

recommended (to reduce the total DOFs and solution time).   

How Would I Know About the Critical Areas Before Carrying Out an Analysis?  

After going through a previous analysis of a similar part (carried out by your colleague or 

a senior in the group) one can get a fairly good idea about the probable locations of the 

high stress. But suppose there is no past record and you are doing it for the first time, 

then run the analysis with a reasonable element length and observe the results. High 

stress regions are critical and could be remeshed with a smaller element length in the 

second run. 
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Rules for modeling holes and fillets 

Critical area General area 

 

Minimum 12 elements around the hole 

 

4 to 6 elements  

 

Minimum 3 elements on fillet.  

 

Suppress small fillets, 1 element for large fillets. 

 

 

Mesh transition techniques and flow lines 

 

1 to 3                           1 to 3 

 

2 to 4                    2 to 4 

 

                                          1 to 2 1 to 2 x 2 
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7.4 Mesh Display Options 

1. Shell Mesh 

a. Mixed mode: Geometry – wireframe, Mesh – shaded This is the most common 

and preferred way of working.  

 

 

 

 

 

b. Line mode: Geometry and Mesh – both wireframes, this mode is preferred for 

brick meshing, for internal mesh adjustment / modifications. 

 

 

c. Solid: Geometry and Mesh – both shaded this mode is not preferred for regular 

meshing but is very useful after the completion of the job. It helps to check the 
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mesh deviation from the geometry and to find the kinks or abrupt changes in the 

mesh. 

 

 

2. Brick Mesh 

a. Line mode options 

 

   All faces display         Free faces display 
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The figure on the left is used for viewing the internal details while the figure on the right 

is used for checking free faces inside the mesh.  

b. Shading mode  

  1. Shaded                                    2. Shaded, no mesh lines                               3. Shaded and shrink option activated 

The solid view is commonly used during regular meshing. The shaded view is used for    

checking the kinks or deviation of the mesh from geometry and the shrink view is used 

for checking for free faces and for missing or extra 1D elements on the edge of the 

element.  

7.5 Mesh density Solution Convergence 

Mesh density and solution convergence are closely related and the factors which 

determine that relationship can be controversial. In an effort to meet specific time and 

accuracy requirements, trade-offs involving modeling time, accuracy, computation time, 

and cost must be made.   

The correct mesh, from a numerical accuracy standpoint, is one that yields no significant 

differences in the results when a mesh refinement is introduced. Although this concept 

may sound simplistic, many factors must be considered. Mesh refinements must 

accurately represent the problem in question if they are to be used in the analysis. Mesh 

refinements by simple splitting of elements can be misleading unless the newly created 

nodes conform closely to the original geometry. As refinement progresses, the original 



 

 

 

168 
 
 
 

element selection must retain its significance. For example, a shell model can be refined 

to the point that it loses its validity in the area of interest, creating a need for a solid 

element model.  

Checks of Convergence 

If you plan to do a convergence check, consider performing at least one refinement of the 

model after the first run. If neighboring elements display large differences in stress, the 

gradient was probably not captured in these areas, therefore some refinement is 

recommended. 

New techniques for automatically computing convergence by several criteria are 

available on certain codes or can be customized by the user. Some computer codes will 

also automatically re-mesh nonconverged portions of a model. These techniques are 

dependent on the load cases and will provide different meshes for different load cases. 

The p-version accomplishes refinement by numerically increasing the complexity of each 

element or nonconverged elements on subsequent re-runs. All automated techniques 

require that the model be set up to “near perfect” or the convergence may focus on small 

details that are irrelevant to the specific problem or have not been modeled with 

elements, boundary conditions or loads that have a natural converged solution. It is best 

to set up a problem so that there is a chance for convergence even if you do not intend 

to perform a convergence test. Below is an example of a flat structure that will converge 

if modeled in shells but will not converge if modeled “more accurately” with solids. Since 

the shells do not sense stress in the direction of the load, they will converge to the shell 

theory solution. The solids will attempt to resolve the “point load” and the stresses will 

go higher and higher as the elements under the load decrease in size. 
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Recommended Video (not related to HyperWorks) 

• Convergence of Finite Eelements 

   (Prof. J. Chessa, University Texas; http://youtu.be/YRJ0c8uO8iU)  

  

http://youtu.be/YRJ0c8uO8iU
https://www.youtube.com/watch?v=YRJ0c8uO8iU&feature=youtu.be
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8 1D Meshing with HyperMesh 
This chapter includes material from the book “Practical Finite Element Analysis (Form Finite to 

Infinite)”. It also has been reviewed and has additional material added by Matthias Goelke. 

8.1 When to Use 1D Elements  

Recall, we typically use 1D elements if one of the dimensions is very large in comparison 

to the other two: 

 

Element shape – Line 

Additional data from user - The remaining two dimensions, the cross-sectional area.  

Element type – Rod, bar, beam, pipe, axi-symmetric shell etc. 

Practical applications - Long shafts, beams, pin joint, connection elements 
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In practice, the following element types are commonly used 

 

8.2 Special Features of Beam/Bar Elements 

a. Orientation of cross section 

Changing the orientation angle of the cross section is supported by most commercial 

software and will be discussed in some detail further below.  

 

Y 

X Z 

Y 

X Z 
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b. Taper Elements 

 

Regular bar elements cannot take into account a variation in the cross section. This could 

be achieved by using a taper beam. Input data for a taper beam is two cross sections 

(front and rear). 

 

c. Curved Beams: Employed to model curvatures 
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d. Beam End Shortening: To represent the geometry accurately at joints 

 

 

               Without Eend Shortening (interference at joint)                                      End Shortening 

e. Beam Ccross Section Offset: Useful in representing the geometry as per a real life 

situation 

 

Original 
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f. Beam End Release  

A beam element has 6 dofs. There are special situations, like a rotating shaft or hinge 

joint, where the rotation or translation in a specific direction is free. The use of a regular 

beam element and its spider connection, using Rigid or RBE2 elements, might not 

represent the exact situation. The end release is a special command to release one or 

more dofs of a beam.   

 

For example, consider the door above. Its rotation about the vertical axis is free. Suppose 

the pin of the hinge is simulated by a beam element. The end release (rotation along 

vertical axis) would be helpful in simulating the door in real life.  

 

 

Beam Offset 
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g. Shear Center  

It is applicable only for non symmetric cross sections (like angle or channel cross sections). 

When a vertical shear force is applied to a symmetric cross-sectional beam, it will bend. 

But for an unsymmetric cross section, the same force would result in bending as well 

twisting. Twisting is due to unbalanced shear forces in the flange. The shear center is the 

point at which when a force is applied, will nullify the effect of torsion.  

 

For symmetric cross sections, the centroid and shear center coincide, therefore there is 

no twisting.  

Shear flow for an I - section shows that the forces in the flange are in equilibrium and thus 

there is no twisting. While for a C channel, there is an unbalanced couple which gives rise 

to torsion.  

The shear center is a property of the given cross section and it does not depend on the 

magnitude of the force. 

Beam elements are recommended for symmetric as well unsymmetric cross sections, as 

it takes into account the shear center. Bar elements have a limitation on the shear center 

and therefore are not recommended for unsymmetric cross sections.  

8.3 Rigid Elements 
Rigid “elements” were devised to simplify the input of constraint equations for commonly 

used configurations. They are not structural elements but are equations that define 

P 1 P 1 

F 

P 1 

P 

C 

P 1 

e 
P 1 

F = P 

P 1 

h 
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dependencies between degrees of freedom. There are many illegal configurations of rigid 

elements which lead to a large percentage of input errors therefore they should be used 

with care. Because there really are no perfectly rigid materials in nature, a rigid element 

is usually a poor representation of any structural component. In general, a rigid is simply 

a constraint equation or a set of constraint equations of the form: 

A1 u1 + A2 u2 + A3 u3 ...= 0; 

where the A = constant coefficients and the u = degrees of freedom. Usually, one degree 

of freedom is dependent on all of the others. 

RBAR Element 

The RBAR element rigidly connects from one to six dependent degrees of freedom (the m 

-set) to exactly six independent degrees of freedom. The six independent degrees of 

freedom must be capable of describing the rigid body properties of the element. 

If a rigid element is long or of similar length as the structure and is strongly coupled to the 

structure, it is probably overly stiffening the structure. In this case a simplified 

representation using structural elements would be preferred. Using rigid elements for 

fasteners such as bolts typically results in overly stiff joints. The use of a beam for 

modeling a bolt not only gives a better representation but allows easy output of force 

quantities. 
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Proper Application of Rigid “Elements” 

When part of a structure is very stiff relative to and lightly coupled to, the structure under 

investigation, it is a candidate for application of rigid elements. An example might be an 

engine connected through soft mounts to a frame. The engine might be considered rigid 

if its deflections have little effect on the frame. 

Rigid elements are also appropriate when modeling a mechanism, such as a hinge as part 

of a structure. In this case, two nodes are placed at the same location and only coupled 

degrees of freedom are constrained together. In fact, this type of zero length rigid 

element is a very important application of rigid element. See the following figure 

depicting a hinge. 

 

Pairs 4 & 7 and 2 & 5 are modelled at the same location and constrained in all degrees of freedom except rotaion 

around the y-axis ` 

Hinge using zero length rigid elements 

8.4 Fasteners 
Modeling of fasteners and welds using the finite element method is an arguable 

procedure. The details around a fastened joint are complex and often exhibit nonlinear 

behavior. The best approach to adopt is one in which the techniques give an indication of 

good versus poor attachment. An “absolute” evaluation of fastener performance would 

be extremely difficult using current standard methods. The following section will discuss 

some of the methods used in modeling for a variety of connections. 
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Spot Welds 

Spot weld connections are normally used between relatively thin sheet metal 

components such as those used in car body design. Rigid elements or common nodes (for 

very thin members) are used to model spot welds. Care must be taken to ensure that 

each rigid element is normal to the surfaces it attaches. It should be noted that the lack 

of “drilling” degrees of freedom in some solvers will allow the welds to virtually spin in 

flat areas of the structure causing matrix singularities. Automatic singularity elimination 

codes will usually ignore nodes attached to rigid elements, so constraints will need to be 

added manually or a soft rotational spring will be added in the normal direction of the 

element. This approach is sometimes referred to as fictitious “drilling” stiffness option. 

If beam elements are used instead of rigid elements, the singularities will be found and 

automatically eliminated. A secondary benefit of using beams for spot welds involves the 

ease of recovering forces in the welds. A round beam with the approximate diameter of 

the spot weld and parent material properties would work well as long as it had a non-zero 

length. The figure below illustrates a typical modeling scenario for spot welds. 

 

Spot Weld Modeling 
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There should be at least one node on the parts between spot weld nodes to allow relative  

 

Fillet Weld Modeling 

motion between the two parts to be joined. If there are no degrees of freedom between 

neighboring spot welds, then there is, in effect, a continuous seam weld simulated. The 

forces recovered in this type of model can be compared to test data on similar welds to 

determine if the number and placement of welds will be adequate. 

Fillet Weld 

Fillet welds normally occur between heavy gage plates or stampings. These welds can be 

effectively modeled by connecting shell elements if the parts are also modeled with shell 

elements. Care must be taken to avoid excessive aspect ratios. The stresses will not be 

accurate but will give relative nominal values. The irregular geometry of the actual weld 

is too complex to capture in a finite element model. The nominal values can be correlated 

to test results or scaled up using notch sensitivity tables for the material in question. The 

following figure depicts this method of modeling. 

It is also common to use rigid elements similar to spot welds for fillet welds. 
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Rivets and Bolts 

To model riveted or bolted joints with a linear code, we must assume that the joined 

surfaces either will never slip relative to each other or that they will always be able to slip. 

In most cases, it is assumed that the heads do not slip but the interface between the 

joined surfaces is allowed to slip. This assumption requires that the fastener carry the full 

shear load between the surfaces (conservative assumption), but that there are no prying 

forces in the joint (usually non-conservative assumption). It is best to design joints so that 

there is no slipping under the peak loads. This can be checked by looking at the shear 

force resultant and comparing it to the intended installation tension multiplied by a 

conservative (lowest) friction coefficient. These methods require the application of basic 

engineering principals and the answers are not printed in the finite element output. 

Pre-Loaded Joints 

To properly account for the pre-load in a joint, the stiffness of the joint in the direction of 

the fastener axis must be included. This will normally require the construction of a 

detailed solid model of at least the joint area. The fastener can still be modeled with 

beams or also be represented with a full solid model. The pre-load can then be applied 

by a thermal shrink of the fastener or by application of equal and opposite forces on a 

segment of the fastener. The thermal or opposite forces will need to be adjusted to 

achieve the desired pre-load after an initial run determines the joint to fastener stiffness 

ratio. Usually this amount of detail is not merited because slipping during bolt up and 

under load, and prying forces are usually ignored. If the full details of a joint are to be 

studied a nonlinear code would probably be required. Today there are solvers that permit 

automatically apply the pre-tension load as a force or a prescribed displacement.  
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8.5 1D Element Creation 
1D elements perform a critical function in Finite Element Analysis as they can be used to 

connect nodes together, attach dissimilar meshes, distribute loads and in general provide 

a quick and easy way to attach things together. 

There are numerous types of 1D elements ranging from infinitely rigid simple connections 

to complex cross sectioned elements that can be stressed. 

HyperMesh currently supports bar2, bar3, rigid links, rbe3, plot, rigid, rod, spring, weld, 

gap, and joint one-dimensional elements. The following is a list of the different element 

types and their purpose.   

• bar2: supports complex beams  

• bar3: supports complex beams (bar3 elements contain a third node designed 

to support second order beams)  

• gap: supports gap elements 

• joint: supports kinematic joint definitions supplied with safety analysis codes 

• plot: supports display type elements 

• rbe3: supports NASTRAN RBE3 elements 

• rigid link: supports rigid elements with multiple nodes 

• rigid: supports rigid elements 

• rod: supports simple beams 

• spring: supports springs or damper 

• weld: supports weld elements 
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HyperMesh also uses an entity called a connector which defines how different 

components or assemblies in the model are fastened to each other. These connectors are 

used to create or realize one-dimensional elements in the model. 

Some Modeling Hints Regarding 1D Elements with HyperMesh  

While working with 1D elements, sooner or later you will come across the following 

element types: 

• CROD 

• CBAR 

• CBEAM 

In brief, CROD elements support (allow) tension and compression only, whereas CBARS 

and CBEAMS allow bending as well. A CBAR element is a kind of simplified CBEAM 

element and should be used whenever the cross-section of the structure and its 

properties is constant and symmetrical. The CBAR element requires that its shear center 

and the neutral axis coincide. Due to this requirement, CBAR elements are not useful for 

modeling structures that may warp, such as open channel-sections. This limitation is not 

present in CBEAM elements. 

Thus, CBEAM elements are used to model more “complicated” geometries with varying 

cross sections. Important to note, in CBEAM elements the neutral axis and shear center 

are noncoincident. Overall, this type of element demands a deeper understanding of 

beam theory.  

Furthermore, we recommend the beginner to use the predefined 1D element cross-

sections available with the OptiStruct library (provided you are using OptiStruct as your 

finite element solver). Another benefit of employing the cross-sections available with the 

OptiStruct library is that the stress recovery points which are needed for postprocessing 

stress results are predefined already. Of course, in addition to the cross-sections depicted 
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further below (OptiStruct library) you can create your very own and general 1D cross-

sections with HyperMesh. 

CROD Elements 

In the following the general modeling building process based on CROD elements is 

documented. Most of the working steps can also be applied to CBAR and CBEAM 

elements, too.  

This element “understands” tension and compression loads (axial forces) only. In other 

words, the nodes of a CROD element only have translation degrees of freedom (still this 

element has a torsional stiffness). 

 

 

 

 

How to Model CROD’s 

As we are going to use the FEM program OptiStruct, make sure that the corresponding 

User Profile is activated. 

You may start by building CROD elements manually (with/without any property 

definition) by making use of the Rods panel.  This panel is found in the menu bar by 

selecting Mesh > Create > 1D Elements > Rods. 
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Make sure that the “element type” to be created is set to CROD. In the simplest case, a 

CROD element is created by selecting its bounding nodes. 

Other more general options to create many CROD’s in a single step exist of course. For 

instance, by making use of the Line Mesh panel. This panel can be found through the 

menu bar by selecting Mesh > Create > Line Mesh.  

 

Again, make sure and specify the element configuration to be rod.  

It may happen that the newly created elements are displayed as CWELD elements (not 

what we want). 

 

If this is the case, then the “element type” must be updated. This is done using the 

Element Type panel, which is found through the menu bar by selecting Mesh > Assign > 

Element Type. 
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The element types are updated by setting rod= to CROD, then selecting the corresponding 

elements and the selecting update. 

Up until now the element specific information, such as cross-section data, is missing. The 

CROD elements are thus simply displayed as a “line”: 

 

In order to define the elements cross-sectional properties, we recommend using 

HyperBeam which is found in the menu bar by selecting Properties > HyperBeam (also 

accessible from the 1D page > HyperBeam). 

In the HyperBeam panel, select the standard section subpanel: 

 

As stated before, we will make use of the readily available cross sections in OptiStruct. 

Therefore, make sure that for standard section library, OPTISTRUCT is activated. From the 

list of available cross-sections (standard section type:), chose the one of interest. Above 
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it is set to Rod (Box, H at etc. are also valid of course). Note, the cross section is named 

“Rod” – it doesn’t say anything about the 1D element type! 

Clicking the create button then starts up HyperBeam which allows to interactively change 

the radius of the rod cross-section.  

 

Note, that all the relevant cross-sectional data such as area, moments of inertia are 

automatically calculated and listed in the side bar of HyperBeam. This information is 

stored as a beamsection collector (here named rod; listed in the side bar on the left). 

Later the beamsection will be referenced inside the mandatory property collector. 

Complicated? Not really, as you will see … 

In order to switch back to the HyperMesh GUI, just activate the icon  in the upper 

left menu bar (beneath Model in the Model Browser). 



 

187 
 
 
 

 

Before we proceed creating a property collector, we need to define a material (right 

mouse click in the Model Browser > Create > Material). In many cases, especially while 

getting started with FEM, the material card image will be MAT1 (MAT1 describes linear 

elastic isotropic temperature independent material behavior). The material is named 

steel using standard values for Young’s Modulus, Poisson’s ratio and density. 

Then, in the next step the property collector for the CROD elements is created (right 

mouse click in the Model Browser > Create > Property). In the pop-up window of the 

property collector, the Card Image is chosen as PROD. In here we also reference the 

previously defined cross-section, namely the beamsection rod and the material steel. 

 

Note, if you are using CBEAM or CBAR elements, the property Card Image would either 

be PBEAML or PBARL (L = as we are using the Library). Activate the Material tab next to 
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Material and assign the previously created material steel to this property collector (here 

the material is named “steel” (image above). 

Eventually, the property collector is created. Its card image (solver syntax) then reads as 

 

 

Where PID = property collector ID, MID = material collector, A is the area and J is the 

torsional constant. 

In the general analysis work flow (not restricted to 1D elements), the property collector 

must now be assigned to the elements of interest.  

To visually check the attributes of the 1D elements, make sure that Shaded Elements  

and 3D Element Representation is activated. Then the CROD element will be 

displayed as: 
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CBAR Elements 

 

Simple beams with constant properties (symmetrical and constant cross-section), may 

be modeled with CBAR or CBEAM elements. However, what you need to recall is that in 

CBAR elements, the origin of the element coordinate system is centered at the shear 

center of the cross-section (shear center and neutral axis coincide). Any offsets between 

the neutral axis and the shear center is not accounted for. As a consequence, CBAR 

elements are not useful for modeling beams that warp, as may be the case with open 

channel sections. This is because the cross-sections of CBAR elements remain plane. In 

other words, whenever you are modeling open or nonsymmetrical sections, be 

especially cautious with the element type you are going to use. 

The following cross-sections shown are available: 
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The cross-sectional properties, shear flexibility factors, and stress recovery points (C, D, 

E, and F) are then computed using the TYPE and DIMi as shown.  

As the CBAR and CBEAM elements also account for bending, the orientation of the 

element and thus of its cross-section becomes important (as it automatically defines the 

location of the pre-defined stress recovery points; see discussion below). 

       

 

CBAR                  CBEAM 

 

Meshing (building) of CBAR or CBEAM elements is just as simple as with the creation of 

CROD elements (e.g. Line Mesh panel) 

 

This time the element config is set to bar2 (if you miss this step, you still can update the 

element configuration later). 

In order to define the cross-section, we again make use of HyperBeam and the OptiStruct 

library.  
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1.  Building (manually) CBAR / CBEAM elements: 

Start the meshing process with the Bars panel (Mesh > Create > 1D Elements > Bars) 

 

The element type is set to CBAR. 

2.  Specify cross sectional properties (with HyperBeam): 

 

The standard section library OPTISTRUCT is used. 
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Again, the cross-section properties can be interactively changed in HyperBeam. The 

beamsection is named rod_library and the beamsection collector is named rod 

3. In the property collector, the Card Image PBARL is chosen i.e. L indicates that we 

reference the cross section from the library Recall that the material named “steel” 

was created before ... 

 

The Card Image of the property collector now reads as: 



 

195 
 
 
 

 

Please compare this card image with the one belonging to PROD (from the example 

above). Here, the type of the cross-section (CStype) is ROD as defined in HyperBeam, 

DIM1 corresponds to the radius of the rod, PID is the ID of the property collector, MID is 

the ID of the material collector, and beamsec references the before created cross-section. 

4. As mentioned earlier, care must now be taken regarding the orientation of the cross-

section (orientation of the element and thus “location” of the stress recovery 

points). 

 

The local element x-direction is given by its first (A) and second node (B). Its overall 

orientation, i.e. the local xy plane (Plane 1) of the element, is then defined by a vector v 

and the local x-axis. The v vector is defined with respect to the global coordinate system, 

however. Note, more information is also available in the help documentation 
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(\help\hwsolvers\hwsolvers.htm, then Index > CBEAM or CBAR). To review and update 

the elements orientation (if needed) use the Bars panel (Mesh > Edit >1D Elements > 

Bars). 

In this example, the v vector parallels the global y-direction i.e. ycomp=1. Consequently, 

the stress recovery point C is located at the “upper” side of the rod. 

A note regarding the stress recovery points: Its location essentially defines the c in the 

equation σ= Mc/I: 

           

 M = Moment, c distance from neutral fiber (i.e. location of the stress recovery point), I = 

Moment of Inertia.  Based on c, OptiStruct calculates the stresses in the rod or on its 

surface. Actually, the stress recovery points are automatically calculated at specific 

locations to give the maximum stress for the cross-section. 

Visualization of Element Stresses 

Evaluating element stresses opens up a very different aspect. In the case of CBAR 

(CBEAM) elements, stresses are determined with respect to the stress recovery points C, 

D, E, F (see explanations above). This stress value is then used to contour the entire 

CBAR/CBEAM element. 

In HyperView, node A or node B and the stress recovery point of interest must be 

specified, e.g. longitudinal stress at node A and recovery point C. 

What Is the Meaning of Pins a, Pins b, Offset a And Offset b? 

So far, the Bars panel was used to manually create CBAR (or CBEAM) elements. 
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Pins a and Pins b 

You may “pin” certain translations or rotations (degrees of freedom) of the 1- D element. 

In other words, if the 1D element is supposed to “transmit” all translations and rotations, 

then “pins a” and “pins b” must be set to 0 (zero). In case a certain degree of freedom 

must be “eliminated”, then the corresponding pin at node a or node b (eventually even 

both) needs to be pinned.  

As an example, rotation with respect to the x-axis (dof 4) should not be transferred from 

node b to the attached element, then pins b=4. This still enables the 1D element to rotate 

around its x-axis, BUT as requested, this rotation is not transmitted to the neighbor 

element attached to node B.  

 

Offset a, Offset b 

Because bar elements are one-dimensional representations of three-dimensional objects, 

these values represent the distance between the real-world edge of a bar and its center 
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axis. For example, if the bar was cylindrical in shape, node a and node b would determine 

where the edge of the bar is attached to another element. The offsets would identify 

where the bar’s central axis lay in relation to the connection points. 

 

*Note, in this model, the 1D elements physically follow the given geometry. 

In the model shown next, the 1D elements form a straight line (elements are displayed 

with Shrink Mode  and Traditional Element Representation ).   

 

However, “internally” the elements nodes a and b are offset in order to account for the 

“true” geometry. This offset can only be visualized by activating the 3D Element 

Representation . 
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Reviewing the elements provides insight on how the offset is defined: 

 

The offset of node B of the selected element is 4 mm (hence by= 4). This way, the 

geometry from the reference model shown above can be modeled without physically 

translating the elements. 
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In the image above the displacement contour plot is shown. In this model the elements 

(i.e. nodes) are offset in order to account for the “true” geometry. 

How to Apply Pressure On 1D Elements? 

Pressure on CBAR or CBEAM elements may be applied as load type PLOAD1, which defines 

concentrated, uniformly distributed, or linearly distributed applied loads to the CBAR or 

CBEAM elements at user-chosen points along the axis (for detailed information see the 

help documentation help\hwsolvers\hwsolvers.htm > Pload1) 

The load type PLOAD1 is specified in the pressure panel directly 
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How to Convert PLOTEL Elements (General 1D Elements) Into CROD Elements 

 

Note, the card edit option  was used to display the element information. 

Note, a meaningful material and property collector must exist. As we are converting the 

PLOTEL element into a CROD element, the Card Image of the property collector must be 
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PROD. Consequently, if the conversion would be from PLOTEL to CBEAM or CBAR, the 

property collector Card Image should be PBEAM/PBEAML or PBAR/PBARL. 

1. Open the panel Element Config (Mesh > Assign > Element Config): 

Specify the new element configuration e.g. rod (for CROD elements; bar2 for 

CBEAM/CBAR elements) and confirm the changes with switch. 

2. Check the element types setting using the Element Type panel (Mesh > Assign > 

Element Type). 

 

Select the elements to be updated. Make sure that rod= is set to the element type CROD, 

(bars= CBEAM/CBAR) and activate update.  

Making use of the card edit option, , again provides the following updated element 

information: 

 

In case PID is not shown, make sure that a property collector is assigned to the CROD 

elements. 
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1D Elements Are Not Properly Displayed What Is Wrong? 

 

In this image, the 1D elements are displayed by using the traditional element 

representation . Additionally, the element shrink option, , is activated.  

However, when activating the 3D element representation, , only some of the 1D 

elements are displayed with respect to their properties (i.e. cross-sections). 

 

What is the Issue with the “Missing” 1D Elements? 

In the first step, make sure that a property is assigned to ALL the 1D elements. This can 

be checked visually. For instance, by activating the element display mode  

 By Prop:  

If a property collector is assigned to the 1D elements, they will be displayed with the same 

color as the property collector. 
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To better understand the properties of the 1D elements, just review the property 

collector (in the Model Browser make a right mouse button click on the corresponding 

property collector and select Card Edit): 

In this particular case, the Card Image of the property collector is PBEAM (so far, we have 

been using PBARL). Also, a beamsection (with the ID = 1), and a material (ID=1) is 

referenced. This looks quite reasonable. 

Even though all of the 1D elements have been assigned the same property (see check 

number 1), let’s have a look at the cross-section. To do this, we open up HyperBeam 

(Properties > HyperBeam), select the edit section subpanel and select the beamsection 

of interest. 

 

This will visualize the cross-sectional properties section (radius, area, moment of inertia 

etc.) as shown below. 
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This looks reasonable too. 

Recall, that the element orientation is defined through the elements local xy-plane. The 

local xy-plane in turn is defined via the elements x-axis (longitudinal direction from node 

a to b) and a vector v (more information is also available in the help documentation Index 

> CBEAM or CBAR). 

To control (or update) the local element xy-plane and thus the v vector, go to the Bars 

panel (Mesh > Edit > 1D Elements > Bars) and select any of the displayed 1D elements (in 

the image below the 3D Element Representation  is active) 
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As shown above, this will display not only the local element coordinate system but also 

the components of the vector v (with respect to the global coordinate system). Here, the 

vector v parallels the global y-direction (y comp = 1). The element xy-plane thus parallels 

the global xy-plane. 

In the next step, we are reviewing the element orientation of a 1D element which is not 

properly displayed (cross-sections are not shown). You may need to switch back to the 

standard visualization mode . 

Then, just repeat the “review steps” from before. 
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This time the location of node a and b is shown only. In the panel shown below it becomes 

apparent that the components of the v vector are all zero. 

 

The components of vector v can be corrected/updated at any time. 

Select one or all of the elements, and then specify the component of the vector v with 

respect to the global (basic) coordinate system. In case the y-component of vector v is set 

to y=1 (global y), both, vector v and local y-direction of the element coincide.   

In the image below the local y direction and v vector are superimposed on each other.  
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As indicated in the next image, the vector v doesn’t coincide with any of the global 

components. Now it is quite apparent, that vector v and local x-axis together specify the 

local xy-plane of the element. 

 

 

 

8.6 Connectors in HyperMesh 

Connectors - What Are They? 

Connectors are a geometric representation of connections between entities. The 

advantage of connectors is the ability to create multiple connections at a single time. 

Hundreds or even thousands of connections that would normally have to be created 

manually one at a time can be mass created, even before the part is meshed. They can 

be used to create numerous types of connection elements such as: 



 

209 
 
 
 

 

Connector - Definition 

The connector is simply a database of information defining a specific request for 

connection at a specific location. 

A connector definition describes the connector between multiple entities at a specific 

location. Entities that are to be connected are referred to as link entities. The connector 

location can be defined as a node or node list, a geometric point, a line or line list, a 

surface, or even as elements or tags.  

In the following example, there are two components (Top and Bottom) that are to be 

connected at the location of a point (with an id of 10). In this case, both components are 

link entities, since they are to be linked together. The point defines the location of the 

connector. 
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After a connector is created, the connector icon is placed at point 10, and components 1 

and 2 are incorporated into the request for connection.  

The following diagram shows the connector after it is created (with an id of 7) at the 

location of point 10 (point 10 is not visible). 

 

In this example, connector 7 has been defined and no welds have been created. The 

connector stores the following information: 

• Which link entities the request for connection is to connect (Comp 1 and Comp 2)  

• The thickness of the realization (Thickness = 2)  
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• Where to connect the link entities (the connector’s current location)  

HyperMesh entities currently supported as link entities include ASSEMS, COMPS, 

ELEMS, SURFS, NODES, and TAGS. Any number of link entities of differing types can be 

added to a connector in any order. The connector sets the order of link entities during 

the realization process.  

The example above is a simple case where we have added two link entities of the same 

type (COMPS) to a single connector. For more detailed cases of connecting assemblies, 

see Example of Connecting Assemblies. 

Connectors Terminology 

• Link Entities - The entities that are being connected 

• Connector Location - Where the entities are linked 

• Connector Realization – The creation of the finite element representation of 

that connector 

• Connector State – Whether an FE representation of a connector has been 

created  

• Unrealized - The initial status of the connector entity upon creation 

• Realized - The status only if creation of the FE weld representation at the 

connector was successful 

• Failed – The status if creating the FE weld representation at the connector was 

not successful 

• # of Layers – Number of FE weld layers to attempt to generate for the 

connector 

• Connect When – Specifies when the link entity information is added to the 

connector 
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8.7 Learn More About 1D Meshing and Connectors 
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STANDARD SECTION: Predefined sections  

  

GENERIC SECTION: New sections managed by parameters  

  

EDIT SECTION: Changing section properties  

  

REVIEW UTILS: Section orientation respect to axial direction  

 

 13  
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Smaller conflicts can be resolved automatically when realizing the connectors. This releases the 

overlapping elements and performs a normal remesh in that area. This is permitted as long as the 

overlapping area is smaller than half the regular quad transition element. However, if a conflict is too 

great it cannot be resolved in this fashion.  
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• In the second step, the conflicting elements can be manually modified with all of the functions 

that  HyperMesh provides.   

• Then the manual mesh imprint is performed.   

 

 

8.8  1D Meshing Tutorials and Videos 
Recommended Tutorials 

These tutorials are included in your HyperWorks installation. 

• HM-3000: Creating 1D Elements 

• HM-3400: Creating Connectors 

• HM-3410: Creating Area Connectors 

• HM-3420: Creating Bolt Connectors 

• HM-3430: Part Replacement Through Connectors 

• HM-4020: Obtaining and Assigning Beam Cross-Section Properties using 

HyperBeam  

   

    

http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hwtut.aspx?hm3000.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm3400.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm_3410.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm_3420.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hwtut.aspx?hm_3430.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hwtut.aspx?hm4020.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hwtut.aspx?hm4020.htm
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Recommended Webinars 

Creating, Checking, and Visualizing 1D Elements in HyperMesh  

 

Videos About 1D Elements (not only related to HyperWorks) (Prof J Chessa, University 

Texas;  

 

 

 

 

 

 

1D Bar element, part 1 

http://youtu.be/zYPrPntBUEg 

 

 

1D Bar element, part 2 

http://youtu.be/A6R3UIe5xQY 

HyperMesh for CBAR models part 1 

https://youtu.be/hGmPIz1FRgo  

 

 
HyperMesh for CBAR models part 2 

https://youtu.be/De1Z1GV6sQg  

https://altair-2.wistia.com/medias/v7q27rwtx1?wvideo=v7q27rwtx1
https://www.youtube.com/watch?v=zYPrPntBUEg&feature=youtu.be
https://www.youtube.com/watch?v=hGmPIz1FRgo&feature=youtu.be
http://youtu.be/zYPrPntBUEg
https://www.youtube.com/watch?v=A6R3UIe5xQY&feature=youtu.be
http://youtu.be/A6R3UIe5xQY
https://youtu.be/hGmPIz1FRgo
https://www.youtube.com/watch?v=De1Z1GV6sQg&feature=youtu.be
https://youtu.be/De1Z1GV6sQg
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8.9 Student Racing Car Project - 1D Meshing 
As the given geometry consists of lines, the Line Mesh panel is used for meshing. To 

access the Line Mesh panel, select Mesh > Create > Line Mesh from the menu bar.  

   

At this stage, there is no property collector available. Thus, the property field remains 

blank. The mean element size is set to be 100 mm and the element configuration is bar2. 

Bar2 elements are 1D (1st order) elements with 2 nodes used to model axial, bending, 

and torsion behavior. We just have to specify the kind of 1D element which should be 

used for the analysis. 

The Element Type panel is used to set the type of 1D elements to be used. This panel is 

accessed by selecting Mesh > Assign > Element Type. 

The element type “bars” may be set to CBEAM (default). As we are going to use CBAR 

elements it may be necessary to switch the element type in here. 
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Below: image of the meshed frame with the elements displayed in Shrink Mode, . 

 

 

 

Wheel Suspension 

The wheel suspension is modeled through rigid links (RBE2). However, before creating 

the rigids links temporary nodes at the location of the independent nodes must be 

created. The location of these nodes is given through the geometry points (stored in the 

component “points_wheel”). In the first step temporary nodes are placed at the location 

of the geometry points by selecting Mesh > Create > Nodes. 
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Temporary nodes (yellow) at the location of the geometry points. These temporary nodes are then used to create the 

rigid elements representing the wheel suspension by selecting Mesh > Create > 1D Elements > Rigids. 

 

Note that the selector next to “dependent” is set to “nodes” i.e. multiple nodes. 

 

 

 

 

 

 

 

 

Suspension modeled by means of rigid links (RBE2) with independent and dependent nodes. 



 

233 
 
 
 

9 2D Meshing with HyperMesh 
This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 

Infinite)”. It also has been reviewed and has additional material added by Matthias Goelke. 

Once geometry cleanup is completed (e.g. surfaces are stitched together — no unwanted 

free surface edges inside the geometry), meshing is next. 

Some rules of thumb when meshing: 

• The mesh should look rather smooth and regular (keep in mind that the 

analysis is based on your mesh and the mesh quality is key.  

• Use the simplest element type suited for the problem. 

• Start with a coarse mesh and understand the modeling results; then use a finer 

mesh if needed. 

• Try to keep mesh related uncertainties to a minimum if possible. Keep it simple 

as it can get more complicated on its own. 

 

The image above illustrates an “ugly” mesh. This chapter focuses on how to create 2D 

elements of good quality, and how to use HyperMesh to create 2D elements. 
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Overview on 2D Element Shapes 

  

 

 

*L – Linear Element   *P – Parabolic Element 

                                     *( ) – Indicates Number of Nodes/Element 

 

 

 

  

Also known as 

Constant Strain 

triangle (CST) 

Also known as 

Linear Strain 

triangle (LST) 
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9.1 Effect of Biasing in the Critical Region 

             

       No bias                                                                            Bias 15 (on the right side) 

During meshing, an option named “biasing” may be used. When element length is not 

the same on the edge and biased towards a point, then it is known as biased meshing. 

Different commercial software calculate bias differently. One of the simplest schemes is 

where the bias factor is a ratio of the maximum element length divided by the minimum 

element length.  

 

                     Bias 0                             Bias 5       Bias 20 

The above geometry was split along the diagonal and the bias was defined on the 

diagonals (at the edge point near the circular hole). 
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 Stress N/mm2      

   (3 N/mm2)    

Nodes Elements 

No Bias 1.59 168 144 

Bias 5 2.13 168 144 

Bias 10 2.41 168 144 

Bias 15 2.56 168 144 

Bias 20 2.65 168 144 

The conclusion from the previous example was that the higher the number of elements in 

the critical area, the higher the accuracy. The example on biasing shows that even without 

increasing the number of elements, one can achieve a better result just by the appropriate 

arrangement of the nodes and elements. This was done at no extra computational cost. 

9.2 Symmetric Boundary Conditions 
In order to reduce the total number of elements one may consider only 1/2 or 1/4 of the 

original structure. In this way a locally refined mesh (i.e. higher accuracy) may be used 

whereas the total number of elements may still be less than an evenly coarse meshed full 

model.  

 

6 

6 

6 6 

6 6 

6 6 

6 6 
6 

6 

Biased Mesh Exercise: Distribution of elements  
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Full Plate: 

 

Half Plate: 

 

How to apply symmetric boundary conditions: 

Step 1: Write plane of symmetry for half plate i.e. x z 

Step 2: Fix in plane rotations (θx , θz) and out of plane translations (Uy). 

Please find more details about symmetric boundary conditions in Chapter 12. 

 Stress Displacement Nodes Elements 

Complete model 2.68 0.00486 352 320 

Half Symmetry 2.68 0.00486 187 160 
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The advantage of symmetric boundary conditions is that the same accuracy is achieved 

at a lesser computational time and cost.  

Symmetric boundary conditions should not be used for dynamic analysis (vibration 

analysis). It can not calculate anti nodes. 

Different Element Type Options for Shell Meshing: 

 

 

The image above depicts a geometry that has been partially meshed. How would you 

“link” both meshes? Depending on whether some single tria elements are allowed, you 

may use the mixed meshing method or the pure quad mesh. Both meshes are shown 

below. Note the more homogeneous mesh pattern resulting from “mixed” meshing. 
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           Mixed Mesh            Quad Only Mesh 

The mixed mode element type is the most common element type used due to the better 

mesh pattern that it produces (restriction: total tria % <5). Sometimes for structural 

analysis or for convergence and better results for a non linear analysis, the pure 

quadrilateral element meshing option is selected.  

 

If Quads are Better Than Trias, Why Not Always Mesh Using Only Quad Elements? 

Why Do FEA Software Provide the Option for Tria Elements?   

1) Mesh Transition: In structural and fatigue analysis, rather than a uniform mesh, what 

helps is a small element size in the critical areas and a coarse mesh or bigger elements 

in general areas. This type of mesh gives good accuracy with manageable dofs.  Trias 

help in creating a smooth mesh transition from a dense mesh to a coarse mesh.  

2) Complex Geometry: Geometry features like rib ends or sharp cutouts demand for the 

use of triangular elements. If quads are used instead of trias, then it will result in poor 

quality elements. 

3) Better Mesh Flow: For crash or non linear analysis, systematic mesh flow lines where 

all the elements satisfy the required quality parameters is very important. Using a mix-

mode element type instead of pure quad element type helps to achieve better flow 

lines and convergence of solution.  
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4) Tetra Meshing (conversion from Tria to Tetra): For tetra meshing, all the outer 

surfaces are meshed using 2D triangular elements and then trias are converted to 

tetras. This methodology is discussed in detail in the next chapter. 

5) Mold Flow Analysis: Mold flow analysis requires triangular elements.  

Comparison Between Equilateral Tria and Right Angle Tria Meshing  

The default tria mesh in commercial software produce equilateral triangles while the R-

tria option generates right angle triangles (generating a rectangular or square mesh and 

then splitting along the diagonal gives two trias per element).   

 

In the figure above, the left image shows meshing with equilateral trias, while the right 

image shows meshing with the option R-trias (which simply splits quad elements into two 

tria elements). 

The ideal shape for a triangular element is an equilateral triangle and is theoretically 

better than a R-tria element. But for the following specific applications, R-trias have an 

advantage over equilateral trias.   
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1) Tetra Meshing  

For defining contacts, a similar mesh pattern on the two surfaces is desirable. The 

equilateral tria option produces a ziz-zag mesh and there is also no control over the mesh 

pattern. A similar mesh requirement could be achieved by generating a structured 

quadrilateral mesh (maintaining exactly same number of elements on two contact 

surfaces) and then splitting it to trias (R-tria). 

Typical applications are as follows: 

a) Bolt hole and washer area: 

 

b) Bearing contact surfaces: Contact surfaces are meshed with quad elements (same 

mesh pattern and equal number of elements) and converted to trias before tetra 

conversion.   
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2) Variable Thickness of Ribs for Mold Flow Analysis 

The ribs are modelled using quad elements in three layers as shown below and then split 

to R-trias. The average section thickness is assigned to each different layer.  

 

9.3 Geometry Associative Mesh 
Creating a geometry associative mesh allows for automatic meshing to be carried out by 

picking surfaces or volumes from the geometry. The generated mesh is associative with 

the geometry.   

Advantages:  

1) If the geometry is changed, then the mesh will also change automatically. 

t 1 avg  = 1.5 mm 

t 3 avg  = 3.5 mm 

t 2 avg  = 2.5 mm 

1  mm 

2  mm 

3  mm 

4  mm 
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2) Boundary conditions could be applied on the geometry (edges, surfaces instead 

of nodes and elements, etc.) which is more user friendly.  

 

      Original geometry                                               Geometry based mesh 

 

                  Geometry modification (cut hole at center)              Auto update of mesh 
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9.4 How Not to Mesh 
1) Back to back triangles should be avoided. Two tria elements should not be connected 

to each other directly.  

 

2) On plane surfaces triangular element should be avoided.  

 

 not recommended      not recommended          recommended 
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3) No mesh transition on constant radius fillets / curvatures 

 

The mesh transition should be carried out on the planer surfaces (and not in the 

area of the fillet) 

 

 

4)    Avoid tria elements on outer edges or holes 
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5)    What is not “acceptable” at a professional level 

 

 

 

 

 

 

 

 

 

 

 

 

 

What is “acceptable”. 
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6) Circular holes should be modelled carefully with a washer (1.5 to 2 times diameter) 

and a minimum of two layers around the hole. 

 

7)      Holes should be modelled with an even number of equally spaced elements: 

For a better representation of the hole geometry and smooth mesh flow lines, holes 

should be modelled with an even number of elements (like 6, 8, 12,16 etc. rather than 5, 

7, 9 or 13). 
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8)       Nodes should lie properly on the surface, with no deviation (and no kinks). 

 

 

 

 

Switch off the element mesh lines and observe the contour (in particular at curvatures). 

Kinks as shown above are not acceptable. 

9) Follow the feature lines (nodes should lie exactly on the edges). 
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10) Instead of a zig-zag distribution, a structured or smooth mesh is recommended 

(nodes aligned in a straight line)  

                                       

            Not recommended                    Recommended 

Use of a “smooth” option, provided by most of the commercial software, helps in 

achieving systematic mesh.    

11) For crash analysis, follow the mesh flow line requirement. 

 

Diamond elements are not allowed 
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12) For crash analysis, rotating quads are not Recommended.  

 

  

13) For crash analysis, constant mesh size (by using trias) is preferred (due to a 

minimum element length and a time step criteria). 

 

      Recommended for Crash Analysis 

Rotating Quads 

Recommended for Strutural Analysis 

Not Recommended for Crash Analysis 

Recommended 

Recommended for Crash Analysis 

Not Recommended for Structural Analysis 
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 Variable Mesh Ssize Not Recommended for Crash but Recommended for Structural 

Analysis 

9.5 Creating 2D Elements in HyperMesh 
A surface mesh or “shell mesh” represents model parts that are relatively two-

dimensional, such as sheet metal or a hollow plastic cowl or case.  In addition, surface 

meshes placed on the outer faces of solid objects are used as a baseline mapping point 

when creating more complex 3D meshes (the quality of a 3D mesh largely depends on 

the quality of the 2D mesh from which it is generated). 

Three-noded trias, four-noded quads, six-noded trias, and eight-noded quads can all be 

built in HyperMesh.  These two-dimensional elements can be built in any of the following 

panels. A detailed look at automeshing and shrink wrap meshing will follow. For 

additional information regarding the other panels, please refer to the appropriate video. 

Below is a listing of the panels available for creating and editing 2D elements. Most of 

these tools are located in the menu bar by selecting Mesh > Create > 2D Elements. 

• cones: Builds elements on conic or cylindrical surfaces. 

• drag: Builds elements by dragging a line, row of nodes, or group of elements 

along a vector. 

• edit element: Builds elements by hand. 



 

252 
 
 
 

• elem offset: Builds elements by offsetting a group of elements in the direction 

of their normals. 

• line drag: Builds elements by dragging a line or group of elements along or 

about a control line. 

• planes: Builds elements on square or trimmed planar surfaces. 

• ruled: Builds elements between two rows of nodes, a row of nodes and a line, 

or two lines. 

• spheres: Builds elements on spherical surfaces. 

• spin: Builds elements by spinning a line, row of nodes, or group of elements 

about a vector. 

• spline: Builds elements that lie on a surface defined by lines. 

• torus: Builds elements on toroidal surfaces 

• automesh: Builds elements on surfaces according to user specifications 

(further details given below).   

• shrink wrap: Builds 2D (optionally 3D) simplified meshes of existing complex 

models. Further details are given further below and in the chapter about 3D 

(solid) meshing. 

9.6 Automeshing 
The Automesh panel is a key meshing tool in HyperMesh. Its meshing module allows you 

to specify and control element size, density, type, and node spacing, and also perform 

quality checks before accepting the final mesh.  
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The optimal starting point for creating a shell mesh for a part is to have geometry surfaces 

defining the part. The most efficient method for creating a mesh representing the part 

includes using the Automesh panel and creating a mesh directly on the part’s surfaces. 

The Automesh panel can be accessed from the menu bar by selecting Mesh > Create > 

2D AutoMesh. A part can be meshed all at once or in portions. To mesh a part all at once, 

it may be advantageous to first perform geometry cleanup (please see Chapter 3 on 

Geometry) of the surfaces, which can be done in HyperMesh.  

 

Provided your geometry is clean e.g. the surface of the rib is merged with the adjacent 

surfaces, then the resulting mesh will be automatically compatible (all elements are 

connected with each other). 

There are two approaches to the Automesh panel, depending on whether or not you use 

surfaces as the basis for the operation.  

1. If you use surfaces, you may choose from a greater variety of algorithms, have 

more flexibility in specifying the algorithm parameters, and employ the mesh-

smoothing operation to improve element quality. 
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2. If you do not use surfaces, the meshing process is usually faster and uses less 

memory.  Most of the functions are still available and operate in the same way.  

Furthermore, there are situations in which it is not possible or not desirable to 

create a surface. 

For either method, the module operates the same.  You interactively control the number 

of elements on each edge or side and can determine immediately the nodes that are used 

to create the mesh.  You can adjust the node biasing on each edge to force more elements 

to be created near one end than near the other, which allows you to see immediately the 

locations of the new nodes.   

 

You can also specify whether the new elements should be quads, trias, or mixed and 

whether they should be first or second order elements.   

 

The created mesh can also be previewed, which allows you to evaluate it for element 

quality before choosing to store it in the HyperMesh database.  While you are in the 
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meshing module, you can use any of viewing tools on the Visualization toolbar to simplify 

the visualization of complex structures in your model. 

If you use surfaces, you can specify the mesh generation and visualization options to use 

on each individual surface.  You may choose from several mesh generation algorithms.  

Mesh smoothing is also available, and you may select the algorithm for that operation as 

well.  

What You Need to Know/Remember: 

While working with the Automesh panel you will come across the following options and 

settings: 

Element size = the element size in the model may deviate from the specified size 

considerably (it depends on the size of the surface). 

Mesh type = mixed; default (is a combination of many quad-shaped elements and some 

tria elements).  Leads to rather smooth meshes. 

Elems to surf comp vs. Elems to current comp = specifies the “storage” place of the 

elements. 

Start meshing, explore the meaning of the other settings later! What may happen is that 

the mesh looks a bit weird … 

Some surfaces apparently cause trouble. This may not actually be a problem, but a matter 

of your visual settings. In this example, the geometry is still shaded, overprinting the 

mesh in some spots. Displaying the geometry in wireframe and shading the elements will 

improve the mesh “visibility”. 
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Note: In case you don’t see any mesh, check the Model Browser and the status of the 

corresponding collector (is the elem icon activated?) 

   

9.7 Shrink Wrap Meshing 
Shrink wrap meshing is a method to create a simplified mesh of a complex model when 

high-precision models are not necessary, as is the case for powertrain components during 

crash analysis. The model’s size, mass, and general shape remains, but the surface 

features and details are simplified, which can result in faster analysis computation. You 

can determine the level of detail retained by determining the mesh size to use, among 

other options.  
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You can shrink wrap elements, components, surfaces, or solids. 

The shrink wrap allows for wrapping of multiple components if they are selected. 

The selection provides the option to wrap all elements, components, surfaces or solids, 

or only a certain portion of the model if desired. The input to the shrink wrap (that is, the 

model parts that you wish to wrap) can consist of 2D or 3D elements along with surfaces 

or solids. 

A shrink wrap mesh can be generated as a surface mesh (using a loose or tight wrapping), 

or as a full-volume hex mesh by use of the Shrink Wrap panel. This panel is located in the 

menu bar by selecting Mesh > Create > Shrink Wrap Mesh.  The distinction between 

surface or volume mesh is an option labeled generate solid mesh. The Shrink Wrap panel 

is covered in more detail in the 3D meshing section. 

9.8 Meshing FAQ’s 

1.  What to Do When You Are Unable to Specify a Minimum Elem Size Lesser Than a 

Particular Value in Automesh Panel? 

In the menu, go to ‘Preferences’ > ‘Meshing options’ panel, or press the <o> key.  
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Specify the element size in the element size field, this specifies a default edge length for 

elements, in the same units that the loaded model was created in (mm, inches, etc). This 

determines the default values to be used for meshing, such as in the automesh panel. 

2. What to Do When You Get the Error One or More Surfaces Failed to Mesh? How to 

Retrieve the Failed Surfaces from Meshing?  

In 2D > automesh > there are two options: 1. failed surfaces, 2. unmeshed surfaces. Click 

on one of the options according to whether you search for failed or unmeshed surfaces. 
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The corresponding surfaces will get highlighted. You can save these surfaces into the so-

called “user mark” (click on the yellow panel “surfs” will open the extended selection 

menu, then select the option “save”. Later, for instance in the “mask” panel the saved 

surfaces can be “retrieved” from within the extended selection menu. By inverting the 

selection (because the failed surfaces are active) all other surfaces will be masked after 

executing the mask command. 

3. How to Edit a Surface but Not Have the Mesh Change?  

In the menu, go to ‘Preferences’ > ‘Meshing options’ panel, and for ‘topology revision’ 

choose ‘keep mesh’. 

 

4.  How to Coarsen Your 2D Mesh? 

Go to Mesh menu > create > coarsen mesh 
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Use the Coarsen Mesh utility to simplify the mesh by combining many small elements 

into a smaller number of larger ones. This dialog allows you to pick the Components that 

you wish to simplify, any Hard points (such as those defining a hole or ridge) that must 

be preserved, a new element size, and a mesh type (Mixed or Trias-only). In both cases, 

you must click the selector twice, as if you were accessing its extended entity selection 

menu; however, the second click opens a temporary panel in the panel area. This panel 

allows you to select the desired components or nodes, and then proceed in order to 

close the panel and return to the Coarsen Mesh dialog. 

Once you set the desired options, you can “Mesh” the selected components. If the results 

are not satisfactory, you can “Reject” the new coarse mesh, change the options, and try 

again. 

Manually  

Detach elements from its neighbouring mesh and remesh the selection can be a bad idea 

if a good connectivity is required or the number of elements is too large. 

Create surface from elements, delete the selected elements and remesh the surface, 

which has points on its edges created from the surrounding mesh. Based on the 

difference of old and new mesh sizes, can provide a very good connectivity  

5.  How to Create a Matching Mesh on Two Opposing Identical Surfaces or How-to 

Project Elements on to Surface?  

Tool page >project->to surface,  
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You may need to duplicate the existing elements so that a copy of the elements is 

projected. 

 

6. How to Delete Duplicate Nodes? 

Go to Tools > edges  

 

Select elements or components > select the elements or components using the extended 

entity selector > preview equivalence > if the automatic selection based on the tolerance 

specified is satisfactory > click equivalence. 

 

7.  How to Make Changes to The Configuration of Existing Elements? For Instance, How 

to Change a 1D Bar Element to a Beam Element? 

Go to 1D > config edit > select existing elements > select the necessary config and click on 

switch. 
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8. How to Change the Order of Your Elements from First Order to Second Order 

Elements?  

Go to 2D > order change > select elements and click on change order 

 

9.  How to Fill One or More Holes in Your Geometry with Automatically-Generated 

Mesh?  

Go to utility tab > Geom/mesh > fill hole 
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Use this option to select holes automatically based on size. Type a value into the entry 

field labelled 

“Fill circular holes with radius smaller than:” 

The model is automatically scanned for holes smaller than this value and attempt to fill 

them with mesh. 
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10.  How to Specify a New Element Density Along Surface Edges? 

Activating the “mesh” option in the “2D->automesh” panel opens up the density-mesh 

style-biasing-checks subpanel. In the density subpanel, click the selector, adjust: “edge” 

to make it active. 

 

From the graphics area, left-click an edge’s element density number to increase it by one. 

 

Right-click an edge’s number to decrease it by one. Click and hold the mouse pointer on 

an edge’s number and drag the mouse up or down to increase or decrease the number. 

Click mesh to update the preview mesh based on the change. 
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9.9 2D Meshing Tutorials and Videos 

Recommended Tutorials: 

The following tutorials are part of the HyperWorks installation (check the “help-

documentation” for details): 

• HM-3100: AutoMeshing 

• HM-3110: Meshing without Surfaces 

• HM-3120: 2D Mesh in Curved Surfaces 

• HM-3130: QI Mesh Creation 

• HM-3140: Batch Meshing 

• HM-3150: Meshing a Model Using Shrink Wrap 

Recommended Videos  

• Automeshing  

 

 

 

 

(https://altairuniversity.com/learning-

library/hypermesh-automeshing/ ) 

 

(https://altairuniversity.com/learning-
library/hypermesh-edit-elements/ ) 

 

•          Edit Elements  

 

http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hwtut.aspx?hm3100.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm3110.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm3120.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm3130.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm3140.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hwtut.aspx?meshing_a_model_using_shrink_w.htm
https://altairuniversity.com/learning-library/hypermesh-automeshing/
https://altairuniversity.com/learning-library/hypermesh-automeshing/
https://altairuniversity.com/learning-library/hypermesh-automeshing/
https://altairuniversity.com/learning-library/hypermesh-edit-elements/
https://altairuniversity.com/learning-library/hypermesh-edit-elements/
https://altairuniversity.com/learning-library/hypermesh-edit-elements/
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•    Ruled Mesh  

 

 

• Mesh checking editing  

 

 

• Refining surface topology  

 

 

(https://altairuniversity.com/learning-
library/hypermesh-creating-ruled-mesh/ ) 

 

 

(https://altairuniversity.com/learning-

library/hypermesh-creating-spline-mesh/ ) 

• Spline mesh  

 

(http://altair-

2.wistia.com/medias/ftu42udf77) 

 

 

(http://altair-

2.wistia.com/medias/ujt7sb9sgm) 

 

• Introduction in meshing  

 

(http://altair-

2.wistia.com/medias/2p48j67uav) 

 

https://altairuniversity.com/learning-library/hypermesh-creating-ruled-mesh/
https://altair-2.wistia.com/medias/ftu42udf77?wvideo=ftu42udf77
https://altair-2.wistia.com/medias/2p48j67uav?wvideo=2p48j67uav
https://altairuniversity.com/learning-library/hypermesh-creating-ruled-mesh/
https://altairuniversity.com/learning-library/hypermesh-creating-ruled-mesh/
https://altairuniversity.com/learning-library/hypermesh-creating-spline-mesh/
https://altairuniversity.com/learning-library/hypermesh-creating-spline-mesh/
https://altairuniversity.com/learning-library/hypermesh-creating-spline-mesh/
http://altair-2.wistia.com/medias/ftu42udf77
http://altair-2.wistia.com/medias/ftu42udf77
https://altair-2.wistia.com/medias/ujt7sb9sgm?wvideo=ujt7sb9sgm
http://altair-2.wistia.com/medias/ujt7sb9sgm
http://altair-2.wistia.com/medias/ujt7sb9sgm
http://altair-2.wistia.com/medias/2p48j67uav
http://altair-2.wistia.com/medias/2p48j67uav
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10 3D Meshing with HyperMesh 

This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 

Infinite)”. It also has been reviewed and has additional material added by Matthias Goelke. 

10.1 3D Element Types 
3D Elements 

 

10.2 Tetra Meshing Techniques 
There are two methods of tetra meshing: 

1) Automatic mesh: This approach is limited to simple geometries and the pre-requisite 

is an error free CAD model. The user just has to select the volume and the software 

automatically carries out the meshing as per the specified element length, quality 

criteria, etc.  

Advantage: Very quick, no meshing efforts 

Tetra Penta or Wedge Hex or Brick Pyramid  

Linear  
Tetra 4 

Linear Penta 6 Linear Hex 8 

Parabolic  
Tetra 10 

Parabolic Penta 15 Parabolic Hex 20 

Linear Pyram 5  
Not supported by  

all software 

Parabolic Pyram 13  
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Disadvantage: Results in a very high number of nodes and elements. There is no control 

over the mesh flow and the specific mesh pattern requirement (like bolted, welded joints 

or contact surface simulation).  

2) 2D (tria) to 3D (tetra): This is the most commonly used method. Quad or tria meshing 

is carried out on all the outer surfaces of the geometry. During the tetra meshing the 

quads are automatically split into trias which then serve as the “basis” of the tetra 

elements.  

Steps for 2D (tria) to 3D (tetra) mesh generation 

Step 1) Study the geometry  

 

Step 2) Separate (isolate) the surfaces and split the job among engineers (if there is 

time constraint) 
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a. CAE engineer 1 

 

b. CAE engineer 2 

 

Step 3) Combine the mesh  
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Step 4) Perform quality checks for the triangular elements.  

For instance, min. tria angle > 150, Max. tria angle < 1200, Jacobian > 0.6, zero free edges, 

no T-connection  

Step 5) Convert the tria mesh to a tetra mesh 

Step 6) Perform quality checks for the tetra elements (tet collapse > 0.1, Jacobian and 

distortion > 0.5, stretch > 0.2 etc.). Improve the quality of the mesh if required.    

Step 7) Perform a free-free run or otherwise linear static analysis with dummy BC’s.  

Common Algorithms for Tria To Tetra Conversion 

• Advancing Front: This algorithm is very powerful and the most commonly used 

algorithm. 

• Delaunay algorithm 

• Tria-quad mesh 

All algorithms provide the following two options for tria to tetra conversion: 

1) Floating trias: The original tria mesh generated by the user on the outer surfaces might 

not match with the software produced tetra.  Selection of this algorithm gives freedom 

to the software to change the triangular mesh pattern (in case of any problem in the 

tetra mesh generation). This option could be used for the meshing of general 

components or areas (areas without high stress, components representing stiffness or 

mass, etc.).  

2) Fixed trias: The original tria mesh and the generated tetra mesh pattern match. This 

meshing option should be used whenever you intend to “glue”/merge individually 

meshed components together. Otherwise it may happen that the mesh of the 

components to not match resulting in an incompatibility of the mesh (i.e. the mesh 

would not be properly connected). 
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10.3 Brick Meshing 
Brick meshing (also known as hex-meshing) is all about planning, hard work and patience. 

Brick meshing supports only manual and semi-automatic meshing options. Automatic 

meshing or an option like quad to brick (tria to tetra), is not supported by commercial 

software. 

 

Rear axle assembly with brake drum and wheel hub, brick mesh 

(Image source: Altair Calendar 2006, Courtesy: Ashok Leyland) 
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The procedure for brick meshing of complicated parts is to first create a shell mesh on 

the surfaces and then convert this to hex elements by using the meshing commands 

extrude, spin, sweep, linear solid, etc. Free face check is very important after the 

completion of hex meshing.  

 

Extrude / Drag 

 

Rotate / Spin  

 



 

273 
 
 
 

Sweep / Line Drag 

 

 

Linear Solid 
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10.4 Tips for Brick Meshing 
Even experienced engineers fear and do not willingly accept the job of brick meshing. No 

book or consultant or university can teach you how to brick mesh. The real teacher is a 

determined approach and hours of sitting in front of the computer, making mistakes, and 

learning from the mistakes.  

1) Proper planning before starting the job: Sufficient time should be spent in studying 

the geometry and meshing should not be started until this is done. How to proceed 

next is visualized in the mesher’s mind. Symmetry, sub symmetry or repetitive 

features are located, and if they exist, this could save you time.  

2) 2-D quad mesh should be systematic (ruled or mapped), avoid 2-D auto mesh: Flow 

lines should be maintained with minimum number of trias and diamond or rotating 

quads should be avoided. Use of the auto mesher on surfaces sometimes results in a 

zig-zag or random mesh which might lead to unexpected problems later.  

3) Do not hurry to convert the shell mesh to brick: One should not convert a 2D mesh 

to a 3D mesh immediately.  Instead, proceed further with the quads and checking for 

any possible problem with the current pattern is recommended.   

4) Start from the most complicated feature and not the simplest one or a corner of the 

part: During exams for effective time management, the basic thumb rule told to 

students is to “Attack the simple problems first and then the complicated one.”   The 

thumb rule for brick meshing is exactly the reverse, i.e. “Attack the complicated 

features first and then the simple ones”.  Beginners make a common mistake to mesh 

the simplest and outer corners of the part first.   

5) Use the linear solid command: Linear solid and morphing are very powerful 

commands for brick meshing and should be utilized.  
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Brick and Tetra Meshing Comparison 

 

• The number of elements and nodes generated by a brick mesh are of the order of 1/2 

to 1/50 in comparison to a tetra mesh. A brick mesh reduces the solution time and 

results in the ease of handling the model on a workstation (pre and post display).  

• Analysis types like crash or nonlinear give preference to brick mesh due to the 

number of nodes and mesh flow lines.  

• The time consumed in brick meshing is more and requires experience, hard work, and 

a lot of patience too. 

• Over the years, the algorithm for tetra meshing has improved and accuracy wise there 

is not much difference in tetra 10 and brick 8 elements. 

10.5 How Not to Mesh 

1) Mid nodes should lie exactly on the geometry 

 

    Not Recommended        Recommended 

vs 
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For a parabolic tetra meshing task, many CAE engineers prefer to start with linear tria 

(instead of parabolic) meshing and then covert it to parabolic. In the conversion process, 

mid nodes might not get projected automatically on the curved surfaces and fillets. If so, 

it should be projected on corresponding surfaces before conversion to tetras.  

2) When the job is split among several engineers, the element length and over all 

mesh pattern should be consistent  

 

The above job was split among 3 engineers due to a very short time duration provided by 

the client. The same mesh size and pattern was not followed by the engineers working 

independently on sub parts of the geometry. 



 

277 
 
 
 

3) Minimum 2 Elements on the Fillets for Tetra Meshing  

Elements at fillets and curved surfaces usually fail in the jacobian/distortion element 

check. The manual adjustment for improving the element quality results in mesh 

deviation from the geometry and visible kinks. This could be avoided by modeling the 

fillets with 2 or more elements.  

 

4) For Brick Meshing, a minimum of 2 elements across the thickness should be used 

A single element leads to a poor interpolation and thus affects the accuracy of the results. 

A minimum of 2 elements across any thickness is recommended. The exception is NVH 

applications, where stress is not the main criteria, but the representation of the mass and 

stiffness (with the least dofs) is the main criteria.  

 

 

 

 

 

 

 



 

278 
 
 
 

5) Use of Tetra / Pyramid Elements While Brick Meshing 

 

Pyramid Tetra 

Some clients allow for a few tetra elements during brick meshing. Also, some software 

and analysis types support pyramid elements. Use of tetra and pyramid elements can 

make the life of a brick mesher tolerable. It’s good practice to clarify the instructions for 

the use of these elements from the client.   

6) Modeling a Ssheet Metal Part with 3D Elements 

For sheet metal or very small thickness parts, 2D shell elements are better suited and 

recommended. It’s not like we cannot use a 3D mesh, but it will result in a very high 

number of nodes and elements.  

Consider the following sheet metal part (200 x 200 x 2 mm). We will mesh the same part 

with 3D parabolic tetra elements and 2D quad-4 (linear) elements using the same 

element length and compare the number of nodes and elements needed.  

         

    3D Tetramesh              2D quad-4 mesh  

  Nodes =1496 Elements = 689                     Nodes = 121 Elements = 100 
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7) Limitation of 1D Element and Advantage of 3D Meshing 

Fillets, cutouts and complicated geometry features cannot be represented accurately by 

1D elements. 

3D elements, because of 3 dimensions, can capture all the minute details accurately. For 

example, consider the following shaft. It is very difficult to capture the key way slot and 

variable fillet using 1D elements. Instead 3D meshing is recommended for such 

applications.  

 

10.6 Creating 3D Elements Using HyperMesh 
HyperMesh can be used to generate a tetra mesh or a brick mesh. Below is an explanation 

on how to perform both types of meshing. 

Tetra Elements 

Tetrahedral (tetra) elements are solid elements which have been extracted from 2D tria 

elements. They have a tetrahedral shape as shown below: 
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HyperMesh builds 4- and 10-noded tetras. Tetra elements can be created through the 

edit element panel, tetra mesh panel, Tetramesh Process Manager template, and shrink 

wrap panel.   

Edit Element Panel 

Tetra elements can be created manually by using the edit element panel. The “Edit 

Element” panel allows you to hand build, combine, split, or modify elements. Tetra 

elements can only be created in the edit element panel through the create subpanel. 

Tetramesh Panel 

Tetra elements can be automatically created using the tetramesh panel. The Tetramesh 

panel allows you to fill an enclosed volume with first or second order tetrahedral 

elements. A region is considered enclosed if it is entirely bounded by a shell mesh (tria 

and/ or quad elements).  

Different sub-panels exist for different types of tetra meshing: 

• tetra mesh allows you to fill an arbitrary volume, defined by its surface using 

tria/quad elements, with tetrahedral elements 

• tetra remesh: regenerates the mesh for a single volume of tetrahedral 

elements 
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• CFD mesh allows you to automatically generate meshes with boundary layer 

type elements (pyramids and hexas) from selected boundary 

regions/elements, and fill the remaining core volume with tetrahedral 

elements 

• volume tetra given a solid entity or a set of surfaces representing a closed 

volume, this meshing option generates a shell mesh and fills the enclosed 

volume with solid elements 

Shrink Wrap Panel 

Within the shrink wrap panel there is an option to generate solid mesh – this will produce 

an all-hexa or all-tetra mesh based on the selected elements or geometry. The shrink 

wrap can thus be used as a quick mechanism to generate solid meshes. Note that when 

generating such a mesh, the Jacobian value has a large effect on the coarseness of the 

resulting volume mesh. For additional information, please refer to the online help. 

Hexa And Penta Elements 

Hexahedral (hexa or brick) elements are solid elements which have been extracted from 

2D quad elements. Pentahedral (penta) elements are solid elements which have been 

extracted from 2D tria elements. Their shapes are shown below: 

 

      Hexa      Penta 

HyperMesh builds 6- and 15-noded pentas and 8- and 20-noded hexa elements. Pentas 

and hexas can be built in any of the following panels: 
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• drag: Drags a group of two-dimensional elements along a vector to create 

solids. 

• edit element builds elements by hand 

• line drag: Drags a group of two-dimensional elements along a line 

• linear solid: creates solid elements between two-dimensional elements 

• solid map:  builds solid elements between nodes, lines and surfaces 

• solid mesh: builds solid elements between a variable number of lines 

• elem offset creates solid elements by offsetting a group of two-dimensional 

elements normal to the surface formed by the group of two-dimensional 

elements 

• spin: spins a group of two-dimensional elements about a vector to create solid 

elements 

• split propagates split hexas 

As stated above, pentas and hexas can be created in the solid map panel. Below is a 

detailed description of this panel. 

Solid Map Meshing 

In the Solid Map panel, solid elements are created. These solid elements can be created 

from solid geometry as well as from nodes, lines, and surfaces. Below is a short 

description on mappability. For a detailed explanation on how to split a solid geometry 

for solid meshing, please refer to the online help topic Partitioning Solids for Mappability. 

In solid meshing, the ability to be meshed is referred to as mappability. Mappability is 

directional and can be likened to putting a surface mesh on one face of the solid, then 

extending that mesh along a vector through the solid volume. So, for example, a perfect 
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cylinder is mappable in one direction (the axis between its top and bottom faces) while a 

perfect cube is mappable in three (the axes between each pair of its identical faces). 

However, a combustion engine’s cylinder head consisting of two cylinders of different 

radius joined together into a single solid entity would need to be partitioned to divide the 

two cylinders. Once partitioned, each cylinder would become mappable in one direction. 

Below is an example which shows a volume which is mappable in one direction: 

 

While this example shows two faces that are of the same shape and directly oppose each 

other, that is not a requirement. The source and destination can be of drastically different 

shape and contour and need not lie directly opposite each other. 

Any given volume can have one of four states, which are color-coded when using the 

mappable view option on the visualization toolbar. Although the colors can be 

customized, the default settings are: 

• Blue indicates a solid that has not been edited at all and therefore isn’t 

evaluated for mappability. 

• Orange indicates a solid that has been edited but remains completely 

unmappable (further partitioning may enable mapping). 

• Yellow indicates a solid that is mappable in 1 direction. 
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• Green indicates a solid that is mappable in three directions (this is very rare). 

 

In the images above, the first cube is mappable in 3 directions. The second image shows 

that if a corner is split off, it becomes mappable in only 1 direction and the corner is not 

mappable without further partitioning. 

The “Solid Map” panel is used for solid-map meshing, and this panel includes several sub-

panels. The general, line drag, linear solid, and ends only sub-panels all draw from the 

same set of input controls (the more specialized panels simply filter out the controls that 

do not apply to their mapping techniques). Note that all of these sub-panels depend on 

an existing 2D mesh, which is then extrapolated into a 3D mesh based on the parameters 

you input. The one volume and multi solids sub-panels, however, can automatically 

create 3D mesh directly on solids as long as the solids you select are already mappable. 

Solid Map Panel 

• general: Use the general sub-panel to access all of the possible entry controls 

for maximum flexibility. 

• line drag: Use the line drag sub-panel to select a 2D mesh, and then select a 

line from the model geometry to use as the mapping direction. 

• linear solid: Use the linear solid sub-panel to select two existing 2D meshes 

and extrapolate a 3D mesh that connects them. 
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• ends only: Use the ends only sub-panel to select two opposing surfaces and 

one 2D mesh, then extrapolate the mesh between the surfaces. 

• one volume: Use the one volume sub-panel to select a single mappable solid 

volume and create a new 3D mesh for it. 

• multi solids: Use the multi solids sub-panel to select multiple mappable solids 

and create 3D meshes for them. 

10.7 Tutorials and Videos 

Recommended Tutorials 

The tutorials listed below are included in the HyperWorks installation. 

• HM-3200: Tetrameshing  

• HM-3210: Creating a Hex-Penta Mesh using Surfaces 

• HM-3220: Creating a Hexahedral Mesh using the Solid Map Function 

Additional tutorials about tetrahedral and hexahedral meshing are also included in the 

Academic Learning Library In the category Tetrameshing we posted tutorials about 

tetrameshing of a steering wheel; working with tetra-elements, and local fixing/ editing 

of tetras. 

With respect to hexameshing you will be challenged to hexamesh a steering wheel (gives 

you also an idea about the additional time it takes compared to tetrameshing the same 

part), and various meshing projects ranging from simple to moderate complicated 

provided by our team from India. 

 

 

http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm3200.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm3210.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm3220.htm
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Recommended Videos  

• Symmetrical Mesh Edit  

 

 

 

• Gear solid mesh 

 

 

 

 

 

 

 

 

 

 

 

(http://altair-

2.wistia.com/medias/6r7jc6k231) 

 

 

(http://altair-

2.wistia.com/medias/dbzc76mguv) 

 

• Symmetrical meshing  

 

(http://altair-

2.wistia.com/medias/u2lmb0ixfu) 

 

• Gear shell mesh  

 

 

(http://altair-

2.wistia.com/medias/r81811rb7u) 

 

https://altair-2.wistia.com/medias/6r7jc6k231?wvideo=6r7jc6k231
https://altair-2.wistia.com/medias/u2lmb0ixfu?wvideo=u2lmb0ixfu
http://altair-2.wistia.com/medias/6r7jc6k231
http://altair-2.wistia.com/medias/6r7jc6k231
https://altair-2.wistia.com/medias/dbzc76mguv?wvideo=dbzc76mguv
http://altair-2.wistia.com/medias/dbzc76mguv
http://altair-2.wistia.com/medias/dbzc76mguv
http://altair-2.wistia.com/medias/u2lmb0ixfu
http://altair-2.wistia.com/medias/u2lmb0ixfu
https://altair-2.wistia.com/medias/r81811rb7u?wvideo=r81811rb7u
http://altair-2.wistia.com/medias/r81811rb7u
http://altair-2.wistia.com/medias/r81811rb7u
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• Transition shell 

 

 

 

• Hexa transition  

 
 

 

 

• Tips and Tricks for Tetrameshing with 

HyperMesh  

 

 

(http://altair-

2.wistia.com/medias/ideze69n5m) 

 

• Transition solid  

 

(http://altair-

2.wistia.com/medias/jkm1ht915e) 

(http://altair-

2.wistia.com/medias/vaclbgnmen) 

 

 

• Tetrameshing 

(http://altair-

2.wistia.com/medias/fk0y05vnm5) 

 

(https://altair-

2.wistia.com/medias/elexrsc3t0) 

 

https://altair-2.wistia.com/medias/ideze69n5m?wvideo=ideze69n5m
https://altair-2.wistia.com/medias/vaclbgnmen?wvideo=vaclbgnmen
http://altair-2.wistia.com/medias/ideze69n5m
http://altair-2.wistia.com/medias/ideze69n5m
https://altair-2.wistia.com/medias/jkm1ht915e?wvideo=jkm1ht915e
http://altair-2.wistia.com/medias/jkm1ht915e
http://altair-2.wistia.com/medias/jkm1ht915e
http://altair-2.wistia.com/medias/vaclbgnmen
http://altair-2.wistia.com/medias/vaclbgnmen
https://altair-2.wistia.com/medias/fk0y05vnm5?wvideo=fk0y05vnm5
http://altair-2.wistia.com/medias/fk0y05vnm5
http://altair-2.wistia.com/medias/fk0y05vnm5
https://altair-2.wistia.com/medias/elexrsc3t0
https://altair-2.wistia.com/medias/elexrsc3t0
https://altair-2.wistia.com/medias/elexrsc3t0?wvideo=elexrsc3t0
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11 Element Quality and Checks 

This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 

Infinite)”. It also has been reviewed and has additional material added by Gareth Lee. 

11.1 Compatibility and Mechanisms 
Modeling with a variety of element types provides many opportunities to introduce 

numerical incompatibilities and mechanisms in your structural model. Incompatibilities 

arise when the element degrees of freedom do not match at a common node, or element 

faces of solids are mismatched. Mechanisms occur due to some forms of incompatibility 

or incomplete connectivity. Rigid elements which can model and/or cause a number of 

interesting problems will be discussed in another section. 

Spring Elements 

Spring elements are not really elements. The spring is a method of directly coupling two 

degrees of freedom with a stiffness value or to connect a single DOF to ground through a 

stiffness. If the DOFs connected are not aligned in the global coordinate system, a 

mechanism will occur. This mechanism will not cause a singularity but will cause the 

introduction of a mysterious “torque from nowhere”. The following figure depicts aligned 

and misaligned springs. 
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Spring “Element” Alignment 

Shells to Solids 

The connection of shells to solids is useful in the transition from a compact solid structure 

to a more shell-like structure. Unfortunately, solids do not support moments applied to 

nodes and thus more innovative methods are required to connect shells to solids. 

Running the model with irregular geometry will cause the mesh to lock up and the hinges 

to be hidden, resulting in answers which appear to be reasonable. 

One accurate method of connecting shells to solids is depicted below. This method 

requires refinement in the solid mesh near the connection to the shell. Also note that 

local coordinate frames would be required if the normal direction does not line up with 

the basic coordinate frame. 

Aligned for 2 direction 

connection 

Misaligned for 2 

direction connection 

(M = L × F unbalanced) 
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Beams to Solids 

Beam to solid connections can be handled in a similar manner as shell-to-solid 

connections. The moments will need to be coupled in at least two directions rather than 

in only the out-of-plane bending as in the shell-to-solid case. 

Beams Normal to Shells 

Beams connect well to shells except in the drilling direction. This connection can be made 

by the addition of crank arms to the end of the beam as show below. 

Nodes 4 and 12 are tied in the one direcrion only. 

Nodes 8 and 12 are tied in the one direction only. 

Node 4 and 12, 6 and 8 and 9 are actually coincident but have been 

displaced in this illustration to show their relationship 
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Beam to Shells 

Beam to Shell Edge 

An incompatibility exists when connecting beams to shells in the plane of the shell as 

shown below. 

 

Beam to Shell Edge 
Shell in-plane edge 

deflection allowed 

Possible Beam Edge 

Deflection 
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11.2 General Element Quality Checks 
Element quality is a subject often talked about and never fully understood. The reason 

for this is complex but is related to the fact that quality is relative and the solution, by 

definition, is approximate. In the formulation of finite elements, a local parametric 

coordinate system is assumed for each element type and how well the physical 

coordinate systems, both element and global, match the parametric dictates element 

quality. Below you see some graphics representing element quality and you should 

attempt to follow them, however, there will be a point of diminishing return if you try 

too hard to get every element within the acceptance criteria. Your judgment is your only 

guide in those cases. Always perform quality checks on the meshes you create. Check 

with “local experts” regarding the appropriate values for each element type required by 

your element checking computer programs. Be aware that, in these situations, “correct” 

answers can vary a great deal as illustrated in the following table where the range 

between “OK” and “very poor” is quite wide. 

Solid elements use the determinant of the Jacobian Matrix and compare to the ideal 

value. 
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Some common element quality measures are detailed below: 

 

Skewness 

Skew in trias is calculated by finding the minimum angle between the vector from each 

node to the opposing mid-side and the vector between the two adjacent mid-sides at 

each node of the element. Ninety degrees minus the minimum angle found is reported.   

 

                   Triangle skew = 90 - a   
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Skew in quads is calculated by finding the minimum angle between two lines joining 

opposite mid-sides of the element. Ninety degrees minus the minimum angle found is 

reported. 

 

      Square skew = 90 - a 

The skew check is performed in the same fashion on all faces of three-dimensional 

elements.  

Aspect Ratio 

Aspect ratio in two-dimensional elements is calculated by dividing the maximum length 

side of an element by the minimum length side of the element. The aspect ratio check is 

performed in the same fashion on all faces of three-dimensional elements. 

Warpage 

Warpage in two-dimensional elements is calculated by splitting a quad into two trias and 

finding the angle between the two planes which the trias form. The quad is then split 

again, this time using the opposite corners and forming the second set of trias. The angle 

between the two planes which the trias form is then found. The maximum angle found 

between the planes is the warpage of the element. Warpage in three-dimensional 

elements is performed in the same fashion on all faces of the element. 

Jacobian  

The Jacobian ratio is a measure of the deviation of a given element from an ideally shaped 

element. The Jacobian value ranges from -1.0 to 1.0, where 1.0 represents a perfectly 
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shaped element. The ideal shape for an element depends on the element type. The check 

is performed by mapping an ideal element in parametric coordinates onto the actual 

element defined in global coordinates. For example, the coordinates of the corners of an 

ideal quad element in parametric coordinates are (-1,-1), (1,-1), (1,1), and (-1,1).   

The determinant of the Jacobian relates the local stretching of the parametric space 

required to fit it onto global coordinate space. HyperMesh evaluates the determinant of 

the Jacobian matrix at each of the element’s integration points (also called Gauss points) 

and reports the ratio between the smallest and the largest. 

Different solver codes use different patterns of integration points, and the same solver 

may use different patterns for different formulations of the same element configuration. 

One method is as follows: 

quad4     (2x2 points)  

tria3     (1 point)  

tetra4     (1 point) 

quad8     (2x2 points)  

tria6    (4 point)  

tetra10    (4 point) 

penta6     (3x2 points)  

hexa8     (2x2x2 points)   

penta15    (3x2 points)  

hexa20     (2x2x2 points) 

   

If the local stretching is the same at all of its Gauss points, then the Jacobian value equals 

1.0. As the element becomes more distorted, the Jacobian value approaches zero. A 

Jacobian value of less than zero represents a concave element, which most analysis codes 

do not allow.   
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Both first and second order solid and plate elements are included in this check; however, 

first order tria and tetra elements always have a Jacobian value of 1.0. 

11.3 2D Quality Checks 

Ideal shape for quad elements – Square    

Ideal shape for triangular elements – Equilateral triangle   

Different quality parameters like skew, aspect ratio, included angles, jacobian, stretch, 

etc. are the measures of how far a given element deviates from the ideal shape. A square 

means that all of the angles are 900 with equal sides, while an equilateral triangle has all 

angles at 600 with equal sides. Some of the quality checks are based on angles (like skew 

and included angles), while others on side ratios and area (like aspect and stretch).  

To reduce the solution time, elements are mapped to a local coordinate system 

(individual for every element at the centroid), instead of using a single coordinate system 

(global). The effectiveness of this transformation is checked by the jacobian and 

distortion. Ideally all the nodes of a quad element should lie in the same plane, but 

because of curvatures and complicated geometry profiles, that is not possible. The 

measure of the out of plane angle is the warp angle.  

The following are the general definitions of various quality checks. Though the names 

sound the same, the exact definitions may differ from software to software.  

Warp Angle: warp angle is the out of plane angle  

  Ideal value = 00 (Acceptable < 100).  

  Warp angle is not applicable for triangular elements.   

 It is defined as the angle between the normals to two planes formed by splitting the quad 

element along the diagonals.  The maximum angle of the two possible angles is reported 

as the warp angle.  
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Aspect: maximum element edge length / minimum element edge length 

 Ideal value = 1 (Acceptable < 5).  

 

 

Skew 

  Ideal value = 0 (Acceptable < 450) 

  Skew for quadrilateral element = 900 minus the minimum angle between the two 

lines joining the opposite mid-sides of  the element (α).   

 
α 

α 
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Skew for triangular element = 900 minus the minimum angle between the lines from each 

node to the opposing mid-side and between the two adjacent mid-sides at each node of 

the element 

Jacobian 

  Ideal value = 1.0 (Acceptable > 0.6) 

 In simple terms, the jacobian is a scale factor arising because of the transformation of 

the coordinate system. Elements are transformed from the global coordinates to local 

coordinates (defined at the centroid of every element), for faster analysis times. 

Distortion 

  Ideal value = 1.0 (Acceptable > 0.6) 

  Distortion is defined as -  | Jacobian | * AreaLCS / AreaGCS 

  LCS – Local Coordinate system 

  GCS – Global Coordinate system 

Stretch 

  Ideal value: 1.0 (Acceptable > 0.2) 

  For quadrilateral elements stretch = Lmin * √ 2 / dmax 

 

  Stretch for triangular element = R * √ 12 / Lmax 

  

L max 

R 
L min 

d max 
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Included Angles 

 Skew is based on the overall shape of the element and it does not take into account the 

individual angles of a quadrilateral or triangular element. Included or interior angle check 

is applied for individual angles. 

  Quad Ideal value = 900. (acceptable = 450 < θ <1350) 

  Tria: Ideal value = 600 (acceptable = 200 < θ < 1200) 

Taper 

  Ideal value = 0  (acceptable  < 0.5) 

  Taper = ∑ | (Ai – Aavg) / Aavg | 

   Aavg =(A1 + A2 + A3 + A4) / 4 

  

Minimum Element Length  

This is a very important check for crash analysis (time step calculations). It is also applied 

in general to check for the minimum feature length captured and the presence of any 

zero-length element.   

Chord Deviation 

This helps in determining how well curvatures have been modeled. It is defined as the 

distance between the mid node of an element edge to the curved surface. It is only 

applicable for linear elements.  

  

A4 

A3 

A1 
A2 



 

300 
 
 
 

How to Improve the Quality of Poor Elements? 

1) Manual adjustment: This is done by translating the nodes manually or remeshing in 

the poor mesh region. This method consumes lot of time and was the only technique 

available for years.   

2) Drag node: The user has to drag the nodes of the failing elements. It works faster and 

the advantage is that it instantaneously shows the effect of dragging the node on all 

the attached elements.   

3) Auto quality improvement programs: This is the latest option for quality improvement. 

The user has to submit the mesh for quality improvement and a software program 

runs in the background to improve the elements quality automatically.   

There is a word of caution for the use of auto mesh improvement programs. For warpage 

improvement of 2D meshing and Jacobian/distortion improvement of 10 noded tetra 

meshes, sometimes the software moves the nodes off of the geometry by a considerable 

amount. This could cause visible kinks and distortion of the geometry. 

Apart from the above standard checks, the mesh model should also be subjected to 

following the additional checks.  
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11.4 Other Checks for 2D Meshing 

1) Element Free Edges - What is a free edge? 

Any single quad element has 4 free edges.  

Two elements   

In the case above, the middle edge is shared and is no longer a free edge. For a real-life 

FE model, free edges should match with the geometry outer edges / free edges. Any 

additional free edges are an indication of unconnected nodes.  

 

2) Duplicate Element 

Mistakes during operations like reflect or translate can result in duplicate elements. These 

duplicate elements do not cause any error during the analysis but increase the stiffness 

of the model and results in smaller displacements and stresses. For example, consider a 

White line indicates free  
edge and unconnected  
nodes. 
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simple plate (thickness = 2 mm) subjected to a tensile load. Assume that due to some 

meshing operation all the elements are duplicated. If the analysis is carried out, then it 

will show half the stress and displacement. 

3) Duplicate Node 

Operations like copy, translate, orient, or reflect can result in duplicate nodes at a 

common edge. 

 

In the above image there are duplicate nodes at the interface where the mesh was 

reflected. The duplicate nodes are highlighted in yellow.   

4) Shell Normal 

Consider the following example.  

 

After deformation, the top surface of the cantilever beam is under tension and the 

bottom is under compression.  
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For 2D meshing, a mid surface is extracted, and an analysis is carried out on the mid 

surface mesh. Now the question is, whether the result plot (as shown below) corresponds 

to the mid surface, the top surface, or the bottom surface?  

 

The shell element normal helps us in viewing the top or bottom side stresses. Every 

element has an elemental (or local) coordinate system. The shell normal is the direction 

of the element normal (common practice is to represent the normal using the Z axis, 

assuming the element is oriented in the xy plane). For viewing stress, commercial post 

processors provide options known as top / bottom or Z1/Z2 indicating the positive and 

negative direction of the shell normal. The top or bottom is not decided by how the FE 

model is oriented on the screen but as per the + Z axis orientation of the elements. The Z 

axis could be displayed on the screen by turning the element triad switch or shell normal 

vector display option on. 

Top side (or Z1) = + Z axis (along the 

direction of arrow as shown in figure 

below) Bottom side (or Z2) =  - Z axis   
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What Would Happen If the Shell Normals are Not Aligned Properly?  

From an analysis process point of view, there is no error. All of the calculations will be 

carried out properly. But at the time of post processing when viewing the results for 2D 

elements, the software does not understand tension or compression. What it recognizes 

is the shell normal orientation. It can show either the stresses along the + Z axis or –Z 

axis. Suppose in the above figure, one of the element’s shell normal is in the opposite 

direction. While viewing the results on the bottom side (Z2) all the elements (except the 

reverse shell normal orientation) show tensile (+) stresses and the odd element shows 

compressive (–) stresses, as shown in the following figure. The beginner would interpret 

from the following result that something is wrong with the boundary conditions, but an 

experienced engineer knows that this is due to an inconsistent shell normal.  

 

How do you correct the shell normal’s alignment? The FEA software provides special 

commands for consistent shell normals (all shell normals aligned in one direction).  

4) Geometry Deviation 

After the completion of meshing the geometry, the mesh and the geometry should be 

viewed together (mesh line option off). The mesh should not deviate from the geometry.  

5) Delete Free / Temporary Nodes  

Free nodes, if not deleted, result in rigid body motion. When the auto singularity option 

is turned on, the software uses a spring element with a very small stiffness to connect 

the free nodes with the parent structure. This results in a warning message during the 

analysis.  
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6) Renumber Nodes, Elements, Properties Etc Before Export Operation 

Frequent import /export operations could lead to a very large number for the nodes and 

element IDs. Some software refuses to read the file if the node/element IDs are greater 

than a specific limit. This could be avoided by renumbering the nodes, elements etc.  

7) Observe Type, Family and Number of Elements (Element Summary for Complete 

Model) 

The mesh should be checked carefully prior to the export operation, as well as after 

importing it in the external solver for element type, family, numbers, etc. Sometimes due 

to a translator problem, if properties are not defined properly, or for non supportive 

elements, either the elements are not exported at all or the family is changed (like 

membrane elements converted to thin shell, etc.). Plot, trace lines, element free edges, 

and free faces, if any, should be deleted.   

8) Check Mass (actual mass vs FE model mass) 

When a prototype or physical model of the component is available, the FE model mass 

should be compared with the actual mass. A difference means that there are missing or 

additional components, or improper material or physical properties.    

9) Free-Free Run or Dummy Linear Static Analysis 

Before delivering the final mesh to the client, a free–free run should be performed. 6 rigid 

modes indicate that all the parts in the assembly are properly connected to each other. 

In the case of a single component meshing job, a linear static analysis with dummy 

boundary conditions should be carried out.  

10) Request Your Colleague to Check the Model 

Due to continually working on the same project, our mind tends to take some of the 

things for granted and there is a possibility of missing some of the points. It is a good 

practice to get it cross checked by your colleague prior to final delivery. 
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11.5 Quality Checks for Tetra Meshes 

The ideal shape for a tetrahedron element is an equilateral tetrahedron (all equilateral 

triangle faces). Various quality parameters check how far a given element deviates from 

the ideal shape.  

Tetra Collapse 

  Ideal Value = 1.0 (Acceptable > 0.1)   Tetra collapse = (min of h /√ A) / 1.24 

  (The height of the tetra element is measured from each of the four nodes to its 

opposite face, and then divided by the square root of the face’s area, the minimum of 

the four resulting values (one per node) is then normalized by dividing it by 1.24.) 

 

Volumetric Skew 

  Create a sphere passing through the corner nodes of the tetra, fit an ideal 

(equilateral) tetra in it. Find the volume of the  ideal and actual tetra elements. 

  Ideal value = 0 (Acceptable < 0.7) 

  Volumetric Skew = (Videal - Vactual) / Videal 
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Stretch 

  Ideal value = 1.0 (Acceptable > 0.2) 

  Stretch = R * √24 / Lmax  

  R = Radius of largest possible sphere inside given tetra element.   

 

 

Distortion 

  Ideal value = 1.0 (Acceptable > 0.5) 

  Distortion  =  | J | * Volm
LCS / Volm

GCS    

             LCS – Local Coordinate System 

  GCS – Global Coordinate System 

Jacobian 

  Ideal value = 1.0 (Acceptable > 0.5) 

 In simple terms, the Jacobian is a scale factor arising because of the transformation of 

the coordinate system. Elements are transformed from global coordinates to local 

coordinates to reduce the solution time.  

11.6 Other Checks for Tetra Meshes 

1) Quality checks for 2D tria elements: Before converting trias to tetras, all the quality 

checks as discussed for shell elements should be applied.  

2) Free edges: Conversion from tria to tetra is possible only when there are no free edges. 

No free edges indicate the mesh is enclosing a volume.   
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3) T-connections: The mesh model should not contain any T-connection.  

                    

                                 Geometry              

 

No T-connection (correct mesh) 

4) Consistent Shell normals: Before converting trias to tetras, the shell normals should be 

corrected. Some software does not allow shell to solid conversion unless the normals 

of all the elements are properly aligned.   

5) Geometry deviation: After the completion of meshing, the geometry as well as the 

mesh should be viewed together (mesh line     option off). The mesh should not deviate 

from the geometry. In the process of quality improvement (in particular for distortion/     

Jacobian on curved surfaces or fillets), sometimes nodes get translated too far away 

from the geometry and is not acceptable.  

T-connection, not acceptable Green 

elements should not be there in model 
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6) 2D tria elements should be deleted before the final submission: It’s a common mistake 

to export 2D shell elements along with      tetra mesh in the final delivery.  

How to Improve Quality of Tetra Mesh 

Software provides auto algorithms/localized remeshing options for improving the mesh 

quality. These programs improve most of the elements, but some might stay the same. 

For such elements, the quality improvement is carried out using the manual translation 

of nodes. Unlike 2D shell elements, ‘dragging the nodes is not an available option for 3-D 

elements.   

Linear vs Parabolic Tetra Elements 

Linear tetra elements are not recommended for structural analysis. They are very stiff 

and inaccurate compared to parabolic elements.  

If Linear Tetra Elements Are Not Recommended for Structural Analysis, Then Why Is 

This an Option Provided Within Commercial FEA Software?  

1) For the structural analysis of very big assemblies, to reduce the overall dofs, 

components away from critical areas are meshed with linear tetras.  

2) For thermal analysis, a linear tetra is convenient as temperature only has 1 variable 

(1 dof unlike 3 for structural).  The use of tetra 10 elements would unnecessarily 

increase dofs. 

3) CFD calculations are mostly based on linear elements. 

4) Mold flow analysis   
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11.7 Brick Mesh Quality Checks 
The ideal shape for a brick element is a cube. Various quality criteria check how far a given 

element deviates from the ideal shape.  

Warp Angle 

  Ideal value = 0 (Acceptable <300) 

 Warp angle is calculated on faces (quadrilateral) of a hex element. It is the angle between 

the planes that form by splitting   the quad element.  

Jacobian 

  Ideal value = 1.0 (Acceptable > 0.5) 

 In simple language, the Jacobian is a scale factor arising because of the transformation 

of the coordinate system.  Elements are transformed from global to local coordinates to 

reduce the solution time.  

Distortion 

  Ideal value = 1.0 (Acceptable > 0.5) 

  Distortion = |J | * Volm
LCS / Volm

GCS         

  LCS – Local Coordinate System 

  GCS – Global Coordinate System 

Stretch 

  Ideal value = 1.0 (Acceptable > 0.20);  Stretch = min. edge length * √ 3 / max. diagonal 

length 
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Aspect Ratio 

  Ideal value =1.0  (Acceptable < 5);  Aspect ratio = max. edge length / minimum edge 

length. 

Skew 

  Ideal value = 00 (Acceptable < 450) 

  Skew is checked on all the faces of a hex element (quadrilateral). For the skew 

definition, please refer to the shell element checks.  

  Quad face included angles: 450 < θ < 1350 

  Tria face (wedge / penta elements) included angles: 200 < θ < 1200 

  % of Pentas: Acceptable < 5 % 

11.8 Other Checks for Brick Meshes 

Free Faces 

A free face check is the most important check for brick meshing. A single brick element 

has 6 free faces. Free faces of the mesh should match with the outer surfaces (skin) of 

the solid part. Any extra (inside) faces indicate that either nodes are not connected 

properly or there are mismatching elements. 

                      

       Brick mesh      Free faces  
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Converting Free Faces to Tetras  

For complicated geometries, checking the internal free faces could consume lot of time. 

A quick shortcut is to convert the free faces to a tetra mesh. Successful conversion 

indicates that the brick mesh is OK and there are no internal faces.  

 

Hidden Line or Dynamic Viewing Option   

 

       Line mode      Hidden line mode  
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By displaying the brick mesh model in the hidden line or fast dynamic viewing mode, one 

can immediately recognize node / element connectivity problems if there are any.  

Apart from the above listed checks, other checks (like duplicate elements, duplicate 

nodes, deleting temporary or free nodes) as discussed earlier, should also be applied.  

11.9 Mesh Check Tools in HyperMesh 
HyperMesh supplies many tools for checking the quality of your elements. These tools 

are located on the 2D page (for checking two dimensional elements), Tool page, and in 

the Utility Menu on the QA/Model page.   

Quality Index Panel 

The quality index panel is located on the 2D page and can be accessed by selecting Mesh 

> Check > Elements > Quality Index. This panel is used to calculate a single value to 

represent the quality of the displayed two-dimensional (shell) elements.  The criteria for 

the element quality are stored and retrieved using a criteria file. The results from the 

quality index panel can also be saved to a summary file. 

To calculate the quality index, twelve different criteria are used, each with a user-defined 

weight factor. The twelve different criteria are listed below with their corresponding ideal 

and worst values. 

 

 

 

 



 

314 
 
 
 

Feature Ideal Worst 

min. size Average element 

size 

0.0 

max. length Average element 

size 

infinity 

aspect ratio 1.0 infinity 

warpage 0.0 90 

skew 0 90 

Jacobian 1 -1 

max. angle quad 90 180 

min. angle quad 90 0 

max. angle tria 60 180 

min. angle tria 60 0 

chordal 

deviation 

0 infinity 

% of trias user-defined user-

defined 

 

Each criterion has five rating levels. Each element is assigned a penalty value according to 

its rating for individual criteria. Elements failing a criterion are assigned a penalty of 1.0 

to 10.0 as a linear function of how far the element is from satisfying the criterion. 

Elements passing a criterion have a penalty value of 0.0 to 1.0 for that criterion. The 

quality index (Q.I.) is a function of individual criteria penalty values. Below is a list of the 

five levels with a short description. Please refer to the online help for a complete 

description. 
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Ideal: This is the absolute best/ideal value that an element can achieve. Elements that fall 

in this level are drawn in black by default (not highlighted).  Ideal elements have no 

penalty assigned to them. 

Good: This level is slightly worse than ideal but is still considered good for the required 

analysis. Elements that fall in this level (between good and warn) are drawn in black by 

default (not highlighted). 

Warn: This is an intermediate level between good and fail.  This level is used to highlight 

the elements that have not failed the criteria but are close to it. The elements that are in 

this level (that is, falling between warn and fail) are drawn in cyan by default.  

Fail: This level determines the elements that are considered to be unacceptable for 

analysis, thus failed.  It is recommended that you fix these elements before performing 

the analysis. The elements that have failed (between fail and worst) are drawn in          

yellow by default. 

Worst: This level allows you to highlight elements that failed the criteria by a large margin, 

and which require immediate attention.  

         The elements that fall in and beyond this worst level are drawn in red 

Main Panel Controls 

Below is a listing of the controls that are available on the quality index panel. These 

controls are located on the right-hand side of the panel and include a set of buttons used 

to optimize the elements for quality check purposes. 

display thresholds: This combination of a slider and buttons (one button for each quality 

level) allows you to visually identify all of the elements at or below a certain quality level.  

For example, setting the slider to “warn” causes HyperMesh to highlight all elements in 

the model whose assessed quality level is “warn” or worse—in other words, elements at 

the “warn”, “fail”, and “worse” quality levels. 
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place node: While this button is highlighted, click-and-drag a node to interactively 

reposition it to improve the quality of its attached elements.  The nodes only move on 

the inferred surface and cannot be moved beyond its edges. 

swap edge: Change the element connectivity between adjoining elements to improve 

their quality. When you pick on an element edge, the connectivity of the two elements 

that share this edge is altered (see image below). 

 

node optimize:  Click node optimize and select a node on the screen. HyperMesh 

repositions the node on the inferred surface to obtain the best possible quality for all 

elements attached to that node. 

element optimize: Click element optimize and select an element on the screen. The 

locations of all its nodes move on the inferred surface to obtain the best possible quality 

for that element and its neighbors. 

Element Cleanup Panel 

The “elem cleanup” panel is also on the 2D page and can be accessed by selecting Mesh 

> Cleanup Elements > Element Cleanup from the menu bar. It is used to perform 

automatic cleanup of two-dimensional elements based on the element quality criteria 

that is set in the quality index panel. You can also specify the element quality criteria by 

selecting a criteria file. Once the elements have been selected there is an option to use 

surrounding elements. This option allows HyperMesh to expand your selection to include 

additional elements, which provides HyperMesh more freedom to reduce localized 
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distortions. There are also many additional options in this panel for cleaning up the 

elements. The various options as well as a short description are listed below: 

fix folded elements, angle >: Sometimes mesh can get “folded” in such a way that multiple 

elements occupy nearly the same space.  Use this option to combine such elements and 

simplify the mesh, based on the angle between them.  This option requires that an angle 

be entered.  180 degrees indicates that two elements occupy the same space, so the 

angle should be close to but less than 180. By default, this value is set to 150. reduce tria 

elements: This option attempts to combine tria elements into quad elements wherever 

possible. 

keep surf edges: This is a selection under the reduce tria elems option.  This setting is 

used to preserve clean, straight feature lines which were defined from model geometry. 

QI smooth elems with target =: When this option is active, HyperMesh attempts to 

smooth the selected elements until they reach the composite Quality Index value that 

you specify in this text box. 

fix elems failing QI check: This option limits other options by examining whether or not 

the resulting elements would fail your QI criteria. For example, using tria reduction with 

this option activated might result in fewer trias being removed, but better overall mesh 

quality. 

feature angle <: On feature lines with greater angles than this, element cleanup of nodes 

on the feature lines will only move long the lines. Nodes on feature lines below this angle 

threshold can be moved in any direction, which may cause jagged features. 

Check Elements Panel 

The “check elems” panel is located on the Tool page or by selecting Mesh > Check > 

Elements > Check Elements from the menu bar. This panel is used to verify the basic 

quality of your elements. There are subpanels for 1D element, 2D element and 3D 
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element checks with the appropriate element quality checks on each subpanel. This panel 

allows for each element quality check to be performed individually.    

 

For example, on the 2D subpanel, the check for the Jacobian can be performed. This is 

done by entering the desired Jacobian value to be checked and then clicking on the green 

Jacobian button. This then highlights all the elements displayed in the model which have 

a Jacobian value of less than the value specified.  

 

In addition to the element checks on the 1D, 2D, and 3D subpanels, there are also the 

following functions:  

connectivity: This option tests the connectivity of a group of elements  

duplicates: This function checks for duplicate elements 

settings: This opens the Check Element Settings window. This window allows the user to 

determine which version of the element check to use. Each check can be set to use a 

different solver’s check method, or the user can set everything to the same method. 
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save failed: This saves the elements which fail the element check and places them on the 

user mark. These elements can then be retrieved in a different panel. standard, assign 

plot, histogram: This switch is used to determine which view mode should be used. Util 

 

                      standard                        assign                                         histogram 

In addition to the 1D, 2D, and 3D subpanels, there are three additional subpanels 

available: 

time: The time subpanel calculates element time steps and checks for steps that fall below 

a specified value.  To use this function, you much have the template function, 

HM_CALC_TIMESTEP defined in the current template. 
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user: This subpanel allows you to specify a template file that checks for any type of user-

defined qualify group: Using this subpanel you can delete interface elements that are not 

attached to a normal element 

Utility Menu - QA/Model Page 

The QA Utility Menu contains many tools to help you quickly review and clean up the 

quality of a pre-existing mesh. Under QA Tools, there are multiple macros to check the 

element quality of the mode. The element quality criteria used by these tools comes 

directly from the values entered on the check elements panel. There are eight tools to 

isolate elements that fail certain element check criteria: Length, Jacob, Warp, Aspect, 

Max ang: Q, Min ang: Q, Max ang: T, and Min ang: T. Each of these tools checks all the 

displayed elements for the selected criteria and highlights those elements which fail.  

Another tool available is the Quality Report macro. This macro launches a user interface 

that allows the user to set the various quality values and check the quality of all the 2D 

elements in the model.  

The results are shown as the number of elements and percentage of elements failing each 

criterion.   
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11.10 Mesh Check Tools Tutorials and Videos 

Recommended Tutorials 

The following tutorials are part of the HyperWorks installation: 

• HM-3300: Checking and Editing Mesh 

• HM-3320: Penetration 

Recommended Videos  

You need to be online to view the following videos 

• Quality Index  

 

 

• element edges  

 

 

(https://altairuniversity.com/learning-

library/quality-index/ ) 

 

(http://altair-

2.wistia.com/medias/4im0absvzu) 

• Mesh checking editing 

 
 

 

• Element Checks and Mesh Styles 

 

(http://altair-

2.wistia.com/medias/ftu42udf77) 

 

 

 

 

 

 

 

(https://altairuniversity.com/learning-library/hypermesh-
element-quality-check-and-mesh-styles/ ) 

 

http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm3300.htm
https://altairuniversity.com/learning-library/quality-index/
https://altair-2.wistia.com/medias/4im0absvzu?wvideo=4im0absvzu
https://altairuniversity.com/learning-library/quality-index/
https://altairuniversity.com/learning-library/quality-index/
http://altair-2.wistia.com/medias/4im0absvzu
http://altair-2.wistia.com/medias/4im0absvzu
https://altair-2.wistia.com/medias/ftu42udf77?wvideo=ftu42udf77
http://altair-2.wistia.com/medias/ftu42udf77
http://altair-2.wistia.com/medias/ftu42udf77
https://altairuniversity.com/learning-library/hypermesh-element-quality-check-and-mesh-styles/
https://altairuniversity.com/learning-library/hypermesh-element-quality-check-and-mesh-styles/
https://altairuniversity.com/learning-library/hypermesh-element-quality-check-and-mesh-styles/
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• Check element normals  

 

 

 

11.11 Student Racing Car Project - Mesh Quality 

What is the minimum element size? Open the Check Elements panel by clicking on the 

symbol . 

 

As a “critical” minimum element size (no special reason for this figure) 20 mm is chosen. 

The check reveals “4 of 372 (1%) failed. 

The minimum length is 2.72.” 

What is causing these small elements? To extract the failed elements, click on “save 

failed” (right after the check was carried out) which places the failed elements in a 

dedicated user mark. This results in the following message, “The highlighted elements 

have been placed in the user mark.” 

Then turn off all elements and geometry within the Model Browser (leaving a blank 

screen). In order to retrieve the failed elements from the user mark activate the Find 

option and then click on elems: 

(http://altair-

2.wistia.com/medias/dk91yzip0z) 

 

• Refining topology 

 
(http://altair-

2.wistia.com/medias/2p48j67uav) 

 

https://altair-2.wistia.com/medias/dk91yzip0z?wvideo=dk91yzip0z
http://altair-2.wistia.com/medias/dk91yzip0z
http://altair-2.wistia.com/medias/dk91yzip0z
https://altair-2.wistia.com/medias/2p48j67uav?wvideo=2p48j67uav
http://altair-2.wistia.com/medias/2p48j67uav
http://altair-2.wistia.com/medias/2p48j67uav
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In the extended selection window select retrieve. 

 

This will upload the failed elements into the screen (you may have to hit  to resize 

the elements) 

 

Adding line information to the display indicates that something with the underlying lines 

are wrong! 
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As shown in the image above the CAD lines and hence the CBAR elements are not properly 

connected. In other words, the squared area is a design flaw and needs to be removed. 

Depending on the project requirement (for example, meshing with different mesh sizes), 

you may decide to fix (repair) the problem by rebuilding the lines or by editing the 

elements directly. For this example, we will fix the elements directly:  

First step: deleting the small elements (length < 2.7 mm) (use the Delete panel ). 

 

As a result, the 1D elements are not coupled anymore (i.e. there is a physical gap). In 

order to merge both nodes together, the functionality “replace” is employed (Page 1D > 

replace): 
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The “replace” functionality allows to merge (equivalence) nodes in such a way that 

selected nodes move towards each other and meet at their midpoint (half the gap 

distance). Of course, in doing this, we are introducing another inaccuracy into the model. 
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12 Linear Elastic Material 

Information 

This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 

Infinite)”. It also has been reviewed and has additional material added by Sascha Beuermann. 

12.1 Hooke’s Law and Two Constants 
It is common knowledge that for the same force effect (i.e. same stress) you get different 

strains for different materials. Considering a simple tensile test, you have for a lot of 

materials, for small displacements there is a linear correlation between stress (force per 

unit area) and strain (elongation per unit length). 

   

 

  

with the constant E with is dependent on the material. This equation is called Hooke’s 

Law (Robert Hooke, 1635-1703) and is a material equation for linear elastic behavior. E is 

called the Modulus of elasticity or Young’s Modulus, and the slope of the normal stress–

strain curve in the linear elastic domain. It is defined as normal stress / normal strain. 

Units: e.g. N/mm2. 

 

σ 

ε 

E 

Young's 
Modulus 
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Another phenomenon can be seen at the tensile test. There is not only an elongation in 

the force direction, but also a contraction in the lateral direction. 

 

For the physical interpretation of u consider a cube of 1x1x1 mm dimension. Poisson’s 

ratio of 0.30 means that if the cube is elongated by 1 mm, lateral direction contraction 

would be 0.3 mm. For metals poisson’s ratio is between 0.25 to 0.35. The maximum 

possible value of poisson’s ratio is 0.5 (for rubber).   

There is also the material parameter G Modulus of rigidity, which is the slope of the shear 

stress-strain curve in the linear elastic domain. It is defined as shear stress/shear strain. 

Units: e.g. N/mm2 

E, G, and u are inter-related by the equation:  

E = 2 G (1+ u)  

Only two independent material constants are required for a linear static analysis (i.e. E, 

and u). Additional data is required for gravity, centrifugal load, and dynamic analysis 

(material density r = m/V, mass per unit volume e.g. g/cm3) and for temperature induced 

stresses or strains (coefficient of thermal expansion a = ε/DT = Dl/lDT, 

expansion/shrinkage per unit length per temperature e.g. 1/K).  

Typical values for steel, r = 7.89 •10-9 t/mm3 and a = 1.2 •10-5 1/K, and for aluminum, r = 

2.7 •10-9 t/mm3 and a = 2.4 •10-5 1/K. 
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12.2 Generalized Hooke’s Law and 36 Total 

Constants in the Equation 

Hooke’s law is familiar to us as σ = E * ε.  

This equation holds true for isotropic material that is in the linear elastic domain. The 

general equation of Hooks law for an anisotropic material is:  

σxx = E11 εxx + E12 εyy + E13 εzz + E14 γxy +  E15 γyz+ E16 γzx  

σyy = E21 εxx + E22 εyy + E23 εzz + E24 γxy +  E25 γyz+ E26 γzx  

σzz = E31 εxx + E32 εyy + E33 εzz + E34 γxy +  E35 γyz+ E36 γzx 

 τxy = E41 εxx + E42 εyy + E43 εzz + E44 γxy +  E45 γyz+ E46 γzx  

τyz = E51 εxx + E52 εyy + E53 εzz + E54 γxy +  E55 γyz+ E56 γzx  

τzx = E61 εxx + E62 εyy + E63 εzz + E64 γxy +  E65 γyz+ E66 γzx 

There are a total of 36 constants (E11,E12,………,E66) out of which 21 are independent.  

12.3 Material Classification 
Isotropic Orthotropic  Anisotropic  Laminates 

Iso – same,   

Tropic - 

directions 

• Properties 

independent of 

direction/axes 

• 2 Independent  

Constants (E, υ) 

• Metals 

Ortho – three, 

  Tropic - directions 

• Different  

properties along  

3 axes 

• 9 independent 

constants 

• Wood, Concrete,  

rolled metals  

•  

•  

•  

Different 

properties along 

crystallographic 

plane 

21 independent 

constants  

All real life 

materials are 

anisotropic only 

but we simplify 

them into 

category of 

Isotropic and  

Orthotropic  

•  

•  

•  

Two or more materials 

bonded together in layers.  

Simplest example is 

lamination carried out on 

certificates, Identity cards 

etc. 

Mainly used for space 

applications and these 

days in automobiles the 

trend is shifting towards 

plastics and laminates 

from metals.  
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12.4 Material Properties 

 Material 

Elastic  

Modulus    

(N/mm2) 

Poisson’s  

Ratio 

Density   

(tonne/mm3) 

Yield 

strength 

(N/mm2) 

Ultimate 

strength 

(N/mm2) 

Steel 2.10 • 105 0.30 7.89 • 10-9 250 420 

Cast Iron  1.20 • 105 0.28 7.20 • 10-9 85 220 

Wrought Iron 1.90 • 105 0.30 7.75 • 10-9 210 320 

Aluminium 0.70 • 105 0.35 2.70 • 10-9 35 90 

Aluminium alloy 0.75 • 105 0.33 2.79 • 10-9 165 260 

 Brass 1.10 • 105 0.34 8.61 • 10-9 95 280 

Bronze 1.20 • 105 0.34 8.89 • 10-9 105 210 

 Copper 1.20 • 105 0.34 9.10 • 10-9 70 240 

Copper alloy 1.25 • 105 0.33 9.75 • 10-9 150 400 

Magnesium  0.45 • 105 0.35 1.75 • 10-9 70 160 

Titanium 1.10 • 105 0.33 4.60 • 10-9 120 300 

Glass 0.60 • 105 0.22 2.50 • 10-9 -- 100 

 Rubber 50 0.49 0.92 • 10-9 4 10 

 Concrete 0.25 • 105 0.15 2.10 • 10-9 -- 40 

* Above listed properties are approximate and properties as per actual material 

composition are recommended.  

Why mass is in tonne and density tonne /mm3 for N-mm unit system?   

      1 N = 1 kg • 1 m / s2       (F = m*a)            1 N = 1 kg * • 1000 mm/s2   

  1 N = 1000 kg • 1 mm / s2         1 N = 1 tonne • 1 mm/s2 
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Hence when force is specified in N, length in mm, mass must be specified in tonne and 

density in tonne /mm3 

Examples of sets of consistent units (see Chapter 5) for steel are: 

 SI-system  

  

System 

mm-t-s 

System 

mmkg-ms 

Length unit meter millimeter millimeter 

Mass unit kilogram tonne kilogram 

Time unit second second millisecond 

Force unit Newton Newton kiloNewton 

Young’s 

Modulus 
210.0e+09 210.0e+03 210.0 

Density 7.85e+03 7.95e-09 7.98e-06 

Poisson’s Ratio 0.3 0.3 0.3 

 

12.5 Linear Elastic Material and Property Tutorials 

and Videos 

Recommended Videos  

• Material definition  

 

 
(http://altair-

2.wistia.com/medias/f5ns69ht1t) 

 

• Property definition  

 

 

(http://altair-

2.wistia.com/medias/wzxc0wm2r2) 

 

http://www.altairuniversity.com/edu/videos/Analyse/Starter_Material.htm
https://altair-2.wistia.com/medias/f5ns69ht1t?wvideo=f5ns69ht1t
http://altair-2.wistia.com/medias/f5ns69ht1t
http://altair-2.wistia.com/medias/f5ns69ht1t
https://altair-2.wistia.com/medias/wzxc0wm2r2?wvideo=wzxc0wm2r2
http://altair-2.wistia.com/medias/wzxc0wm2r2
http://altair-2.wistia.com/medias/wzxc0wm2r2
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• Assign property to elements  

 

 

• More general aspects  

   
 
 
 
 

 

 

 

(http://altair-

2.wistia.com/medias/93agyi4f0v) 

 

• Material property browser 

 

 
(http://altair-

2.wistia.com/medias/c07ugfgthk) 

 

Elastic material constant (by Prof J 
Chessa, Texas University  

http://youtu.be/T0XiH8tCv1o) 
 

 

Poisson’s Ratio (by Prof J Chessa, Texas 

University; http://youtu.be/VyLSJfUEJSk) 

 

Lecture on Tensile Test and Hooke’s 
Law; part 1 (by Prof J Chessa, Texas 

University; 
http://youtu.be/LKApztvxsuU) 

 

 
Lecture on Tensile Test and Hooke’s Law; 

part 2 (by Prof J Chessa, Texas University; 

http://youtu.be/NniYO0qlZFQ) 

 

http://www.altairuniversity.com/edu/videos/Analyse/Starter_Prop_Assign.htm
https://altair-2.wistia.com/medias/93agyi4f0v?wvideo=93agyi4f0v
https://www.youtube.com/watch?v=T0XiH8tCv1o&feature=youtu.be
https://www.youtube.com/watch?v=LKApztvxsuU&feature=youtu.be
http://altair-2.wistia.com/medias/93agyi4f0v
http://altair-2.wistia.com/medias/93agyi4f0v
https://altair-2.wistia.com/medias/c07ugfgthk?wvideo=c07ugfgthk
http://altair-2.wistia.com/medias/c07ugfgthk
http://altair-2.wistia.com/medias/c07ugfgthk
http://youtu.be/T0XiH8tCv1o
https://www.youtube.com/watch?v=VyLSJfUEJSk&feature=youtu.be
http://youtu.be/VyLSJfUEJSk
http://youtu.be/LKApztvxsuU
https://www.youtube.com/watch?v=NniYO0qlZFQ&feature=youtu.be
http://youtu.be/NniYO0qlZFQ
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12.6 Student Racing Car Project - Material Definition 

The frame will be built out of steel with the following properties: linear elastic, isotropic 

and temperature independent, which corresponds to the definition of MAT1 (Card 

image). 

 

 

Units are: N, mm2 and t (tons) 

Frame Property Definition & Trouble Shooting 

For simplicity reasons the frame will be modeled with CBAR elements referencing a 

“tube” cross-section with constant properties. The CBAR element properties can be best 

created with HyperBeam (integrated in HyperMesh). Once the cross section is defined, 

the cross section information is then stored as a beamsection within a beamsection 

collector.  
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The workflow is as: 

1. Define the required tube cross-section with HyperBeam and store the respective 

cross section data (area, moment of inertia etc.) in a beamsection collector  

2. Generate a property collector with Card Image PBARL. Inside this property collector 

the previously defined beamsection and a material collector is referenced. 

Eventually, the property collector is then assigned to all CBAR elements 

These steps are explained in some detail next: 

1. Defining the Tube Cross-Section with HyperBeam 

HyperBeam can be accessed through the menu bar by selecting Properties > HyperBeam. 

Note: As we are using OptiStruct as FEM solver, our lives become easier if we make use 

of the 1D section library of OptiStruct. Therefore, the standard section library should be 

OptiStruct, the standard section type should be Tube. Other section do exist of course. 

 

In the graphic editor of HyperBeam, the chosen tube section is displayed.  
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For the base design (it is actually just a “guess”) the tubes radii are assumed to be: 

rout=12.5 mm, rinside=10.5 mm. 

Of course, the tubes inner (DIM2) and outer (DIM1) radii can be easily changed and 

adjusted in HyperBeam.  

 

Based on the cross-section, values such as area, moments of inertia etc. are automatically 

determined and listed in the side bar of HyperBeam. All this information is now readily 

available as a beamsection stored in a beamsection collector (Note that different 

beamsections with different attributes, names and ID’s may reside inside a beamsection 

collector). 
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Once the definition of the cross section is completed you can return to the HyperMesh 

GUI by clicking the icon   within the Model Browser. 

2. Defining A Property Collector 

As before with the material collector, make a right mouse button click in the Model 

Browser and specify the Card Image PBARL as well as the previously defined material. 

 

The Card image of the property collector (PBARL) includes references to: 

• Beamsection (here the ID of the beamsection is 8) of cross section type 

(CStype) TUBE. Inner and outer radii are DIM2 and DIM1 

• Material (MID=1) 

In the next step, this property collector is assigned to the 1D elements.  Hereto, the 

respective functionality available in the Model Browser is used (right mouse button click 

on the property and select Assign). 
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To better visualize the 1D elements, we switch from the Traditional Element 

Representation  to 3D Element Representation . In addition, the element shrink 

option  is activated.  

 

Figure: Car frame meshed with 1D elements (CBARS) with shrink view        on. The x-

symbols outside the frame refer to geometry points. These points will be used to model 

the wheel suspension. 

 

Figure: Detailed view of the meshed frame (shrink view mode is active). A uniform tube cross 

section is used for simplicity reasons (ro=12.5 mm, ri=10.5 mm). 
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Trouble Shooting 

However, it may happen that some 1D elements are not properly displayed. What is the 

problem? 

 

 

In the figure above, the depicted line is actually a CBAR element. 

Likely Causes and Ways to Solve This Issue: 

1. Make sure that a “property” is assigned to ALL the 1D elements. This can be checked 

visually in many ways, for instance, by activating the element display mode: 

 

If a property collector is assigned to the 1D elements, they will be displayed with the same 

color as the property collector. 

1. Check the properties of the 1D elements again i.e. review the property collector (in 

the Model Browser make a right mouse button click on the corresponding property 

collector and select Card Edit). 

2. Check the element orientation. 
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The element orientation is defined through its local xy-plane. The local element xy-plane 

in turn is defined through its x-axis (longitudinal direction from node a to b) and a vector 

v. Basically, one needs to take care of the v vector in order to solve (determine) the 

element orientation! 

(more information is also available in the help documentation 

\help\hwsolvers\hwsolvers.htm, then Index > CBEAM or CBAR) 

To control (or update) the local element xy-plane and thus the v vector go to the Bars 

panel by selecting Mesh > Edit > 1D Elements > Bars > Update from the menu bar.  

Select any of the displayed 1D elements (in the image the 3D Element Representation 

 is active).  

As shown above this will display not only the local element coordinate system but also 

the components of the vector v (with respect to the global coordinate system). Here, the 

vector v parallels the global y-direction (y comp = 1). The element xy-plane thus parallels 

the global xy-plane. 

In the next step, we are reviewing the element orientation of a 1D element which is not 

properly displayed (cross-sections are not shown).  
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Just repeat the “review steps” from before: 

 

This time the location of node a and b is shown only. In the panel shown below it becomes 

apparent that the components of the v vector are all zero. 

 

The good thing: the components of vector v can be corrected/updated at any time. 

Select a single or all elements, then specify the component of the vector v with respect 

to the global (basic) coordinate system. In case the y-component of vector v is set to y=1 

(global y), both, vector v and local y-direction of the element coincide. In the image below 

the local y direction and v vector are superimposed on each other.  
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In the image below, the vector v doesn’t coincide with any of the global components. 

Now it is quite apparent, that vector v and local x-axis together specify the local xy-plane 

of the element. 
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The same element is viewed from a different direction  
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13 Boundary Conditions and 

Loads 

This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 

Infinite)”. It also has been reviewed and has additional material added by Matthias Goelke. 

 

13.1 Boundary Conditions 

Example: Simply supported beam 

Note: Even though you may not be able to start an analysis on your own yet, this example 

provides an interesting insight into the challenging topic of boundary conditions.  

 

Create 3 nodes and 2 beam elements. Apply a force on the central node and the 

appropriate boundary conditions on the end nodes. Solve the problem and compare the 

results. If the applied boundary conditions are correct, then the results would match with 

following values: 

δ = (1/48)*{PL3/EI}      and      σ = M*y/I    (M = PL/4) 

If your results do not match with the above values, then try following formulas: 

δ = (2/384)*{PL3/EI}     and    σ = M*y/I    (M = PL/8)  

If your answer matches with the 2nd set of formulas, then it means the fix-fix boundary 

conditions have been applied instead of the simply supported.  

30 ,000 N  
100 
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Please observe rotation of scale at the end   

(Rz = free) and deformation profile 

 

 

Fix- Fix is all the dof’s fix (clamped, just like 

cemented in the wall) 
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The difference between the above two boundary conditions is simply because of one dof, 

the rotation about the z axis (free in case of simply supported and fixed for fix-fix). There 

is a drastic change in the stress and displacement results. The stress differs by a factor of 

2 and displacements by a factor of 4. Now imagine a real-life steel structure which is 

simply supported, being modelled by a CAE engineer as fix-fix and the analysis shows that 

stress = 200 N/mm2 and displacement = 2.5 mm. Since the magnitude of the stress is less 

than the yield stress (250 N/mm2), a colorful impressive report with a wonderful power 

point presentation supported by animation files, would be submitted to a design 

engineer with the conclusion that the design is safe. But in real life, since it is simply 

supported, the magnitude of stress will be double (400 N/mm2 )  and the displacement 4 

times (10 mm) and the structure will fail soon….. 

Boundary conditions take least amount of time to define, but it is the most important 

step in FEA. Typically, the brick meshing of a 4-cylinder Engine block requires 300 hours 

and defining the boundary condition requires 8 hours. 300 hours hard work would go in 

vain if the boundary conditions are not applied properly.  
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How to Apply the Correct Boundary Conditions? Who Can Teach Us Quickly?  

The application of boundary conditions is a tricky subject and is based on pure 

engineering judgment, skill, and common sense.  

No university, consultant, or book can teach these things. This is something to be learned 

from practical and field experience. 100% involvement, thinking about the behavior of 

the component due to various forces, and checking after every iteration whether the FE 

model is behaving in the same way as in reality (displacement plots and strain gauge 

results for static analysis or natural frequencies and response comparison for dynamic 

analysis, etc.). If the model is not behaving correctly, then modifications in the boundary 

conditions are needed. Discussions with experienced CAE engineers, field engineers, and 

testing department engineers are also needed. In short, making mistakes and reworking 

and modifying the FE model again and again until satisfactory correlation is achieved is 

the true teacher. 

In HyperMesh, boundary conditions are stored within what are called load collectors. 

Load collectors may be created using the right click context menu in the Model Browser 

(Create > Load Collector). 

Quite often (especially at the beginning) a load collector is needed for the constraints 

(also called SPC – Single Point Constraints) and a second one is needed for the forces 

and/or pressures. Keep in mind, you can place any constraints (e.g. nodes constraint) with 

respect to dof 1, or nodes with constraints dof123, etc. in a single load collector. The same 

rule applies for forces/pressures. They are stored within a single load collector regardless 

of their orientation and magnitude. 

In the following you will learn some basic principles about the way forces may be applied 

to a structure. 
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1. Concentrated load (at a point or single node) 

 

Applying forces to single nodes may cause irritating effects, especially while looking at 

the stresses in this area. Typically, concentrated loads (i.e. forces on a single node) 

impose high stress gradients. Even though the high stresses are correct (i.e. force applied 

to an infinitesimal small area) one needs to ask whether this kind of loading is reasonable 

at all. In other words, which real-life loading scenario is represented in the model? 

Therefore, forces are commonly applied as distributed loads, namely line loads, and 

surface loads which are “closer” to reality. 

2. Force on Line or Edge 
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In the above figure, a plate subjected to 10.000 N. The force is equally applied to all (11) 

nodes at the model edge. Note that the forces at the corner will act only on ½ of the 

element edge.   

The figure below is a displacement contour plot. Note the red “hotspots” located in the 

corners of the plate. The local displacement maximus are imposed by boundary effects 

(i.e. the forces applied to the corner nodes act only on ½ of the element edge), however  

 

we applied a constant magnitude along the plate’s edge. 

In the example below, the plate is also subjected to 10.000 N. This time the forces at the 

corners are just ½ the magnitude of the other applied forces.  
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Quite apparently, the displacements are now more evenly distributed (see figure below). 

 

3. Traction (Or “Oblique” Pressure) 

Traction is a force acting on an area in any direction other than the normal direction. A 

force acting normal to an area is known as pressure.    

 

4.  Distributed Load (Force Varying as Equation) 
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How to apply a force with “variable” magnitude?   

 

Distributed loads (varying with respects to the coordinates of the nodes or elements) can 

be applied by means of an equation. In the displayed example, the magnitude of the 

applied forces varies with respect to the nodal y-coordinate (i.e. the force is acting in 

negative z-direction and increases along positive y-direction by a factor of 10 

respectively).  

5. Pressure and Vacuum 

 

In the image above, a distributed load (pressure) is shown. The origin of the plate is 

located at the highlighted node in the left upper corner. 
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How to apply a pressure with “variable” magnitude? 

 

In the example above, the magnitude of the applied pressure depends on the x- and z-

direction of the element’s centroid. 

6. Hydrostatic Pressure 

Civil engineering applications:  Dam design. Mechanical engineering applications: Vessels 

/ tanks containing liquid. 

Hydrostatic pressure is zero at the top surface of the liquid and is maximum (= ρ* g * h) 

at the bottom surface. It varies linearly as shown in the following figure:  

The hydrostatic pressure is applied taking into account the element centroids location 

(vertical position, h). 

7. Bending Moments 

The convention for representing a force is a single arrow (), pointed towards the 

direction of the force. A moment is represented by a double arrow, where the direction 

of the moment is decided by the right-hand rule.  
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The nodes along the plate’s edge are subjected to moments. As a consequence, the nodes 

will tend to rotate with respect to the y-axis (dof 5). 

 

 

 

 

 

 

 

 

In the image above, the plate is subjected to moments along its edge on the right. The 

displacements are scaled by 100 and the initial model is displayed as wire frame. 

The moment applied to the nodes in the figure above can also be modeled by adding rigid 

elements (RBE2) to each node which are then subjected to corresponding forces. In this 
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example, the RBE2 would be oriented in the z-direction and subjected to a force acting in 

x-direction as shown in the figures below.  

 

While postprocessing the results make sure that the RBE2 results (i.e. nodal position) are 

not postprocessed (just display the displacements of the shell elements). 

  

8. Torque 

What is torque? Are torque and bending moments different?  

Torque is a bending moment applied parallel to the axis of a shaft (Mx).   
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Torque or Mx causes shear stresses and angular deformation, while the effect of the other 

two moments (My , Mz) is the normal stress and longitudinal deformation.  

How to decide the direction of torque (clockwise or anticlockwise)   

It is based on the right-hand rule. Point the thumb of your right hand towards the arrow 

direction. The direction of your fingers indicates the direction of torque.  

 

 

y 

x 
z 

Torque Constraints   
( clamped,  123456=0) 
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How to apply torque for solid elements (brick /tetra) 

As solid elements have no rotational stiffness at the grid points (only 3 translational dofs), 

a common mistake is to apply torques and moments to the grid points of solid elements 

directly. 

The correct way to apply a moment to a solid model is to use an RBE2 or RBE3 rigid-body 

element. The rigid-body element distributes an applied moment into the solid element 

model as forces. 

Rigid Element Connection RBE2   

A center node is connected to the outer edge nodes using a rigid element (RBE2). The 

torque is then applied at the center node.  

 

Alternatively, you may use an RBE3 elements instead 

 

Select the nodes at the outer contour of the shaft as independent nodes. The dependent 

node may then be determined automatically.  It is pretty easy. 

However, care needs to be taken with respect to the dof’s being referenced. The node of 

the solid shaft possesses translational degrees of freedom only (dof 123). The dependent 
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node also allows for rotational displacements (dof 123456). If the rotational dof (in this 

example dof 5; rotation y-axis) of the dependent node is not “activated”, the moment 

will not be transferred to the independent nodes.  

 

Shell Element Coating 

On the brick/tetra element outer face additional quad/tria (2D) elements coating the 

solid elements are created. The thickness of these shell element should be negligible (so 

that it would not affect the results). Moment could now be applied on all the face nodes 

(moment per node = total moment / no. of nodes on the face). 
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The shell element coating can be easily created within HyperMesh. Create faces using the 

Faces panel. This panel can be accessed through the    toolbar icon which is displayed 

using View > Toolbars > Checks. 

The faces (nothing more than 2D plot elements) are automatically created and stored in 

a component collector named ̂ faces. All you need to do is treat these elements as regular 

elements (i.e. rename the component collector, assign materials and properties). 

  

In the figure above, the elements of the shaft are displayed by means of the shrink 

element command,   . The orange elements are the hexahedral elements (3D), and 

the red elements are the 2D elements placed on the free faces of the 3D elements. 
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9. Temperature Loading 

Suppose a metallic ruler is lying on the ground freely as shown in the figure below. If the 

temperature of the room is increased to 50 degrees, would there be any stress in the 

ruler due to temperature?   

 

There will be no stress in the ruler. It will just expand (thermal strain) due to the higher 

temperature. Stress is caused only when there is a hindrance or resistance to 

deformation. Consider another case, this time one end of the metallic object is fixed on a 

rigid wall (non conductive material). Now if the temperature is increased, it will produce 

thermal stress (at the fixed end) as shown below.    

 

For thermal stress calculations, the input data needed is the temperature value on nodes, 

the ambient temperature, thermal conductivity, and the coefficient of linear thermal 

expansion. 

 

 

 



 

358 
 
 
 

10. Gravity Loading 

Specify direction of gravity and material density. 

A load collector with the card image GRAV is needed (here the FEM Solver OptiStruct is 

chosen as the User Profile in HyperMesh). Please keep your unit system in mind. 
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11. Centrifugal Load 

The user has to specify the angular velocity, axis of rotation, and material density as input 

data.  

 

The RFORCE Card Image defines a static loading condition due to a centrifugal force field. 

12. ‘G’ Values (General Rules) For Full Vehicle Analysis 

• Vertical acceleration (Impact due to wheel passing over speed breaker or pot holes): 

3g 

• Lateral acceleration (Cornering force, acts when vehicle takes a turn on curves): 0.5 

to 1 g 

• Axial acceleration (Braking or sudden acceleration): 0.5 to 1 g 

13. One Wheel in Ditch 

The FE model should include all of the components (non critical components could be 

represented by a concentrated mass). The mass of the vehicle and FE model mass, as well 

as actual wheel vehicle reactions and FE model wheel reactions, should match.  

While applying a constraint, the vertical dof of the wheel, which is in considered in the 

ditch, should be released. The appropriate constraints should be applied on the other 

wheels so as to avoid rigid body motion. Specify the gravity direction as downward and 

magnitude = 3*9810 mm/sec2 



 

360 
 
 
 

 

Another simple but approximate approach (since most of the time either we do not have 

all the CAD data for the entire vehicle or sufficient time for a detailed FE model) is to 

apply 3 times the reaction force on the wheel which is in the ditch. Suppose the wheel 

reaction (as per test data) is 1000 N. Therefore, apply 3 * 1000 or 3000 N force in the 

vertically upward direction and constraint the other three wheels enough to avoid rigid 

body motion. This approach works well for relative design (for comparison of two 

designs). 

14. Two Wheels in Ditch 

Same as discussed above, except now instead of one wheel, two wheels are in the ditch. 

One wheel in the ditch causes twisting, while two wheels in the ditch produces a bending 

load.  

 

 

 

 

3  g 

3  g 

3  g 
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15. Braking 

Linear acceleration (or gravity) along the axial direction (opposite to vehicle motion) = 0.5 

to 1 g.  

 

 

16. Cornering 

Linear acceleration along the lateral direction = 0.5 to 1 g. 

 

13.2 How to Apply Constraints 
A beginner may find it difficult to apply boundary conditions, and in particular, 

constraints. Everyone who starts a career in CAE faces the following two basic questions:  

0.5  to 1 g 

0.5  to 1 g 
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i) For a single component analysis, should forces and constraints be applied on the 

individual component (as per the free body diagram) or should the surrounding 

components also be considered. 

ii) At what location and how many dof should be constrained.  

Constraints (supports) are used to restrain structures against relative rigid body motions. 

Supporting Two Dimensional Bodies 

 

The figure above depicts two-dimensional bodies that move in the plane of the paper 

(taken from: 

http://www.colorado.edu/engineering/CAS/courses.d/IFEM.d/IFEM.Ch07.d/IFEM.Ch07.

pdf ). 

If a body is not restrained, an applied load will cause infinite displacements (i.e. the FEM 

program will report a rigid body motion and will abort the run with an error message). 

Hence, regardless of loading conditions, the body must be restrained against two 

translations along x and y, and one rotation about z. Thus, the minimum number of 

constraints that has to be imposed in two dimensions is three. 

In figure (a) above, the constraint at A fixes (pins) the body with respect to translational 

displacements, whereas the constraint at B, together with A, provides rotational 

restraint. This body is free to distort in any manner without the supports imposing any 

deformation constraints. 

http://www.colorado.edu/engineering/CAS/courses.d/IFEM.d/IFEM.Ch07.d/IFEM.Ch07.pdf
http://www.colorado.edu/engineering/CAS/courses.d/IFEM.d/IFEM.Ch07.d/IFEM.Ch07.pdf
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Figure (b) is a simplification of figure (a). Here the line AB is parallel to the global y-axis. 

The x and y translations at point A, and the x translation at point B are restrained, 

respectively. If the roller support at B is modified as in figure (c), a rotational motion about 

point A is possible (i.e.  the rolling direction is normal to AB). This will result in a singular 

modified stiffness matrix (i.e. rigid body motion). 

Supporting Three Dimensional Bodies 

 

The figure above (taken from: 

http://www.colorado.edu/engineering/CAS/courses.d/IFEM.d/IFEM.Ch07.d/IFEM.Ch07.

pdf) illustrates the extension of the freedom restraining concept to three dimensions. 

The minimal number of freedoms that have to be constrained is now six and many 

combinations are possible.  

In the example above, all three degrees of freedom at point A have been fixed. This 

prevents all rigid body translations, and leaves three rotations to be taken care of. The x 

displacement component at point B is constrained to prevent rotation about z, and the z 

component is fixed at point C to prevent rotation about y. The y component is constrained 

at point D to prevent rotation about x. 

http://www.colorado.edu/engineering/CAS/courses.d/IFEM.d/IFEM.Ch07.d/IFEM.Ch07.pdf
http://www.colorado.edu/engineering/CAS/courses.d/IFEM.d/IFEM.Ch07.d/IFEM.Ch07.pdf
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1. Clutch Housing Analysis 

 

The aim is to analyze (only) the clutch housing. The clutch housing is connected to the 

engine and transmission case by bolts. There are 2 possibilities for analysis:  

Approach 1) Only the clutch housing is considered for the analysis. Therefore, apply 

forces and moments as per the free body diagram and constrain the bolt holes on both 

the side faces (all dof = fix).   

 

Approach 2) Model at least some portion of the engine and transmission case at the 

interface (otherwise model both these components completely with a coarse mesh by 

neglecting small features). Then, represent the other components like the front axle and 

rear axle using beam elements (approximate the cross sections). Apply constraints at the 

wheels (not all the dof are fixed but only minimum dofs required to avoid rigid motion or 

otherwise inertia relief / kinematic dof approach). Please note that the clutch housing, 

being the critical area, should be meshed fine.  

Engine 
Clutch 
housing 

Transcase 
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The second option is recommended as the stiffness representation, as well as constraints, 

are more realistic. The first approach, fixing both sides of the clutch housing, results in 

over constraining and will lead to safer results (less stress and displacement). Also, it is 

not possible to consider special load cases like one wheel in ditch, two wheels in ditch, 

etc.   

2. Bracket Analysis  

Problem definition: A bracket fixed in a rigid wall is subjected to a vertically downward 

load (180 kg).  

 

If above problem is given to CAE engineers working in different companies then you will 

find different CAE engineers applying constraints differently: 

• Fix the bolt hole edge directly.  

• Model the bolt using rigid / beam elements and clamp bolt end.  

• Model the bolt, clamp bolt end, bracket bottom edge translations 

perpendicular to surface fixed. 
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 Stress 

N/mm2 

Displacement mm 

Bolt holes edge fixed  

 

993 

 

15.5 

 

Bolt – modeled by beam 

elements 

 

770 

 

16.2 

 

Bolt by beams and Bracket 

bottom edge only z-dof fixed  

 

758 

 

15.8  

 

 

Applying a direct constraint on the hole edge causes very high stress. The second method 

shows the deformation of the bracket bottom edge, which is not realistic. Method 3 is 

recommended. Please observe the difference in the magnitude of the stress and 

displacement. 
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In some organizations it is a standard practice to neglect stress at the washer layer 

elements (washer area and one more layer surrounding the beam/rigid connection) due 

to high stresses observed at the beam/rigid and shell/solid connections. 

A modified version of the bracket is depicted in the figure below. This time the bracket is 

pinned to the “wall” by means of 3 simplified screws/bolts. The bolts are represented by 

rigid elements (RBE2).  The center of the rigid elements is fixed/constrained with respect 

to any translational displacements (dof 1-3). 

 

What would you expect to happen? Even though this kind of constraint seems reasonable 

(i.e. bracket mounted to the wall), the unconstrained rotational dofs allow the central 

node to rotate. Thus, the hole itself (even though the magnitude is very small) deforms 

(see figure below). 
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In the figure above, the displacements are scaled by 100. The undeformed shape is 

plotted in a wireframe mode. Note the deformation of the hole.  Is/was this effect really 

intended? 

 

In the figure above, the displacements are scaled by 100. The undeformed shape is 

plotted in a wireframe mode. All the dofs of the central node are constrained. The hole 

remains its initial shape and “position”. 

Another illustrative example regarding the effects of the boundary constraints on the 

modelling results is shown in the figure below. The translational degrees of freedom (dof 

123) of the nodes at the rear end of the cantilever are constrained. At the tip a uniform 

force is applied in negative x-direction. 

What would you expect to happen, especially in the vicinity of the constraints?  
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In the figure above, all the nodes at the rear are constrained with respect to any 

translational displacements. The displacements in the y- and x-direction are scaled by a 

factor of 200 and 5, respectively. The undeformed mesh is shown as wireframe (orange). 

Note the thickening at the base of the cantilever accompanied with thinning at the top of 

the cantilever. 

 

In the figure above, there are modified constraints at the rear of the cantilever. The nodes 

at the rear part are constraint in the x- and z-direction. In addition, nodes located at the 

symmetry axis (at the rear) are constraint in the y-direction. The displacements in the y- 
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and x-direction are scale by a factor of 200 and 5, respectively. The undeformed mesh is 

shown as wireframe (orange). The displacements are quite different compared to the 

earlier figure. The question to be answered is which model is correct? 

Imposing Boundary Conditions (Constraints and Forces) By Means of RBE2 and RBE3 

What Are the Differences?  

 

In the figure above, the nodes at the hole are constrained by an RBE2 element where the 

independent node is fixed with respect to all degrees of freedom (dof 123456). 

Before looking at the simulation results, ask yourself, what will the displacement contours 

look like? 
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The figure above is a plot of the displacement field. Note that the displacements at the 

hole are zero. In other words, the RBE2 element “artificially” stiffens the hole. 

Next, we are constraining the model by means of a RBE3 element. Note, that the 

dependent node of the RBE3 element (i.e. the one in the center of the spider) can’t be 

constraint directly. This is because this node would depend on the nodes at the hole and 

the SPC. A work around is to attach the dependent node to a CBUSH element (with zero 

length and high stiffness values). The free node of the CBUSH element is then constrained 

with respect to all degrees of freedom. 

 

The above figure illustrates how the dependent node of the RBE3 is grounded to an 

CBUSH element with zero length. All degrees of freedom of the free node of the CBUSH 



 

372 
 
 
 

are constrained. CBUSH elements are created in the spring panel which can be accessed 

by selecting Mesh > Create > 1D Elements > Springs. 

 

In order to create CBUSH elements, you first need to determine the corresponding “elem 

types” (default is CELAS), reference a property (can also be assigned later), and select the 

two end nodes of the spring. The options dof1-6 are irrelevant. 

The property definition of the CBUSH element is shown in the following image 
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The figure above is a displacement contour plot. The hole is “supported” by a RBE3 

element, which in turn is grounded to a CBUSH element with high stiffness values.  All 

degrees of freedom of the free node of the CBUSH element are constrained. 

 

The figure above depicts the displacement contour plot scaled by a factor 200. The hole 

deforms due to the applied pressure. The RBE3 element thus allows us to model a kind 

of soft support (whereas the RBE2 approach can be considered as a rigid/stiff support). 

3.  Pressure Vessel Lying Freely on The Ground and Plate Subjected to Tensile Load On 

Both the Sides  

Sometimes a situation demands for an unconstrained structural analysis like a pressure 

vessel lying freely on the ground (just placed, no constraint/fixing) or a plate subjected to 

tensile load on the opposite edges without any constraint. A static analysis problem 

cannot be solved for an unconstrained structure. It should be fixed at least one node, or 

alternatively, at a few nodes so as to restrict rigid body motion.  
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If the problem of the pressure vessel (subjected to internal pressure) or the plate with 

tensile load is solved without specifying any constraints, then either the solver will quit 

giving a singularity error message or otherwise report that there is a high stress at an 

unrealistic location (if the auto singularity option is switched on).  

 

To solve an unconstrained structural problem there are 2 ways: 

1) Approximate approach: Create spring / beam elements (negligible stiffness value) 

on the entire circumference (outer edges or surface nodes) and apply the 

constraint at the free end of spring or beam. 

2) Recommended: Inertia relief method or defining kinematic dofs in the model (see 

HyperWorks help documentation and corresponding tutorials) 
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13.3 Symmetry 

 

Condition for Using Any Type of Symmetry  

Symmetric conditions could be used only when both the following conditions are fulfilled.  

1) Geometry is symmetric 

2) Boundary conditions (forces and constraints) are symmetric.  

Advantages: Half, quarter or a portion of the model could be used for analysis, resulting 

in fewer dofs and computational cost. 

Which dof must be constrained at the symmetry level? 

 

Symmetry 

Plane  
symmetry 

Anti  
symmetry 

Axial  
symmetry 

Cyclic  
symmetry 
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In the figure above, the dark vertically oriented plane represents the plane of symmetry. 

The finite elements nodes are colored gray, whereas possible nodal rotations are shown 

by means of blue, green and red arrows. Nodal rotations with respect to the green and 

red axis/arrows would “move/rotate” the node out of the plane of symmetry (just 

imagine the arrows would be glued to the nodes). Hence these degree of freedoms (dof) 

must be constrained. In contrast, nodal rotations with respect to the blue axis/ arrow are 

not needed to be constrained. As the nodes of solid elements do only allow translational 

displacements, one just need to constrain any out of symmetry plane motions. 

 

In the figure above the full model is considered. The beam ends are constrained with 

respect to any translational displacements (dof 123). A vertical load of 200 N is applied at 

its center. 

If the symmetry plane is in the x-y plane then the translational displacements in its normal 

direction i.e. z-direction (dof 3) need to be constrained. On the other hand, we don’t need 

to fix/delete rotations with respect to z-axis as solid elements do not allow nodal 

rotations. Remember, the nodes at the symmetry plane are not allowed to move (or 

rotate) out of the plane of symmetry. 
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In the image above only a half model is considered. At the plane of symmetry, the z-

displacements (dof 3) are constrained. In addition, the original force is divided by two (as 

it acts only on half of the structure). 

 

Let us consider a symmetrical plate with a hole subjected to symmetrical loads on the 

two opposing edges. 
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Above the full plate model is shown (and serves as a reference model) 

 

Contour plot of element stresses (von Mises). 

In the next step, a quarter segment of the plate is investigated. The corresponding loads 

and constraints are shown in the figure below.  
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Contour plot of the element stresses (von Mises). 

Limitations: Symmetric boundary conditions should not be used for dynamic analysis 

(natural frequency and modal superposition solver). A symmetric model (half or portion 

of part) would miss some of the modes (anti nodes or out of phase modes) as shown 

below: 

 

Natural Frequency comparison for Full and Half symmetric model  
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Question: We need to do a simulation of a casting component to decide the best option 

out of two casting materials. What will be the differentiating parameters, since the 

modulus of elasticity and Poisson’s ratio for both of the materials are the same. Secondly, 

we do not have stress strain data for both of the materials. 

1) If the nature of the loading is static (most of the time static and rarely dynamic) and 

the company has only a linear static solver:  

Different grades of cast iron have different ultimate strength (or proportional yield 

strength). Linear static stress is independent of material and both the materials would 

report the same stress. The decision could be made based on the ultimate strength 

(and endurance strength).  Say the maximum stress as per the FEA is 300 N/mm2.  For 

material 1, the ultimate stress is 350 and for material 2 it is 500 N/mm2. In this 

situation, the second material is clearly the choice. Consider another case. Suppose 

the maximum stress reported by the FEA is 90. One can calculate the approximate 

value of endurance strength. For grey cast iron, the endurance strength = 0.3 * 

Mode No. Full model  

Hz 

Half symmetric model 

Hz 

1 448 448 

2 449 718 

3 718 1206 

4 719 2078 

5 1206 2672 

6 1211 4397 
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ultimate strength. Therefore, for material 1 the endurance strength is 105 N/mm2 and 

should be preferred over the second one.    

2) If the nature of the loading is dynamic and subjected to a sever load: Fatigue analysis 

is strongly recommended. Commercial fatigue analysis software usually provides 

material library. Specifying the appropriate material grade, surface finish, etc. and 

calculations for the life / endurance factor of safety would lead to realistic and 

optimum selection out of the two options. 

13.4 Creating Loadsteps In HyperMesh 

And finally, once the constraints and loads are specified, a corresponding loadstep needs 

to be created (otherwise the Finite Element program would not know what to do with 

these entities). In HyperMesh, this is done by selecting Setup > Create > LoadSteps. 

 

The image above shows the Load Step panel in HyperMesh. This panel is used to define a 

loadstep. First, specify the name and the type of the loadstep. The load collector with the 

constraints are referenced using SPC and the forces/pressure are referenced using LOAD. 

The loadstep will then be listed in the Model Browser along with all the other model 

entities. 

Now the model can be exported, and the analysis can be started! 
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13.5 Discussion On AUTOSPC In OptiStruct 
This section is based on discussions with Kristian Holm, Juergen Kranzeder and Bernhard 

Wiedemann. Written by Matthias Goelke 

A First Look At AUTOSPC 

AUTOSPC checks the global stiffness matrix for degrees-of-freedom with no stiffness. If 

found, these degrees-of-freedom are automatically constrained. In the *.out file, the 

nodes which are virtually constrained are listed. 

Note, that AUTOSPC,YES is the default setting. 

AUTOSPC is defined under Control Cards > PARAM > AUTOSPC > YES/NO. 

 

Example 1 

AUTOSPC,YES 

In this example two CROD elements, which support tension, compression and torsion, are 

subjected to a vertical load at their common node.  
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Running the analysis yields the following information: 

 

At node 2 the dofs in 2 and 3, (2 =y, 3=z translation), 5 and 6 (5= rotation y axis, 6= rotation 

z-axis) are not available. With the setting AUTOSPC =YES, these unsupported dofs are 

automatically constrained. As a consequence, the analysis gets completed without 

warning or error messages. 

 

However, note that the displacements are in the order of 10e-13 mm, which is “zero” 

(despite the applied loading).  

In a first reaction, this result may provoke the idea that material attributes, cross-

sectional properties of the rods, or the magnitude of the load is not properly defined. 

However, if the focus of the analysis is about bending (which seems to be the case due to 

the applied loads), the chosen element type is simply wrong. Instead of CROD elements 

(which only allow for compression, tension and torsion), CBAR or CBEAM (capable of 

bending) should be applied. 

Deactivating AUTOSPC (=NO) demonstrates that the model setup is wrong: 
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AUTOSPC, NO  

Running the same model but with AUTOSPC set to NO, the analysis stops with the error 

message depicted below: 

 

This time, as AUTOSPC is set to be NO, grid 2 has no stiffness regarding dof 2, 3, 5, and 6. 

The analysis stops, requesting that these dofs must be constrained in order to run 

analysis. 

Example 2 

AUTOSPC, YES 

 

The solid mesh (first order hexahedral elements) is constrained (all dofs are fixed) at the 

independent node of the RBE2 element.  
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• The independent node of the RBE2 element is pinned/fixed with respect to all dofs 

(1-6). 

• All dofs of the RBE2 element are active. 

• The nodes of the hexahedral element (with dof 1-3; no rotation) are coupled to the 

dependent nodes of the RBE2 element (with dof 1-6). 

 

Will this cause any problems? What do you expect? 

The *.out file provides the following information: 

 

Since the solid elements do not support dof 4-6, the rotational dofs of the RBE2 element 

(dof 4-6) have been removed.  
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However, during the analysis with AUTOSPC,YES the solver detects nodes (altogether 62 

nodes) whose rotational dofs have been removed.  Now, AUTOSPC will automatically 

constraints these nodes.   

 

Altogether 62 nodes are listed with a total of 186 dofs 

Note, that by default, the RBE2 element allows for translation and rotation: 

 

Simply deactivate dof 4, 5, and 6 to avoid the automatic pinning/fixing of nodes due to 

AUTOSPC, YES. 

AUTOSPC, NO 

Running the same model with AUTOSPC,NO the following information is listed in the *.out 

file: 
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Again, we are informed that the rotational dofs of 62 nodes (=186 dofs) need not to be 

constrained.  

At the end the results of Example 2 with AUTOSPC,YES or NO are identical. Example 3 

       

In this model, a ROD element that supports compression, tension and torsion (here dof 

2, dof 5) is attached to shell elements (with dof 1-6) and subjected to a force in positive 

y-direction. 

• Coupling of Rod element (dof2 and dof5) with shell element (dof1-6) 

• No constraints at the free end of the ROD element (location of the applied force) 
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Do you see any problems? What do you expect?  

 

Since the dofs 1, 3, 4, and 6 are not available/supported at node 442, AUTOSPC, YES 

places “virtual” constrains on this node. 

Therefore, we do get results – but can we trust the results? 

 

This question becomes even more striking by looking at the model with the setting 

AUTOSPC, NO. 

AUTOSPC, NO 

The solver “detects” that node 442 is missing any stiffness associated with dof 1, 3, 4, and 

6 (due to the incompatibility of dofs at node 253). Since we do not allow the solver to add 

constraints to this node, the analysis fails: 
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As reported in the *.out file, node 442 has no stiffness for dof 1, dof3, dof4, and dof 6, 

causing the analysis to stop with a fatal error!  

So in the first scenario we do get results because of an introduced stiffness related to 

AUTOSPC,YES at node 442. In the latter with AUTOSPC,NO the same model cannot be run 

at all. In order to overcome the model error, we either need to constrain node 442 

according to the information provided in the table – or we make use of a CBAR/CBEAM 

element (with bending stiffness) instead of CROD. 

Remark 

AUTOSPC,YES is the default setting. 

Though the solver run may be completed successfully (because of AUTOSPC,YES), it 

doesn’t necessarily mean that the model is physically correct. User defined SPC’s may be 

incomplete or incorrect (not always that obvious at all) – AUTOSPC,YES may then 

automatically add further constraints which may lead to intriguing results as depicted by 

the examples shown above. 

Make sure and always check the *.out file for additional information. Also, you may run 

the model again, this time applying the dofs (constraints) as listed in the *.out file and 

AUTOSPC,NO. 
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13.6 Recommended Tutorials and Videos 

Recommended Tutorials: 

The following tutorials are included in your HyperWorks installation (see HyperWorks 

help documentation). 

• HM-4000: Setting up Loading Conditions 

• HM-4040: Working with Loads on Geometry 

Recommended Videos  

• Creating boundary conditions  

 

 

• Loadstep definition  

 

 

(http://altair-

2.wistia.com/medias/3m5mzg42dn) 

 

• Loads and constraints  

 

 

(http://altair-

2.wistia.com/medias/tq0gr7zafo) 

 

(http://altair-

2.wistia.com/medias/52c93wwc5x) 

 

 

Where Do You Get Your Loads to Assess 

Component Strength and Durability? 

(http://altair-2.wistia.com/medias/91h98xs0h9) 

 

http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm4000.htm
http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/hm4040.htm
https://altair-2.wistia.com/medias/3m5mzg42dn?wvideo=3m5mzg42dn
https://altair-2.wistia.com/medias/52c93wwc5x?wvideo=52c93wwc5x
http://altair-2.wistia.com/medias/3m5mzg42dn
http://altair-2.wistia.com/medias/3m5mzg42dn
https://altair-2.wistia.com/medias/tq0gr7zafo?wvideo=tq0gr7zafo
http://altair-2.wistia.com/medias/tq0gr7zafo
http://altair-2.wistia.com/medias/tq0gr7zafo
http://altair-2.wistia.com/medias/52c93wwc5x
http://altair-2.wistia.com/medias/52c93wwc5x
https://altair-2.wistia.com/medias/91h98xs0h9?wvideo=91h98xs0h9
http://altair-2.wistia.com/medias/91h98xs0h9
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More General (not HyperWorks related) 

Distributed loads in finite elements, part 1 (Prof J Chessa; University Texas; 

http://youtu.be/8lwJQmDo7zQ) 

 

 

Distributed loads in finite elements, part 2 

(Prof J Chessa; University Texas;  https://youtu.be/gtBFrF7nt0s ) 

 

  

http://youtu.be/8lwJQmDo7zQ
https://youtu.be/gtBFrF7nt0s
https://www.youtube.com/watch?v=8lwJQmDo7zQ&feature=youtu.be
https://www.youtube.com/watch?v=gtBFrF7nt0s&feature=youtu.be
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Recommended Tips and Tricks 

Where are your loads coming from - Suspension and Chassis Loads  

(http://www.altairuniversity.com/wp-

content/uploads/2013/07/Loads_Extraction_120309.pdf) 

 

 

13.7 Student Racing Car Project - Boundary 

Conditions 

BC’s & Loads 

Three different loadsteps are considered:  

• Torsion 

• Bending 

• Shear 

In all three loadsteps the frame is constraint in the same way (see image below). Thus, 4 

loadcollectors (no Card Images needed) must be created. 

 

ftp://ftp.altair.de/pub/edu/protected/FormulaStudent_Webinare/Schmueser_2010/Loads_Extraction_120309.pdf
http://www.altairuniversity.com/wp-content/uploads/2013/07/Loads_Extraction_120309.pdf
http://www.altairuniversity.com/wp-content/uploads/2013/07/Loads_Extraction_120309.pdf
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Constraints 

The corresponding nodes are fixed with respect to translational and rotational 

displacements (dof 123456). To create constraints, from the menu bar select BCs > Create 

> Constraints. 

 

Torsion 

Torsion is imposed through vertically applied forces. To create forces, from the menu bar 

select BCs > Create > Forces.  Of course, the referenced forces and magnitudes are just 

“dummy” assumptions. The frame is constrained as described before. 

The corresponding torsional loadstep is defined in the “LoadStep” panel (Setup > Create 

> LoadSteps). 

 

Bending & Shear 

The working steps related to the setup of the bending and shear load cases are pretty 

much the same. The orientation of the bending and shear forces is shown in the images 

below. Care must be taken, that these forces are stored in their respective load collectors 

(no Card Image needed). The loadstep named “Bending” then references the 
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loadcollectors “Bending” and “Constraint”; the loadstep “Shear” the loadcollectors 

“Shear” and “Constraint”.   

 

Load case: Bending 

 

Load case :Shear 
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This completes the model set-up. The model is saved as a binary *.hm file (including CAD 

information) and then exported as an OptiStruct analysis deck (ASCII format). 
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14 Linear Static Analysis 

This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 

Infinite)”. It also has been reviewed and has additional material added by Debdatta Sen and 

Matthias Goelke. 

 

14.1 Linear Static Analysis 
 

 

Linear 

Linear indicates a linear elastic behaviour of the material. That is, the linear portion of the 

Stress Strain Curve a straight-line following Hooke’s Law: σ =ε E which can be interpreted 

as the equation of a straight line (y = m x) passing through the origin. “E”, the Elastic 

Modulus, is the slope of the curve and is a constant. In real life, after crossing the yield 

point, the material follows a non-linear curve, but the solver follows the same straight 

line. Components are broken into two separate pieces after crossing the ultimate stress, 

although a linear static analysis never shows failure in this fashion. It shows a single 

unbroken part with high stresses at the location of failure. Very large, unrealistic 

deformations may also be seen. An analyst has to conclude whether the component is 

safe or if it failed by comparing the maximum stress value with the yield or ultimate 

stress. Hence, it’s necessary for the analyst to decide, if under the given loading 

conditions, a Linear Static Analysis can be carried out. 

Software follows this path for  
linear static calculation 

Actual stress-strain curve 
Stress 

Strain 
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Static 

There are two conditions for static analysis: 

1) Force is static meaning there is no variation with respect to time (dead weight) 

dF/dt = 0 
F  

2. Equilibrium condition - ∑ Force = 0, ∑ Moments = 0 

      ∑Fx = 0   ∑Mx = 

0 

      ∑Fy = 0   ∑My = 

0 

      ∑Fz = 0   ∑Mz = 

0  

The FE model should fulfil this condition at each and every node. The summation of all 

external forces and moments should at all locations, be equal to the reaction forces and 

moments. 

Practical Applications: This is the most commonly used analysis. All Aerospace, 

Automobile, Offshore and Civil engineering industries perform linear static analysis.  

14.2 Linear Static Analysis Example Using 

HyperMesh 

Theoretical Result 

In mechanics we can define static state as the state of a system that is in equilibrium 

under an action of balanced forces and torques so that they remain at rest (V=0). A static 
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load is one which does not vary. If it changes slowly, the structure’s response may be 

determined with static analysis, but if it varies quickly (relative to the structure’s ability 

to respond), the response must be determined with a dynamic analysis. When solving a 

static problem, all finite element solvers will solve the following equation: 

 

Where: 

• K : It is the global stiffness  matrix 

• x : It is the displacement vector response to be determined. 

• f : It is the external forces vector applied to the structure. 

We will now consider a small static example that will be used to better understand what 

a static analysis is. The example is showed on the following image: 

 

This is a stepped column consisting of two uniform sections with different cross-sectional 

areas. 

The methodology that will be described here can be easily extended to any kind of 

problem. First, we need to represent the structure as nodes and elements. For this case, 

it is clear that we need at least 2 elements, one for each distinct section. 

Let’s consider the following finite element model to solve this linear static problem. In 

our case, we will use rod elements as showed on the following image: 



 

399 
 
 
 

 

The model comprises of 3 nodes {1, 2, and 3} and 2 elements {1 and 2}. Consider a 

material that is associated to a rod element with the with cross-section A and length L. 

Every node is assumed to have only one DOF (x) and the stiffness matrix for this 

onedimensional rod element can be written as: 

 

We can then evaluate the matrix for each element based on the input data: 

 

Now the next step is to assemble these two element stiffness matrices to form the global 

stiffness matrix: 
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Now we need to define the vector matrices for forces and the displacements:      

     

 

Finally, the global system can now be represented in terms of the global stiffness matrix, 

displacement and force matrices as: 

 

Node 1 is fixed in this model and hence the displacement for this node would be zero. So, 

we can eliminate the first line and the first column of our system: 

 

To solve this problem, we just need to invert the global stiffness matrix and multiply it to 

both sides: 

 

This gives us the displacement values at nodes 2 and 3. With the displacement vector 

defined, it is now possible to determine the element strain, stresses and forces: 
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STRAIN 

 

STRESS 

 

FORCES 

 

This is a very simple example, but elaborately summarizes the finite element method used 

in a linear static solution. All the calculations demonstrated here are done by the solver. 

If the user needs detailed information about finite element method, it can be found in 

the online documentation or in the referenced books.  

14.3 Linear Static Analysis Setup Using HyperMesh 

There are some basic steps that the user needs to follow to setup a static analysis for 

OptiStruct, we will describe these steps using HyperMesh to setup the example described 

above. This example assumes that the OptiStruct BulkData user profile is used. 

Step 1 - Define Material 

1. From the Model Browser, right click and select Create > Material. 
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2. Then the user should input the material Name and select the card image 

(MAT1) and click on Create: 

 

3. The material card now needs to be filled with the Young Modulus [E], Poisson 

[Nu], and optionally (dependent on the type of analysis carried out) Density 

[RHO] values and click return: 

 

 *If there are only 1D elements the Poisson value can be ignored.  

The user should now see in the Model Browser the Material group with the material steel. 

 

Step 2 – Create New Component- And Property Collectors 

1. From the Model Browser, right click and select Create > Component. 
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2. Then the user should input the component Name as A1. Notice that there currently 

isn’t an assigned property or material. 

3. Click on the property tab and check the box for Assign property. For name enter A1 

and for the card image select PROD. Select create property to enter the property 

card image. 

 

 

 

 

 

 

 

4. Click on [A] to update the value of the area to 314.16 as shown below: 

 

5. Click return to return to the create component dialog. 

6. Click on the material tab and check the box for assign material. From the name drop 

down, select steel.    

7. Click on the component tab and review the assigned property and material. Click 

create to create the property. 
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8. Repeat the process to create a second component named A2 with a PROD property 

named A2 with an area of 78.54.    Also assign the material steel. Also, be sure to 

select a different color for the component. 

 

After creating these 2 components, you should see 2 new groups in the Model Browser 

called Component and Assembly Hierarchy, each with 2 instances called A1 and A2: 
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Step 3 – Create the Finite Element Mesh with the Appropriate Properties Associated 

to The Elements 

This step is very model dependent. It can start with a CAD geometry that is imported or 

from other FEA Model or can be a combination of existent models and imported 

geometries. In our case, this is a very simple model that we can model by creating the 

nodes and the respective elements.  

1. To create the nodes, use the shortcut key F8 that will open the Create Nodes panel: 

 

2. Create three nodes at the following coordinates: (0, 0, 0), (100, 0, 0) and (300, 0, 0). 
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3. In our case it is necessary to create CROD elements. The user should use the Element 

Types panel (Mesh > Assign > Element Type) to set the rod element to CROD as below. 

 

4. The Create rod panel can be accessed by the Mesh > Create > 1D Elements > Rods pull 

down menu. 

5. Within the Create Rods panel, create a rod element between node 1 and node 2 in the 

A1 component with the A1 property (make the A1 component the Current Component 

using the Model Browser). Be sure to select the property before selecting the nodes to 

ensure that the appropriate property is assigned.   

6. Repeat substep 5, making the component A2 the Current Component. Then create an 

element between node 2 and node 3 with the property A2. 

 

Step 4 – Define the Constraint Load Collector and Apply the Model Constraint 

1. Right click in the Model Browser and select Create > LoadCollector to access the Create 

LoadCollector dialog box.    
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2. For Name, enter SPC, leave the Card image set to none and select Create. 

 

After creating this load collector, the user should see a new group called LoadCollector 

with an instance called SPC in the Model Browser. 

 

3. Select BCs > Create > Constraints to create the SPC constraints. These constraints will 

fix the DOF that are not allowed to move.  

4. In OptiStruct the rod element is a spatial element and has 3 DOFs (Ux, Uy and Uz). To 

reproduce the simple configuration, we had on the first section, we need to remove all 

Uy and Uz DOFs and the Ux at node 1 as we did on the first section. Within the     

Constraints panel, select node 1 and check only the boxes for dof1, dof2, and dof3: 

5. Select Create. 
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6. Repeat this process only selecting dof2 and dof3 for nodes 2 and 3. The model will 

appear as below: 

 

  Now there are only 2 DOFs in this model Ux2 and Ux3. 

Step 5 – Define the Force Load Collector and Apply the Loads 

1. Create a load collector named Force with no card image. 

After creating this load collector, the user should see a new instance called Force on the 

LoadCollector group in the Model Browser: 

 

2. Now the user should create the force in the -X direction at node3 using the Forces 

panel. This panel is accessed from BCs > Create > Forces. 
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3. For nodes, select node3. Enter -10.000 as the magnitude and select x-axis as shown 

below 

4.  Select Create to create the force. 

 

Step 6 – Define the Load Step 

1. To create the load step, select Setup > Create > LoadSteps. 

This will access the LoadSteps panel where the user should select the SPC and the load 

for a static load case and click on create to create the load step.  

 

: 
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2. For name enter force. Check the box for SPC and then click on the = and select the load 

collector SPC. Check the box for LOAD     and then click on the = and select the load 

collector Force. 

3. Verify that the type is set to linear static and select create. 

This will add a new group to the model browser tree called Loadstep with an instance 

called force: 

 

Step 7 – Run the Analysis 

1. Enter the Analysis page and then select the OptiStruct panel. 

2. Click on “save as…” for input file and select a location and filename for the OptiStruct 

file using the extension *.fem. 

 

3 . Verify that the settings are the same as the image below and then select OptiStruct. 
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Step 8 – Post-Process the Results 

1. After the run is complete, the easiest way to access the results is by using the 

HyperView green button that is on the right-hand side below the OptiStruct button 

used to call the solver.   

This will add another page to the session with HyperView loaded as the client the resulting 

.h3d file loaded into HyperView. 

2. In HyperView on the toolbar, click on the Contour icon, , select Displacement and 

Mag as the Result type and click Apply. This will generate the contour shown below: 

 

3. The Measure panel, , can be used to compare this result with the one solved in 

the first section. Just click on “Add” and change the measure type to Nodal contour 

and select the nodes 2 and 3: 
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As we can see in the measures notes, the values match with the results evaluated earlier.   

Many complex problems which can be approximated to a static system can be simplified 

and solved as a static analysis. Static analyses can also be used as a first check for 

nonlinear behavior, indicating a more involved simulation is required. The density of the 

materials is not needed, unless effects of mass of the components are desired. For a linear 

static analysis, when defining the material, one needs to specify either the Young’s 

Modulus or the Bulk Modulus and the Poisson’s Ratio. Care must be taken while 

evaluating the results from a static analysis to ensure that the linear assumptions are still 

valid. The following questions should be answered: 

• Are the deflections and rotations small relative to the size of the structure being 

evaluated? 

• Are there stress levels above the material yield? 

• Is there any pass through of components with each other or with a boundary which 

would change the load paths through the system? 
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14.4 Linear Static Analysis Tutorials and Videos 

Recommended Tutorials: 

OS-1000: Linear Static Analysis of a Plate with a Hole (part of the HyperWorks Help 

documentation) 

Recommended Videos  

• Loads  

 

 

 

• Input File  

 

 

(http://altair-

2.wistia.com/medias/tq0gr7zafo) 

 

• LoadStep/Subcase 

 
(http://altair-

2.wistia.com/medias/52c93wwc5x) 

 

( http://altair-

2.wistia.com/medias/3y89bitzjn ) 

• Log file, Error messages 

 

( https://altair-

2.wistia.com/medias/thkt5mhd79 ) 

 

https://altair-2.wistia.com/medias/tq0gr7zafo?wvideo=tq0gr7zafo
https://altair-2.wistia.com/medias/3y89bitzjn?wvideo=3y89bitzjn
http://altair-2.wistia.com/medias/tq0gr7zafo
http://altair-2.wistia.com/medias/tq0gr7zafo
https://altair-2.wistia.com/medias/52c93wwc5x?wvideo=52c93wwc5x
http://altair-2.wistia.com/medias/52c93wwc5x)
http://altair-2.wistia.com/medias/52c93wwc5x)
http://altair-2.wistia.com/medias/3y89bitzjn%20)
http://altair-2.wistia.com/medias/3y89bitzjn%20)
https://altair-2.wistia.com/medias/thkt5mhd79?wvideo=thkt5mhd79
https://altair-2.wistia.com/medias/thkt5mhd79
https://altair-2.wistia.com/medias/thkt5mhd79
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Some basic theory on the convergence of finite elements and how to determine the 

convergence rate theoretically and experimentally (published on Youtube by Prof. J. 

Chessa, Texas http://youtu.be/YRJ0c8uO8iU) 

 

 

Webinars 

(Note that the capabilities described in the webinars are now all part of OptiStruct) 

HOW Best Practice Webinars: Stress Calculation and Output in RADIOSS/OptiStruct  

 

http://youtu.be/YRJ0c8uO8iU
http://youtu.be/YRJ0c8uO8iU
http://youtu.be/YRJ0c8uO8iU
http://www.youtube.com/watch?v=YRJ0c8uO8iU
http://www.youtube.com/watch?v=YRJ0c8uO8iU
http://youtu.be/YRJ0c8uO8iU
https://www.youtube.com/watch?v=YRJ0c8uO8iU&feature=youtu.be
https://altair-2.wistia.com/medias/d7vdajqbp6?wvideo=d7vdajqbp6
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14.5 Example: Analysis of A Rotating Disc 

The following illustrates the setup for the analysis of radial and tangential stresses of a 

“rotating” disc (linear static analysis). 

 

Figure: 3D FEM model of a “rotating” disc. Ri=50 mm, Ra=250 mm, Thickness T= 5 mm, 

material properties: E= 210.000 N/mm2,  

Rho=7.9e-9 t/mm3, average element size 10 mm 

Geometry 

The disc may be modeled by creating for instance: 

• 2 circles (Ri = 50 mm; Ra=250 mm)  

 

• Create a filler surface between the two circles 



 

416 
 
 
 

 

• Then drag the surface by 5 mm which results in a closed 3D geometry 

 

 

Meshing 

For the volume meshing the Solid Map Mesh panel may be used. 
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Define center of disc and cylindrical coordinate system 

A cylindrical coordinate system needs to be assigned to the model in order to calculate 

the radial and tangential stresses (Sxx and Syy). 

The center of the disc may be determined by making use of the Distance panel (note: The 

three nodes subpanel is active) 

 

Just select three nodes on the inner hole and select circle center.  
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Repeat this last step for the lower edge of the hole 

 

The two temporary nodes will be used to define the z-orientation of the cylindrical 

coordinate system. This is done by selecting Geometry > Create > Systems > Node 

Reference. 
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This newly created cylindrical coordinate system must be assigned to all nodes of the 

model. To do this, select all nodes, then select graphically the local coordinate system 

(you need to click on it) and select set displacement. 

 

Boundary Condition and Loads 

The disc will be constrained at its inner hole (inner radius) by fixing/deleting the 

translational displacements in the tangential and axial direction. The radial displacements 

are not constrained (free boundary). 

Dof 1 (radial): free, no constraints 

Dof 2 (tangential) = 0 

Dof 3 (axial) = 0 

Remember: The rotational dofs are not available with solid elements 
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The rotational forces due to a constant angular velocity of the disc are created by means 

of a specific card image named RFORCE (rotational forces act in the positive radial 

direction). Note: the modeled disc is not really rotating as this is a static analysis.  

Thus, create another load collector (in this example it is named: rotation) with the card 

image RFORCE. 

 

RFORCE card image: SID refers to the ID of the load collector, G defines the node through 

which the rotation vector acts, CID typically refers to the global Cartesian coordinate 

system, A is the rotational velocity in revolutions per unit time (here 39.789 revolutions 

per second = 250 rad/second); R1-R3 define the rotation axis (here rotation axis is z-

direction). 

Eventually, create a static load step based on the two load collectors named “spc” and 

“rotation”. 
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Material and Property 

Create a material collector using the standard values for steel: 

 

While creating the property collector, keep in mind that the elements are solid elements 

 

Then, assign the property (which internally references the material) to either the 

elements or their corresponding collector. It is up to you. 

That’s it - you are ready to start the analysis. 
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Post-Processing 

Make sure that when creating the stress contour plots that the local cylindrical coordinate 

system is selected. To do this, select under “Resolved in” the System ID of the cylindrical 

coordinate system.  

 

Otherwise the Sxx will be normal stresses in Cartesian coordinates. 

 

Radial averaged element stress. 
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In the image above the element path used for plotting the elemental stresses (at the 

centroid) versus distance is shown. 

 

Radial stresses (at element centroid). Distance is measured from element centroid to 

element centroid, with an average element size of 10 mm. 



 

424 
 
 
 

14.6 Student Racing Car Project: Linear Static 

Analysis 
As the User Profile (hence the FEM solver) is chosen to be OptiStruct, we start the analysis 

from within the panel OptiStruct (Optimization > OptiStruct): 

 

Take care and don’t forget to add the file extension *.fem. The “run options” is set to 

“analysis”. 

Before visualizing displacements and stresses, check the *.out file located in the directory 

where the analysis file was saved in. 

  

In the outfile a model summary, estimated memory, likely warning and errors etc. are 

documented.  
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Hint: The most typical error messages and debugging steps related to a linear static 

analysis are discussed in the video: 

Debugging (http://altair-2.wistia.com/medias/thkt5mhd79) 

 

 

http://altair-2.wistia.com/medias/thkt5mhd79
https://altair-2.wistia.com/medias/thkt5mhd79?wvideo=thkt5mhd79
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15 Modal Analysis 
 

15.1 Introduction 
Normal Modes Analysis, also called eigenvalue analysis or eigenvalue extraction, is a 

technique used to calculate the vibration shapes and associated frequencies that a 

structure will exhibit. It is important to know these frequencies because if cyclic loads are 

applied at these frequencies, the structure can go into a resonance condition that will 

lead to catastrophic failure. It is also important to know the shapes in order to make sure 

that loads are not applied at points that will cause the resonance condition. 

Normal modes analysis is also required for modal frequency response and modal 

transient analysis. In these analyses the problem is transformed from the direct mesh 

coordinates, where the number of degrees of freedom can be in the millions, to the 

modal coordinates where the number of degrees of freedom is just the number of modes 

used. Typically, the upper bound frequency in this case is 1.5 times the highest loading 

frequency or response frequency of interest. 

The Governing Equations - Normal Modes Analysis 

The equilibrium equation for a structure performing free vibration appears as the 

eigenvalue problem: 

   

where K is the stiffness matrix of the structure and M is the mass matrix. Damping is 

neglected.  

The solution of the eigenvalue problem yields n eigenvalues λ, where n is the number of 

degrees of freedom. The vector {Fi} is the eigenvector corresponding to the eigenvalue λ. 
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The eigenvalue problem is solved using Lanczos, AMSES, or AMLS (see further down for 

details) The natural frequency fi follows directly from the eigenvalue λ. 

 

In OptiStruct, normal modes analysis can be performed using one of two algorithms: 

Lanczos or the automated multi-level substructuring eigenvalue solution (AMSES). The 

eigenvalue extraction data for Lanczos is specified on the EIGRL data and for the 

automated multi-level sub-structuring eigenvalue solution method, the EIGRA data is 

used (EIGRL and EIGRA are explained further below). 

In addition, OptiStruct has an interface to the AMLS software developed at the University 

of Texas. AMLS uses the automated multi-level sub-structuring method for eigenvalue 

extraction. The use of AMLS is triggered by using the PARAM AMLS set to YES input data 

in conjunction with the EIGRL card (only). 

The Lanczos Method 

The Lanczos method has the advantage that the eigenvalues and associated mode shapes 

are calculated exactly. This method is efficient for calculations in which the number of 

modes is small, and the full shape of each mode is required. The disadvantage of the 

Lanczos method is that it is slow for large problems with millions of degrees of freedom 

for which hundreds of modes are required. The run times for these types of problems can 

easily stretch into days. In these cases, the AMSES or AMLS method must be used. 

The Automated Multi-Level Sub-Structuring Eigenvalue Solution Method (AMSES) 

The AMSES method has the advantage that only a portion of the eigenvector need be 

calculated. Since only a portion of the eigenvector is calculated, the disk space and disk 

I/O is greatly reduced. This leads to much shorter run times. For typical NVH frequency 

response analysis there is only about 100 degrees of freedom of interest. In these cases, 

solutions of thousands of modes for meshes of millions of degrees of freedom can be 
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solved in just a few hours. The disadvantage of the AMSES method is that the calculations 

are not exact. However, the modal frequencies are still accurate to a few digits. Also, for 

NVH analysis it is important that the mode shapes form modal space that covers all 

possible deformation patterns, but not so important that each individual mode shape is 

accurate. 

More information about AMSES Usage is included in the HyperWorks Help 

Documentation. 

Input Specification 

In order to run a normal modes analysis, an EIGRL or EIGRA bulk data entry needs to be 

given to define the number of modes to be extracted. EIGRL or EIGRA data needs to be 

referenced by a METHOD statement in a SUBCASE in the subcase information section. 

EIGRL and EIGRA are so-called Card Images of a corresponding load collector 

 

 

More information about the EIGRL Card Image is also included in the tutorial “Modal 

Analysis with Altair OptiStruct / HyperMesh” at the end of this chapter). 
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It is not necessary to define boundary conditions using an SPC statement (SPC = Single 

Point Constraint). If no boundary conditions are applied, a zero eigenvalue is computed 

for each rigid body degree of freedom of the model. 

Subcase Definition (Loadstep) 

A normal modes subcase may be explicitly identified by setting ANALYSIS=MODES, but it 

is also implicitly chosen for any subcase containing the METHOD data selector (when the 

ANALYSIS entry is not present). 

In the loadstep/subcase panel (Setup-->Create-->Loadsteps) activate the toggle “type”. 

This opens up a window with a selection of available analysis types .... 

 

 

The following data selectors are recognized for a normal mode’s subcase definition. 

1. METHOD – references an eigenvalue extraction bulk data definition (EIGRL or EIGRA). 

This reference is required.  

2. SPC – references single point constraint bulk data entries (SPCADD or SPC and SPC1).   

3. MPC – references multi-point constraint bulk data entries (MPCADD or MPC).  



 

430 
 
 
 

 

Bulk Data 

Bulk data entries which have particular significance for normal modes analysis include: 

1. EIGRL – specifies the modes to be calculated and solution parameters for the 

Lanczos eigenvalue extraction method.  

2. EIGRA – specifies the modes to be calculated and solution parameters for the 

AMSES eigenvalue extraction method.  

3. PARAM, AMLS, YES – specifies that the AMLS software will be used for eigenvalue 

extraction based on the modal parameters on the EIGRL or EIGRA data.  

4. SPC, SPC1, SPCADD - specify the base where excitation is applied and other 

constraints.  

5. MPC, MPCADD - specify multi-point constraints.  

 Output 

Results of interest from eigenvalue extraction include maximum displacement, modal 

stresses, energies and multi-point constraint forces. These are requested via the I/O 

Options DISPLACEMENT, EKE, ESE, STRESS, GPSTRESS and MPCFORCE respectively. 

Let’s have a look at the model setup in the following tutorial / project. 

15.2 Example: Modal Analysis 
This example originally comes from Tony Gray, modified by Moritz Guenther, Jacob 

Tremmel, Rahul Ponginan and Prakash Pagadala 

Some Hints 

All components in the model must have material and properties 

assigned/defined. Make sure units are consistent and density is defined.  
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(Example - if model is in mm for Steel then: Young’s Modulus = 210.000 MPa, 

Density = 7.9e-9 t/mm3) 

Modal analysis is typically a free or constrained model. A free analysis doesn’t 

require constraints but will generate rigid body modes. You can avoid extracting 

these using variables on the EIGRL card. 

 

 

 

 

 

Let’s Get Started - Work Flow 

• Start HyperMesh and set the user profile to OptiStruct 

• Open the model: model_start.hm 

• Mesh components, create/define material and property 

• Define constraints (if desired) and modal extraction load collector 

• Create load step / subcase 

• Define any special output requests and/or control cards 

Meshing 

Mesh the model using “AutoMesh” panel with element size of approx. 2mm (mixed 

element types) 

1. Access the “Automesh” panel (Menu Bar>Mesh>Create>2D AutoMesh 

http://training.altairuniversity.com/analysis/structural/modal-analysis/modal-analysis/
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2. Select surfs >> displayed  

3. Element size = 2 mm; mesh type: mixed.  

4. Meshing mode “interactive” (lower left corner) 

5. Ensure that “elems to current comp” is active.  

6. Click “mesh” to enter the meshing subpanel 

(Notice that you are in the density subpanel of the automesh panel. Mesh density 

changes etc. could be made there if necessary) 

7. Click “return” to accept the mesh as the final mesh 

Material Definition 

Create a material of type MAT1 (Card image), named “steel”  

1. Right click in Model Browser>Create>Material 

2. Enter name = steel  

3. Click type = and select ISOTROPIC 

4. Click card image = select MAT1  

5. Activate the checkbox next to “Card edit material upon creation” 

6. Click “create” 
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(Notice: If a material property in brackets does not have a value below it, it is off. To edit 

these material properties, click the property in brackets you wish to edit, and an entry 

field will appear below it. Click the entry field and enter a value) 

 

7. Accept the standard values prompted 

E as 2.1e5 N/mm2 

NU as 0.3 

RHO as 7.9e-09 t/mm3 

8. Click return 

A new material, named “steel”, has been created. The material uses OptiStruct’s linear 

isotropic material model, MAT1. This material has a Young’s Modulus of 2.1e+05 MPa, a 

Poisson’s Ratio of 0.3, and a density of 7.9e-9 t/mm3. 
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At any time, the card image for this collector can be viewed & modified with right mouse 

click on the material of interest (or more general, the collector of interest). In the pop-up 

window select “Card Edit” 

Property Definition 

Create a property collector with Card image “PSHELL”, named “prop_model” with 

thickness 1mm.  

Follow the process as described with respect to the material definition and enter the 

corresponding values. Make sure that the previously defined material is referenced. 

 

Finally assign the property collector to all elements: 

 Right click on property collector “prop_model” in the Model Browser, then select 

“Assign” ... 

Loads 

Create a load collector with Card image EIGRL, named “freq”. 

The working steps are similar to the previous ones. The Card Image EIGRL is displayed 

below with V1 = 1.0 and ND = 3. 

 

V1&V2 define the range you wish to extract the modes over. ND defines the number of 

modes you wish to find. Various combinations of these cards can be used to control what 
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is extracted. This combination extracts the first 3 modes above 1 Hz. Setting V1 to 1.0 is 

a “trick” to avoid the extraction of rigid body modes. 

Note: MORM specifies the Method used for eigenvector normalization. If MASS, then 

eigenvectors are normalized to the unit value of the generalized mass (this is not a valid 

option for linear buckling analysis). If MAX, then eigenvectors are normalized to the unit 

value of the largest displacement in the analysis set. Default = MASS for normal modes 

analysis; Default = MAX for linear buckling analysis (MASS or MAX).  

If you use the default (MASS) for normal mode analysis, then the deformed plot in 

HyperView may show very high “displacements”. This is because HyperView displays 

deformations (by default) using the scale option “Model units”. Thus, simply use a scale 

factor < 1 to display the deformed structure. Alternatively, change “Scale: Model units” 

to “Model percent”.   

Finally, click return. 

Loadstep / Subcase 

Create a subcase called “modal” which refers to the EIGRL card defined before. This is 

done using the METHOD card as shown below.  

1. Click Setup > Create > LoadSteps  

2. name =modal; type = normal modes 

3. Activate METHOD (STRUCT) and select the load collector with the EIGRL card image.  
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Analysis 

In the Control Cards (located on page Analysis >Control Cards>) set the SCREEN output to 

OUT 

Save the model then run the analysis from the OptiStruct panel (Analysis > OptiStruct). 

You should see the following results. Note the first frequency is 429 Hz. 

 

Start HyperView, load the corresponding *.h3d file and open up the “deformed panel”.  

Change “Scale: Model units” “Model percent”, then click “Apply”. 

 

You will be able to animate the 3 mode shapes using the modal button.  

Annotation / Remark 

Edit the EIGRL card by removing V1 and set ND to 10 (= the first 10 modes). 
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Re-run the model. Note the first 6 modes are now very small – these are the 3 

translational and 3 rotational degrees of freedom. 

 

15.3 Example: Modal Analysis with Constraint Model 
1. Create another load collector (using no card image) called “constraints” 

2. From Model Browser expand LoadCollectors, right-click on constraints and click “Make 

Current” to set constraints as the current load collector. 

3. Fully constrain (all 6 dofs) the nodes around each hole as illustrated in the image below.  
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• Click BCs > Create > Constraints to open the Constraints panel.  

• Select the nodes around the two holes  

• Constrain dof1, dof2, dof3, dof4, dof5, and dof6 and set all of them to a value 

of 0.0. 

Note: 

Dofs with a check will be constrained, while dofs without a check will be free. 

Dofs 1, 2, and 3 are x, y, and z translation degrees of freedom. 

Dofs 4, 5, and 6 are x, y, and z rotational degrees of freedom. 
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• Click create 

• Click return to go to the main menu 

• Update the existing loadstep/subcase to include this SPC (= Single Point 

Constraint) 

• Click Setup > Create > LoadSteps to open the LoadSteps panel. 

• Select SPC and then click on the field next to SPC and select the constraints 

load collector created above,  

 

Finally, re-run the analysis. Note that the rigid body modes are gone. 
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15.4 Tips & Tricks Regarding Post-Processing 

Result Information Which Needs to Be Requested Prior to The Analysis  

Sometimes you want more data from your analysis or your results in different formats. 

Note that by default OptiStruct creates an HTML file summarizing the analysis and writes 

a HyperMesh results file. To get results in other formats e.g. H3D use the output control 

card (Analysis > Control Cards >….). 

 

Another output that is often useful in modal analysis is element strain energies. You can 

request these using the ESE function of the GLOBAL_OUTPUT_REQUEST control card 

(Analysis > Control Cards > ….). 
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The strain energy results allow you to identify areas critical to given modes 

 

Post-Processing with HyperView 

1. Load the .h3d file into HyperView using Load model  

2. Use the Shaded Elements and Mesh lines button to turn the mesh on 

3. Use the Contour button and plot Strain Energy 

4. Change the traffic light from transient to linear/modal 

5. Animate the first mode by clicking the Play button 

6. If the deformation is too large change it to Model percent (10%) using the Deformed 

options 

7. Add more frames and control the speed of the animation using the Animation controls 

button 

8. Step through the modes using load case selector 
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Videos / Webinars 

 

https://altair-.wistia.com/medias/lr7un6kib7 

https://altair-2.wistia.com/medias/lr7un6kib7?wvideo=lr7un6kib7
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16 Linear Buckling Analysis 

This chapter includes material written by Markus Kriesch and André Wehr (Universität der 

Bundeswehr München) as well as material from Matthias Goelke. 

16.1 Introduction 
The demand for automobiles with less fuel consumption and less emissions has increased 

since the year 2000 because of rising commodity prices. However, the quest for light 

weight designs is (partly) counterbalanced by the additional weight related to passive and 

active safety systems and the steadily increasing comfort level for passengers. This 

creates a demand for intelligent lightweight concepts in many industries, not only in 

aerospace and automotive. 

 

Besides the lightweight design, the increasing usage of optimization software leads to 

thin-walled and slender components which tend to buckle under axial loading. 

Thin structures subject to compression loads that haven’t achieved the material strength 

limits can show a failure mode called buckling. Buckling is characterized by a sudden 
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failure of a structural member subjected to high compressive stress, where the actual 

compressive stress at the point of failure is less than the ultimate compressive stresses 

that the material is capable of withstanding (may be helpful is the explanation on 

Wikipedia (if still alive) http://en.wikipedia.org/wiki/Buckling) 

In other words, once a critical load is reached, the slender component (for example a 

beam where its length is much larger than its cross-sectional area) draws aside instead of 

taking up additional load.  

 

Force versus displacements of a slender beam; from Ihlenburg: Skript Technische Mechanik 2.7 Knicken. HAW 

Hamburg – FB MP; 2012 

This failure can be analyzed using a technique well known as linear buckling analysis. The 

goal of this analysis is to determine the buckling load factor, λ, and the critical buckling 

load.  

In OptiStruct, if the load factor λ is > 1, the component is considered to be safe (i.e. the 

actual load can be multiplied by λ until buckling would occur). 

http://en.wikipedia.org/wiki/Buckling
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16.2 Elastic Buckling 

 

Euler buckling cases; K=effective buckling length factor; L=unsupported length of column 

(from Läppele, Volker: Einführung in die Festigkeitslehre; Vieweg+Teubner Verlag; 2011) 

In 1757 Leonhard Euler derived the following equation: 

Fcrit = π2 Ε Ι / (K L)2 = π2 Ε Ι / s2 

where 

F = maximum or critical force (vertical load on column) 

E = modulus of elasticity; I = area moment of inertia (second moment of area) 

L = unsupported length of column 

K = column effective length factor, whose value depends on the conditions of the end 

support of the column, as follows:  

• For both ends pinned (hinged, free to rotate), K = 1.0 

• For both ends fixed, K = 0.50 

• For one end fixed and the other end pinned, K = 0.707 

• For one end fixed and the other end free to move laterally, K = 2.0 
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KL = the effective buckling length of the column 

In other words, the critical force depends on: 

• Length of column 

• Cross-section (second moment of surface area) 

• Material property (Young’s modulus, in case of elastic material) 

• Boundary condition (The boundary conditions determine the mode of bending and 

the distance between inflection points on the deflected column. The closer together 

the inflection points are, the higher the resulting capacity of the column.) 

The strength of a column may therefore be increased by distributing the material so as 

to increase the moment of inertia.  This can be done without increasing the weight of the 

column by distributing the material as far from the principal axis of the cross section as 

possible, while keeping the material thick enough to prevent local buckling. This bears 

out the well-known fact that a tubular section is much more efficient than a solid section 

for column service. 

Note: Real constructions often contain imperfections, such as pre-deformations, due to 

which large displacements or failure may occur even if the loading is still below the ideally 

critical load. The linear buckling analysis in general overestimates the strength/ stability 

of the structure and leads to non-conservative results. Thus, it shouldn’t be used as the 

only measure.  However, the linear buckling analysis at least provides information about 

the expected deformation shapes. 

Looking at Euler’s equation and dividing it by the area A defines the critical stress at which 

buckling will occur: 

σkrit = Fcrit / A ≤ Re 
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where Re is the elastic limit. 

σkrit = Fcrit / A = π2 E I / A s2 = π2 E / λ2 ≤ Re 

with           λ = s / √ (I / A) 

16.3 Linear Buckling Analysis with OptiStruct 
The problem of linear buckling in finite element analysis is solved by first applying a 

reference level of loading, Fref to the structure. This is ideally a unit load, F, that is applied. 

The unit load and respective constraints, SPC, are referenced in the first load steps/ 

subcase. A standard linear static analysis is then carried out to obtain stresses which are 

needed to form the geometric stiffness matrix KG. The buckling loads are then calculated 

as part of the second loadsteps/subcase, by solving an eigenvalue problem: 

(K-λKG) x = 0 

Κ is the stiffness matrix of the structure and λ is the multiplier to the reference load. The 

solution of the eigenvalue problem generally yields n eigenvalues λ, (buckling load factor) 

where n is the number of degrees of freedom (in practice, only a subset of eigenvalues is 

usually calculated). The vector x is the eigenvector corresponding to the eigenvalue. 

The eigenvalue problem is solved using a matrix method called the Lanczos method. Not 

all eigenvalues are required. Only a small number of the lowest eigenvalues are normally 

calculated for buckling analysis. 

The lowest eigenvalue is associated with buckling. The critical or buckling load is: 

Fcrit = λcrit Fref 

In other words,  

λcrit = Fcrit / Fref  
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thus               

 

Note: The displacement results obtained with a buckling analysis depict the buckling 

mode shape. Any displacement values are meaningless. The same holds true for stress 

and strain results from a buckling analysis. 

From Theory to Practice: How to Set Up a Linear Buckling Analysis 

In order to run a linear buckling analysis, the following two steps are required: 

Step 1 

 3 load collectors and 2 loadsteps/subcases must be specified: 

• One Load collector for constraints (SPC = SinglePoint Constraints; no Card Image 

needed) 

• One Load collector for loads (ideally unit load); no Card Image needed 

• One load collector (with Card Image EIGRL) which defines the number of buckling 

modes to be determined (card image shown below) 

• ND = 1: This tells OptiStruct to extract the first buckling mode 

 

Step 2 

Defining of 2 loadsteps; one for static and for buckling. The load collectors with the SPCs 

and the unit load define a static load subcase.  Notice that the type is set to linear static: 
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Then the buckling load step (which needs the results from the static loadstep) is defined: 

 

As before SPC references the load collector which contains the model constraints. 

STATSUB(BUCKLING) is referencing the static subcase/loadstep from before, and finally, 

METHOD references the load collector which bears the information about the number of 

eigen (buckling) modes to be extracted (i.e. load collector with Card Image EIGRL). Also 

notice that the type is now set to= linear buckling.  

Note:  

• STATSUB cannot refer to a subcase that uses inertia relief. 

• The buckling analysis will ignore zero-dimensional elements, MPC, RBE3, and CBUSH 

elements. These elements can be used in buckling analysis, but they do not 

contribute to the geometric stiffness matrix, KG.  

• By default, the contribution from the rigid elements to the geometric stiffness matrix 

is not included. Users have to add PARAM, KGRGD, YES to the bulk data section to 

include the contribution of rigid elements to the geometric stiffness matrix. 

• In addition, through the EXCLUDE subcase information entry, users may decide to 

omit the contribution of other elements to the geometric stiffness matrix, effectively 
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allowing users to control which parts of the structure are analyzed for buckling. The 

excluded properties are only removed from the geometric stiffness matrix, resulting 

in a buckling analysis with elastic boundary conditions. This means that the excluded 

properties may still be showing movement in the buckling mode. 

 

16.4 Example: Linear Buckling Analysis of a Beam 

Structure 

Step 1 

Launch HyperMesh, select the OptiStruct User Profile and retrieve the file 

BAR_EULER_1.hm: 

 

Imported model “BAR_Euler_1.hm”. The 1D elements are displayed via 3D Element Representation,  

 

 

ftp://ftp.altair.de/pub/edu/protected/Buckling/BAR_Euler_1.hm
ftp://ftp.altair.de/pub/edu/protected/Buckling/BAR_Euler_1.hm
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Model information:   

b = 10 mm 

h = 20 mm 

l = 1000 mm 

E = 210.000 N/mm2, ν=0.3 (steel) 

Area moment of inertia = 1.666,667 mm4 

Analytical critical buckling force Fcrit = 863,59 N (Euler case 1) 

  

The model is built on 1D elements (of type CBAR) with Property Card Image PBARL (in 

case you are interested to learn more about 1D elements, please see the corresponding 

chapter in this book). The material parameters correspond to steel.  

In order to better understand the model details, please review the Card Images of the 

property and material collector, respectively.  

Step 2 

Create three load collectors. 

• SPC (Single Point Constraints; no Card Image) 

• Force (static unit load; no Card Image) 

• Buckling (with Card Image EIGRL) 

The load collectors can be easily created through right-click in the Model Browser 

window, and activate the option Create > Load Collector. 

Then simply assign names and colors or your choice, respectively. 
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Creation of load collectors SPC and force (no Card image needed) 

 

Creation of the load collector named “buckling” with Card Image EIGRL 

Clicking “Create” will bring up the Card Editor for this load collector: 

 

Card Image EIGRL 

In the Card Image, activate ND and enter in a value of 1. This tells OptiStruct to extract 

the first buckling modes.  
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Step 3 

Create the loads and boundary conditions. Make sure that the respective load collector 

is set to be the current collector (in the Model Browser right-click on, for instance SPC 

and select “Make Current”). 

 

“Model Browser”. The load collector names SPC is set to be the current collector and hence listed in bold letters 

In the constraints panel (BCs > Create > Constraints) select the node on the bottom face 

of the beam, as shown in the image below.  All degrees of freedom dof are constraint 

(dof 1-6= 0). 

 

Constraint panel. The node at the lower end of the column is constraint with respect to all of its dof’s 
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Next, set the load collector force as the current collector and create the reference load 

(unit load). In the forces panel (BCs > Create > Forces) the node at the top of the beam is 

selected, as shown in the figure below: 

 

Force Panel. A reference unit load in negative x-direction is applied (magnitude= -1, x-axis) 

Step 4 

Create the loadsteps. For the linear buckling analysis, two loadsteps/subcases are 

required. 

• Linear static loading 

• Linear buckling analysis 

The subcases are created in the Loadsteps panel which can be accessed from the menu 

bar by selecting Setup > Create > LoadSteps.  

Make sure the type is set to linear static. In here SPC references the single point 

constraints load collector (named SPC), and LOAD the load collector with the reference 

load (load): 
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Loadsteps panel (definition of a linear static subcase) 

In the second loadstep, the buckling loadstep, make sure the type is set to linear buckling: 

 

Loadstep panel (Definition of the linear buckling subcase) STATSUB references the static subcase and METHOD the load 

collector with the information about the buckling modes to be determined 

That’s all it takes – time to run the analysis. 

Step 5 

Start the computation run of OptiStruct. On the Analysis page, select the OptiStruct panel, 

chose the working directory and then save the model as .*fem (the extension *.fem 

indicates in input files for OptiStruct). Finally, click OptiStruct to execute the calculation. 

With the start of the calculation, the Solver View appears. This shows the steps of the 

calculation and possible errors 

in the Message log area. 

 

Note: the *.out file includes 

information from the model 

check run before the 

calculation as well as 

additional base information of 

the calculated results. Also, 
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check this file error messages and warnings that will help you debug your input deck if 

any errors are present. In general, always view this file, even if the analysis run was 

successful. 

 

Step 6 

Postprocessing of the analysis. If the job is successful, you should see new results files in 

the working directory. The working directory is the directory where the model was saved. 

The default files that will be written to your directory are: 

File Explanation 

*.h3d Binary HyperView result file 

*.res Includes all the results of displacement through stress, which 

can be shown in the Post panel of HyperMesh 

*.out ACSII-based output file, which includes information about the 

model check run before the calculation and additional base 

information of calculation results 

*.stat Detailed breakdown of the elapsed CPU-time for all important 

analysis steps 

Table: Standard computed files 

To view the results, start HyperView.  

Make sure and pay attention to the loadstep/subcase selected for display.  This is 

controlled in the Results Browser. 
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Subcase 2 “buckling” in HyperView. Reference (undeformed) model in blue 

The critical buckling load for the calculated bar (with unit load 1 N) is F = 863,53 N (critical 

buckling factor λcr = 863.53). In other words, the model could be loaded 863 times the 

unit load until buckling would occur.  Of course, we need to remember that this is an 

ideally linear buckling analysis and that real parts tend to buckle at lower loads than the 

theoretical value due to imperfections. 

 

16.5 Example: Wing Linear Buckling Analysis 
This exercise runs a linear buckling analysis on a simple aircraft wing. This is a typical 

problem for aerospace structures that need to be very light and consequently become 

slender.  Because the structure has a high slenderness ratio, the buckling failure 

verification becomes necessary. The objective of this project is to verify if the 3 static load 

cases applied to the wing will not make it fail. 

In this exercise, you will learn how to verify a wing baseline design for buckling criteria. 
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Model Information (Wing.hm): 

Design Criteria: 

  Buckling: first mode > (1.5 x). 

  (Static: U < 20 mm and Von Mises < 70 MPa) 

Material Aluminum: 

  ρ = 2.1e-9 T/mm3 [RHO] Density    

E = 70.000 MPa [E] Young’s modulus    

ν = 0.33 - [nu] Poisson’s ratio 

In the given model (Wing.hm), the load, constraints and loadcases have already been 

created. Please review the property, material, and load collectors before starting the 

baseline analysis. 

Here, we focus on the load collectors: 

 

ftp://ftp.altair.de/pub/edu/protected/Buckling/wing_complete.hm
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Left: Applied constraints (green triangles) are in the load collector constraints. Right: Applied pressure (yellow arrows) 

are in the load collector pressure. 

 

Tip load at the wing (purple arrows are in the load collector tip_load) 

In the load collector named SUM (with Card Image LOAD), the loads from the load 

collectors’ pressure (ID=2) and tip_load (ID=3) are combined.  S, S1(1), and S1(2) are 

weighting factors, respectively. 
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The three static loadsteps are: 

 

 

 

 

 

Note, the analysis type is set to linear static, respectively. 

In order to define the buckling load step, another load collector is needed. Do you recall 

what the missing load collector is about? 

We need to create a load collector with Card Image EIGRL (to define the number of 

buckling modes we are interested in). 
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It’s Card Image is 

 

 

With respect to the loadsteps of interest, 

 

we define the buckling loadsteps next.  

Please compare the ID’s of the referenced load collectors (SPC= and METHOD =) and 

loadstep (STATSUB =) 

 

 



 

463 
 
 
 

 

 

Finally, run the analysis and view the buckling modes. 

16.6 Example: Buckling with Gravitational Load  

Typically, the critical load factor is determined with respect to all loads defined in the 

referenced linear static loadcase (referenced by STATSUB).  

In case the critical load factor should only be applied to variable loads (e.g. pressure, 

forces) and NOT to the gravitational load (constant load), the two procedures/techniques 

described below may be employed. The below described working steps are considered in 

the model file: Prestressed_gravity.zip. 

Working Procedure - A 

In case gravitational and variable loads are to be considered, the following load collectors 

are required: 

• Load collector for variable loads (here named force; no Card Image needed) 

• Load collector for gravity (Card Image GRAV; remind the system units)  

 

Load collector which combines variable and constant loads (Card image LOAD needed; 

here named: gravity_and_force). 

ftp://ftp.altair.de/pub/edu/protected/Buckling/prestressed_gravity.hm
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In the Card Image above, L1(1) is linked to the gravity load collector, L1(2) refers to the 

variable load (in this case, force).  S, S1(1) and S1(2) are scale factors, respectively. 

In addition, we have a load collector for the model constraints (here named spc; no Card 

image needed) and a load collector which defines the number of eigenmodes to be 

extracted (Card Image EIGRL, here the load collector is named EIGRL).  

Step 1:  

Determine the critical load factor for all loads (constant and variable loads).  We may call 

this critical load factor buckling_all (i.e. run the buckling analysis taking into account all 

loads). 

Step 2: 

Scale the constant load, L1(1), by adjusting the associated scale value S1(1) in the Card 

Image of the load collector: 

S1(1) = 1 / [critical load factor “buckling_all”] 
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The scale factor S1(2) of the variable load L1(2) remains unchanged i.e. S1(2)=1.0. 

Step 3: 

Run the buckling analysis with the newly scaled value for the gravity load, L1(1).  We call 

this additional buckling analysis and critical load factor, A_buckl_grav_force. 

Provided that the buckling factor A_buckl_grav_force equals buckling_all, 

everything is fine, because then: gravitational load L1(1) = L1(1) / [critical load 

factor buckling_all] * [critical load factor A_buckl_grav_force] 

However, if A_buckl_grav_force ≠ buckling_all then Step2 to Step 3 must be repeated 

iteratively.  

Now the gravity load L1(1) is scaled by A_buckl_grav_force: 

S1(1) = 1 / [A_buckl_grav_force] 

This will lead to another buckling value which may be called B_buckl_grav_force and so 

on. 
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Eventually, when the new (e.g. C_buckl …) and the last (e.g. B_buckl …) buckling factors 

are equal, an additional review buckling analysis can be carried out. In this analysis, ALL 

loads are scaled by the last buckling factor e.g. C_buckl … 

 

This buckling analysis will then depict a buckling factor very close to ±1. 

Working Procedure - B 

Starting with the OptiStruct solver update HW11.0.220-HW (July 2012) the above 

described process becomes much easier and straighter forward. 

In addition to the load collectors spc” and EIGRL (see above), we now need the two load 

collectors: 

• Load collector for variable loads (here named force; no Card Image needed) 

• Load collector for gravity (Card Image GRAV; remind the system units)  

 

Based on these two load collectors, the two loadcases are defined: 

• Loadcase forces_only  
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• Loadcase gravity_only 

 

Note: Currently (July 2012) the definition of a buckling loadstep in which the 

gravitational/constant loads are neglected requires you to select type: generic.  

As before SPC references the model constraints, METHOD (STRUCT) references the load 

collector with the Card Image EIGRL, 

 

STATSUB (BUCKLING) references forces_only, and 

 

eventually, the gravity loading gravity_only is applied as a pre-load. 
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You can view the load collectors and loadsteps in the file: prestressed_gravity.hm 

16.7 Linear Buckling Analysis Tutorials and Videos 

Recommended Tutorials: 

The following tutorial is part of the HyperWorks Help Documentation: 

• OS-1040: 3D Buckling Analysis using OptiStruct 

Demo Files: 

• Buckling analysis of a bottle 

• Buckling analysis of the central wing of aircraft 

• MBD Cable showing torsional buckling 

 

 

 

 

 

 

http://www.altairhyperworks.com/hwhelp/Altair/hw11.0/help/hwtut/rd1040.htm
http://www.altairhyperworks.com/ResLibDownload.aspx?file_id=206&keywords=buckling&industry=All&product_service=All&category=All&order_by=date_created&order_by_da=desc&resource_id=365
http://www.altairhyperworks.com/ResLibDownload.aspx?file_id=205&keywords=buckling&industry=All&product_service=All&category=All&order_by=date_created&order_by_da=desc&resource_id=364
http://www.altairhyperworks.com/ResLibDownload.aspx?file_id=210&keywords=buckling&industry=All&product_service=All&category=All&order_by=date_created&order_by_da=desc&resource_id=369
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Videos on Youtube 

• HyperMesh 12 - Tower – Buckling (http://youtu.be/BueeQiwc0JY , 15 minutes) 

 

 

• Buckling of a Thin Column (http://youtu.be/wrdO8hPJGyg , 8 minutes) 

 

 

http://youtu.be/BueeQiwc0JY
http://youtu.be/BueeQiwc0JY
http://youtu.be/wrdO8hPJGyg
http://youtu.be/wrdO8hPJGyg
https://www.youtube.com/watch?v=BueeQiwc0JY&feature=youtu.be
https://www.youtube.com/watch?v=wrdO8hPJGyg&feature=youtu.be
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17 Post-Processing 
This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 

Infinte)”. It also has been reviewed and has additional material added by Kristian Holm, Hossein 

Shakourzadeh and Matthias Goelke. 

*Please note that this chapter is mostly intended for post-processing of linear analysis 

results. Not all the comments made are relevant for crash or nonlinear analysis.  

17.1 How to Validate and Check Accuracy of The 

Result 
Finite Element Analysis is an approximate technique. The level of accuracy of the 

displayed results could be 25%, 60%, or 90% with respect to the experimental data. The 

following checks helps in reducing the error margin  

 

• Visual check – Discontinuous or an abrupt change in the stress pattern across the 

elements in critical areas indicate a need for local mesh refinement in the region.  

• 10 to 15% difference in FEA and experimental results is considered a good correlation 

Computational Accuracy  Correlation with actual testing 

1) Strain energy norm, residuals 

2) Reaction forces and moments 

3) Convergence test 

4) Average and unaverage stress difference 

1) Strain gauging – Stress comparison 

2) Natural frequency comparison 

3) Dynamic response comparison 

4) Temperature and pressure  

     distribution comparison 

FEA Accuracy 
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• Probable reasons for more than 15% deviation – wrong boundary conditions, 

material properties, presence of residual stresses, localized effects like welding, bolt 

torque, experimental errors etc.  

Computational accuracy does not guarantee the correctness of the Finite Element Analysis (i.e. the component may still 

behave in a different way in reality, than what’s being predicted by the software). Correlation with test results or approval 

of the results by an experienced CAE / Testing department engineer (who has worked on a similar product / component over 

the years) is necessary. One has to distinguish between the FE error due to the quality of mesh and the deviation of the 

mathematical model to the physical problem related to modeling assumptions 

17.2 How to View and Interpret Results 

Important Rule of Thumb 

Always view the displacement and animation for deformation first, and then any other 

output. Before viewing the result please close your eyes and try to visualize how the 

object would deform for the given loading conditions. The deformation given by the 

software should match with this. Excessive displacement or illogical movement of the 

components indicate something is wrong. 

 

The displacements shown in the plot below is exaggerated to be able to see the results 

properly. The true (scalefactor = 1.0) displacement might not be visible at all due to a very 
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small magnitude. Therefore, most of the post processors provide the ability to display 

scaled results (without actually changing the magnitude of the results). 

 

Displacement contour plot; displacements scaled by factor 100. 

An extremely useful visualization technique is to animate results. This option is also (and 

especially) useful while interpreting results from a static analysis. The animated motion 

of the model provides insight into the overall structural response of the system due to 

the applied loads (and constraints).  

 

 

Check Reaction Forces, Moments, Residuals and Strain Energy Norms 

Comparing the summation of applied forces or moments and reaction forces or moments, 

external and internal work done, and residuals helps in estimating the numerical accuracy 

of the results. The values should be within the specified limits. This can be activated by 

selecting Check > Loads Summary (under the OptiStruct UserProfile). 

The following summary table about the applied loads can be output: 
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Results data such as SPCFORCE etc. must be requested through the 

GLOBAL_OUTPUT_REQUEST (Setup > Create > Control Cards). 

 

 

Then, in the corresponding *.out file the following summary is provided: 
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Stress Plot 

The location and contour in the vicinity of the maximum stress should be observed 

carefully. Discontinuities, or abrupt changes, in the stress pattern across the elements in 

critical area indicates the need for local mesh refinement. Commercial software offer 

various options for stress, like nodal, elemental, corner, centroidal, gauss point, average 

and unaverage, etc. Unaverage, corner, or nodal stress values are usually higher than the 

average, centroidal or elemental stress values. 



 

475 
 
 
 

 

Which stress one should refer to? If you were to ask this question to FEA experts from 

different companies, nations, or commercial software representatives, and you will be 

surprised to hear different answers; everyone confident about the practice that is 

followed by his or her company or software. The best way to understand the output 

options of a specific commercial software and to decide which stress one should be refer 

to is to solve a simple problem with a known analytical answer (like a plate with a hole) 

and compare the analytical answers with the various options. 

Interestingly, if the same results are viewed in different post processors, it would show 

different result values. This is due to the software’s default settings (some software 

default settings are to average the stress while others is to not average, some prefer 

elemental while other’s nodal, etc.). 
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Convergence Test 

 

In general, increasing the number of nodes improves the accuracy of the results. But at 

the same time, it increases the solution time and cost. Usual practice is to increase the 

number of elements and nodes in the areas of high stress (rather than reducing the global 

element size and remeshing the entire model) and continue until the difference between 

the two consecutive results is less than 5 to 10%. In the case of application of point forces 

on a FE model or the application of a boundary condition on a node, a high stress value 

can be observed. Refining the mesh around this point is not a solution as the theoretical 

stress value is infinite. See also the video of Prof. Chessa about “Convergence of Finite 

Elements” ( http://www.youtube.com/watch?v=YRJ0c8uO8iU). 

Meshing for Symmetric Structures Should Be Symmetric Otherwise the Analysis Would 

Show Unsymmetric Results (even for symmetric loads and restraints) 

In the above figure stress is higher at one of the holes though the loading, restraints, and 

geometry are symmetric. This is due to meshing that was carried out using the auto 

meshing option. It created an unsymmetric mesh even though an equal number of 

elements were specified on both of the holes. 

file:///C:/Users/Gabriel/Desktop/Altair/eBooksReview/(%20http:/www.youtube.com/watch%3fv=YRJ0c8uO8iU)
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Importance of Duplicate Element Check 

Always perform a duplicate element check before running the analysis: Duplicate 

elements are very dangerous and might go undetected (if scattered and not on the outer 

edge or boundary of the structure) in the free-edge check. Duplicate elements add extra 

thickness at respective locations and result in too less stress and displacement (without 

any warning and error during the analysis). 

To check for duplicate elements, activate the “Check” panel  . 

 

By the way, we only talk about duplicate elements, if these elements share the same 

nodes! Elements which lie on top of each other (but do have different nodes) are not 

duplicated. Please think this definition over! 
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Selection of Appropriate Type of Stress: 

• VonMises stresses should be reported for ductile materials and maximum principal 

stresses for brittle material (casting) components. 

• For nonlinear analysis, we should pay attention to true and engineering stress. 

• True stress: is defined as the ratio of the applied load to the instantaneous cross-

sectional area 

• With engineering stress, the cross-section remains constant. 

Additional Questions to Ask 

The following questions are also valuable when validating a linear analysis after 

computation: 

• Is the maximum stress less than yield stress? 

• Are the displacements are small with respect to the characteristic structural size? 

• Is there any rotation larger than 10°? 

• Is there any overlaps after deformation (contact)? 

17.3 Post-Processing in HyperView 
The open architecture of HyperView allows for loading and viewing result files obtained 

from several sources. Based on the solver type of the files and the results you would like 

to visualize and analyze, there are different ways to load the input deck and their 

corresponding results into HyperView. This chapter guides you through the various ways 

you can load your files and the various tools available for viewing the model according to 

your interest. 

To begin post processing, in the HyperWorks Desktop Version split the screen:  
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and then activate the client HyperView. 

 

To access the Load Model panel: 

• Click the Open Model button   from the Standard toolbar. 

or 

• From the menu bar, select File > Open > Model 

The Load Model panel allows you to load the result files along with the model files. If the 

result file already contains the model definition, it is not a requirement that you load the 

model file along with the results. However, when only result files are loaded, the 

component definitions such as name and color are not preserved. The solver definition 

for component names along with the default color settings is loaded. You can also choose 

to load only a model or result file. 
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There are a couple of options in this panel: Overlay, Result math template, and Reader 

Options. The Result math template option allows you to select a template to be loaded 

into the Derived Result panel. The options are Standard, Advanced, NVH, Composite or 

None.  The Reader Options button opens a window where different options can be 

specified for the different results readers. 

Activating the Overlay check box in the panel allows you to load multiple models and 

their results into a single window. You can then set the active model in the window from 

the Results Browser. This is done by selecting the model from the model list in the Results 

Browser: 
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Supported Solver Result File Formats 

The following solver result file formats are supported by HyperView: 

HyperMesh results (RES) file Hyper3D (H3D) file 

Altair FLX file Altair MRF file 

ABAQUS ODB file NASTRAN OP2 file 

LS-DYNA D3PLOT and PTF files ADAMS GRA and RES files 

ANSYS RST and RTH files DLM or LS-DYNA DYNAIN files 

FEMZIP DSY file  DYNA DB file 

MADYMO KIN3 (KN3) and FAI files MARC T16 file 

NIKE3D N3PLOT file OptiStruct OP2 file 

PAM-CRASH DSY file RADIOSS A001 file 

DADS BIN file Moldflow UDM file 

Universal UNV file  

In addition to the solver result file formats supported through direct readers, HyperView 

supports additional solver formats via result translators.  

After reading in the results file (for example, *.h3d) have a look at the global 

displacements. 

Activate the icon   and specify the Result type: as Displacement.  

Ask yourself:  

• Are the displayed magnitudes reasonable?  

• Magnitudes in the order of e.g. 10e5 indicate that the model is pursuing a rigid 

body motion —> constraints are erroneous.  
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• Check the constraints in some detail 

• Is the “response” of the model “correct”?  

    

Tip: Animate your results—even though it was a static analysis and check the global and 

local (where the constraints are placed) model behavior. 

 

General Remark: FEM programs do not check whether the input data are meaningful. For 

instance, there may be typos in the Young ‘s modulus, element thickness, magnitude of 

your loading, wrong constraints, mesh “mistakes“ etc. As long as the FEM can solve the 

equations — you will get a result, regardless of whether it is correct or not. 

Contour Plots 

A contour plot generates color bands on the model, based on the values found in the 

results file. A contour plot can be created from tensor, scalar, vector, or complex results. 

There are two different ways to contour results in HyperView; the Contour panel and the 

Results Browser. There are advantages to using each tool. Below an in depth look at each 

tool is shown and the advantages are discussed. 
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The Contour Panel 

The “contour” panel allows you to contour a model and graphically visualize the results. 

In the contour panel you can view vector,  

tensor, or scalar type results. To access the contour panel either click the contour panel 

button   on the results toolbar or select Results > Plot > Contour from the menu bar. 

 

This panel, like most panels in HyperView, works from left to right. First the result type is 

defined, then the selection and resolved in system is selected, and finally the averaging 

method is defined. After these setting, the display and legend options are defined. 

Result Type  

From the drop-down menus under the result type field, vector, tensor, or scalar result 

types are selected. First the result type (displacement, etc) is selected, then the 

component of the result type is selected (X, Y, Mag, etc). There is also an option, Entity 

with layers, that allows you to display a contour for a specified element layer when a layer 

definition is available for an element. The final option available under the result type 

heading is the Use corner data checkbox. This option is only active when corner data is 

available in the results file. When this option is selected, HyperView displays color bands 

by interpolating available corner results within each element. This allows for a 

discontinuity of the result distribution across element boundaries to be seen. 
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Selection  

Next the selection on which the contour should be applied is selected.  Before creating a 

contour plot, you may pick one or more entities from the model. You can do this by 

picking entities directly from the screen, using the quick window selection, or clicking 

the Elements, Components, or Assemblies input collector and using the extended entity 

selection menu. If no selection is made, the contour will be applied to displayed 

components or elements by default. 

Resolved in  

This drop-down menu allows you to select the result coordinate system to be used to 

contour the results. The available options are dependent on the current selection for the 

Averaging method. You can select the global, element, or analysis coordinate system as 

well as a user-defined system.   

• Global System: Transforms to the global system. 

• Elemental System: Transforms results to the element coordinate system. In 

HyperView, the element coordinate system is defined by element connectivity. 

• Analysis System: Displays the vector and tensor results as they are output from the 

solver. 

• User System: This option is available when the results file contains a user-defined 

coordinate system. The System input collector is enabled when User System is 

selected. Select a system by ID or pick from the screen. 

The Results Browser 

Within the Results Browser there is the Result View. The Result View shows a hierarchical 

view of available results for the current load case. The result types are grouped by their 

type, and are broken up into Scalar, Vector, and Tensor folders. You can expand the folder 

to see all of the details for each result type. For example, each of the Scalar, Tensor, and 
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Vector folders are expanded to see the Result Type within the folders. By selecting one 

of those Result Types (for instance, Stress), the different Components are shown: 

 

To apply a contour plot using the Results Browser, simply click on the icon to the left of 

the result to be used for the contour.  For example, in the plot below, the vonMises 

component for Stress is contoured. 
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Viewing Deformed Shapes 

The “deformed” panel allows you to specify parameters for deformation display. You can 

use this function to see the motion of your model after analysis. You can display the 

original structure and the deformed shape to see the total amount of movement or view 

the deformed shape by itself. You can also create an animation sequence of the 

structure’s movement that shows the motion of the structure in a series of frames, based 

on what the analysis code has predicted the model will do. 

To access the “deformed” panel: 

• Click the Deformed panel button   on the Results toolbar. 

• From the menu bar, select Results > Plot > Deformed  
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The first step in the Deformed panel is to define the Deformed shape. This includes 

defining the Result type and Scale factor to be applied. The Result types available in this 

panel depend on the result file that was imported. For example, all result files have 

Displacement (v) loaded as a Results type, but OptiStruct also has Rotation (v), 

Eigenvector (v), and Shape change (v) available.   

Once the result type is determined, the scale factor needs to be assigned. The “Scale” can 

be set with respect to “model percent”, or “model units”. A scale factor multiplies the 

displacement to produce the deformed shape. This option is available for all animation 

modes. When the Model percent option is used, the deformed shape of the model is 

scaled, so that the maximum deformation of the model is displayed as a specified 

percentage of the current model size. The model size is the diagonal length of the 

axisaligned bounding box which contains all model geometry. This is only available for 

modal and linear static animation modes. The final option, Model units, has the maximum 

value in the results displayed as the number of model units defined. This option is also 

only available for modal and linear static animation modes. 

Next the Type of scaling to be done is selected. The two options are Uniform and 

Component. Uniform allows you to enter a single value into the Value field which is used 

to multiply each component (X, Y, and Z) by the same value. The Component options 

allows you to specify different scale factors for X, Y, and Z. To eliminate the movement in 

a direction, specify 0.0 in the component field for that direction.   

Once the Deformed shape has been specified, the Resolved in system is selected. The 

Resolved in drop down menu allows you to select the result system in which you want to 

display the results.  The available options are: 

• Global System:  Transforms vectors into the global coordinate system. 

• Analysis System: Displays the vector results as they are output from the solver. 
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• User System: Transforms vector results into a user defined system. This option is 

available when the results file contains a user defined coordinate system, or a system 

has been created in HyperView. 

Once the “deformed shape” has been defined, the options for the Undeformed shape can 

be set. The Show option sets how the “undeformed shape” should be displayed: 

• None: The deformed shape is not shown. 

• Wireframe:  The deformed shape is shown in wireframe mode. 

• Edges: The edges of the deformed shape are shown. 

• Features: The features of the deformed shape are displayed. 

The color of the undeformed shape can also be defined. When Component or Mesh Lines 

is selected, the default colors are automatically applied to the undeformed shape. When 

User is selected, you can click the color button and select a different color for the 

undeformed shape. 

 

The Query panel allows you to view and export properties, as well as other information, 

for all nodes, elements, components, and systems contained in the active model.  The 

Query panel can be accessed using the   icon in the Results toolbar or by selecting 

Results > Query from the menu bar.   
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Nodes, elements, components, and systems can be selected to be queried. Depending on 

the entity type selected, different properties can be selected to be queried. Once the 

properties are selected, the entities can be selected by either graphically selecting them 

or using the extended entity selector. The table is populated as each entity is selected.  

To clear the table, the Clear Table button is selected. The “Export…” button is used to 

export the data in the table to a .csv file. 

In order to query results, a contour, vector, or tensor plot needs to be applied to the 

model. Once a plot is created, the available properties for querying will appear in the 

property list.  Also, by selecting the “...” after the entity selector, a full list of the 

properties available is opened. For example, the image to the left shows the properties 

available before a contour is applied, while the image to the right shows the properties 

available after the contour plot is created: 
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Notice how additional options are available for querying the contour results (Contour 

(Displacement) and Contour Resolved-in System). Another thing to note is that if the 

result type is nodal based, then the properties to query the results will only appear when 

Nodes are selected. The same is true with elemental results only being available when 

elements are selected. For a full listing of the available properties in the query panel, 

please refer to the Online Help. 

Once the model has a contour, vector, or tensor plot applied, you can also access the 

Query panel directly from the Contour, Vector, or Tensor panel by clicking on the Query 

Results button located on the right side of each panel:  
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17.4 Stress Calculation and Output in OptiStruct 
This section is based on a webinar held by Kristian Holm. A link to the webinar is provided 

at the end of the section. In the examples below, the first paragraph focuses is on the 

standard/default stress output data, then the various averaging and extrapolation 

options available in OptiStruct and HyperView are discussed and explained. 

Example: In-Plane Bending 

The cantilever shown in the image below is meshed with shell elements. Note that 

Poisson’s ratio NU, and Shear Modulus G are set to “0”. Also, the dimension of the 

cantilever is chosen such that the shear deformation effects can be neglected (Bernoulli 

beam). 

 

with MB bending moment (F*l), Ι moment of area inertia (t*h3)/12; σBM= bending stress at 

upper and lower left corner. 
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The file rods.fem contains the ready-to-run model. This model is meshed, has the 

appropriate constraints and loads applied, and the necessary cards are defined for 

analysis. 

 

The displacement and stress results (based on the default output settings) are depicted 

in the following images: 

 

Displacement contour plot (displacements in mm) 

Apparently, the displacements match the analytical results pretty well. 

http://www.altairuniversity.com/wp-content/uploads/2013/09/rods.zip
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However, what about stresses? 

To better view/resolve the stresses, the legend threshold is adjusted to Max: 160 MPa: 

 

In the Query panel: 

 

As listed in the Query panel, the stresses in the two elements (id 134 and 137) are 144.2 

MPa, whereas the analytical value is 300 MPa. 

Quite a difference! Why? 
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Thus, the analytical stresses need to be calculated with respect to the coordinates of the 

element centroid h/4 (and not at its upper or lower edge at h/2) 

 

 

Stress at element centroid 

The element centroid stress is 144 MPa, whereas the analytical value is 150 MPa 

indicating an error of about 4 %.  

What about the stress at the elements “upper / lower edge”? 

Hereto, the stresses at the integration points are extrapolated to the element nodes. 

 

As depicted in the image, extrapolation of the integration point stresses takes places 

within each element.  Thus, depending on the number of elements attached to a 

particular node, different stress values are associated with a single node, respectively.  
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This may cause numerical stress “jumps” from element to element. These “jumps” 

strongly depend on the kind of extrapolation chosen and the mesh size. 

There are different extrapolation options available. The simplest one is bilinear 

extrapolation (always with respect to the stresses at the integration points).  

Note, the kind of extrapolation needs to be specified in OptiStruct before the analysis is 

started! BILINEAR extrapolation of stress data can be requested through either: 

        STRESS (H3D, CORNER) = YES 

        STRESS (H3D, BILIN) = YES 

Analysis > control cards > GLOBAL_OUTPUT_REQUEST 

 

 

Only if this request has been made inside the solver, then the Use corner data option is 

active in HyperView (Contour panel). 
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Element stress contour plot based on bilinear extrapolation. In the contour panel “Use corner stress” is activated 
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The query option now lists 4 different stress results per element. In element 137, the 

stress at node 138 and 41 is 288 MPa, at node 136 and 129 the stress is 8.3 MPa. In 

contrast, in element 136 the stress at node 138 is 269 MPa (i.e. two different stress 

results at the same node). 

Quite obviously, the finer the mesh discretization in the longitudinal direction, the smaller 

the stress jumps from element to element will be. 

To better visualize the stress difference across adjacent elements, inside HyperView the 

averaging method Difference may be used. This averaging method simply calculates the 

difference between maximum and minimum stress value at each node. This kind of 

contour plot thus can also be considered (or used) as a measure of element discretization 

quality.  

 

Making use of the max/min option (in the Measure panel) helps to identify the location 

of the greatest stress gradient between adjacent elements: 
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If the maximum stress gradient is located in a critical area of the structure local remeshing 

may be required.  

Another averaging method is named Simple. This method averages the various stress 

results per node: 

 

The query option for node 138 lists: 

 

278.8 MPa (compare with the values shown before).  However, this method “simply” 

averages the given von Mises stress (which is not entirely correct). More precise is to 

average the stress tensor first and then to form the von Mises at a common node. 
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This can be accomplished through the averaging method named Advanced. In this case 

since we are looking at a uniaxial stress state simple and advanced are the same. In 

general, Advanced is recommended over Simple. 

If the averaging method Maximum is used, then the maximum value per node is 

displayed, respectively. 

 

 

This averaging method leads to a more conservative assessment of the structural 

behavior. 

Summary: Using the output options BILINEAR during the solver run (analysis) leads to 

more “realistic” values. 
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Example: Out of Plane Bending 

 

Note that in this model the width of the beam is 1 mm its height is 0.2 mm. 

 

Displacement contour plot. 

The displacements of 2.38 mm again match the analytical result. 
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What about the stresses? 

 

 

von Mises stress at element centroid 

The stress at the element centroid is 1453 MPa. 

Looking at the three adjacent elements, we see a jump by about 100 MPa from element 

139 to element 136. 

 

As well as another jump by about 100 MPa from element 136 to element 137.  

Activating the Use corner data indicates that the stress results are pretty much the same 

as without the bilinear averaging method! 
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The Query panel lists identical stress values at each of the 4 nodes 1453 MPa (from the 

same element). 

  

In other words, bilinear averaging doesn’t affect the stress results in this case. 

Why? 

Looking at an element from the top view, it becomes apparent that the length of the 

element changes uniformly. Thus, the integration points will be stretched (to a new 

position) uniformly too.   
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In case of in-plane bending, the nodes will experience different displacements. Therefore, 

the integration points will have different stress too. 

 

 

 

Therefore, the extrapolation option CUBIC may be used during the analysis. 

CUBIC extrapolation method can be requested with: 

      STRESS (H3D, CUBIC) = YES 

This method outputs element stresses for shell elements (not available for solids) at the 

element center and grid points using the strain gage approach with cubic bending 

correction 

 

Strains G1-G2, G1-G3 and G1-G4 will be calculated from relative displacement between 

the nodes and used as strain-gauge rosette. In addition, the bending stresses are 

calculated assuming a cubic displacement function like on Bernoulli beam. 
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Element stress based on cubic interpolation is 1480 MPa resulting in a difference between 

analytical and numerical result of 1.3 %. 

Summary - Stress Averaging at Nodes in HyperView 

 

 

Location Method Comment 

simple averaging of the stress invariants Advanced  should  provide  more  

accurate results 

Advanced Averaging the stress tensor and calculate invariants from 

this 
 

Difference Max-min nodal value Good to find areas with large stress 

discontinuities 

Max/min Max/min value  
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Summary - Stress Locations for Shells 

(recall – this information/data needs to be requested before the analysis is started)  

Location Method Comment Request example 

Center Integration point stresses 

are averaged to the center 

“Correct” stresses in terms of the used 

FE-Model 

Most stable regards to element 

quality 

Default 

Corner, bilin Bilinear extrapolation from 

integration point stresses 

to nodes 

Good results for in-plane bending 

Cannot capture out of plane bending 

effects  

Can be very oscillatory particularly 

with bad element quality 

STRESS(H3D,CORNER)=YES 

STRESS(H3D,BILIN)=YES 

Cubic Strain gauge method with 

cubic bending correction 

Good results for out of plane bending 

Less  oscillatory  then  bilin 

 on complex stress 

distributions 

Can overestimate stresses for inplane 

bending 

STRESS(H3D, CUBIC)=YES 

sgage Strain gauge method Kind of obsolete 

Cubic should provide more accurate 

results 

STRESS(H3D,SGAGE)=YES 

Note: Extrapolation for 2nd order shell elements are always BILINEAR 
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Summary - Stress Locations for Solids 

Note: GPS –grid point stress can only be requested for solid elements. Here the stresses 

are also bilinearily extrapolated from the integration points to the nodes. However, 

OptiStruct then averages the stresses at each node so that only 1 stress value/result per 

node remain. As a consequence, the before discussed option to contour stress difference 

(as a measure of mesh quality) is not available any more. Alternative Options  

Shell Elements (2D) 

Place Rods on the edge of shells (checking the model for free edges will create plot 

elements which then can be converted into rod elements). The rods (only 

tension/compression) are assigned the following attributes: 

• Same Material as solid material 

• Rod should be thin, but not too thin to jeopardise numerical stability e.g. r=0.01 mm 

Tip: Use HyperBeam to get reasonable A and J values. 

Location Method Comment Request example 

Center Integration point stresses 

are averaged to the center 

“Correct” stresses in terms of the used 

FE-Model 

 Most stable regards to element 

quality 

Default 

Corner, bilin, 

sgage, cubic 

Bilinear extrapolation from 

integration point stresses 

to nodes 

Extrapolation for solid elements will 

always be bilinear 

Keywords sgage and cubic are 

allowed to support cubic stresses for 

shells in same model 

STRESS(H3D,CORNER)=YES 

STRESS(H3D,BILIN)=YES 

STRESS(H3D,CUBIC)=YES 

STRESS(H3D,SGAGE)=YES 

GPS - grid 

point stress 

Bilinear extrapolation from 

integration point stresses 

to nodes and average at 

node 

1 value per nodes, whereas the others 

give 1 value per element 

Global  average  or  average  by  

property can be requested 

GPSTRESS(H3D)=YES 
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Rod elements are placed along the free edges of the shell elements 

Solid Elements (3D) 

 

Place membrane elements on the free surfaces of the solid elements (checking the model 

for free faces will create 2D elements which then can be converted into membrane 

elements). The membrane elements (only tension/compression) are assigned the 

following attributes: 

• Same material as solid material 

• Membrane elements should be thin, but not too thin to jeopardise numerical stability 

• Remove transverse shear and bending stiffness by leaving MID2 and MID 3 blank as 

shown in the image below (set MID2_ opts (bending) and MID3_opt (transverse 

shear) to BLANK) 
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Final Remarks 

• Default stress output location is at the element center, which is the “correct” stress 

in terms of the FE-Model. 

• Usually the highest stresses of the physical part are at the surface/edge of the part 

due to bending effects (not true for shear dominant load). 

• This can be evaluated with stress extrapolation, but there is no guarantee that the 

extrapolation reflects the physical behavior of the part, so it has to be used with 

caution. 

• Alternatively, membrane/rod elements can be used to measure the stresses at the 

surface/edge. 

17.5 Special Tricks for Post-Processing 
1. How to Avoid Wasting Printer Ink: 

A colored plot consumes a lot of ink which is very costly. In the stress contour plot, the 

color blue (low stresses) consumes a lot of ink unnecessarily. Wastage of ink could be 

avoided by using the color white in the color bar as shown below. 
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2. Adjusting the Scale of The Color Bar 

It may be helpful to reduce the number of colors and to adjust the legend scale. In this 

way all elements above a certain stress threshold (e.g. yield strength) would be displayed 

in red. 

Elements with stresses below this threshold would then be depicted in a different color, 

which makes it easier to distinguish between “safe” and “failed” areas. 

3. Linear Superposition of Results 

Say the results for two individual load cases Fx and Fy are already available. Now we need 

the result for a combined load case (Fx + Fy). The regular way to achieve this is to run the 

analysis by creating new combined load case (Fx and Fy applied together). 



 

510 
 
 
 

For linear static analysis, the results could be obtained even without running the analysis 

via (superposition of individual results): 

Result for combined load (Fx + Fy) = Result for Fx + Result for Fy the individual load results 

could also be combined with an appropriate scale factor like  

3Fx + Fy or 2Fx-0.5Fy. 

Is there any advantage in solving load cases individually when results are required for a 

combination of loads? Yes! The advantage of solving all the load cases individually is that 

we come to know how the individual load cases are contributing to the combined stress. 

This helps in subsequent corrective action for stress reduction. 

 

Loadstep 1: vertical force. Displacements scaled by factor 30. 
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Loadstep 2: Displacements scaled by factor 30. 

 

Superposition of loadstep 1 and loadstep 2. Displacements scaled by factor 30. 

In HyperView loadsteps can be combined by selecting Results > Create > Derived Load 

Steps from the menu bar. Then select the loadsteps of interest and set Type to Linear 

Superposition. 
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Note: Linear Superposition should be applied on Linear Analysis results only. 

In HyperView the superpositioned loadstep is directly accessible from the Results 

Browser. 

 

  

4. Scaling of Results: For linear static analysis, stress is directly proportional to the force.  
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Therefore, when the force is doubled, the stress is also doubled. Some CAE engineers 

prefer running the analysis with a unit load and then specifying the appropriate scale 

factor to get the desired results in post processing. 

5. JPEG / BMP / TIFF Format Result Files and High-Quality Printouts: Common post-

processors provide special provisions for stress and displacement contour plots in jpeg, 

bmp, tiff or postscript format files. Another simple way to achieve this is to use the Print 

screen command available on the keyboard.  

 

These panels/options allow you to save your screen, panel, user defined area or even just 

icons as a file or directly into the clipboard. Very convenient and very helpful. 

Additionally, while running OptiStruct / Radioss a report is automatically created. The 

report (html format) is located in your working directory (i.e. where the analysis file & 

results files are stored).  
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6. Directional Stress, Vector Plot Like xx, yy etc 

To know the direction and nature of stress (tension or compression) and for comparing 

CAE and strain gauge results, vector plots are recommended. 
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Superposition of normal stress (x-direction) contour and vector plot (outward pointing 

arrows indicated tension, inward oriented arrows compression) 

7. Two Color Representation 

Red represent stress above the yield strength (i.e. failure) and blue shows safe areas 

(values are conceptual). 
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8. Always Report Maximum Stress Location 

 

 

9. Stress Distribution Across Cutting Planes 

Useful for 3-D elements. Just activate the corresponding icon   in the side bar and 

define the orientation of the clipping (section) plane. 
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10. Graphical Display 

To create a graph from within HyperView, activate the Measures panel  and add a 

new Measure (Measure title can be renamed, of course). Depending on the kind of 

information you may specify “Node Path”, then select the corresponding nodes. 

Eventually, click on “Create Curves …”. 

 

The highlighted nodes represent the selected node path along which the stresses will be 

plotted in a graph. 

Naturally, the graph layout can be adjusted according to your needs. 
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11. Top and Bottom Stresses for 2D Shell Elements 

For 2D elements, both the top and bottom side (some postprocessors term it as Z1, Z2) 

stresses should be viewed. Cracks originate from the tensile side. VonMises stresses are 

always positive and it’s not possible to know whether the displayed stresses are tensile 

or compressive. Directional stresses like xx, yy, or zz, using the vector plot option, could 

confirm the nature of the stress.  

12. Result Mapping 

Residual / process stress consideration: Some software like Deform, HyperForm, etc. 

calculate the process or residual stresses. These stresses could be mapped to a FE model 

using a special option available in postprocessors. Consideration of these stresses during 

structural, crash, or fatigue analysis leads to better accuracy and correlation between the 

FEA and experimental results.  

Animate results (even of a static analysis) 
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13. How to Plot When Only a Black and White Printer Is Available? 

This question might sound funny the first time reading it, but this is the reality. Since color 

plots are very costly and there is a possibility of misuse, in many organizations’ permission 

is necessary for making color plots. But there is no restriction on black and white prints 

i.e. contour plots are based on different gray colors. 

In practice, the legend color is edited. A start color (white) and a end color (black) is 

defined, then the intermediate colors are automatically determined through 

“Interpolate”. 
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17.6 Interpretation of Results and Design 

Modifications  
Based on stress and displacement contours 

First step is to observe the locations of the maximum displacement and maximum stress. 

Also, the locations of minimum displacement and minimum stress should be found.  

A general rule to reduce the stress or displacement is to provide a connection (using ribs 

or stiffeners) between the maximum stress or displacement location and the minimum 

stress or displacement location.  

Using Strain Energy Plot for Modification 

One of the tools used for suggesting modifications is based on the elemental strain energy 

plot. Strain energy is elastic energy stored in the element, defined as ½ 

stress*strain*volume. Modifications in the region of the maximum strain energy (such as 
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increasing the stiffness, addition of material, etc.) is recommended while low strain 

energy areas are good for providing bolted or welded joints or material removal from an 

optimization point of view.   

Failure is at Sharp Corner 

Suggest radius and smoothening changes 

 

    Shaft with sharp corners failing      Recommended (priority 1) 

  

 

       Recommended (priority 2)                                                                            Not recommended 
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Rounded Corners Are Recommended Instead of Sharp  

 

         Original        Recommended 

If Failure is at Radius – Increase Radius  

 

           Original           Recommended 

If Failure is at Hole Say Elliptical - Rotate It By 90 Or Try with Circular Shape of The 

Hole  

 

           Original          Recommended 
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Load Is Not Distributed Among Bolts – Rearrange Bolt Position 

 

                                          σ = 972N/mm2                                                                                                                   σ = 758N/mm2 

In the above image, the top bolt is taking most of the load while the bottom one is not 

effective from a design point of view. Rearrangement of the bolts along the horizontal 

axis would reduce the stresses without any additional cost.   

If the Object is Flexible (Large Deformation) - Add Ribs / Stiffeners  

 

Introduction of a rib or stiffener reduces the stress as well as the displacement 

significantly.  

Additional Support / Fixing Point  
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Consider a simply supported shaft (say it is located in a gear box or clutch housing). The 

addition of an extra support (bearing) would reduce the stress. Also, it results in a higher 

natural frequency and might help in the reduction of noise.   

Increase Area Moment of Inertia  

To reduce the stress and displacement. Sometimes just reorientating the cross section 

also work very well.  For example:  

 

       Original               Recommended 

Selection of Appropriate Cross Section 

A closed section (rectangular) is generally recommended over a C- section. In particular 

when the loading is not symmetric. The selection depends on the design concept. For 

example, in civil engineering, the thin-walled sections are very common because of the 

ease of use. 

   

        Original            Recommended 
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Increasing Load Transfer (Contact) Area  

Two casting parts in contact – due to a surface finish, the area of the contact is small and 

results in less life.  

 

Machining of contact surfaces in the above casting parts prior to assembly would give a 

better fatigue life (due to increased contact area). 

Spot Weld is Stronger in Shear– Reorient Welding in The Case Where Failure is 

Reported 

 

             Original              Recommended 

Spot welds are stronger in shear and weak in normal (tension, compression, bending) 

loading.  Many times, just rearranging the spots (say orientation of the spot is changed 

by 90 degree) works well and solves the problem. 
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Arc Weld Stress Could Be Reduced by Increasing Contact Area Between Two Joining 

Parts  

The following two cylinders (yellow and green) are welded at the inner and outer side.  

 

A slight press fit (or interference fit) between the two cylinders prior to welding can 

increase the life substantially (without the press fit, all the load would be transferred to 

the weld, while press fitting will increase the load transfer area and reduce the stresses 

at the weld).  

Avoiding Arc Welding for Sheet Metal Parts Having a Thickness < 0.8 mm  

Spot welds should be used for such cases. 

Introduction of Favorable Residual Stress  

Shot pinning, nitriding, flame and induction hardening, and cold rolling induce favorable 

residual stress and increases the life of the component.  

Keeping the Design Simple and Restricting the Number of Parts  

The general rule of thumb is that a single piece part has a higher strength than the same 

geometry produced by combining many small parts than one bolted and welded joints. 

When the product is in the design phase, a one-piece suggestion is recommended. But 

when the product is already in the field and it’s a case of failure analysis, then patching 

up the work by the addition of ribs or stiffeners is recommended. A one-piece design and 

changes for such a situation would mean throwing away existing dies, jigs, and fixtures, 
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and thus a major tooling changes which is quite costly and time consuming too. CAE 

engineer should adapt a flexible approach and suggest the best feasible design 

modification, while taking in to account the cost, strength, and manufacturing ease.    

Increase Thickness  

Increasing the thickness should be the last option as is costly as well new dies are required 

(if it is increased beyond the capacity of existing ones). 

High Strength Material for Highly Stressed Component  

The higher strength material could be an option when failure occurs. Changing the 

material will not require rerunning the analysis for stress (in case of linear static analysis) 

and a decision could be taken just by comparing the maximum stress value with the yield 

/ ultimate strength of the material. Higher strength materials are costly and should be 

considered only when other options are not giving satisfactory results.  

Low Strength Material for an Over Designed Components  

When the magnitude of stress is far below acceptable limit, a low strength material could 

be suggested. For example, existing material is cold rolled (high strength) and reported 

stress magnitude is well below yield stress (and endurance limit), hot rolled material has 

low strength as well as low cost and could be suggested for cost reduction.    

17.7 CAE Reports 
Documentation and proper data storage or backup after the completion of the project is 

essential and should not be avoided.  

After completion of the project, the following documentation is recommended. 

A) 2 hard copies of the report (precise and to the point short report) 

B) Power point presentation 

C) Animation files 
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A) Hard Copy:  

CAE report should include:  

Page 1: Title or Front Page of Report: The title of the project, a nice small figure of the 

component, a report number, date of    submission, name of customer, name of analyst, 

company name, address, contact details of the analyst.  

Page 2: Summary (Maximum 1 Page) of The Project: A summary should be written in 

simple language (avoiding core technical terms) clearly stating the objective of the 

analysis, conclusion and recommendations. It is meant for managers, decision           

makers and team members involved in the project who either do not have enough time 

to go through the complete report or are not familiar with FEA terminology.  

Signature of CAE Engineer: The CAE engineer should sign the report, preferably on the 

page of the summary. This shows that he/she is taking responsibility of whatever has 

been written in the report. 

Page 3 and Onwards: FEA technical report 

i. Aim / scope of project  

ii. About component / assembly, basic design details, functionality etc. 

iii. Methodology or strategy of analysis  

iv. Mesh details, quality checks, connection details with appropriate plots 

v. Material properties 

vi. Boundary condition details with separate figure corresponding to each load 

case 

vii. Tabular results for various load cases, various iterations/modifications etc. 

(preferably in *.xls sheet) 

viii. Result plots 

ix. Figures clearly showing recommendations/suggestions/modification to the 

original design. 
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B) Power Point Presentation 

Nicely prepared power point presentation, briefly covering all of the above points should 

also be submitted along with the hard copies and animation files. Power point 

presentations are required for project presentation by the CAE engineer, group leader, 

and managers. 

C) Animation Files 

Animation or movie files are very useful in understanding the deformation as well the 

variation of stress. Also, it could be opened easily on any PC without the necessity of 

having a FEA software license at the customer end.  

17.8 Post-Processing Tutorials and Videos 

Recommended Tutorials 

These tutorials are part of the HyperWorks Help Documentation 

Animation 

• HV-1000: Loading Model Files 

• HV-1010: Using the Animation Controls 

Visibility and View Controls 

• HV-2000: Controlling the Model View 

• HV-2020: Using the Results Browser 

• HV-2030: Masking Elements 

Result Data Analysis 

• HV-3000: Contouring Results 

• HV-3010: Viewing Deformed Shapes 
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• HV-3020: Viewing Iso Values 

• HV-3030: Editing Legends 

• HV-3040: Viewing Vector Plots 

• HV-3050: Viewing Tensor Plots 

• HV-3060: Transforming and Averaging Stresses 

• HV-3070: Creating Derived Loadsteps 

• HV-3080: Creating Linear Superposition Loadsteps 

• HV-3090: Creating Envelope Loadsteps 

• HV-3095: Generating CFD Plots/Streamlines 

• HV-3099: Creating Derived Results 

Querying 

• HV-4000: Querying Results 

• HV-4010: Performing Advanced Queries 

Working with The Model 

• HV-5000: Creating Section Cuts 

• HV-5010: Using Exploded View 

Working with The Model (see HyperWorks Help Documentation) 

• HV-5020: Tracking Entities during Animation 

• HV-5030: Tracing Nodes and Components during Animation 
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Annotations 

• HV-6000: Creating Measures for an FEA Model 

• HV-6010: Creating Notes 

• HV-6020: Using Video Overlay 

Recommended Videos  

• Self paced HyperView training class (HyperView / HyperGraph 12.0) 

• Result Math Overview 

• HyperView – published by Prof J Chessa (Texas) on Youtube 

Recommended Reading 

• Help Document: HyperView > Graphical User Interface > HyperView Toolbars: Results 

Toolbar 

• Help Document: HyperView > Animation Types (HyperView) 

• Help Document: HyperView > Results > Deformed Panel 

• Help Document: HyperView > User’s Guide > Animating Results > Contour Panel 

  

http://www.altairhyperworks.com/training/new_feature_videos/12/hvhg.htm
http://www.altairhyperworks.com/training/new_feature_videos/11/videos/result_math_Overview_final/result_math_Overview_final.htm
https://www.youtube.com/watch?v=-84zPaPpuhM
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17.9 Student Racing Car Project: Post-Processing 
Finally, we are there – the FEM solver OptiStruct reports: solution is completed.  

The results shown below are just “conceptual”. The detailed evaluation of the car frames 

performance (i.e. displacements and stresses) is deliberately left to the “reader” of this 

tutorial. 

Bending Loadstep 
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The above images show the bending loadstep contoured with the magnitude of 

displacements (in mm). Displacements are scaled by factor 50. Undeformed structure is 

displayed in gray.  

In order to display element stresses, one needs to recall the definition and location of the 

stress recovery points of the CBAR element.  

 

Of course, the orientation of the CBAR element now determines whether for instance 

recovery point C experiences tension or bending. Furthermore, it is important to realize 

that the stress value at the node of consideration (for instance node A), is then used to 

contour the entire element! Shear Loadstep 

 



 

534 
 
 
 

 

The images above show the sear loadstep contoured with the magnitude of 

displacements (in mm) and scaled by a factor 50. Undeformed structure displayed in gray 

Torsion Loadstep 
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The figures above show the torsion loadstep. The model is contoured with the magnitude 

of displacements (in mm) and are scaled by a factor 50.  

 

Summary Base Design Total mass 42.1 kg ro= 12.5 mm 

ri=10.5 mm (Note, the initial radii used in the base design are just a first guess). 

Load Step Maximum Displacement (mm) Node 

Bending 1.45 2764 

Shear 2.03 2678 

Torsion 6.29 2085 
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 Quiz: Torsion Loadstep Do You See Any Errors in Here?   

 

Torsion load case: Displacements scaled by a factor 10. 

 

One lesson to be learned: Not every modeling mistake necessarily causes the FEM 

program to abort its run. In other words, it is your responsibility to understand and judge 

simulation results ... 
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Appendix A 

Strategic Planning 
This chapter includes material from the book “Practical Finite Element Analysis”. It also has been reviewed 

and has additional material included by Matthias Goelke. 

Planning the Solution 
Planning the various phases of a problem’s solution is the first step in solving an 

engineering problem. Stay focused on the problem itself rather than on mechanical 

processes to ensure that the model you create accurately represents the problem in 

question. Thoughtful planning will save time in the long run and ensure a higher level of 

success. 

Understanding the relationship between your solution strategy and the problem 

objectives will help you fulfil your responsibility to provide the customer with information 

concerning assumptions you have made, and the limitations of methods used. 

The following sections provide an outline of issues to consider prior to modeling, which 

will help to plan a problem’s solution. 

Communicate 

Work toward understanding the customer’s needs by maintaining a clear line of 

communication between yourself and the customer. This is important as it ensures that 

the customer’s expectations are directly made known to you. Although the customer 

(typically a designer or manufacturer) may not understand the details of finite element 

analysis, they would have the most knowledge concerning design requirements and 

manufacturing issues. Understanding your customer’s needs is crucial to successful 

planning. It is a good idea to have a meeting to discuss the project before beginning to 

effectively plan or at least review the goals of the project. 
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Goals 

1. Determine project goals, such as: 

• Maximum deflections 

• Peak stresses 

• Stiffness under load 

• Ultimate strength 

• Fatigue life 

• Vibration characteristics 

• Thermal stresses 

• Combinations of several requirements 

• Optimization 

2. Determine the specific objectives of the analysis. 

• Form a consensus with all involved to establish objectives. 

• Customers may be unable to clearly define goals. 

If a clear plan is not agreed to in the beginning, a project will be continuously 

redirected 

History 

Examine the components under investigation. 

• Note the strengths and weaknesses of past performance. 
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• Examine the components in their working environment. 

• Study reports written on similar studies. 

• Discuss the problem with the authors of related reports, if possible. 

• View films or operating tests to observe the components in action. 

FEA Feasibility 

Determine whether or not finite element analysis (FEA) is the best method to solve the 

problem. It may be necessary to consider other options such as classical analysis 

methods, especially if time is limited and the problem can be reduced to a simple 

calculation or handbook formula. 

When modeling cannot be performed with existing software packages, the possibility of 

testing should be explored. Testing should always be considered if parts are available and 

a test method has been previously developed. 

Whenever possible, the powerful combination of testing and finite element analysis 

should be employed. Test results provide useful insight into modeling and analysis while 

FEA results aid in the design and understanding of test procedures. 

Time Constraints 

Know the timetable for conducting the analysis. This information will help to determine 

whether compromises in accuracy and confidence need to be made to deliver timely 

results. But before these types of compromises are made, concentrate your effort on 

reaching a compromise with the customer so that a more realistic amount of time can be 

allotted to the project. Consider the many details that need to be considered to obtain a 

solution, the effort involved in correcting results, and any miscellaneous problems that 

might arise. 
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Consider Boundaries and Surrounding Systems 

Determine the amount of the surrounding structure that should be included in the model 

to obtain an accurate representation of the operating environment. Consider both local 

details and overall environment. 

Consider the simple example below which has both localized and total structure issues. 

The bolted attachment alone could consume years of research if examined in detail, yet 

the support conditions may be more important to the overall performance of the channel 

section. Therefore, a determination must be made regarding the appropriate boundary 

conditions and loads. If historical data exists, it should be used to aid in this 

determination, and if used, be certain that you have a clear understanding of its relevance 

to the current project so that you can offer an intelligent response to questions regarding 

its use. 

Total System 

 

Local Detail 
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Decide whether the performance of the bracket, the rail, or the bolted connection is to 

be determined. 

Plan Element Types and Model Size 

Selecting element type(s) and target model size are important factors affecting timing, 

accuracy, and computational costs.  Since there is usually no single correct answer to 

the question of how many and what type of elements to use, take the following points 

into consideration when deciding. 

• It is usually better to err on the “too detailed” side. Due to increasing speed and 

decreasing costs of computer cycles, fewer assumptions and higher accuracy can be 

achieved using this logic.   

• Take care not to go to extremes because it will lead to extended turnaround times 

for model changes and increase time devoted to computer calculations. A good rule 

of thumb to follow is that the size of the problem grows with the square of the 

number of nodes in the model, and the solution time grows with the cube of the 

number of nodes. For example, if the number of nodes doubles the memory required 

will be four times larger and the solution time will be eight times longer. In addition, 

Local Detail 
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when the available RAM of the computer is exceeded then the solver must use a 

scratch file from disk and then the solution times are longer and unpredictable. 

Experience with a solver will help in future determinations of model size.   

• Consider if the design information is detailed and complete.  You may want to use 

less detailed models if you are evaluating several alternative concept designs.  A 

completely developed design merits a more detailed finite element model. 

• Solving subsequent coarse models will help you make decisions about element types 

and element density. 

Review the Plan 

“See the end before you begin” - conduct a review of the selected methods and modeling 

techniques.  Keep the following questions in mind: 

• What results will be most useful? 

• What do you expect to happen? 

• What things can go wrong? 

• What questions will be asked when you present your results? 

• Will you be prepared to answer questions the analysis has and has not 

addressed? 

• How and in what form will you present your results? 

You may choose to decide in advance which tables, x-y plots, stress plots, and deflection 

plots will support the questions that the analysis answers. Conducting these exercises will 

lessen the chance that an analysis will need to be re-run and will better prepare you to 

discuss your findings. 
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Planning the Solution Summary 

Follow these steps to help ensure a successful analysis. 

• Discuss the problem with all the appropriate people. 

• Define the project goals as clearly as possible. 

• Research the history of the component. 

• Consider the application of alternative solutions. 

• Be realistic in your objectives and approach based on the time available. 

• Form a solution strategy based on the operating environment of the 

component. 

• Select element types and number based on timing, accuracy, and 

computation cost. 

• “See the end” before you begin in terms of final results requirements. 

The 10 Questions You Should Be Able to Answer… 

The following is a list of the 10 questions you should be able to answer about any given 

FE simulation. It is also a good checklist to bring along to presentations by others as a 

guide to assure all your questions are answered. If you have not or cannot answer these 

questions you need to go back and understand why. 

1. What is the problem you are trying to solve?    

• Problem statement 

• Objective 

• Constraints 

• Design Variables (i.e. what is to be changed) 
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2. What geometry are you using? 

• Do you trust the fidelity? 

• Is the geometry changing? 

• Can you change the geometry? 

3. What solution type are you using?    

• Is it consistent with your problem? 

4. What is your material model? 

5. What are your element selections? 

6. What are your constraints?   

• How are you holding the model?   

• Over constrained or under constrained? 

7. What are your loads? 

8. How are you combining the loads and the constraints? 

9. What are the results?   

• What results are important for this problem?   

• What is success? 

• Are the results correct?   

• How do you know? 

10. What are your recommendations? 
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Sample Linear FEA Deck 

Once the FEM modeling phase is completed, in other words the CAD geometry is meshed 

(i.e. approximated by finite elements), material and property information linked to the 

elements, loads and constraints assigned, the FEM model is exported from the pre-

processor in a solver specific syntax (ASCII format). 

An example of an OptiStruct solver input deck (ASCII format) is provided below.  

 

$$ OptiStruct Input Deck Generated by HyperMesh Version: XXXX 

$$ Generated using HyperMesh-OptiStruct Template Version: XXXX 

$$ 

$$                      Case Control Cards                                      $ (Definition of the so-called load step / subcase) 

$$------------------------------------------------------------------------------$ 

$$ 

SUBCASE       1 

  SPC =        1 

  LOAD =        2 

BEGIN BULK 

$$ 

$$  GRID Data 

$$ 
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GRID           1        0.0     0.0     0.0                             

GRID           2        0.0     1.0     0.0                             

GRID           3        1.0     1.0     0.0                             

GRID           4        1.0     0.0     0.0                              

GRID           5        1.0     0.0     3.25                            

GRID           6        0.0     0.0     3.25                            

GRID           7        0.0     1.0     3.25                            

GRID           8        1.0     1.0     3.25                            

GRID           9        1.0     0.0     3.0                              

GRID          10        0.0     0.0     3.0                             

GRID          11        0.0     1.0     3.0                              

GRID          12        1.0     1.0     3.0                              

$$ 

$$ 

CBEAM          8       1      10       11.0     0.0     

0.0             CBEAM          9       1      11       

21.0     0.0     0.0              

CBEAM         10       1       9       41.0     0.0     

0.0              

CBEAM         11       1      12       31.0     0.0     

0.0              

$$ 

$$ 

CQUAD4         2       2       4       3       2       1                 

$$ 

$$ 

CHEXA          1       3       5       6       7       8       9      10 

+             11      12 

$$ 

$$ 

PSHELL         2       10.25           11.0            10.8333330.0      

$$ 

$$ 

PSOLID         3       1                                         

$$ 

$$ 

PBEAM          1       10.063   0.00033 0.00033 0.0     0.0              

$$ 

$$ 
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MAT1           13.0+7           0.3                                      

$$ 

$$ 

SPC            1       4  1234560.0      

SPC            1       3  1234560.0      

SPC            1       2  1234560.0      

SPC            1       1  1234560.0      

$$ 

$$ 

FORCE          2       9       01.0     -20.0   0.0     0.0      

FORCE          2       8       01.0     -20.0   0.0     0.0      

FORCE          2       5       01.0     -20.0   0.0     0.0      

FORCE          2      12       01.0     -20.0   0.0     0.0      

ENDDATA 

 

Sample Linear FEA Results 

 

Displacement Contour Plot (m) 
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Stress Contour Plot 

Accuracy of the Results 

In any FE analysis, the objective is to obtain some results that will help you solve some 

problem. In order to determine the success of the exercise you must have some feeling 

for the accuracy of your answers. The problem with this is that errors can be introduced 

in a FE analysis in many places.  

Below is a list of some of them: 

1. Solution type not matching the “in vitro” environment. 

2. Material model or properties 

3. Tolerances 

4. Geometry considerations – detail captured 

5. Elements 
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• Shape- quality (Jacobian (Global – local) 

• Size – matching the detail of geometry 

• Type – matching displaced shapes, stress output 

6. Loads and Constraints 

7. Results 

• Not calculated where you want them 

• Interpretation 

• Averaging/Smoothing 

Because of the many places that errors can be introduced into a FE analysis, it is 

sometimes a better practice to compare results that were achieved through comparable 

methods to see improvements in design. At least then the results are consistent. 

Consistency is really the key, because with consistency you can have predictability. 

Creating a Solution Checklist 
Use the following example of a solution checklist as a guide to develop your own checklist: 

• Assign project number and describe the job to be completed. 

• Set the goals of the solution. (This is done through communication with your 

customer). 

• Identify resource and time constraints to the above goals. 

• Evaluate past historical data.  

• Describe the operating environment you are interested in simulating. 

• Determine type of analysis that is applicable to the goals.  
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• Describe your selected boundary conditions. 

• List the element types/combinations you have chosen. 

• Determine your material model. 

• List the assumptions you are making by selecting the analysis type, element 

selection, boundary conditions, and material model.  

• List the limitations you expect as a result of the above assumptions. (Do the 

assumptions let you achieve your goal?) 

• List the results you will present to attain the goal of the project. 

• List the media by which you will present the results. 

• Make a list of data required from outside sources. 

Boundary Conditions and Load Cases 
Study the boundary conditions (BCs) and applied loads of the component or system and 

establish proper sets before initiating finite element modeling and analysis. Keep in mind 

that even though chosen boundary conditions are an approximation of the actual physical 

conditions, they should match reality as closely as possible. Poorly chosen BCs can be 

misleading and produce costly design errors. 

In some cases, several sets which bound the actual conditions may be appropriate. For 

example, a flexible boundary may be considered partially fixed, completely fixed, or not 

fixed at all. The flexibility of a boundary should be included in the model if possible and 

the applied loads combined with the BCs should be in proper balance. 

Methods which can help to understand and select BCs and load cases are 

explained in the following sections.  
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History 

Research the history of similar systems by: 

• Reading reports. 

• Discussing similar projects with design engineers. 

• Visiting test labs. 

• Physically inspecting the components in their operating environment. 

• Studying layout and detail drawings. 

Check Environment 

Determine the surrounding environment included in the study to capture the best 

approximation of the actual BCs. Is the area under study strongly or weakly coupled to its 

environment? This will be dependent on the types of attachments between different 

structures in the problem. Drawings, parts lists, and observation can tell you if two parts 

are welded, bolted, or pinned together. Each attachment scheme will have an impact on 

the assumed boundary condition. Creation of a free body diagram will greatly aid in the 

understanding of the boundary conditions. 

Free Body Diagrams 

Sketch free body diagrams of: 

• Component and boundary forces. 

• Attached and surrounding components. 

Include all sets of forces in separate diagrams.  Some of the forces will become BCs, others 

will become applied loads.   
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Gather Load Data 

Gather known load information from previous tests and/or load simulations. You may 

need to initiate a test or simulation if no load data is available. Be certain that available 

data consists of a complete set (no missing values) since you cannot proceed without 

knowing the complete loading of the structure. If you do not know all the loading 

conditions, it is sometimes possible to assume “unit” loads that can be superimposed and 

scaled later.   

Minimize Number of Boundary Condition Sets 

Select the load and BC sets in a manner which will minimize the number of different BC 

sets. Minimizing the number of BC sets will reduce computer time since the number of 

matrix inversions that must be computed will be fewer. 

Eliminate Rigid Body Motion 

Be sure to provide at least enough boundary constraints to eliminate the possibility of 

rigid body motion. Rigid body motion occurs when the model is not fully constrained 

resulting in free motion in any of the six translation or rotation directions in the model. If 

this occurs, the solver translates this into a zero-stiffness term in the global stiffness 

matrix and fails to solve the problem.  If this requirement is not satisfied, the solver will 

either fail or give implausible results. (An exception to this rule is the solution for a free-

free normal modes analysis.) 

The inertia relief solution is a distinct and useful type of solution that requires the explicit 

identification of a minimum set of constraints. In this solution, the constraint forces are 

automatically eliminated by body forces with the results being similar to a free structure. 

Remember that a finite element solution is an approximate solution and the assumption 

of a “balanced force system” may not be true to the solver. Even extremely small 

perturbations in a direction unconstrained will lead to rigid body motions. 
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Mechanisms 

Mechanisms refer to the various mechanical connections that can be idealized with a set 

of boundary conditions. Below is a list of some common mechanisms and their 

corresponding boundary condition assumptions: 

Support ASSUMPTIONS APPLICATION 

Simple support Reacts forces only in direction of support Object resting on a support 

Pinned support Reacts forces but no rotations 

Eyelet connection, clevis 

attachment 

Fixed support Reacts all forces and moments Welds, bolted, riveted connection 

Ball joint, Cable Reacts only forces Suspension ball joints 

Pulley 
Reacts forces at the center of the pulley and tangent 

to the cable connection. 
Pulleys 

Bushing  Reacts forces and moments perpendicular to the 

axis of rotation. 

Automotive suspension bushing, 

roller bearings. 

 

Symmetry 

Symmetry can greatly simplify a problem by reducing its size and complexity both during 

the solution and preparation phases. Care must be taken however to ensure a consistent 

set of symmetry boundary conditions. In order to use symmetry assumptions both the 

loads and boundary conditions and the actual geometry must be symmetric If either 

of these two criteria cannot be satisfied then the entire structure must be modeled. 

However, if the geometry is symmetric but the loads and boundary conditions are not, 

preparation of the model can still be simplified by using the symmetry assumption. Below 

is a list of common assumptions for setting up a plane of symmetry for both shells and 
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solid elements. Constrain the degree of freedom that are shaded for the symmetry listed 

on the left. Note that beams and shells have the same assumptions. For more information 

on this topic please refer to Chapter 13 (Boundary Conditions and Loads). 

 ux uy uz rotx roty rotz 

Shell xy       

Shell xz       

Shell yz       

Solid xy       

Solid xz       

Solid yz       

The plane of symmetry is indicated as xy, xz, yz, etc. respectively. 

Superposition 

Superposition is used to describe the practice of adding the force or load boundary 

conditions for a linear solution with the same constraints. If the constraints remain the 

same, the stiffness matrix only has to be solved once and, therefore, the loads can be 

applied separately. The results can then be added or superimposed during the results 

calculation stage. This can be useful in the practice of creating many “unit” loads and then 

both scaling and adding results together without rerunning the analysis.  This technique 

requires that you consider as many possible units loads as possible to avoid rerunning the 

analysis. 

Choose Modeling Methods 

Establish the modeling methods for load and boundary condition application. Determine 

whether point or pressure loads should be used, and whether the boundary conditions 

should be spread over an area or applied at a single point. 
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Keep in mind that errors always result at the point of application of loads and boundary 

conditions so choose a method to reduce the severity of the effects. 

The following example illustrates the process 

of selecting modeling methods. 

 Clevis Support Bracket 

 

Clevis Support Bracket 

The clevis support plate is of constant thickness and the loads are applied in the plane of 

the plate. Therefore, this is considered to be a plane stress problem. In a plane stress 

problem, all of the stresses are in the same plane as the applied loads.  The plate is loosely 
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coupled to the other parts by pins, therefore it can be analyzed separately with some 

confidence. 

If the possibility that loads will occur out of the plane of the plate exists, a full 3D shell 

analysis should be considered. A plane stress element formulation could be used to solve 

this problem or, if some computation waste is acceptable, a shell formulation could be 

used. Shell elements will often provide more accurate results since their use is more 

universal and greater effort has been devoted to their development. The plane stress 

element formulation results in a significantly reduced stiffness matrix and therefore a 

faster solution time. 

A full 3-D structural model with solid elements could be used if localized “through 

thickness” effects at the pins are to be considered. If interaction between the plate and 

the pin is to be investigated, a detailed and complex contact model would be required. A 

free body diagram of the system is shown in the following figure. 

 

Free Body Diagram for  Clevis Support Plate and Attached Structure 
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The above diagram only considers the effect of the P1 load case. The P2 load case would 

result in a horizontal component of force in the pin above the clevis and the plate at the 

attachment of the same pin. 

Loads and Boundary Conditions Summary 

1. Research the history of prior studies and conduct physical inspections. 

2. Determine how much of the surrounding structure should be included. 

3. Sketch and study free body diagrams of the component and attached 

structures. 

4. Gather load information or conduct tests and or analyses to obtain loads. 

5. Select load and boundary sets to study. 

6. Check for a minimum number of constraints to eliminate rigid body motion. 

7. Establish the modeling methods for application of load and boundary 

conditions. 

Linear Assumption 
Many problems in structural analysis can be solved with a linear finite element solver. 

The linear assumption arises due to the mathematics used to formulate the solutions. 

The physics of the problem can be greatly simplified if higher order terms are dropped 

from the deformations and the material behavior is assumed to be linear. 

The following are several considerations that should be reviewed to determine if your 

problem can be solved using a linear assumption. 
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Small Deflections 

Determine whether the deflections obtained or predicted are small relative to the size of 

the structure. For thin structures, a deflection that is less than the thickness would be 

considered a small deflection. The deflection between two supports should be only a 

small percent of the distance between supports. This is especially true if the deflection 

causes a differential stiffness effect such as mid-plane stretching of a clamped plate. 

Small Rotations 

In linear codes all rotations are assumed to be small. Any angle measured in radians 

should be small enough that the tangent is approximately equal to the angle. Using this 

assumption, a ten-degree angle introduces an error of approximately one percent in all 

related calculations. A thirty-degree angle results in approximately a 10 percent error in 

deflection due to rotations assumed linear. 

Material Properties 

Linear solvers assume that all materials behave in a linear elastic manner. Some materials 

have a nonlinear elastic behavior, and although they do not necessarily yield, they still 

result in nonlinear structural behavior and require nonlinear codes for solution. If a 

structure is to be loaded beyond its yield point, nonlinear analysis would also be required. 

See the figure below for a comparison of material behavior. 

 

Material Behavior 
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Constant Boundary Conditions 

In order to correctly use a linear finite element program, the boundary conditions must 

not be dependent on the load application. The figure below illustrates an example where 

this is not true. A structure placed on an elastic foundation might tend to physically 

separate under the load, resulting in the formation of a gap. This gap is dependent on the 

load and therefore behaves as nonlinear. 

 

Example of Elastic Foundation 

Nonlinear contact is another source of nonlinear behavior illustrated in the figure below. 

Two parts are attached at several points and subjected to loading. The actual parts will 

come in contact and the load paths through the parts may be dramatically altered. In 

linear finite element analysis, there may be a tendency for the parts to penetrate each 

other (sometimes called pass through). 

Since this is a load dependent nonlinear behavior, a linear solver will not handle this type 

of problem properly. 

Pass through can be handled in an approximate way by the addition of constraints 

between the parts normal to the contact surface. Care must be taken not to add too 

many constraints since separations may also occur. The constraint locations are also 

load case dependent. 
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Pass Through Under Load 

Linear Assumption Summary 

1. Deflections should be small relative to the structure. 

2. Rotations should be less than 10 -15 degrees. 

3. Material should be linear elastic. 

4. Boundary conditions should be constant. 
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Appendix B 

Common Mistakes and Errors 
This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 

Infinite)”. It also has been reviewed and has additional material included by Matthias Goelke and 

Gareth Lee. 

Modeling and Visualization 
The following high-level summary is about modeling and visualization errors. During the 

analysis, the FEM solver will report warnings and errors. While warnings can be 

considered as hints e.g. element quality is bad, errors cause the analysis to stop. Errors 

may be related to extremely distorted elements, missing material properties, rigid body 

modes due to insufficiently defined constraints, etc. 

The modeling pitfalls listed below can be considered as “appetizers” with the intention 

of making you think (and worry) more about the model set-up. More in-depth details 

regarding the different modeling pitfalls are provided in the remaining chapters of this 

book.  

Geometry Simplification 

In many cases, it is appropriate or even required to simplify the imported geometry in 

order to achieve a better mesh quality. For instance, the required minimum element size 

must not be smaller than x millimeters. In order to solve this (project) related 

requirement, small fillets may be replaced by sharp edges, as shown in the images below. 

Even though this simplification was/is requested, keep in mind that your FEM model now 

“deviates” from the initial geometry. 
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 Meshing 

What kind of elements are you using in your model? Why are you using this element 

type? Did you use this element type before? 

You may mesh a thin walled 3D structure with 3D elements such as hexahedral or 

tetrahedral elements, or you may mesh the same structure with respect to its midsurface 

using 2D elements (trias or quads). 

 

Model meshed with 3D elements 

 

Model meshed with 2D elements 

Aside from the “decision” of whether to use 2D or 3D elements, there are other 

“uncertainties” (or even errors) related to the different numerical characteristics of quad 

versus trias and hexahedral versus tetrahedral elements (see the chapters on 2D and 3D 

meshing).  
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Another modeling error may be related to element size. The ultimate objective or aim is 

that the modeling results are independent of mesh size. Typically, you need to re-run the 

analysis based on a finer mesh to check for convergence of the simulation results. As a 

rule of thumb, areas of interest should be meshed finer (smaller element size). 

Of utmost importance is the element quality. Keep in mind that the elements not only 

“reflect” the CAD model, but eventually the analysis is based on the finite elements. 

Hence, any deviation from the ideal element shape (e.g. perfect quadrilateral shape in 

case of a quad element) introduces numerical errors. The magnitude of such errors is 

generally difficult to assess. 

In the model shown below, some elements are not coupled to each other (i.e. duplicated 

nodes exist), hence the mesh is locally incompatible. The area along the edge where the 

elements are not coupled is marked in red. 

 

Still, the FEM program does not prompt any warning or error messages as this may be an 

intended model behavior. If the mesh is not intentionally detached (and the model is not 

checked for free edges), then this model error may remain unknown until the results are 

fully checked and understood. As shown in the contour plot below, the displacements 

are not continuous across some parts of the mesh. 
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Also, keep in mind the orientation of the element normals.  In the image below, a simple 

plate subjected to bending is shown.  The stress contour plot (at the base of the elements 

Z1) reveals a sudden change of its sign from bending (positive) to compression (negative).  

 

The following figure helps to understand this situation. In the green area, Z1 is located at 

the top of the plate (tension) while in the blue area Z1 is located at the lower side of the 

element (compression). 

 

Material 

Inconsistencies in your unit system represent another likely source of error, i.e. mixing 

millimeters with meters, kilograms with tons, etc. Be especially cautious if you need to 
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convert properties from one system to another (e.g. pound-force lbf to Newton). There 

will be no warning message associated with any typos, except the “typo” will cause the 

entire model to “collapse” during analysis.  

Boundary Conditions and Loads 

Applying boundary conditions and loads, as discussed in the chapter on Boundary 

Conditions and Loads, are extremely prone to errors. To be mentioned exemplarily, a 

modeling error may be introduced into the model by applying the constraints (or forces) 

to what is named temporary working nodes (in HyperMesh displayed as yellow nodes).  

 

 

 

 

As the temporary nodes (yellow nodes in the image above) are not the same as finite 

element nodes, it may happen that the structure is not constrained or loaded as 

intended. “Ideally”, this may lead to rigid body modes (error message) or to 

questionable results due to an improperly constrained or loaded model. 

Visualization 

When visualizing results, a false sense of achievement that the analyst might 

experience especially after having struggled with the model, could lower his/her 

attention regarding details while looking at the results. Quite often, especially while 

you are new to FEM, one becomes blinded by contour plots. Hence, always check the 

magnitude of displacements and stresses in the first step. Despite a reasonably looking 

displacements (or stress) contour plot, you may see displacement values in the order 
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of 104 mm (small displacements assumed) or stresses far beyond 1000 MPa (linear 

elastic material). 

  

 

 

 

 

 

 

 

 

 

 

  

Errors Within Organizations 
Next, we will be sharing the mistakes made by CAE engineers working in different 

organizations. 

 

CAE Engineers 

1) Submission of A Job Without Proper Cross Checking (Should Be Cross Checked by 

Ideally 2 CAE Engineers) 
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Checking the work of someone else is a rather boring and not willingly accepted job. But 

it is very important and a job of high responsibility. Checking and rechecking all the details 

ensures good quality and minimal mistakes.  

For example, a CAE service-providing company submitted a meshing job to their regular 

client. Everything was perfect except for the material properties. The analyst at the 

customer end was used to error free models being submitted by this CAE team over the 

years. He blindly started the analysis without checking the material properties. At a later 

stage in the design process, a big difference was noticed in the results between the 

current analysis and the previous one carried out for a similar model. After checking both 

the models carefully, the analyst realized the difference in the material properties. Please 

be careful before submitting your work and check it several times and then ask your 

colleague to check it as well. Also, always request that your clients check the model in 

every aspect before starting the analysis.     

2) Import / Export Errors 

Some of the pre-processors do not export all the elements and boundary conditions that 

exist in the model, unless special options are turned on or special translators are used. 

For example, one CAE group exported a large mesh model with the template set for a 

specific external solver. Some of the special elements (RBE3 elements) were not exported 

due to a translator problem. These were extra rigid connections and did not result in rigid 

body modes during the free-free check. The analysis was carried out as expected by an 

analyst. Based on the CAE results, the CAD engineers released the drawings and a 

prototype was created. The test results were not satisfactory and further modifications 

were required. Updated CAD data was provided again to the same meshing group. The 

changes were local and it was to be carried out on the earlier submitted model. By this 

time, the CAE group had an upgraded version of the pre-processing software and the 

export operation was 100% successful (i.e. all the elements including the ones that were 

missed earlier were exported properly). The results for the modified model showed a 
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drastic difference when compared to the original. After careful checking and comparing 

the number of elements, the analyst realized that a few rigid elements were missing in 

the first model. Hundreds of engineers had worked on the job in the meantime (CAD, 

prototype, testing, planning etc.). Who is responsible for this delay and cost? Is it the 

analyst, the service provider, or the pre-processing software? It’s strongly recommended 

to import the mesh model before submission to the client (in a new file) and apply all of 

the quality checks as well as compare the number of elements of each type (such as 

number of tria, quad, rigid, spring, mass elements etc.). 

3) Experienced Engineers Are the Best Guides and Teachers for Newcomers and Less 

Experienced Colleagues 

CAE engineers are usually highly qualified (education wise) and having years of 

experience means that a lot of know-how and knowledge is available within the team. 

The best teachers for newcomers in any organization are undoubtedly the senior 

engineers working in the same group. Software trainers or consultants do not know 

exactly what is required by the customer. Every company should encourage and pay 

special incentives for experienced engineers to share their knowledge with newcomers. 

4) Meshing Is Considered Low Level Work, Post Graduates and PhD’s Are Reluctant 

to Spend Time on Meshing 

Sometimes a dangerous trend is observed among post graduates and PhDs. They feel 

meshing is a low-level job and being highly qualified, they should not waste time in such 

low level work. A building cannot be built on a weak foundation. Meshing is the 

foundation of CAE. At least in the initial years, analysts should be encouraged to mesh 

the components.   
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5) CAE Engineers Are Reluctant to Visit the Shop Floor, Testing Department, or Field 

to Study the Manufacturing, Functioning, And Failures of The Components 

Just sitting in front of the computer in an air-conditioned office and submitting nice 

analysis reports is not going to make the analysis successful. What is absolutely necessary 

is to regularly visit the test department, observing the components on the structure, and 

comparing the real-life performance with results of the computer model. These days, 

many times a CAE team is in a different country than the manufacturing and testing 

facility. The quality of the CAE work would be much better if there is an opportunity to 

know the product, manufacturing process, testing and in-field behavior.   

6) Providing Basic Training Related to Data Acquisition and Testing 

At least a basic training on the data acquisition and testing methods is strongly 

recommended for CAE engineers.  

7) Unnecessary Emphasis on Modeling the Minute Details Without Giving Due 

Consideration to Available Time, Hardware, And Software Capabilities 

Finite Element Analysis is an approximate approach. Modeling the things to the minute 

details without giving due consideration to the capabilities of the available software and 

hardware could unnecessarily complicate the problem. For example, when analyzing a 

structure and the failure is expected at the body, a bolt should not be simulated by 

modeling the minute details like threads. Instead a beam element and connections using 

rigids in the washer area could adequately model the bolt (in the linear static domain).   

8) Loyal to Specific Software and A Resistance to Learn and Use New Ones 

Engineers using a specific software for years, are not willing to switch to other ones. No 

commercial software is perfect, and every software has its own advantages and 

disadvantages. In the service industry, what matters most is the time and quality of the 

work. If a specific software is good but takes more time in comparison to another one for 

some specific application, then it is better to use the better one. Sometimes a 

combination of two different software works faster. For example, meshing in one 
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software and then performing quality improvement or remeshing in other. A CAE 

engineer should be loyal to his/her duty rather than a specific software.   

9) Not the CAE Engineers but The Design Engineers Are the Most Important Person 

in The Design Chain 

CAE engineers are usually highly qualified, paid higher salaries and sometimes it leads to 

a superiority complex (that they are the most important people in the design cycle 

process). But it should always be remembered that the Design engineer is the most 

important person and the role of CAE engineers is to provide analysis services to him/her 

(other service providers are test, purchase, manufacturing, etc.).      

10) While Suggesting the Modifications, No Consideration Is Taken for The 

Manufacturing Constraints and The Cost  

Effectiveness 

Sometimes the CAE engineer gives suggestions which are either not manufacturable or 

cost effective. For example, it is very easy to increase the thickness of the parts showing 

a higher stress, or to suggest that high strength (costly) material should be used, or to 

suggest geometry modifications without considering the manufacturing constraints. 

Sometimes CAE engineers are adamant about their proposals and are not willing to carry 

out further iterations as per suggestions from the design or manufacturing engineer.   

CAE Marketing Engineers 

1) Accepting Jobs Beyond Their Capabilities 

Sometimes marketing engineers accept jobs just because it is from a reputed company 

or because the volume of work is very large, without giving due consideration to the 

capabilities and limitations of their technical team and available software / hardware. 
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2) Promising Unrealistic Time Schedule:   

Sometimes marketing engineers promise to deliver results in a time span that is not 

possible with the current strength of the team and the number of software seats 

available. Maintaining a strict time schedule with good quality work is necessary and 

reflects the successful marketing of any company. Sweet talking, impressive 

infrastructure, and other facilities can create an excellent first impression with the client 

during initial visits, but it will vanish in no time if the delivery schedule isn’t maintained 

and the quality of the work is poor. 

CAE Managers and Group Leaders 

1) Committing to The Job Without Consulting the Cae Engineer 

In particular, during a visit to the clients, managers whose domain expertise is not CAE 

are involved in the meetings and sometimes commit to the job without consulting the 

responsible person.  

2) CAE Manager / Group Leader Should Be Someone Who Has Spent Several Years in 

The Field, Not the One Who Is an Expert in Another Area or A Non-Technical 

Manager 

A CAE experienced manager understands the problems faced by CAE engineers and can 

help them personally when required. A CAE job is supposed to be a white-collar job, but 

it really requires day and night hard work and involves considerable mental stress due to 

tight delivery schedules. The following replies from managers or group leaders could be 

very frustrating and demoralize any CAE engineer “don’t ask me, that’s your job” or “you 

should know these simple things” or “if you cannot do it, we will find someone else” or 

“I want results and not the problems, don’t come to my office without the results, 

understood!”. ……. 

CAE Process Management 

CAE Process Management is helping organizations to capture knowledge and ensure best 

practices for CAE. It can be used for CAE load case automation, process guidance, and 



 

572 
 
 
 

process integration. It lets organizations implement standardized CAE processes that 

automate the load case setup, interface with CAD, PDM systems, databases, and other IT 

systems and applications by capturing the “best practices” as templates. It also helps 

them retain knowledge, even when people quit and leave organizations, besides 

improving productivity and reliability of doing CAE between differently skilled CAE users. 

CAE System Administrators 

1) Laziness in Fixing Computer Hardware / Software Related Problems 

In a group of 15 CAE engineers, a minimum of 15 workstations are required. Computers 

are, after all, machines and bound to create problems. It will not be logical to expect the 

best performance from the team without providing them good computers and fixing the 

hardware, software problems immediately. A knowledgeable and prompt system 

administrator is a very valuable asset for any CAE group.  

2) Improper Data Backup Process 

One cannot afford data loss at the midpoint or at the project completion phase.  Imagine 

what the impression of the organization would be if they say to the client that although 

the job was almost finished, the system crashed, and we did not have proper data backup. 

It is the responsibility of a system administrator and CAE manager to ensure the simple 

arrangement for the daily backup and forcing all the users to backup their data before 

leaving the office. Another good practice is to avoid working in a single file throughout 

the process. Instead, save the file with a different name after every 3 or 4 hours of work 

or whenever deemed appropriate, is recommended.  

Human Resources (HR) 

Inconsistent Salaries for The Same Post and Same Job Profile 

In many (probably all) organizations, the most infamous department is HR. In CAE groups, 

it is common to find inconsistent salaries for the same qualification and the same job 

profile.  When there is an urgent requirement, HR people generally offer higher salaries. 
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When engineers come to know that the newly recruited person has been offered much 

more than what they are getting, they feel frustrated. Sometimes, this results in HR 

recruiting one new engineer and as a result, two existing engineers leave.   
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Appendix C 

Consistent Units 
This chapter includes material from the book “Practical Finite Element Analysis (From Finite to 

Infinite)”. It also has been reviewed and has additional material included by Gareth Lee and Sascha 

Beuermann. 

Numerous errors in engineering calculations can be attributed to the careless use of units. 

To avoid errors, follow these basic rules: 

• Always use a consistent set of units for each problem. 

• Develop a sense of the physical reality of the units being used and think in 

terms of those units. 

• Always apply the test of reasonableness to input and output quantities. If a 

number appears to be out of the expected range, it probably is. 

• Be particularly careful when using someone else’s work. They may have used 

a conversion factor but failed to clearly document it. 

• Avoid conversion factors and non-standard units. 

• Most general-purpose analysis codes have no built-in knowledge of units, 

making unit consistency the analyst’s responsibility. 

The fundamental units of measure used in structural analysis are: 

• Mass 

• Length 
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• Time 

• Temperature 

All other units are based on these fundamental units. Nowadays the International System 

of Units (SI) is used generally to mark the unit of dimension.  

A consistent set of base and derived units, commonly used in engineering, is given in the 

table at the end of this chapter. 

Equations Used to Help Determine Consistent Units 
To test whether a set of units is consistent, one should check basic equations. For 

example, in the case of force,  

F = m • a = m • l / t2 and therefore the definition of a Newton is 1 N = 1 kg • 1 m/s2 

Please see the Chapter about “Material and Property” Information, for examples of sets 

of consistent units.  

Be aware that most codes use angular measures in degrees in some input and output.  

For instance, RADIOSS uses degrees when inputting angles in cylindrical or spherical 

coordinate systems but outputs displacement angles in radians. Refer to the appropriate 

user’s manual to determine which measure to use for angles. 

Physical constants are also closely related to unit systems. Be certain that the constants 

you look up or “inherit” from others are in the same consistent unit set that you have 

chosen. Do not blindly accept constants passed on to you from another person.  It is best 

to look up constant values in a recognized source and reference the source in your 

documentation. 

Complex analytical projects involve a great number of details, each of which must be 

correct in order to obtain an acceptable solution. Seek assistance if you do not feel 



 

577 
 
 
 

comfortable with the magnitude of detail checking required or if you are not confident 

about your intuition regarding the “typical” answers that your type of problem should  

produce. To increase your skills and confidence, solve a scaled down version of the 

problem you are working on or, solve problems that have a handbook or closed form 

solution. 

 

The given conversion multipliers (Mult.) are valid for conversion from the SI-System to the 

given system. 
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Consistent Unit Summary 

• Use a consistent set of units which you fully understand. 

• Know your sources of physical constants. 

• Be careful with decimal points. 

• Study problems with known answers to gain confidence. 

• Solve scaled down versions of the larger problems you are working on. 

 


